Contents

Azure Migrate Documentation

Overview
  About Azure Migrate
  What's new

Common questions
  General
  Azure Migrate appliance
  Server Assessment tool/dependency analysis
  Server Migration tool

Tutorials
  Assess and migrate VMware VMs
    Prepare VMware for assessment and migration
    Assess VMware VMs for migration
    Migrate VMware VMs
      About migration options for VMware VMs
      Migrate VMware VMs with agentless migration
      Migrate VMware VMs with agent-based migration
  Assess and migrate Hyper-V VMs
    Prepare Hyper-V for assessment and migration
    Assess Hyper-V VMs for migration
    Migrate Hyper-V VMs
  Assess and migrate physical servers
    Prepare physical servers for assessment and migration
    Assess physical servers
    Migrate physical servers
  Assess imported servers for migration
    Assess imported servers for migration

Concepts
  Support matrices
General support
VMware assessment support
VMware migration support
Hyper-V assessment support
Hyper-V migration support
Physical server assessment support
Physical server migration support
Azure Migrate appliance requirements
Replication appliance requirements
Azure Migrate appliance architecture
Hyper-V migration architecture
VMware agent-based migration architecture
Assessments overview
Best practices for assessments
Dependency analysis overview
How-to guides
Create and manage Azure Migrate projects
Add a tool for the first time
Add assessment tools
Deploy Azure Migrate appliance
  Deploy appliance with template (VMware)
  Deploy appliance with template (Hyper-V)
  Deploy appliance with script (VMware/Hyper-V)
  Deploy appliance for physical servers
  Deploy appliance in Azure Government
Limit discovery scope for VMware VMs
Discover applications/roles/features
Group machines for assessment
Analyze machine dependencies (agent-based)
Analyze machine dependencies (agentless)
Create an assessment
Assess a SQL Server database
Customize an assessment
Add migration tools
Migrate VMware VMs to Azure VMs encrypted with SSE and CMK
Prepare machines for migration
Delete an Azure Migrate project
Work with previous version
Scale assessment and migration
  Assess large numbers of VMware VMs
  Assess large numbers of Hyper-V VMs
  Assess large numbers of physical servers
  Automate migration of large number of VMs
  Migration examples (Contoso series)
Troubleshoot
  Troubleshoot Azure Migrate
  Troubleshoot Azure Migrate projects
  Troubleshoot Azure Migrate appliance/discovery
  Troubleshoot assessment/dependency visualization
Resources
  Migration in the Cloud Adoption Framework
  REST API
  Resource Manager template
  Pricing
  UserVoice
  Forum
  Blog
  Azure Migrate
  Azure Roadmap
This article provides a quick overview of the Azure Migrate service.

Azure Migrate provides a centralized hub to assess and migrate to Azure on-premises servers, infrastructure, applications, and data.

Azure Migrate provides the following features:

- **Unified migration platform**: A single portal to start, run, and track your migration to Azure.
- **Range of tools**: A range of tools for assessment and migration. Tools include Azure Migrate: Server Assessment and Azure Migrate: Server Migration. Azure Migrate integrates with other Azure services and with other tools and independent software vendor (ISV) offerings.
- **Assessment and migration**: In the Azure Migrate hub, you can assess and migrate:
  - **Servers**: Assess on-premises servers and migrate them to Azure virtual machines.
  - **Databases**: Assess on-premises databases and migrate them to Azure SQL Database or to an Azure SQL Database managed instance.
  - **Web applications**: Assess on-premises web applications and migrate them to Azure App Service by using the Azure App Service Migration Assistant.
  - **Virtual desktops**: Assess your on-premises virtual desktop infrastructure (VDI) and migrate it to Windows Virtual Desktop in Azure.
  - **Data**: Migrate large amounts of data to Azure quickly and cost-effectively using Azure Data Box products.

### Integrated tools

The Azure Migrate hub includes these tools:

<table>
<thead>
<tr>
<th>TOOL</th>
<th>ASSESS AND MIGRATE</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Azure Migrate: Server Assessment</strong></td>
<td>Assess servers.</td>
<td>Discover and assess on-premises VMware VMs, Hyper-V VMs, and physical servers in preparation for migration to Azure.</td>
</tr>
<tr>
<td><strong>Azure Migrate: Server Migration</strong></td>
<td>Migrate servers.</td>
<td>Migrate VMware VMs, Hyper-V VMs, physical servers, other virtualized machines, and public cloud VMs to Azure.</td>
</tr>
<tr>
<td><strong>Data Migration Assistant</strong></td>
<td>Assess on-premises SQL Server databases</td>
<td>Data Migration Assistant helps pinpoint potential problems blocking migration. It identifies unsupported features, new features that can benefit you after migration, and the right path for database migration. Learn more.</td>
</tr>
<tr>
<td></td>
<td>for migration to Azure SQL Database, an Azure SQL Database managed instance, or Azure VMs running SQL Server.</td>
<td></td>
</tr>
<tr>
<td><strong>Azure Database Migration Service</strong></td>
<td>Migrate on-premises databases to Azure VMs running SQL Server, Azure SQL Database, or Azure SQL Database managed instances.</td>
<td>Learn more about Database Migration Service.</td>
</tr>
</tbody>
</table>
Web app migration assistant

Assess on-premises web apps and migrate them to Azure.

Use Azure App Service Migration Assistant to assess on-premises websites for migration to Azure App Service.

Use Migration Assistant to migrate .NET and PHP web apps to Azure.
Learn more about Azure App Service Migration Assistant.

Azure Data Box

Migrate offline data.

Use Azure Data Box products to move large amounts of offline data to Azure.
Learn more.

NOTE

If you're in Azure Government, external integrated tools and ISV offerings can't send data to Azure Migrate projects. You can use tools independently.

ISV integration

Azure Migrate integrates with several ISV offerings.

<table>
<thead>
<tr>
<th>ISV</th>
<th>FEATURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carbonite</td>
<td>Migrate servers.</td>
</tr>
<tr>
<td>Cloudamize</td>
<td>Assess servers.</td>
</tr>
<tr>
<td>Corent Technology</td>
<td>Assess and migrate servers.</td>
</tr>
<tr>
<td>Device42</td>
<td>Assess servers.</td>
</tr>
<tr>
<td>Lakeside</td>
<td>Assess VDI.</td>
</tr>
<tr>
<td>RackWare</td>
<td>Migrate servers.</td>
</tr>
<tr>
<td>Turbonomic</td>
<td>Assess servers.</td>
</tr>
<tr>
<td>UnifyCloud</td>
<td>Assess servers and databases.</td>
</tr>
</tbody>
</table>

Azure Migrate: Server Assessment tool

The Azure Migrate: Server Assessment tool discovers and assesses on-premises VMware VMs, Hyper-V VMs, and physical servers for migration to Azure.

Here's what the tool does:

- **Azure readiness**: Assesses whether on-premises machines are ready for migration to Azure.
- **Azure sizing**: Estimates the size of Azure VMs after migration.
Azure Migrate: Server Migration tool

The Azure Migrate: Server Migration tool helps you migrate to Azure:

- On-premises VMware VMs
- Hyper-V VMs
- Physical servers
- Other virtualized machines
- Public cloud VMs

You can migrate machines after assessing them or migrate them without an assessment.

For agentless migration of VMware VMs and migration of Hyper-V VMs, Server Migration uses an Azure Migrate appliance that you deploy on-premises. The appliance is also used if you set up server assessment. It’s described in the previous section.

Selecting assessment and migration tools

In the Azure Migrate hub, you select the tool you want to use for assessment or migration and add it to an Azure Migrate project. If you add an ISV tool or Movere:

- To get started, obtain a license or sign up for a free trial by following the tool instructions. Each ISV or tool specifies tool licensing.
- Each tool has an option to connect to Azure Migrate. Follow the tool instructions to connect.
- Track your migration across all tools from within the Azure Migrate project.

Movere

Movere is a software as a service (SaaS) platform. It increases business intelligence by accurately presenting entire IT environments within a single day. Organizations and enterprises grow, change, and digitally optimize. As they do so, Movere provides them with the needed confidence to see and control their environments, whatever the platform, application, or geography.

Microsoft acquired Movere, and it’s no longer sold as a standalone offer. Movere is available through Microsoft Solution Assessment and Microsoft Cloud Economics Program. Learn more about Movere.

We encourage you to also look at Azure Migrate, our built-in migration service. Azure Migrate provides a central hub to simplify your cloud migration. The hub comprehensively supports workloads like physical and virtual servers, databases, and applications. End-to-end visibility lets you easily track progress throughout discovery, assessment, and migration.

With both Azure and partner ISV tools built in, Azure Migrate has an extensive range of features, including:

- **Azure cost estimation**: Estimates costs for running on-premises servers in Azure.
- **Dependency analysis**: Identifies cross-server dependencies and optimization strategies for moving interdependent servers to Azure. Learn more about Server Assessment with dependency analysis.

Server Assessment uses a lightweight Azure Migrate appliance that you deploy on-premises.

- The appliance runs on a VM or physical server. You can install it easily using a downloaded template.
- The appliance discovers on-premises machines. It also continually sends machine metadata and performance data to Azure Migrate.
- Appliance discovery is agentless. Nothing is installed on discovered machines.
- After appliance discovery, you can gather discovered machines into groups and run assessments for each group.
- Discovery of virtual and physical servers.
- Performance-based rightsizing.
- Cost planning.
- Import-based assessments.
- Dependency analysis of agentless applications.

If you're looking for expert help to get started, Microsoft has skilled Azure Expert Managed Service Providers to guide you. Check out the Azure Migrate website.

**Azure Migrate versions**

There are two versions of the Azure Migrate service.

- **Current version**: Use this version to create Azure Migrate projects, discover on-premises machines, and orchestrate assessments and migrations. Learn more about what's new in this version.

- **Previous version**: The previous version of Azure Migrate supports only assessment of on-premises VMware VMs. If you used the previous version, you should now use the current version. You can no longer create Azure Migrate projects using the previous version. And we recommend that you don't do new discoveries with it.

  To access existing projects in the Azure portal, search for and select Azure Migrate. The Azure Migrate dashboard has a notification and a link to access old Azure Migrate projects.

**Next steps**

- Try our tutorials to assess VMware VMs, Hyper-V VMs, or physical servers.
- Review frequently asked questions about Azure Migrate.
Azure Migrate helps you to discover, assess, and migrate on-premises servers, apps, and data to the Microsoft Azure cloud. This article summarizes new releases and features in Azure Migrate.

Update (April 2020)

Azure Migrate supports deployments in Azure Government.

- You can discover and assess VMware VMs, Hyper-V VMs, and physical servers.
- You can migrate VMware VMs, Hyper-V VMs, and physical servers to Azure.
- For VMware migration, you can use agentless or agent-based migration. Learn more.
- Review supported geographies and regions for Azure Government.
- Agent-based dependency analysis isn't supported in Azure Government.
- Features in preview are supported in Azure Government, specifically agentless dependency analysis, and application discovery.

Update (March 2020)

A script-based installation is now available to set up the Azure Migrate appliance:

- The script-based installation is an alternative to the .OVA (VMware)/VHD (Hyper-V) installation of the appliance.
- It provides a PowerShell installer script that can be used to set up the appliance for VMware/Hyper-V on an existing machine running Windows Server 2016.

Update (November 2019)

A number of new features were added to Azure Migrate:

- Physical server assessment. Assessment of on-premises physical servers is now supported, in addition to physical server migration that is already supported.
- Import-based assessment. Assessment of machines using metadata and performance data provided in a CSV file is now supported.
- Application discovery: Azure Migrate now supports application-level discovery of apps, roles, and features using the Azure Migrate appliance. This is currently supported for VMware VMs only, and is limited to discovery only (assessment isn't currently supported). Learn more
- Agentless dependency visualization: You no longer need to explicitly install agents for dependency visualization. Both agentless and agent-based are now supported.
- Virtual Desktop: Use ISV tools to assess and migrate on-premises virtual desktop infrastructure (VDI) to Windows Virtual Desktop in Azure.
- Web app: The Azure App Service Migration Assistant, used for assessing and migration web apps, is now integrated into Azure Migrate.

New assessment and migration tools were added to Azure Migrate:

- Rackware: Offering cloud migration.
- Movere: Offering assessment.

Learn more about using tools and ISV offerings for assessment and migration in Azure Migrate.
Azure Migrate current version

The current version of Azure Migrate (released in July 2019) provides a number of new features:

- **Unified migration platform**: Azure Migrate now provides a single portal to centralize, manage, and track your migration journey to Azure, with an improved deployment flow and portal experience.

- **Assessment and migration tools**: Azure Migrate provides native tools, and integrates with other Azure services, as well as with independent software vendor (ISV) tools. [Learn more](#) about ISV integration.

- **Azure Migrate assessment**: Using the Azure Migrate Server Assessment tool, you can assess VMware VMs and Hyper-V VMs for migration to Azure. You can also assess for migration using other Azure services, and ISV tools.

- **Azure Migrate migration**: Using the Azure Migrate Server Migration tool, you can migrate on-premises VMware VMs and Hyper-V VMs to Azure, as well as physical servers, other virtualized servers, and private/public cloud VMs. In addition, you can migrate to Azure using ISV tools.

- **Azure Migrate appliance**: Azure Migrate deploys a lightweight appliance for discovery and assessment of on-premises VMware VMs and Hyper-V VMs.
  - This appliance is used by Azure Migrate Server Assessment, and Azure Migrate Server Migration for agentless migration.
  - The appliance continuously discovers server metadata and performance data, for the purposes of assessment and migration.

- **VMware VM migration**: Azure Migrate Server Migration provides a couple of methods for migrating on-premises VMware VMs to Azure. An agentless migration using the Azure Migrate appliance, and an agent-based migration that uses a replication appliance, and deploys an agent on each VM you want to migrate. [Learn more](#)

- **Database assessment and migration**: From Azure Migrate, you can assess on-premises databases for migration to Azure using the Azure Database Migration Assistant. You can migrate databases using the Azure Database Migration Service.

- **Web app migration**: You can assess web apps using a public endpoint URL with the Azure App Service. For migration of internal .NET apps, you can download and run the App Service Migration Assistant.

- **Data Box**: Import large amounts offline data into Azure using Azure Data Box in Azure Migrate.

Azure Migrate previous version

If you're using the previous version of Azure Migrate (only assessment of on-premises VMware VMs was supported), you should now use the current version. In the previous version, you can no longer create new Azure Migrate projects, or perform new discoveries. You can still access existing projects. To do this in the Azure portal > **All services**, search for **Azure Migrate**. In the Azure Migrate notifications, there's a link to access old Azure Migrate projects.

Next steps

- [Learn more](#) about Azure Migrate pricing.
- [Review frequently asked questions](#) about Azure Migrate.
- Try out our tutorials to assess **VMware VMs** and **Hyper-V VMs**.
This article answers common questions about Azure Migrate. If you have questions after you read this article, you can post them in the Azure Migrate forum. You also can review these articles:

- Questions about the Azure Migrate appliance
- Questions about discovery, assessment, and dependency visualization

What is Azure Migrate?

Azure Migrate provides a central hub to track discovery, assessment, and migration of your on-premises apps and workloads and private and public cloud VMs to Azure. The hub provides Azure Migrate tools for assessment and migration and third-party ISV offerings. Learn more.

What can I do with Azure Migrate?

Use Azure Migrate to discover, assess, and migrate on-premises infrastructure, applications, and data to Azure. Azure Migrate supports assessment and migration of on-premises VMware VMs, Hyper-V VMs, physical servers, other virtualized VMs, databases, web apps, and virtual desktops.

What's the difference between Azure Migrate and Azure Site Recovery?

Azure Migrate provides a centralized hub for assessment and migration to Azure.

Azure Site Recovery is a disaster recovery solution.

The Azure Migrate: Server Migration tool uses some back-end Site Recovery functionality for lift-and-shift migration of some on-premises machines.

What's the difference between Azure Migrate: Server Assessment and the MAP Toolkit?

Server Assessment provides assessment to help with migration readiness, and evaluation of workloads for migration to Azure. The Microsoft Assessment and Planning (MAP) Toolkit helps with other tasks, including migration planning for newer versions of Windows client and server operating systems, and software usage tracking. For these scenarios, continue to use the MAP Toolkit.

What's the difference between Server Assessment Deployment Planner and the Site Recovery Deployment Planner?

Server Assessment is a migration planning tool. The Site Recovery Deployment Planner is a disaster recovery planning tool.

Choose your tool based on what you want to do:

- **Plan on-premises migration to Azure**: If you plan to migrate your on-premises servers to Azure, use Server Assessment for migration planning. Server Assessment assesses on-premises workloads and provides guidance and tools to help you migrate. After the migration plan is in place, you can use tools like Azure Migrate: Server Migration to migrate the machines to Azure.
Plan disaster recovery to Azure: If you plan to set up disaster recovery from on-premises to Azure with Site Recovery, use the Site Recovery Deployment Planner. The Deployment Planner provides a deep, Site Recovery-specific assessment of your on-premises environment for the purpose of disaster recovery. It provides recommendations related to disaster recovery, such as replication and failover.

How does Server Migration work with Site Recovery?

- If you use Azure Migrate: Server Migration to perform an *agentless* migration of on-premises VMware VMs, migration is native to Azure Migrate and Site Recovery isn’t used.
- If you use Azure Migrate: Server Migration to perform an *agent-based* migration of VMware VMs, or if you migrate Hyper-V VMs or physical servers, Azure Migrate: Server Migration uses the Azure Site Recovery replication engine.

Which geographies are supported?

Review the supported geographies for public and government clouds.

How do I get started?

Identify the tool you need, and then add the tool to an Azure Migrate project.

To add an ISV tool or Movere:

1. Get started by obtaining a license, or sign up for a free trial, in accordance with the tool policy. Licensing for tools is in accordance with the ISV or tool licensing model.
2. In each tool, there’s an option to connect to Azure Migrate. Follow the tool instructions and documentation to connect the tool with Azure Migrate.

You can track your migration journey from within the Azure Migrate project, across Azure, and in other tools.

How do I delete a project?

Learn how to delete a project.

Next steps

Read the Azure Migrate overview.
This article answers common questions about the Azure Migrate appliance. If you have other questions, check these resources:

- **General questions** about Azure Migrate
- Questions about **discovery, assessment, and dependency visualization**
- Questions about **server migration**
- Get questions answered in the [Azure Migrate forum](https://aka.ms/im/AzureMigrateHelp)

**What is the Azure Migrate appliance?**

The Azure Migrate appliance is a lightweight appliance that the Azure Migrate: Server Assessment tool uses to discover and assess on-premises servers. The Azure Migrate: Server Migration tool also uses the appliance for agentless migration of on-premises VMware VMs.

Here's more information about the Azure Migrate appliance:

- The appliance is deployed on-premises as a VM or physical machine.
- The appliance discovers on-premises machines and continually sends machine metadata and performance data to Azure Migrate.
- Appliance discovery is agentless. Nothing is installed on discovered machines.

[Learn more](https://aka.ms/im/AzureMigrateHelp) about the appliance.

**How can I deploy the appliance?**

The appliance can be deployed as follows:

- Using a template for VMware VMs and Hyper-V VMs (OVA template for VMware or VHD for Hyper-V).
- If you don't want to use a template, or you're in Azure Government, you can deploy the appliance for VMware or Hyper-V using a PowerShell script.
- For physical servers, you always deploy the appliance using a script.

**How does the appliance connect to Azure?**

The appliance can connect over the internet or by using Azure ExpressRoute with public/Microsoft peering.

**Does appliance analysis affect performance?**

The Azure Migrate appliance profiles on-premises machines continuously to measure performance data. This profiling has almost no performance impact on profiled machines.

**Can I harden the appliance VM?**

When you use the downloaded template to create the appliance VM, you can add components (antivirus, for example) to the template if you leave in place the communication and firewall rules that are required for the Azure Migrate appliance.
What network connectivity is required?
The appliance needs access to Azure URLs. Review the URL list.

What data does the appliance collect?
See the following articles for information about data that the Azure Migrate appliance collects on VMs:

- **VMware VM**: Review collected data.
- **Hyper-V VM**: Review collected data.

How is data stored?
Data that's collected by the Azure Migrate appliance is stored in the Azure location where you created the Azure Migrate project.

Here's more information about how data is stored:

- The collected data is securely stored in CosmosDB in a Microsoft subscription. The data is deleted when you delete the Azure Migrate project. Storage is handled by Azure Migrate. You can't specifically choose a storage account for collected data.
- If you use dependency visualization, the data that's collected is stored in the United States in an Azure Log Analytics workspace created in your Azure subscription. The data is deleted when you delete the Log Analytics workspace in your subscription.

How much data is uploaded during continuous profiling?
The volume of data that's sent to Azure Migrate depends on multiple parameters. As an example, an Azure Migrate project that has 10 machines (each with one disk and one NIC) sends approximately 50 MB of data per day. This value is approximate; the actual value varies depending on the number of data points for the disks and NICs. If the number of machines, disks, or NICs increases, the increase in data that's sent is nonlinear.

Is data encrypted at rest and in transit?
Yes, for both:

- Metadata is securely sent to the Azure Migrate service over the internet via HTTPS.
- Metadata is stored in an Azure Cosmos database and in Azure Blob storage in a Microsoft subscription. The metadata is encrypted at rest for storage.
- The data for dependency analysis also is encrypted in transit (by secure HTTPS). It's stored in a Log Analytics workspace in your subscription. The data is encrypted at rest for dependency analysis.

How does the appliance connect to vCenter Server?
These steps describe how the appliance connects to VMware vCenter Server:

1. The appliance connects to vCenter Server (port 443) by using the credentials you provided when you set up the appliance.
2. The appliance uses VMware PowerCLI to query vCenter Server to collect metadata about the VMs that are managed by vCenter Server.
3. The appliance collects configuration data about VMs (cores, memory, disks, NICs) and the performance history of each VM for the past month.
4. The collected metadata is sent to the Azure Migrate: Server Assessment tool (over the internet via HTTPS) for assessment.
Can the Azure Migrate appliance connect to multiple vCenter Servers?

No. There's a one-to-one mapping between an Azure Migrate appliance and vCenter Server. To discover VMs on multiple vCenter Server instances, you must deploy multiple appliances.

Can an Azure Migrate project have multiple appliances?

A project can have multiple appliances attached to it. However, an appliance can only be associated with one project.

Can the Azure Migrate appliance/Replication appliance connect to the same vCenter?

Yes. You can add both the Azure Migrate appliance (used for assessment and agentless VMware migration), and the replication appliance (used for agent-based migration of VMware VMs) to the same vCenter server.

How many VMs or servers can I discover with an appliance?

You can discover up to 10,000 VMware VMs, up to 5,000 Hyper-V VMs, and up to 250 physical servers with a single appliance. If you have more machines in your on-premises environment, read about scaling a Hyper-V assessment, scaling a VMware assessment, and scaling a physical server assessment.

Can I delete an appliance?

Currently, deleting an appliance from the project isn't supported.

The only way to delete the appliance is to delete the resource group that contains the Azure Migrate project that's associated with the appliance.

However, deleting the resource group also deletes other registered appliances, the discovered inventory, assessments, and all other Azure components in the resource group that are associated with the project.

Can I use the appliance with a different subscription or project?

After you use the appliance to initiate discovery, you can't reconfigure the appliance to use with a different Azure subscription, and you can't use it in a different Azure Migrate project. You also can't discover VMs on a different instance of vCenter Server. Set up a new appliance for these tasks.

Can I set up the appliance on an Azure VM?

No. Currently, this option isn't supported.

Can I discover on an ESXi host?

No. To discover VMware VMs, you must have vCenter Server.

How do I update the appliance?

By default, the appliance and its installed agents are updated automatically. The appliance checks for updates every 24 hours. Updates that fail are retried.

Only the appliance and the appliance agents are updated by these automatic updates. The operating system is not updated by Azure Migrate automatic updates. Use Windows Updates to keep the operating system up to date.
Can I check agent health?

Yes. In the portal, go to the Agent health page for the Azure Migrate: Server Assessment or Azure Migrate: Server Migration tool. There, you can check the connection status between Azure and the discovery and assessment agents on the appliance.

Next steps

Read the Azure Migrate overview.
Discovery, assessment, and dependency analysis -
Common questions

4/19/2020 • 8 minutes to read • Edit Online

This article answers common questions about discovery, assessment, and dependency analysis in Azure Migrate. If you have other questions, check these resources:

- General questions about Azure Migrate
- Questions about the Azure Migrate appliance
- Questions about server migration
- Get questions answered in the Azure Migrate forum

What geographies are supported for discovery and assessment with Azure Migrate?

Review the supported geographies for public and government clouds.

How many VMs can I discover with an appliance?

You can discover up to 10,000 VMware VMs, up to 5,000 Hyper-V VMs, and up to 250 physical servers by using a single appliance. If you have more machines, read about scaling a Hyper-V assessment, scaling a VMware assessment, or scaling a physical server assessment.

I can't see some VM types in Azure Government

VM types supported for assessment and migration depend on availability in Azure Government location. You can review and compare VM types in Azure Government.

The size of my VM changed. Can I run an assessment again?

The Azure Migrate appliance continuously collects information about the on-premises environment. An assessment is a point-in-time snapshot of on-premises VMs. If you change the settings on a VM that you want to assess, use the recalculate option to update the assessment with the latest changes.

How do I discover VMs in a multitenant environment?

- **VMware**: If an environment is shared across tenants and you don’t want to discover a tenant’s VMs in another tenant’s subscription, create VMware vCenter Server credentials that can access only the VMs you want to discover. Then, use those credentials when you start discovery in the Azure Migrate appliance.

- **Hyper-V**: Discovery uses Hyper-V host credentials. If VMs share the same Hyper-V host, there’s currently no way to separate the discovery.

Do I need vCenter Server?

Yes, Azure Migrate requires vCenter Server in a VMware environment to perform discovery. Azure Migrate doesn’t support discovery of ESXi hosts that aren’t managed by vCenter Server.

What are the sizing options?
With as-on-premises sizing, Azure Migrate doesn't consider VM performance data for assessment. Azure Migrate assesses VM sizes based on the on-premises configuration. With performance-based sizing, sizing is based on utilization data.

For example, if an on-premises VM has four cores and 8 GB of memory at 50% CPU utilization and 50% memory utilization:

- As-on-premises sizing will recommend an Azure VM SKU that has four cores and 8 GB of memory.
- Performance-based sizing will recommend a VM SKU that has two cores and 4 GB of memory because the utilization percentage is considered.

Similarly, disk sizing depends on sizing criteria and storage type:

- If the sizing criteria is performance-based and the storage type is automatic, Azure Migrate takes the IOPS and throughput values of the disk into account when it identifies the target disk type (Standard or Premium).
- If the sizing criteria is performance-based and the storage type is Premium, Azure Migrate recommends a Premium disk SKU based on the size of the on-premises disk. The same logic is applied to disk sizing when the sizing is as-on-premises and the storage type is Standard or Premium.

Does performance history and utilization affect sizing?

Yes, performance history and utilization affect sizing in Azure Migrate.

**Performance history**

For performance-based sizing only, Azure Migrate collects the performance history of on-premises machines, and then uses it to recommend the VM size and disk type in Azure:

1. The appliance continuously profiles the on-premises environment to gather real-time utilization data every 20 seconds.
2. The appliance rolls up the collected 20-second samples and uses them to create a single data point every 15 minutes.
3. To create the data point, the appliance selects the peak value from all 20-second samples.
4. The appliance sends the data point to Azure.

**Utilization**

When you create an assessment in Azure, depending on performance duration and the performance history percentile value that is set, Azure Migrate calculates the effective utilization value, and then uses it for sizing.

For example, if you set the performance duration to one day and the percentile value to 95th percentile, Azure Migrate sorts the 15-minute sample points sent by the collector for the past day in ascending order. It picks the 95th percentile value as the effective utilization.

Using the 95th percentile value ensures that outliers are ignored. Outliers might be included if your Azure Migrate uses the 99th percentile. To pick the peak usage for the period without missing any outliers, set Azure Migrate to use the 99th percentile.

How are import-based assessments different from assessments with discovery source as appliance?

Import-based assessments are assessments created with machines that are imported into Azure Migrate using a CSV file. Only four fields are mandatory to import: Server name, cores, memory, and operating system. Here are some things to note:

- The readiness criteria is less stringent in import-based assessments on the boot type parameter. If the boot type isn't provided, it is assumed the machine has BIOS boot type and the machine is not marked as **Conditionally**
What is dependency visualization?

Dependency visualization can help you assess groups of VMs to migrate with greater confidence. Dependency visualization cross-checks machine dependencies before you run an assessment. It helps ensure that nothing is left behind, and it helps avoid unexpected outages when you migrate to Azure. Azure Migrate uses the Service Map solution in Azure Monitor to enable dependency visualization. Learn more.

What’s the difference between agent-based and agentless?

The differences between agentless visualization and agent-based visualization are summarized in the table.

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>AGENTLESS</th>
<th>AGENT-BASED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support</td>
<td>This option is currently in preview, and is only available for VMware VMs. Review supported operating systems.</td>
<td>In general availability (GA).</td>
</tr>
<tr>
<td>Agent</td>
<td>No need to install agents on machines you want to cross-check.</td>
<td>Agents to be installed on each on-premises machine that you want to analyze: The Microsoft Monitoring agent (MMA), and the Dependency agent.</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Review the prerequisites and deployment requirements.</td>
<td>Review the prerequisites and deployment requirements.</td>
</tr>
<tr>
<td>Log Analytics</td>
<td>Not required.</td>
<td>Azure Migrate uses the Service Map solution in Azure Monitor logs for dependency visualization. Learn more.</td>
</tr>
<tr>
<td>How it works</td>
<td>Captures TCP connection data on machines enabled for dependency visualization. After discovery, it gathers data at intervals of five minutes.</td>
<td>Service Map agents installed on a machine gather data about TCP processes and inbound/outbound connections for each process.</td>
</tr>
<tr>
<td>Data</td>
<td>Source machine server name, process, application name. Destination machine server name, process, application name, and port.</td>
<td>Source machine server name, process, application name. Destination machine server name, process, application name, and port. Number of connections, latency, and data transfer information are gathered and available for Log Analytics queries.</td>
</tr>
</tbody>
</table>
### Data export

- **Agentless**: Can't currently be downloaded in tabular format.
- **Agent-Based**: Data can be queried with Log Analytics.

---

### Do I pay for dependency visualization?

No. Learn more about [Azure Migrate pricing](#).

### What do I install for agent-based dependency visualization?

To use agent-based dependency visualization, download and install agents on each on-premises machine that you want to evaluate:

- Microsoft Monitoring Agent (MMA)
- Dependency agent
- If you have machines that don't have internet connectivity, download and install the Log Analytics gateway on them.

You need these agents only if you use agent-based dependency visualization.

### Can I use an existing workspace?

Yes, for agent-based dependency visualization you can attach an existing workspace to the migration project and use it for dependency visualization.

### Can I export the dependency visualization report?

No, the dependency visualization report in agent-based visualization can't be exported. However, Azure Migrate uses Service Map, and you can use the [Service Map REST API](#) to retrieve the dependencies in JSON format.

### Can I automate agent installation?

For agent-based dependency visualization:

- Use a [script](#) to install the Dependency agent.
- For MMA, use the command line or automation, or use a [script](#).
- In addition to scripts, you can use deployment tools like Microsoft Endpoint Configuration Manager and [Intigua](#) to deploy the agents.

### What operating systems does MMA support?

- View the list of [Windows operating systems](#) that MMA supports.
- View the list of [Linux operating systems](#) that MMA supports.
Can I visualize dependencies for more than one hour?

For agent-based visualization, you can visualize dependencies for up to one hour. You can go back as far as one month to a specific date in history, but the maximum duration for visualization is one hour. For example, you can use the time duration in the dependency map to view dependencies for yesterday, but you can view dependencies only for a one-hour window. However, you can use Azure Monitor logs to query dependency data for a longer duration.

For agentless visualization, you can view the dependency map of a single server from a duration of between one hour and 30 days.

Can I visualize dependencies for groups of more than 10 VMs?

You can visualize dependencies for groups that have up to 10 VMs. If you have a group that has more than 10 VMs, we recommend that you split the group into smaller groups, and then visualize the dependencies.

Next steps

Read the Azure Migrate overview.
This article answers common questions about the Azure Migrate: Server Migration tool. If you have other questions, check these resources:

- General questions about Azure Migrate
- Questions about the Azure Migrate appliance
- Questions about discovery, assessment, and dependency visualization
- Get questions answered in the Azure Migrate forum

What geographies are supported for migration with Azure Migrate?
Review the supported geographies for public and government clouds.

How does agentless VMware replication work?
The agentless replication method for VMware uses VMware snapshots and VMware Changed Block Tracking (CBT).

Here’s the process:

1. When you start replication, an initial replication cycle is scheduled. In the initial cycle, a snapshot of the VM is taken. The snapshot is used to replicate the VMs VMDKs (disks).
2. After the initial replication cycle finishes, delta replication cycles are scheduled periodically.
   - During delta replication, a snapshot is taken, and data blocks that have changed since the previous replication cycle are replicated.
   - VMware CBT is used to determine blocks that have changed since the last cycle.
   - The frequency of the periodic replication cycles is automatically managed by Azure Migrate and depends on how many other VMs and disks are concurrently replicating from the same datastore. In ideal conditions, replication eventually converges to one cycle per hour for each VM.

When you migrate, an on-demand replication cycle is scheduled for the machine to capture any remaining data. To ensure zero data loss and application consistency, you can choose to shut down the machine during migration.

Why isn't resynchronization exposed?
During agentless migration, in every delta cycle, the difference between the current snapshot and the previously taken snapshot is written. It's always the difference between snapshots, folding data in. If a specific sector is written N times between snapshots, only the last write needs to be transferred because we are interested only in the last sync. The process is different from agent-based replication, during which we track and apply every write. In this process, every delta cycle is a resynchronization. So, no resynchronization option exposed. If the disks ever are not synchronized because of a failure, it's fixed in the next cycle.

How does churn rate affect agentless replication?
Because agentless replication folds in data, the churn pattern is more important than the churn rate. When a file is written again and again, the rate doesn't have much impact. However, a pattern in which every other sector is written causes high churn in the next cycle. Because we minimize the amount of data we transfer, we allow the data to fold as much as possible before we schedule the next cycle.
How frequently is a replication cycle scheduled?
The formula to schedule the next replication cycle is (previous cycle time / 2) or one hour, whichever is higher.

For example, if a VM takes four hours for a delta cycle, the next cycle is scheduled in two hours, and not in the next hour. The process is different immediately after initial replication, when the first delta cycle is scheduled immediately.

How does agentless replication affect VMware servers?
Agentless replication results in some performance impact on VMware vCenter Server and VMware ESXi hosts. Because agentless replication uses snapshots, it consumes IOPS on storage, so some IOPS storage bandwidth is required. We don’t recommend using agentless replication if you have constraints on storage or IOPs in your environment.

Can I do agentless migration of UEFI VMs to Azure Gen 2?
No. Use Azure Site Recovery to migrate these VMs to Gen 2 Azure VMs.

Can I pin VMs to Azure Availability Zones when I migrate?
No. Azure Availability Zones aren’t supported for Azure Migrate migration.

What transport protocol does Azure Migrate use during replication?
Azure Migrate uses the Network Block Device (NBD) protocol with TLS encryption.

What is the minimum vCenter Server version required for migration?
You must have at least vCenter Server 5.5 and vSphere ESXi host version 5.5.

Can customers migrate their VMs to unmanaged disks?
No. Azure Migrate supports migration only to managed disks (Standard HDD, Premium SSD).

How many VMs can I replicate at one time by using agentless migration?
Currently, you can migrate 100 VMs per instance of vCenter Server simultaneously. Migrate in batches of 10 VMs.

How do I throttle replication in using Azure Migrate appliance for agentless VMware replication?
You can throttle using NetQosPolicy. For example:

The AppNamePrefix to use in the NetQosPolicy is "GatewayWindowsService.exe". You could create a policy on the Azure Migrate appliance to throttle replication traffic from the appliance by creating a policy such as this one:

New-NetQosPolicy -Name "ThrottleReplication" -AppPathNameMatchCondition "GatewayWindowsService.exe" -ThrottleRateActionBitsPerSecond 1MB

When do I migrate machines as physical servers?
Migrating machines by treating them as physical servers is useful in a number of scenarios:
I deployed two (or more) appliances to discover VMs in my vCenter Server. However, when I try to migrate the VMs, I only see VMs corresponding to one of the appliance.

While this may be a good use case, we currently do not support it. Deploying two (or more) appliances to discover same set of VMs causes a service issue in which VM ownership keeps toggling between the two appliances. This is the reason you see VMs appearing and disappearing. In such cases, to resolve the issue, you must delete one appliance and do a hard refresh.

Do I need VMware vCenter to migrate VMware VMs?

To migrate VMware VMs using VMware agent-based or agentless migration, ESXi hosts on which VMs are located must be managed by vCenter Server. If you don’t have vCenter Server, you can migrate VMware VMs by migrating them as physical servers. Learn more.

Next steps

Read the Azure Migrate overview.
This article helps you to prepare for assessment and/or migration of on-premises VMware VMs to Azure using Azure Migrate.

This tutorial is the first in a series that shows you how to assess and migrate VMware VMs. In this tutorial, you learn how to:

- Prepare Azure to work with Azure Migrate.
- Prepare VMware for VM assessment with the Azure Migrate:Server Assessment tool.
- Prepare VMware for VM migration with the Azure Migrate:Server Migration tool.

**NOTE**

Tutorials show you the simplest deployment path for a scenario. They're useful when you learn how to set up a deployment, and as a quick proof-of-concept. Tutorials use default options where possible, and don't show all possible settings and paths.

If you don't have an Azure subscription, create a free account before you begin.

## Prepare Azure

You need these permissions for these tasks in Azure, before you can assess or migrate VMware VMs.

<table>
<thead>
<tr>
<th>TASK</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an Azure Migrate project</td>
<td>Your Azure account needs Contributor or Owner permissions to create a project.</td>
</tr>
<tr>
<td>Register resource providers</td>
<td>Azure Migrate uses a lightweight Azure Migrate appliance to discover and assess VMware VMs, and to migrate them to Azure with Azure Migrate:Server Assessment.</td>
</tr>
<tr>
<td></td>
<td>During appliance registration, resource providers are registered with the subscription chosen in the appliance.</td>
</tr>
<tr>
<td></td>
<td>Learn more.</td>
</tr>
<tr>
<td></td>
<td>To register the resource providers, you need a Contributor or Owner role on the subscription.</td>
</tr>
</tbody>
</table>
Create Azure AD apps

When registering the appliance, Azure Migrate creates Azure Active Directory (Azure AD) apps.

- The first app is used for communication between the agents running on the appliance, and their respective services running on Azure.

- The second app is used exclusively to access KeyVault created in the user's subscription for agentless VMware VM migration. Learn more.

You need permissions to create Azure AD apps (available in the Application Developer) role.

Create a Key Vault

To migrate VMware VMs using agentless migration, Azure Migrate creates a Key Vault to manage access keys to the replication storage account in your subscription.

To create the vault, you need role assignment permissions on the resource group in which the Azure Migrate project resides.

Assign permissions to create project

1. In the Azure portal, open the subscription, and select Access control (IAM).
2. In Check access, find the relevant account, and click it to view permissions.
3. You should have Contributor or Owner permissions.
   - If you just created a free Azure account, you're the owner of your subscription.
   - If you're not the subscription owner, work with the owner to assign the role.

Assign permissions to register the appliance

To register the appliance, you assign permissions for Azure Migrate to create the Azure AD apps during appliance registration. The permissions can be assigned using one of the following methods:

- **Grant permissions**: A tenant/global admin can grant permissions to users in the tenant, to create and register Azure AD apps.
- **Assign application developer role**: A tenant/global admin can assign the Application Developer role (that has the permissions) to the account.

**NOTE**
- The apps don't have any other access permissions on the subscription other than those described above.
- You only need these permissions when you register a new appliance. You can remove the permissions after the appliance is set up.

Grant account permissions

If you want tenant/global admin to grant permissions, do this as follows:

1. In Azure AD, the tenant/global admin should navigate to Azure Active Directory > Users > User Settings.
2. The admin should set App registrations to Yes. This is a default setting that isn't sensitive. Learn more.
Assign Application Developer role
Alternatively, the tenant/global admin can assign the Application Developer role to an account. Learn more about assigning a role.

Assign permissions to create a Key Vault
To enable Azure Migrate to create a Key Vault, assign permissions as follows:

1. In the resource group in the Azure portal, select Access control (IAM).
2. In Check access, find the relevant account, and click it to view permissions.
   - To run server assessment, Contributor permissions are enough.
   - To run agentless server migration, you should have Owner (or Contributor and User Access Administrator) permissions.
3. If you don’t have the required permissions, request them from the resource group owner.

Prepare for VMware VM assessment
To prepare for VMware VM assessment, you need to:

- **Verify VMware settings.** Make sure that the vCenter Server and VMs you want to migrate meet requirements.
- **Set up an account for assessment.** Azure Migrate uses this account to access the vCenter Server, to discover VMs for assessment.
- **Verify appliance requirements.** Verify deployment requirements for the Azure Migrate appliance, before you deploy it.

**Verify VMware settings**
1. **Check** VMware server requirements for assessment.
2. **Make sure** that the ports you need are open on vCenter Server.
3. On vCenter Server, make sure that your account has permissions to create a VM using an OVA file. You deploy the Azure Migrate appliance as a VMware VM, using an OVA file.
Set up an account for assessment

Azure Migrate needs to access the vCenter Server to discover VMs for assessment and agentless migration.

- If you plan to discover applications or visualize dependency in an agentless manner, create a vCenter Server account with read-only access along with privileges enabled for **Virtual machines > Guest Operations**.

If you are not planning to do application discovery and agentless dependency visualization, set up a read-only account for the vCenter Server.

Verify appliance settings for assessment

Before setting up the Azure Migrate appliance and beginning assessment in the next tutorial, prepare for appliance deployment.

1. **Verify** Azure Migrate appliance requirements.
2. Review the Azure URLs that the appliance will need to access in the public and government clouds.
3. **Review data** that the appliance collects during discovery and assessment.
4. **Note** port access requirements for the appliance.

Prepare for agentless VMware migration

Review the requirements for **agentless migration** of VMware VMs.

1. **Review** VMware server requirements.
2. Review the permissions that Azure Migrate needs to access the vCenter Server.
3. Review VMware VMs requirements.
4. Review the Azure Migrate appliance requirements.
5. Note the URL access required for public and government clouds.
6. Review port access requirements.

Prepare for agent-based VMware migration

Review the requirements for agent-based migration of VMware VMs.

1. Review VMware server requirements.
2. Review the permissions Azure Migrate needs to access the vCenter Server.
3. Review VMware VMs requirements, including installation of the Mobility service on each VM you want to migrate.
4. Agent-based migration uses a replication appliance:
   - Review the deployment requirements for the replication appliance.
   - Review the options for installing MySQL on the appliance.
   - Note the URL access required for public and government clouds.
   - Review port access requirements for the replication appliance.

Next steps

In this tutorial, you:

- Set up Azure permissions.
- Prepared VMware for assessment and migration.

Continue to the second tutorial to set up an Azure Migrate project, and assess VMware VMs for migration to Azure.

Assess VMware VMs
This article shows you how to assess on-premises VMware virtual machines (VMs), using the Azure Migrate:Server Assessment tool.

This tutorial is the second in a series that demonstrates how to assess and migrate VMware VMs to Azure. In this tutorial, you learn how to:

- Set up an Azure Migrate project.
- Set up an Azure Migrate appliance that runs on-premises to assess VMs.
- Start continuous discovery of on-premises VMs. The appliance sends configuration and performance data for discovered VMs to Azure.
- Group discovered VMs, and assess the VM group.
- Review the assessment.

**NOTE**

Tutorials show you the simplest deployment path for a scenario so that you can quickly set up a proof-of-concept. Tutorials use default options where possible, and don't show all possible settings and paths. For detailed instructions, review the how-to articles.

If you don't have an Azure subscription, create a free account before you begin.

**Prerequisites**

- Complete the first tutorial in this series. If you don't, the instructions in this tutorial won't work.
- Here's what you should have done in the first tutorial:
  - Prepare Azure to work with Azure Migrate.
  - Prepare VMware for assessment for assessment. This includes checking VMware settings, setting up an account that Azure Migrate can use to access vCenter Server.
  - Verify what you need in order to deploy the Azure Migrate appliance for VMware assessment.

**Set up an Azure Migrate project**

Set up a new Azure Migrate project as follows:

1. In the Azure portal > All services, search for Azure Migrate.
2. Under Services, select Azure Migrate.
3. In Overview, under Discover, assess and migrate servers, select Assess and migrate servers.
4. In **Getting started**, select **Add tools**.

5. In **Migrate project**, select your Azure subscription, and create a resource group if you don’t have one.

6. In **Project Details**, specify the project name and the geography in which you want to create the project. Review supported geographies for **public** and **government clouds**.

7. Select **Next**.

8. In **Select assessment tool**, select **Azure Migrate: Server Assessment > Next**.
9. In Select migration tool, select Skip adding a migration tool for now > Next.

10. In Review + add tools, review the settings, and select Add tools.

11. Wait a few minutes for the Azure Migrate project to deploy. You’ll be taken to the project page. If you don’t see the project, you can access it from Servers in the Azure Migrate dashboard.

Set up the Azure Migrate appliance

Azure Migrate: Server Assessment uses a lightweight Azure Migrate appliance. The appliance performs VM discovery and sends VM metadata and performance data to Azure Migrate. The appliance can be set up in a number of ways.

- Set up on a VMware VM using a downloaded OVA template. This is the method used in this tutorial.
- Set up on a VMware VM or physical machine with a PowerShell installer script. This method should be used if you can’t set up a VM using an OVA template, or if you’re in Azure Government.

After creating the appliance, you check that it can connect to Azure Migrate: Server Assessment, configure it for the first time, and register it with the Azure Migrate project.

Download the OVA template

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, select Discover.

2. In Discover machines > Are your machines virtualized?, select Yes, with VMWare vSphere hypervisor.

3. Select Download to download the OVA template file.
Verify security

Check that the OVA file is secure, before you deploy it:

1. On the machine to which you downloaded the file, open an administrator command window.
2. Run the following command to generate the hash for the OVA file:

   ```
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   ```

   Example usage:

   ```
   C:\>CertUtil -HashFile C:\AzureMigrate\AzureMigrate.ova SHA256
   ```

   For version 2.19.07.30, the generated hash should match these values:

<table>
<thead>
<tr>
<th>ALGORITHM</th>
<th>HASH VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD5</td>
<td>c06ac2a2c0f870d3b274a0b7a73b78b1</td>
</tr>
<tr>
<td>SHA256</td>
<td>4ce4faa3a78189a09a26bfa5b817c7afcf5b55eb46999c2fad9d2ebc808540c</td>
</tr>
</tbody>
</table>

Create the appliance VM

Import the downloaded file, and create a VM:

1. In the vSphere Client console, select File > Deploy OVF Template.
2. In the Deploy OVF Template Wizard > Source, specify the location of the OVA file.
3. In Name and Location, specify a friendly name for the VM. Select the inventory object in which the VM will be hosted.
4. In Host/Cluster, specify the host or cluster on which the VM will run.
5. In Storage, specify the storage destination for the VM.
6. In Disk Format, specify the disk type and size.
7. In Network Mapping, specify the network to which the VM will connect. The network needs internet access.
Verify appliance access to Azure

Make sure that the appliance VM can connect to Azure URLs for public and government clouds.

**Configure the appliance**

Set up the appliance for the first time.

**NOTE**

If you set up the appliance using a PowerShell script instead of the downloaded OVA, the first two steps in this procedure aren’t relevant.

1. In the vSphere Client console, right-click the VM, and then select **Open Console**.
2. Provide the language, time zone, and password for the appliance.
3. Open a browser on any machine that can connect to the VM, and open the URL of the appliance web app: `https://appliance name or IP address:44368`.
   
   Alternately, you can open the app from the appliance desktop by selecting the app shortcut.
4. In the web app > **Set up prerequisites**, do the following:
   
   - **License**: Accept the license terms, and read the third-party information.
   - **Connectivity**: The app checks that the VM has internet access. If the VM uses a proxy:
     - Select **Proxy settings**, and specify the proxy address and listening port in the form `http://ProxyIPAddress` or `http://ProxyFQDN`.
     - Specify credentials if the proxy needs authentication.
     - Only HTTP proxy is supported.
   - **Time sync**: The time on the appliance should be in sync with internet time for discovery to work properly.
   - **Install updates**: The appliance ensures that the latest updates are installed.
   - **Install VDDK**: The appliance checks that VMWare vSphere Virtual Disk Development Kit (VDDK) is installed. If it isn’t installed, download VDDK 6.7 from VMware, and extract the downloaded zip contents to the specified location on the appliance.

   Azure Migrate Server Migration uses the VDDK to replicate machines during migration to Azure.

**Register the appliance with Azure Migrate**

1. Select **Log In**. If it doesn’t appear, make sure you’ve disabled the pop-up blocker in the browser.
2. On the new tab, sign in by using your Azure username and password.
   
   Sign-in with a PIN isn’t supported.
3. After you successfully sign in, go back to the web app.
4. Select the subscription in which the Azure Migrate project was created, and then select the project.
5. Specify a name for the appliance. The name should be alphanumeric with 14 characters or fewer.
6. Select **Register**.
Start continuous discovery

The appliance needs to connect to vCenter Server to discover the configuration and performance data of the VMs.

Specify vCenter Server details

1. In Specify vCenter Server details, specify the name (FQDN) or IP address of the vCenter Server instance. You can leave the default port or specify a custom port on which vCenter Server listens.

2. In User name and Password, specify the vCenter Server account credentials that the appliance will use to discover VMs on the vCenter Server instance.
   - You should have set up an account with the required permissions in the previous tutorial.
   - If you want to scope discovery to specific VMware objects (vCenter Server datacenters, clusters, a folder of clusters, hosts, a folder of hosts, or individual VMs), review the instructions in this article to restrict the account used by Azure Migrate.

3. Select Validate connection to make sure that the appliance can connect to vCenter Server.

4. In Discover applications and dependencies on VMs, optionally click Add credentials, and specify the operating system for which the credentials are relevant, and the credentials username and password. Then click Add.
   - You optionally add credentials here if you've created an account to use for the application discovery feature, or the agentless dependency analysis feature.
   - If you're not using these features, you can skip this setting.
   - Review the credentials needed for app discovery, or for agentless analysis.

5. Save and start discovery, to kick off VM discovery.

Discovery works as follows:

- It takes around 15 minutes for discovered VM metadata to appear in the portal.
- Discovery of installed applications, roles, and features takes some time. The duration depends on the number of VMs being discovered. For 500 VMs, it takes approximately one hour for the application inventory to appear in the Azure Migrate portal.

Verify VMs in the portal

After discovery, you can verify that the VMs appear in the Azure portal:

1. Open the Azure Migrate dashboard.
2. In Azure Migrate - Servers > Azure Migrate: Server Assessment, select the icon that displays the count for Discovered servers.

Set up an assessment

You can create two types of assessments by using Azure Migrate Server Assessment:

<table>
<thead>
<tr>
<th>ASSESSMENT</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance-based</td>
<td>Assessments based on collected performance data</td>
<td>Recommended VM size: Based on CPU and memory utilization data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recommended disk type (standard or premium managed disk): Based on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the IOPS and throughput of the on-premises disks.</td>
</tr>
<tr>
<td>ASSESSMENT</td>
<td>DETAILS</td>
<td>DATA</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>As on-premises</td>
<td>Assessments based on on-premises sizing</td>
<td><strong>Recommended VM size</strong>: Based on the on-premises VM size.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Recommended disk type</strong>: Based on the storage type setting that you select for the assessment.</td>
</tr>
</tbody>
</table>

Run an assessment

Run an assessment as follows:

1. Review the best practices for creating assessments.

2. On the **Servers** tab, in the **Azure Migrate: Server Assessment** tile, select **Assess**.

3. In **Assess servers**, specify a name for the assessment.

4. Select **View all**, and then review the assessment properties.
5. In **Select or create a group**, select **Create New**, and specify a group name. A group gathers one or more VMs together for assessment.

6. In **Add machines to the group**, select VMs to add to the group.

7. Select **Create Assessment** to create the group and run the assessment.
8. After the assessment is created, view it in Servers > Azure Migrate: Server Assessment > Assessments.

9. Select Export assessment to download it as an Excel file.

Review an assessment

An assessment describes:

- **Azure readiness**: Whether VMs are suitable for migration to Azure.
- **Monthly cost estimation**: The estimated monthly compute and storage costs for running the VMs in Azure.
- **Monthly storage cost estimation**: Estimated costs for disk storage after migration.

To view an assessment:

1. In Migration goals > Servers, select Assessments in Azure Migrate: Server Assessment.

2. In Assessments, select an assessment to open it.
**Review Azure readiness**

1. In **Azure readiness**, verify whether VMs are ready for migration to Azure.

2. Review the VM status:
   - **Ready for Azure**: Used when Azure Migrate recommends a VM size and cost estimates for VMs in the assessment.
   - **Ready with conditions**: Shows issues and suggested remediation.
   - **Not ready for Azure**: Shows issues and suggested remediation.
   - **Readiness unknown**: Used when Azure Migrate can't assess readiness because of data availability issues.

3. Select an **Azure readiness** status. You can view VM readiness details. You can also drill down to see VM details, including compute, storage, and network settings.

**Review cost details**

The assessment summary shows the estimated compute and storage cost of running VMs in Azure. Costs are aggregated for all VMs in the assessed group. You can drill down to see cost details for specific VMs.

**NOTE**

Cost estimates are based on the size recommendations for a machine, its disks, and its properties. Estimates are for running the on-premises VMs as IaaS VMs. Azure Migrate Server Assessment doesn’t consider PaaS or SaaS costs.

The aggregated storage costs for the assessed group are split over different types of storage disks.

**Review confidence rating**

Azure Migrate Server Assessment assigns a confidence rating to a performance-based assessment, from one star (lowest) to five stars (highest).

The confidence rating helps you estimate the reliability of the assessment's size recommendations. The rating is based on the availability of data points needed to compute the assessment:
<table>
<thead>
<tr>
<th>DATA POINT AVAILABILITY</th>
<th>CONFIDENCE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%-20%</td>
<td>1 star</td>
</tr>
<tr>
<td>21%-40%</td>
<td>2 stars</td>
</tr>
<tr>
<td>41%-60%</td>
<td>3 stars</td>
</tr>
<tr>
<td>61%-80%</td>
<td>4 stars</td>
</tr>
<tr>
<td>81%-100%</td>
<td>5 stars</td>
</tr>
</tbody>
</table>

Learn about best practices for confidence ratings.

Next steps

In this tutorial, you set up an Azure Migrate appliance. You also created and reviewed an assessment.

To learn how to migrate VMware VMs to Azure by using Azure Migrate Server Migration, continue to the third tutorial in the series:

Migrate VMware VMs
You can migrate VMware VMs to Azure using the Azure Migrate Server Migration tool. This tool offers a couple of options for VMware VM migration:

- Migration using agentless replication. Migrate VMs without needing to install anything on them.
- Migration with an agent for replication. Install an agent on the VM for replication.

## Compare migration methods

Use these selected comparisons to help you decide which method to use. You can also review full support requirements for agentless and agent-based migration.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Agentless</th>
<th>Agent-Based</th>
</tr>
</thead>
<tbody>
<tr>
<td>Azure permissions</td>
<td>You need permissions to create an Azure Migrate project, and to register Azure AD apps created when you deploy the Azure Migrate appliance.</td>
<td>You need Contributor permissions on the Azure subscription.</td>
</tr>
<tr>
<td>Simultaneous replication</td>
<td>A maximum of 100 VMs can be simultaneously replicated from a vCenter Server. If you have more than 50 VMs for migration, create multiple batches of VMs. Replicating more at a single time will impact performance.</td>
<td>NA</td>
</tr>
<tr>
<td>Appliance deployment</td>
<td>The Azure Migrate appliance is deployed on-premises.</td>
<td>The Azure Migrate Replication appliance is deployed on-premises.</td>
</tr>
<tr>
<td>Site Recovery compatibility</td>
<td>Compatible.</td>
<td>You can't replicate with Azure Migrate Server Migration if you've set up replication for a machine using Site Recovery.</td>
</tr>
<tr>
<td>Target disk</td>
<td>Managed disks</td>
<td>Managed disks</td>
</tr>
<tr>
<td>Disk limits</td>
<td>OS disk: 2 TB</td>
<td>OS disk: 2 TB</td>
</tr>
<tr>
<td></td>
<td>Data disk: 4 TB</td>
<td>Data disk: 8 TB</td>
</tr>
<tr>
<td></td>
<td>Maximum disks: 60</td>
<td>Maximum disks: 63</td>
</tr>
<tr>
<td>Passthrough disks</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>
The migrated VM in Azure will be automatically converted to a BIOS boot VM.

The OS disk should have up to four partitions, and volumes should be formatted with NTFS.

### Deployment steps comparison

After reviewing the limitations, understanding the steps involved in deploying each solution might help you decide which option to choose.

<table>
<thead>
<tr>
<th>TASK</th>
<th>DETAILS</th>
<th>AGENTLESS</th>
<th>AGENT-BASED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Assess servers before migration. Assessment is optional. We suggest that you assess machines before you migrate them, but you don't have to. For assessment, Azure Migrate sets up a lightweight appliance to discover and assess VMs.</td>
<td>If you run an agentless migration after assessment, the same Azure Migrate appliance set up for assessment is used for agentless migration.</td>
<td>If you run an agent-based migration after assessment, the appliance set up for assessment isn't used during agentless migration. You can leave the appliance in place, or remove it if you don't want to do further discovery and assessment.</td>
</tr>
<tr>
<td>Prepare VMware servers and VMs for migration</td>
<td>Configure a number of settings on VMware servers and VMs.</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Add the Server Migration tool</td>
<td>Add the Azure Migrate Server Migration tool in the Azure Migrate project.</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Deploy the Azure Migrate appliance</td>
<td>Set up a lightweight appliance on a VMware VM for VM discovery and assessment.</td>
<td>Required</td>
<td>Not required.</td>
</tr>
<tr>
<td>Install the Mobility service on VMs</td>
<td>Install the Mobility service on each VM you want to replicate</td>
<td>Not required</td>
<td>Required</td>
</tr>
<tr>
<td>Deploy the Azure Migrate Server Migration replication appliance</td>
<td>Set up an appliance on a VMware VM to discover VMs, and bridge between the Mobility service running on VMs and Azure Migrate Server Migration</td>
<td>Not required</td>
<td>Required</td>
</tr>
<tr>
<td>Replicate VMs.</td>
<td>Configure replication settings and select VMs to replicate</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>TASK</td>
<td>DETAILS</td>
<td>AGENTLESS</td>
<td>AGENT-BASED</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Run a test migration</td>
<td>Run a test migration to make sure everything's working as expected.</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Run a full migration</td>
<td>Migrate the VMs.</td>
<td>Required</td>
<td>Required</td>
</tr>
</tbody>
</table>

**Next steps**

*Migrate VMware VMs* with agentless migration.
This article shows you how to migrate on-premises VMware VMs to Azure, using agentless migration with the Azure Migrate Server Migration tool.

### Migration methods

You can migrate VMware VMs to Azure using the Azure Migrate Server Migration tool. This tool offers a couple of options for VMware VM migration:

- Migration using agentless replication. Migrate VMs without needing to install anything on them.
- Migration with an agent for replication. Install an agent on the VM for replication.

To decide whether you want to use agentless or agent-based migration, review these articles:

- Learn how agentless migration works, and compare migration methods.
- Read this article if you want to use the agent-based method.

### Prerequisites

Before you begin this tutorial, you should:

1. Complete the first tutorial in this series to set up Azure and VMware for migration. Specifically, in this tutorial you need to:
   - Prepare Azure for migration.
   - Prepare the on-premises environment for migration.

2. We recommend that you try assessing VMware VMs with Azure Migrate Server Assessment before migrating them to Azure. To set up assessment, complete the second tutorial in this series. If you don't want to assess VMs, you can skip this tutorial. Although we recommend that you try out an assessment, but you don't have to run an assessment before you try a migration.

### Add the Azure Migrate Server Migration tool

Add the Azure Migrate Server Migration tool.
If you followed the second tutorial to assess VMware VMs, you can go ahead and add the tool.

If you didn’t follow the second tutorial, follow these instructions to set up an Azure Migrate project. You add the Azure Migrate:Server Migration tool when you create the project.

If you have a project set up, add the tool as follows:

1. In the Azure Migrate project, click **Overview**.

2. In Discover, assess, and migration servers, click **Assess and migrate servers**.

3. In Migration tools, select **Click here to add a migration tool when you are ready to migrate**.

4. In the tools list, select **Azure Migrate: Server Migration > Add tool**

Set up the Azure Migrate appliance

Azure Migrate Server Migration runs a lightweight VMware VM appliance. The appliance performs VM discovery
and sends VM metadata and performance data to Azure Migrate:Server Migration. The same appliance is also used by the Azure Migrate:Server Assessment tool, to perform agentless migration of VMware VMs.

- If you followed the tutorial to assess VMware VMs, you already set up the appliance during that tutorial.
- If you didn’t follow that tutorial, you can set up the appliance now, using one of these methods:
  - Set up on a VMware VM using a downloaded OVA template.
  - Set up on a VMware VM or physical machine with a PowerShell installer script. This method should be used if you can’t set up a VM using an OVA template, or if you’re in Azure government.

After creating the appliance, you check that it can connect to Azure Migrate:Server Assessment, configure it for the first time, and register it with the Azure Migrate project.

## Prepare VMs for migration

Azure Migrate requires some VM changes to ensure that VMs can be migrated to Azure.

- For some operating systems, Azure Migrate makes these changes automatically. Learn more
- If you’re migrating a VM that doesn’t have one of these operating systems, follow the instructions to prepare the VM.
- It’s important to make these changes before you begin migration. If you migrate the VM before you make the change, the VM might not boot up in Azure.
- Configuration changes you make on on-premises VMs are replicated to Azure after replication for the VM is enabled. To ensure that changes are replicated, make sure that the recovery point you migrate to is later than the time at which the configuration changes were made on-premises.

### Prepare Windows Server VMs

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DETAILS</th>
<th>INSTRUCTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure that Windows volumes in Azure VM use the same drive letter assignments as the on-premises VM.</td>
<td>Configure the SAN policy as Online All.</td>
<td>1. Sign in to the VM with an admin account, and open a command window. 2. Type <code>diskpart</code> to run the Diskpart utility. 3. Type <code>SAN POLICY=OnlineAll</code>. 4. Type Exit to leave Diskpart, and close the command prompt.</td>
</tr>
<tr>
<td>Enable Azure serial access console for the Azure VM</td>
<td>This helps with troubleshooting. You don’t need to reboot the VM. The Azure VM will boot using the disk image, and this is equivalent to a reboot for the new VM.</td>
<td>Follow these instructions to enable.</td>
</tr>
<tr>
<td>Install Hyper-V Guest Integration</td>
<td>If you’re migrating machines running Windows Server 2003, install Hyper-V Guest Integration Services on the VM operating system.</td>
<td>Learn more.</td>
</tr>
<tr>
<td>Remote Desktop</td>
<td>Enable Remote Desktop on the VM, and check that the Windows Firewall isn’t blocking Remote Desktop access on any network profiles.</td>
<td>Learn more.</td>
</tr>
</tbody>
</table>

### Prepare Linux VMs
## ACTION | DETAILS
--- | ---
Install Hyper-V Linux Integration Services | Most new versions of Linux distributions have this included by default.
Rebuild the Linux init image to contain the necessary Hyper-V drivers | This ensures that the VM will boot in Azure, and is only required on some distributions.
Enable Azure serial console logging | This helps with troubleshooting. You don't need to reboot the VM. The Azure VM will boot using the disk image, and this is equivalent to a reboot for the new VM. Follow these instructions to enable.
Update device map file | Update the device map file that has the device name to volume associations, to use persistent device identifiers
Update fstab entries | Update entries to use persistent volume identifiers.
Remove udev rule | Remove any udev rules that reserves interface names based on mac address etc.
Update network interfaces | Update network interfaces to receive IP address based on DHCP
Enable ssh | Ensure ssh is enabled and the sshd service is set to start automatically on reboot. Ensure that incoming ssh connection requests are not blocked by the OS firewall or scriptable rules.

Follow this article that discusses these steps for running a Linux VM on Azure, and include instructions for some of the popular Linux distributions.

### Replicate VMs

With discovery completed, you can begin replication of VMware VMs to Azure.

**NOTE**

You can replicate up to 10 machines together. If you need to replicate more, then replicate them simultaneously in batches of 10. For agentless migration you can run up to 100 simultaneous replications.

1. In the Azure Migrate project > Servers, Azure Migrate: Server Migration, click Replicate.
2. In Replicate, > Source settings > Are your machines virtualized?, select Yes, with VMware vSphere.

3. In On-premises appliance, select the name of the Azure Migrate appliance that you set up > OK.

Replicate

Source settings

Virtual machines Target settings Compute Disks Review + Start replication

The first step in migrating servers is to replicate them. Once replication completes, you can perform test migration before finally moving the servers to Azure.

* Are your machines virtualized? Yes, with VMware vSphere

* On-premises appliance

- This step presumes that you have already set up an appliance when you completed the tutorial.
- If you haven't set up an appliance, then follow the instructions in this article.

4. In Virtual machines, select the machines you want to replicate.

- If you've run an assessment for the VMs, you can apply VM sizing and disk type (premium/standard) recommendations from the assessment results. To do this, in Import migration settings from an
Azure Migrate assessment?, select the Yes option.

- If you didn’t run an assessment, or you don’t want to use the assessment settings, select the No options.
- If you selected to use the assessment, select the VM group, and assessment name.

## Replicate

<table>
<thead>
<tr>
<th>Source settings</th>
<th>Virtual machines</th>
<th>Target settings</th>
<th>Compute</th>
<th>Disks</th>
<th>Review + Start replication</th>
</tr>
</thead>
</table>

Select the virtual machines to be migrated.

- Import migration settings from an assessment? 🔄

| Yes, apply migration settings from a Azure Migrate assessment
| No, I’ll specify the migration settings manually |

5. In Virtual machines, search for VMs as needed, and check each VM you want to migrate. Then click Next: Target settings.

## Replicate

<table>
<thead>
<tr>
<th>Source settings</th>
<th>Virtual machines</th>
<th>Target settings</th>
<th>Compute</th>
<th>Disks</th>
<th>Review + Start replication</th>
</tr>
</thead>
</table>

Select the virtual machines to be migrated.

- Import migration settings from an assessment? 🔄

| No, I’ll specify the migration settings manually |

<table>
<thead>
<tr>
<th>Virtual machines 🔄</th>
<th>Name</th>
<th>IP Address</th>
<th>Operating System</th>
<th>Boot Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContosoVMwareMigr...</td>
<td>2404f801:4b00:23:5bf5df37346f91,1...</td>
<td>Microsoft Windows Server Threshold (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
<tr>
<td>ContosoCSASR</td>
<td>2404f801:4b00:23:29f9:2ebd:1ee0:eeb4,...</td>
<td>Microsoft Windows Server 2012 (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
<tr>
<td>Contoso-FrontTier3</td>
<td>2404f801:4b00:23:29f9:2ebd:1ee0:eeb4,...</td>
<td>Microsoft Windows Server Threshold (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
<tr>
<td>Contoso-Configuratio...</td>
<td></td>
<td>Microsoft Windows Server 2012 (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
<tr>
<td>Contoso-AzureMigr...</td>
<td></td>
<td>Microsoft Windows Server 2012 (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
<tr>
<td>ContosoWeb3</td>
<td>10.150.3.18,2404f801:4b00:23:350:55f9:2ebd:1ee0:eeb4,...</td>
<td>CentOS 4/5/6/7 (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
<tr>
<td>ContosoAppSrv2</td>
<td>2404f801:4b00:23:5fde5e919:3448:be33,...</td>
<td>Microsoft Windows Server 2012 (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
<tr>
<td>ContosoWeb2</td>
<td>10.150.3.201,2404f801:4b00:23:250:56f9:2ebd:1ee0:eeb4,...</td>
<td>CentOS 4/5/6/7 (64-bit)</td>
<td>bios</td>
<td></td>
</tr>
</tbody>
</table>

6. In Target settings, select the subscription, and target region to which you’ll migrate, and specify the resource group in which the Azure VMs will reside after migration. In Virtual Network, select the Azure VNet/subnet to which the Azure VMs will be joined after migration.

7. In Azure Hybrid Benefit:

- Select No if you don’t want to apply Azure Hybrid Benefit. Then click Next.
- Select Yes if you have Windows Server machines that are covered with active Software Assurance or Windows Server subscriptions, and you want to apply the benefit to the machines you’re migrating. Then click Next.
8. In **Compute**, review the VM name, size, OS disk type, and availability set. VMs must conform with Azure requirements.

- **VM size**: If you're using assessment recommendations, the VM size dropdown will contain the recommended size. Otherwise Azure Migrate picks a size based on the closest match in the Azure subscription. Alternatively, pick a manual size in Azure VM size.
- **OS disk**: Specify the OS (boot) disk for the VM. The OS disk is the disk that has the operating system bootloader and installer.
- **Availability set**: If the VM should be in an Azure availability set after migration, specify the set. The set must be in the target resource group you specify for the migration.

9. In **Disks**, specify whether the VM disks should be replicated to Azure, and select the disk type (standard SSD/HDD or premium-managed disks) in Azure. Then click **Next**.

- You can exclude disks from replication.
- If you exclude disks, won’t be present on the Azure VM after migration.
10. In **Review and start replication**, review the settings, and click **Replicate** to start the initial replication for the servers.

**NOTE**

You can update replication settings any time before replication starts, in **Manage > Replicating machines**. Settings can't be changed after replication starts.

### Provisioning for the first time

If this is the first VM you're replicating in the Azure Migrate project, Azure Migrate Server Migration automatically provisions these resources in same resource group as the project.

- **Service bus**: Azure Migrate Server Migration uses the service bus to send replication orchestration messages to the appliance.
- **Gateway storage account**: Server Migration uses the gateway storage account to store state information about the VMs being replicated.
- **Log storage account**: The Azure Migrate appliance uploads replication logs for VMs to a log storage account. Azure Migrate applies the replication information to the replica managed disks.
- **Key vault**: The Azure Migrate appliance uses the key vault to manage connection strings for the service bus, and access keys for the storage accounts used in replication. You should have set up the permissions that the key vault needs to access the storage account when you prepared. Review these permissions.

### Track and monitor

- When you click **Replicate** a Start Replication job begins.
- When the Start Replication job finishes successfully, the machines begin their initial replication to Azure.
- During initial replication, a VM snapshot is created. Disk data from the snapshot is replicated to replica managed disks in Azure.
- After initial replication finishes, delta replication begins. Incremental changes to on-premises disks are periodically replicated to the replica disks in Azure.

You can track job status in the portal notifications.

You can monitor replication status by clicking on **Replicating servers** in **Azure Migrate: Server Migration**.
Run a test migration

When delta replication begins, you can run a test migration for the VMs, before running a full migration to Azure. We highly recommend that you do this at least once for each machine, before you migrate it.

- Running a test migration checks that migration will work as expected, without impacting the on-premises machines, which remain operational, and continue replicating.
- Test migration simulates the migration by creating an Azure VM using replicated data (usually migrating to a non-production VNet in your Azure subscription).
- You can use the replicated test Azure VM to validate the migration, perform app testing, and address any issues before full migration.

Do a test migration as follows:

1. In Migration goals > Servers > Azure Migrate: Server Migration, click Test migrated servers.

2. Right-click the VM to test, and click Test migrate.
3. In **Test Migration**, select the Azure VNet in which the Azure VM will be located after the migration. We recommend you use a non-production VNet.

4. The **Test migration** job starts. Monitor the job in the portal notifications.

5. After the migration finishes, view the migrated Azure VM in **Virtual Machines** in the Azure portal. The machine name has a suffix `-Test`.

6. After the test is done, right-click the Azure VM in **Replicating machines**, and click **Clean up test migration**.

**Migrate VMs**

After you've verified that the test migration works as expected, you can migrate the on-premises machines.

1. In the Azure Migrate project > **Servers** > **Azure Migrate: Server Migration**, click **Replicating servers**.
2. In Replicating machines, right-click the VM > Migrate.

3. In Migrate > Shut down virtual machines and perform a planned migration with no data loss, select Yes > OK.
   - By default Azure Migrate shuts down the on-premises VM, and runs an on-demand replication to synchronize any VM changes that occurred since the last replication occurred. This ensures no data loss.
   - If you don’t want to shut down the VM, select No

4. A migration job starts for the VM. Track the job in Azure notifications.

5. After the job finishes, you can view and manage the VM from the Virtual Machines page.

Complete the migration

1. After the migration is done, right-click the VM > Stop Replication. This stops replication for the on-premises machine, and cleans up replication state information for the VM.
2. Install the Azure VM Windows or Linux agent on the migrated machines.
3. Perform any post-migration app tweaks, such as updating database connection strings, and web server configurations.
4. Perform final application and migration acceptance testing on the migrated application now running in Azure.
5. Cut over traffic to the migrated Azure VM instance.
6. Remove the on-premises VMs from your local VM inventory.
7. Remove the on-premises VMs from local backups.
8. Update any internal documentation to show the new location and IP address of the Azure VMs.

Post-migration best practices

- For increased resilience:
  - Keep data secure by backing up Azure VMs using the Azure Backup service. Learn more.
  - Keep workloads running and continuously available by replicating Azure VMs to a secondary region with Site Recovery. Learn more.
- For increased security:
  - Lock down and limit inbound traffic access with Azure Security Center - Just in time administration.
  - Restrict network traffic to management endpoints with Network Security Groups.
  - Deploy Azure Disk Encryption to help secure disks, and keep data safe from theft and unauthorized access.
  - Read more about securing IaaS resources, and visit the Azure Security Center.
- For monitoring and management:
- Consider deploying Azure Cost Management to monitor resource usage and spending.

Next steps

Investigate the cloud migration journey in the Azure Cloud Adoption Framework.
This article shows you how to migrate on-premises VMware VMs to Azure, using agent-based migration with the Azure Migrate Server Migration tool.

In this tutorial, you learn how to:

- Set up the source environment, and deploy an Azure Migrate replication appliance for agent-based migration.
- Set up the target environment for migration.
- Set up a replication policy.
- Enable replication.
- Run a test migration to make sure everything’s working as expected.
- Run a full migration to Azure.

**NOTE**

Tutorials show you the simplest deployment path for a scenario so that you can quickly set up a proof-of-concept. Tutorials use default options where possible, and don’t show all possible settings and paths. For detailed instructions, review the How-tos for VMware assessment and migration.

If you don’t have an Azure subscription, create a [free account](https://azure.microsoft.com/en-us/free) before you begin.

**Before you begin**

We recommend that you try out VMware VM assessment with Azure Migrate Server Assessment, before you migrate VMs to Azure. Set up an assessment as follows:

1. Follow the tutorial to prepare Azure and VMware for assessment.
2. Then, follow this tutorial to set up an Azure Migrate appliance for assessment, and discover and assess VMs.

Although we recommend that you try out an assessment, you don’t have to run an assessment before you migrate VMs.

**Migration methods**

You can migrate VMware VMs to Azure using the Azure Migrate Server Migration tool. This tool offers a couple of options for VMware VM migration:

- **Agentless replication.** Migrate VMs without needing to install anything on them.
- **Agent-based migration.** Install an agent (the Mobility services agent) on the VM for replication.

To decide whether you want to use agentless or agent-based migration, review these articles:

- Learn about the VMware migration options.
- Compare migration methods.
- Follow this article to try out agentless migration.

**Prerequisites**

Before you begin this tutorial, you should:
1. Review the VMware migration architecture.

2. Make sure that your Azure account is assigned the Virtual Machine Contributor role, so that you have permissions to:
   - Create a VM in the selected resource group.
   - Create a VM in the selected virtual network.
   - Write to an Azure managed disk.

3. Set up an Azure network. On-premises machines are replicated to Azure managed disks. When you fail over to Azure for migration, Azure VMs are created from these managed disks, and joined to an Azure network you specify when you set up migration.

Prepare Azure

If you have already run an assessment with Azure Migrate Server Assessment, you can skip the instructions in this section since you've already completed these steps.

If you haven't run an assessment, you need to set up Azure permissions before you can migrate with Azure Migrate Server Migration.

- **Create a project**: Your Azure account needs permissions to create an Azure Migrate project.
- **Register the Azure Migrate replication appliance**: The replication appliance creates and registers an Azure Active Directory app in your Azure account. Delegate permissions for this.
- **Create Key Vault**: To migrate VMware VMs using Azure Migrate Server Migration, Azure Migrate creates a Key Vault in the resource group, to manage access keys to the replication storage account in your subscription. To create the vault, you need role assignment permissions on the resource group in which the Azure Migrate project resides.

**Assign permissions to create project**

1. In the Azure portal, open the subscription, and select **Access control (IAM)**.
2. In **Check access**, find the relevant account, and click it to view permissions.
3. You should have **Contributor** or **Owner** permissions.
   - If you just created a free Azure account, you're the owner of your subscription.
   - If you're not the subscription owner, work with the owner to assign the role.

**Assign permissions to register the replication appliance**

For agent-based migration, delegate permissions for Azure Migrate Server Migration to create and register an Azure AD app in your account. You can assign permissions using one of the following methods:

- A tenant/global admin can grant permissions to users in the tenant, to create and register Azure AD apps.
- A tenant/global admin can assign the Application Developer role (that has the permissions) to the account.

It’s worth noting that:

- The apps don’t have any other access permissions on the subscription other than those described above.
- You only need these permissions when you register a new replication appliance. You can remove the permissions after the replication appliance is set up.

**Grant account permissions**

The tenant/global admin can grant permissions as follows

1. In Azure AD, the tenant/global admin should navigate to **Azure Active Directory > Users > User Settings**.
2. The admin should set **App registrations** to **Yes**.
NOTE
This is a default setting that isn't sensitive. Learn more.

Assign Application Developer role
The tenant/global admin can assign the Application Developer role to an account. Learn more.

Assign permissions to create Key Vault
Assign role assignment permissions on the resource group in which the Azure Migrate project resides, as follows:

1. In the resource group in the Azure portal, select Access control (IAM).
2. In Check access, find the relevant account, and click it to view permissions. You need Owner (or Contributor and User Access Administrator) permissions.
3. If you don’t have the required permissions, request them from the resource group owner.

Prepare on-premises VMware

Prepare an account for automatic discovery
Azure Migrate Server Migration needs access to VMware servers to:

- Automatically discover VMs. At least a read-only account is required.
- Orchestrate replication, failover, and failback. You need an account that can run operations such as creating and removing disks, and powering on VMs.

Create the account as follows:

1. To use a dedicated account, create a role at the vCenter level. Give the role a name such as Azure_Site_Recovery.
2. Assign the role the permissions summarized in the table below.
3. Create a user on the vCenter server or vSphere host. Assign the role to the user.

### VMware account permissions

<table>
<thead>
<tr>
<th>TASK</th>
<th>ROLE/PERMISSIONS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>VM discovery</td>
<td>At least a read-only user</td>
<td>User assigned at datacenter level, and has access to all the objects in the datacenter. To restrict access, assign the <strong>No access</strong> role with the <strong>Propagate to child</strong> object, to the child objects (vSphere hosts, datastores, VMs, and networks).</td>
</tr>
<tr>
<td></td>
<td>Data Center object -&gt; Propagate to Child Object, role=Read-only</td>
<td></td>
</tr>
<tr>
<td>Full replication, failover, failback</td>
<td>Create a role (Azure_Site_Recovery) with the required permissions, and then assign the role to a VMware user or group</td>
<td>User assigned at datacenter level, and has access to all the objects in the datacenter. To restrict access, assign the <strong>No access</strong> role with the <strong>Propagate to child</strong> object, to the child objects (vSphere hosts, datastores, VMs, and networks).</td>
</tr>
<tr>
<td></td>
<td>Data Center object -&gt; Propagate to Child Object, role=Azure_Site_Recovery</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Datastore -&gt; Allocate space, browse datastore, low-level file operations, remove file, update virtual machine files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Network -&gt; Network assign</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource -&gt; Assign VM to resource pool, migrate powered off VM, migrate powered on VM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tasks -&gt; Create task, update task</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Virtual machine -&gt; Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Virtual machine -&gt; Interact -&gt; answer question, device connection, configure CD media, configure floppy media, power off, power on, VMware tools install</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Virtual machine -&gt; Inventory -&gt; Create, register, unregister</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Virtual machine -&gt; Provisioning -&gt; Allow virtual machine download, allow virtual machine files upload</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Virtual machine -&gt; Snapshots -&gt; Remove snapshots</td>
<td></td>
</tr>
</tbody>
</table>

### Prepare an account for Mobility service installation

The Mobility service must be installed on machines you want to replicate.

- The Azure Migrate replication appliance can do a push installation of this service when you enable replication for a machine, or you can install it manually, or using installation tools.
- In this tutorial, we're going to install the Mobility service with the push installation.
- For push installation, you need to prepare an account that Azure Migrate Server Migration can use to access the VM. This account is used only for the push installation, if you don't install the Mobility service manually.
Prepare the account as follows:

1. Prepare a domain or local account with permissions to install on the VM.
2. For Windows VMs, if you're not using a domain account, disable Remote User Access control on the local machine by adding the DWORD entry `LocalAccountTokenFilterPolicy` with a value of in the registry, under `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System`
3. For Linux VMs, prepare a root account on the source Linux server.

Check VMware requirements

Make sure VMware servers and VMs comply with requirements for migration to Azure.

**NOTE**

Agent-based migration with Azure Migrate Server Migration is based on features of the Azure Site Recovery service. Some requirements might link to Site Recovery documentation.

1. Verify VMware server requirements.
2. Verify VM support requirements for migration.
3. Verify VM settings. On-premises VMs you replicate to Azure must comply with Azure VM requirements.

Add the Azure Migrate Server Migration tool

If you didn't follow the tutorial to assess VMware VMs, set up an Azure Migrate project, and then add the Azure Migrate Server Migration tool:

1. In the Azure portal > All services, search for Azure Migrate.
2. Under Services, select Azure Migrate.
   
   ![Azure Migrate](https://azure.microsoft.com/en-us/blog/azure-migrate/)

   1. In **Overview**, click Assess and migrate servers.
   2. Under Discover, assess and migrate servers, click Assess and migrate servers.
5. In Discover, assess and migrate servers, click Add tools.

6. In Migrate project, select your Azure subscription, and create a resource group if you don’t have one.

7. In Project Details, specify the project name, and geography in which you want to create the project, and click Next. Review supported geographies for public and government clouds.

8. In Select assessment tool, select Skip adding an assessment tool for now > Next.


10. In Review + add tools, review the settings, and click Add tools.

11. After adding the tool, it appears in the Azure Migrate project > Servers > Migration tools.

Set up the replication appliance

The first step of migration is to set up the replication appliance. The replication appliance is a single, highly available, on-premises VMware VM that hosts these components:

- **Configuration server**: The configuration server coordinates communications between on-premises and Azure, and manages data replication.
- **Process server**: The process server acts as a replication gateway. It receives replication data; optimizes it with caching, compression, and encryption, and sends it to a cache storage account in Azure. The process server also installs the Mobility Service agent on VMs you want to replicate, and performs automatic discovery of on-premises VMware VMs.

You can set up the replication appliance in a couple of ways.

- Set up with a downloaded Open Virtualization Application (OVA) template. You import the template into VMware, and create the replication appliance VM. This is the method used in this tutorial.
Download the replication appliance template

Download the template as follows:

1. In the Azure Migrate project click **Servers** under **Migration Goals**.


3. In Discover machines > Are your machines virtualized?, click Yes, with VMWare vSphere hypervisor.

5. In **Target region**, select the Azure region to which you want to migrate the machines.

6. Select **Confirm that the target region for migration is region-name**.

7. Click **Create resources**. This creates an Azure Site Recovery vault in the background.
   - You can’t change the target region for this project after clicking this button.
   - All subsequent migrations are to this region.

8. In **Do you want to install a new replication appliance?**, select **Install a replication appliance**.

9. Click **Download**, to download the replication appliance. This downloads an OVF template that you use to create a new VMware VM that runs the appliance.

   - The replication appliance (Configuration Server) is a virtual appliance that is deployed on-premises. The replication appliance coordinates and manages replication for the servers that are being migrated. Follow the steps outlined below to set up and configure the replication appliance.

   1. **Download and deploy replication appliance**
      - Download the replication appliance virtual machine template and import it into your vCenter server using the Deploy OVF Template wizard.

   2. **Download** OVF file 12GB

10. Note the name of the resource group and the Recovery Services vault. You need these during appliance deployment.

    **Import the template in VMware**

    After downloading the OVF template, you import it into VMware to create the replication application on a VMware VM running Windows Server 2016.

    1. Sign in to the VMware vCenter server or vSphere ESXi host with the VMware vSphere Client.
    2. On the **File** menu, select **Deploy OVF Template** to start the **Deploy OVF Template Wizard**.
    3. In **Select source**, enter the location of the downloaded OVF.
    4. In **Review details**, select **Next**.
5. In **Select name and folder** and **Select configuration**, accept the default settings.

6. In **Select storage > Select virtual disk format**, for best performance select **Thick Provision Eager Zeroed**.

7. On the rest of the wizard pages, accept the default settings.

8. In **Ready to complete**, to set up the VM with the default settings, select **Power on after deployment > Finish**.

   **TIP**
   If you want to add an additional NIC, clear **Power on after deployment > Finish**. By default, the template contains a single NIC. You can add additional NICs after deployment.

---

**Kick off replication appliance setup**

1. From the VMWare vSphere Client console, turn on the VM.

2. The VM boots up into a Windows Server 2016 installation experience. Accept the license agreement, and enter an administrator password.

3. After the installation finishes, sign in to the VM as the administrator, using the admin password.

4. The first time you sign in, the replication appliance setup tool (Azure Site Recovery Configuration Tool) starts within a few seconds.

5. Enter a name to use for registering the appliance with Azure Migrate Server Migration. Then click **Next**.

6. The tool checks that the VM can connect to Azure. After the connection is established, select **Sign in** to sign in to your Azure subscription.

7. Wait for the tool to finish registering an Azure AD app to identify the appliance. The appliance reboots.

8. Sign in to the machine again. In a few seconds, the Configuration Server Management Wizard starts automatically.

---

**Register the replication appliance**

Finish setting up and registering the replication appliance.

1. In the Configuration Server Management Wizard, select **Setup connectivity**.

2. Select the NIC (by default there's only one NIC) that the replication appliance uses for VM discovery, and to do a push installation of the Mobility service on source machines.

3. Select the NIC that the replication appliance uses for connectivity with Azure. Then select **Save**. You cannot change this setting after it's configured.

4. If the appliance is located behind a proxy server, you need to specify proxy settings.
   - Specify the proxy name as **http://ip-address**, or **http://FQDN**. HTTPS proxy servers aren't supported.

5. When prompted for the subscription, resource groups, and vault details, add the details that you noted when you downloaded the appliance template.

6. In **Install third-party software**, accept the license agreement. Select **Download and Install** to install MySQL Server.

7. Select **Install VMware PowerCLI**. Make sure all browser windows are closed before you do this. Then select **Continue**.

8. In **Validate appliance configuration**, prerequisites are verified before you continue.

9. In **Configure vCenter Server/vSphere ESXi server**, enter the FQDN or IP address of the vCenter server, or vSphere host, where the VMs you want to replicate are located. Enter the port on which the server is listening. Enter a friendly name to be used for the VMware server in the vault.

10. Enter the credentials for the account you created for VMware discovery. Select **Add > Continue**.

11. In **Configure virtual machine credentials**, enter the credentials you created for push installation of the Mobility service, when you enable replication for VMs.
Replicate VMs

Now, select VMs for migration.

NOTE
You can replicate up to 10 machines together. If you need to replicate more, then replicate them simultaneously in batches of 10.

1. In the Azure Migrate project > Servers, Azure Migrate: Server Migration, click Replicate.

2. In Replicate, > Source settings > Are your machines virtualized?, select Yes, with VMware vSphere.
3. In **On-premises appliance**, select the name of the Azure Migrate appliance that you set up.

4. In **vCenter server**, specify the name of the vCenter server managing the VMs, or the vSphere server on which the VMs are hosted.

5. In **Process Server**, select the name of the replication appliance.

6. In **Guest credentials**, specify the VM admin account that will be used for push installation of the Mobility service. Then click **Next: Virtual machines**.

7. In **Virtual Machines**, select the machines that you want to replicate.

   - If you've run an assessment for the VMs, you can apply VM sizing and disk type (premium/standard) recommendations from the assessment results. To do this, in **Import migration settings from an Azure Migrate assessment?**, select the **Yes** option.
   - If you didn't run an assessment, or you don't want to use the assessment settings, select the **No** options.
   - If you selected to use the assessment, select the VM group, and assessment name.

8. Check each VM you want to migrate. Then click **Next: Target settings**.

9. In **Target settings**, select the subscription, and target region to which you'll migrate, and specify the resource group in which the Azure VMs will reside after migration.

10. In **Virtual Network**, select the Azure VNet/subnet to which the Azure VMs will be joined after migration.

11. In **Azure Hybrid Benefit**:

   - Select **No** if you don't want to apply Azure Hybrid Benefit. Then click **Next**.
   - Select **Yes** if you have Windows Server machines that are covered with active Software Assurance or Windows Server subscriptions, and you want to apply the benefit to the machines you're migrating. Then click **Next**.

12. In **Compute**, review the VM name, size, OS disk type, and availability set. VMs must conform with **Azure requirements**.

   - **VM size**: If you're using assessment recommendations, the VM size dropdown will contain the recommended size. Otherwise Azure Migrate picks a size based on the closest match in the Azure subscription. Alternatively, pick a manual size in **Azure VM size**.
   - **OS disk**: Specify the OS (boot) disk for the VM. The OS disk is the disk that has the operating system bootloader and installer.
• **Availability set:** If the VM should be in an Azure availability set after migration, specify the set. The set must be in the target resource group you specify for the migration.

13. In **Disks**, specify whether the VM disks should be replicated to Azure, and select the disk type (standard SSD/HDD or premium managed disks) in Azure. Then click **Next**.

  • You can exclude disks from replication.
  • If you exclude disks, won’t be present on the Azure VM after migration.

14. In **Review and start replication**, review the settings, and click **Replicate** to start the initial replication for the servers.

NOTE
You can update replication settings any time before replication starts, Manage > Replicating machines. Settings can't be changed after replication starts.

Track and monitor

• When you click **Replicate** a Start Replication job begins.
• When the Start Replication job finishes successfully, the machines begin their initial replication to Azure.
• After initial replication finishes, delta replication begins. Incremental changes to on-premises disks are periodically replicated to the replica disks in Azure.

You can track job status in the portal notifications.

You can monitor replication status by clicking on **Replicating servers** in Azure Migrate: Server Migration.
Run a test migration

When delta replication begins, you can run a test migration for the VMs, before running a full migration to Azure. We highly recommend that you do this at least once for each machine, before you migrate it.

- Running a test migration checks that migration will work as expected, without impacting the on-premises machines, which remain operational, and continue replicating.
- Test migration simulates the migration by creating an Azure VM using replicated data (usually migrating to a non-production VNet in your Azure subscription).
- You can use the replicated test Azure VM to validate the migration, perform app testing, and address any issues before full migration.

Do a test migration as follows:

1. In Migration goals > Servers > Azure Migrate: Server Migration, click Test migrated servers.
2. Right-click the VM to test, and click **Test migrate**.

3. In **Test Migration**, select the Azure VNet in which the Azure VM will be located after the migration. We recommend you use a non-production VNet.

4. The **Test migration** job starts. Monitor the job in the portal notifications.

5. After the migration finishes, view the migrated Azure VM in **Virtual Machines** in the Azure portal. The machine name has a suffix -**Test**.

6. After the test is done, right-click the Azure VM in **Replicating machines**, and click **Clean up test migration**.

---

**Migrate VMs**

After you've verified that the test migration works as expected, you can migrate the on-premises machines.
1. In the Azure Migrate project > Servers > Azure Migrate: Server Migration, click Replicating servers.

2. In Replicating machines, right-click the VM > Migrate.

3. In Migrate > Shut down virtual machines and perform a planned migration with no data loss, select Yes > OK.
   - By default Azure Migrate shuts down the on-premises VM to ensure minimum data loss.
   - If you don't want to shut down the VM, select No

4. A migration job starts for the VM. Track the job in Azure notifications.

5. After the job finishes, you can view and manage the VM from the Virtual Machines page.

**Complete the migration**

1. After the migration is done, right-click the VM > Stop migration. This does the following:
   - Stops replication for the on-premises machine.
   - Removes the machine from the Replicating servers count in Azure Migrate: Server Migration.
   - Cleans up replication state information for the VM.

2. Install the Azure VM Windows or Linux agent on the migrated machines.

3. Perform any post-migration app tweaks, such as updating database connection strings, and web server configurations.

4. Perform final application and migration acceptance testing on the migrated application now running in Azure.

5. Cut over traffic to the migrated Azure VM instance.

6. Remove the on-premises VMs from your local VM inventory.

7. Remove the on-premises VMs from local backups.

8. Update any internal documentation to show the new location and IP address of the Azure VMs.

**Post-migration best practices**

- On-premises
  - Move app traffic over to the app running on the migrated Azure VM instance.
- Remove the on-premises VMs from your local VM inventory.
- Remove the on-premises VMs from local backups.
- Update any internal documentation to show the new location and IP address of the Azure VMs.

**Tweak Azure VM settings after migration:**
- The Azure VM agent manages VM interaction with the Azure Fabric Controller. It’s required for some Azure services, such as Azure Backup, Site Recovery, and Azure Security. When migrating VMware VMs with agent-based migration, the Mobility Service installer installs Azure VM agent on Windows machines. On Linux VMs, we recommend that you install the agent after migration.
- Manually uninstall the Mobility service from the Azure VM after migration.
- Manually uninstall VMware tools after migration.

**In Azure:**
- Perform any post-migration app tweaks, such as updating database connection strings, and web server configurations.
- Perform final application and migration acceptance testing on the migrated application now running in Azure.

**Business continuity/disaster recovery**
- Keep data secure by backing up Azure VMs using the Azure Backup service. Learn more.
- Keep workloads running and continuously available by replicating Azure VMs to a secondary region with Site Recovery. Learn more.

**For increased security:**
- Lock down and limit inbound traffic access with Azure Security Center - Just in time administration.
- Restrict network traffic to management endpoints with Network Security Groups.
- Deploy Azure Disk Encryption to help secure disks, and keep data safe from theft and unauthorized access.
- Read more about securing IaaS resources, and visit the Azure Security Center.

**For monitoring and management:**
- Consider deploying Azure Cost Management to monitor resource usage and spending.

**Next steps**

Investigate the cloud migration journey in the Azure Cloud Adoption Framework.
This article describes how to prepare for assessment of on-premises Hyper-V VMs with Azure Migrate:Server Assessment, and migration of Hyper-V VMs with Azure Migrate:Server Migration.

This tutorial is the first in a series that shows you how to assess and migrate Hyper-V VMs to Azure. In this tutorial, you learn how to:

- Prepare Azure. Set up permissions for your Azure account and resources to work with Azure Migrate.
- Prepare on-premises Hyper-V hosts and VMs for server assessment. You can prepare using a configuration script, or manually.
- Prepare for deployment of the Azure Migrate appliance. The appliance is used to discover and assess on-premises VMs.
- Prepare on-premises Hyper-V hosts and VMs for server migration.

**NOTE**

Tutorials show you the simplest deployment path for a scenario so that you can quickly set up a proof-of-concept. Tutorials use default options where possible, and don't show all possible settings and paths. For detailed instructions, review the How-tos for Hyper-V assessment and migration.

If you don’t have an Azure subscription, create a [free account](https://azure.microsoft.com/en-us/free/) before you begin.

### Prepare Azure

**Azure permissions**

You need set up permissions for Azure Migrate deployment.

<table>
<thead>
<tr>
<th>TASK</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an Azure Migrate project</td>
<td>Your Azure account needs Contributor or Owner permissions to create a project.</td>
</tr>
<tr>
<td>Register resource providers</td>
<td>Azure Migrate uses a lightweight Azure Migrate appliance to discover and assess Hyper-V VMs with Azure Migrate Server Assessment. &lt;br&gt;During appliance registration, resource providers are registered with the subscription chosen in the appliance. Learn more. &lt;br&gt;To register the resource providers, you need a Contributor or Owner role on the subscription.</td>
</tr>
</tbody>
</table>
### Create Azure AD app

When registering the appliance, Azure Migrate creates an Azure Active Directory (Azure AD) app that's used for communication between the agents running on the appliance with their respective services running on Azure. [Learn more.](#)

You need permissions to create Azure AD apps (available in the Application Developer) role.

<table>
<thead>
<tr>
<th>TASK</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Azure AD app</td>
<td>When registering the appliance, Azure Migrate creates an Azure Active Directory (Azure AD) app that's used for communication between the agents running on the appliance with their respective services running on Azure. Learn more. You need permissions to create Azure AD apps (available in the Application Developer) role.</td>
</tr>
</tbody>
</table>

### Assign permissions to create project

Check you have permissions to create an Azure Migrate project.

1. In the Azure portal, open the subscription, and select **Access control (IAM)**.
2. In **Check access**, find the relevant account, and click it to view permissions.
3. You should have **Contributor** or **Owner** permissions.
   - If you just created a free Azure account, you're the owner of your subscription.
   - If you're not the subscription owner, work with the owner to assign the role.

### Assign permissions to register the appliance

You can assign permissions for Azure Migrate to create the Azure AD app during appliance registration, using one of the following methods:

- A tenant/global admin can grant permissions to users in the tenant, to create and register Azure AD apps.
- A tenant/global admin can assign the Application Developer role (that has the permissions) to the account.

### NOTE

- The app does not have any other access permissions on the subscription other than those described above.
- You only need these permissions when you register a new appliance. You can remove the permissions after the appliance is set up.

### Grant account permissions

The tenant/global admin can grant permissions as follows:

1. In Azure AD, the tenant/global admin should navigate to **Azure Active Directory** > **Users** > **User Settings**.
2. The admin should set **App registrations** to **Yes**.
**NOTE**

This is a default setting that isn't sensitive. [Learn more.](#)

**Assign Application Developer role**

The tenant/global admin can assign the Application Developer role to an account. [Learn more.](#)

**Prepare Hyper-V for assessment**

You can prepare Hyper-V for VM assessment manually, or using a configuration script. Preparation steps are as follows:

- **Verify** Hyper-V host settings, and make sure that the **required ports** are open on Hyper-V hosts.

- Set up PowerShell remoting on each host, so that the Azure Migrate appliance can run PowerShell commands on the host, over a WinRM connection.

- Delegate credentials if VM disks are located on remote SMB shares.

- Set up an account that the appliance will use to discover VMs on Hyper-V hosts.

- Set up Hyper-V Integration Services on each VM you want to discover and assess. The default settings when you enable Integration Services are sufficient for Azure Migrate.
Prepare with a script

The script does the following:

- Checks that you're running the script on a supported PowerShell version.
- Verifies that you (the user running the script) have administrative privileges on the Hyper-V host.
- Allows you to create a local user account (not administrator) that the Azure Migrate service uses to communicate with the Hyper-V host. This user account is added to these groups on the host:
  - Remote Management Users
  - Hyper-V Administrators
  - Performance Monitor Users
- Checks that the host is running a supported version of Hyper-V, and the Hyper-V role.
- Enables the WinRM service, and opens ports 5985 (HTTP) and 5986 (HTTPS) on the host (needed for metadata collection).
- Enables PowerShell remoting on the host.
- Checks that the Hyper-V Integration Services is enabled on all VMs managed by the host.
- Enables CredSSP on the host if needed.

Run the script as follows:

1. Make sure you have PowerShell version 4.0 or later installed on the Hyper-V host.

2. Download the script from the Microsoft Download Center. The script is cryptographically signed by Microsoft.

3. Validate the script integrity using either MD5, or SHA256 hash files. Hashtag values are below. Run this command to generate the hash for the script:

   ```
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   ```
4. After validating the script integrity, run the script on each Hyper-V host with this PowerShell command:

   C:\>CertUtil -HashFile C:\Users\Administrators\Desktop\MicrosoftAzureMigrate-Hyper-V.ps1
   SHA256

### Hashtag values

<table>
<thead>
<tr>
<th>HASH</th>
<th>VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD5</td>
<td>0ef418f31915d01f896ac42a80dc414e</td>
</tr>
<tr>
<td>SHA256</td>
<td>0ad60e7299925eff4d1ae9f1c7db485dc9316ef45b0964148a3c07c80761ade2</td>
</tr>
</tbody>
</table>

### Prepare manually

Follow the procedures in this section to prepare Hyper-V manually, instead of using the script.

**Verify PowerShell version**

Make sure you have PowerShell version 4.0 or later installed on the Hyper-V host.

**Set up an account for VM discovery**

Azure Migrate needs permissions to discover on-premises VMs.

- Set up a domain or local user account with administrator permissions on the Hyper-V hosts/cluster.
  - You need a single account for all hosts and clusters that you want to include in the discovery.
  - The account can be a local or domain account. We recommend it has Administrator permissions on the Hyper-V hosts or clusters.
  - Alternatively, if you don’t want to assign Administrator permissions, the following permissions are needed:
    - Remote Management Users
    - Hyper-V Administrators
    - Performance Monitor Users

**Verify Hyper-V host settings**

1. Verify [Hyper-V host requirements](#) for server assessment.

2. Make sure the [required ports](#) are open on Hyper-V hosts.

**Enable PowerShell remoting on hosts**

Set up PowerShell remoting on each host, as follows:

1. On each host, open a PowerShell console as admin.

2. Run this command:

   ```powershell
   Enable-PSRemoting -force
   ```

**Enable Integration Services on VMs**
Integration Services should be enabled on each VM so that Azure Migrate can capture operating system information on the VM.

On VMs that you want to discover and assess, enable Hyper-V Integration Services on each VM.

**Enable CredSSP on hosts**

If the host has VMs with disks are located on SMB shares, complete this step on the host.

- You can run this command remotely on all Hyper-V hosts.
- If you add new host nodes on a cluster they are automatically added for discovery, but you need to manually enable CredSSP on the new nodes if needed.

Enable as follows:

1. Identify Hyper-V hosts running Hyper-V VMs with disks on SMB shares.
2. Run the following command on each identified Hyper-V host:

   ```
   Enable-WSManCredSSP -Role Server -Force
   ```

When you set up the appliance, you finish setting up CredSSP by enabling it on the appliance. This is described in the next tutorial in this series.

**Prepare for appliance deployment**

Before setting up the Azure Migrate appliance and beginning assessment in the next tutorial, prepare for appliance deployment.

1. **Verify** appliance requirements.
2. Review the Azure URLs that the appliance will need to access in the public and government clouds. If you're using a URL-based firewall or proxy, ensure it allows access to the required URLs.
3. Review the data that the appliance will collect during discovery and assessment.
4. **Review** port access requirements for the appliance.

**Prepare for Hyper-V migration**

1. **Review** Hyper-V host requirements for migration, and the Azure URLs to which Hyper-V hosts and clusters need access for VM migration.
2. **Review** the requirements for Hyper-V VMs that you want to migrate to Azure.

**Next steps**

In this tutorial, you:

- Set up Azure account permissions.
- Prepared Hyper-V hosts and VMs for assessment and migration.
- Prepared for deployment of the Azure Migrate appliance.

Continue to the next tutorial to create an Azure Migrate project, deploy the appliance, and discover and assess Hyper-V VMs for migration to Azure.

Assess Hyper-V VMs
This article shows you how to assess on-premises Hyper-V VMs, using the Azure Migrate:Server Assessment tool.

This tutorial is the second in a series that demonstrates how to assess and migrate Hyper-V VMs to Azure. In this tutorial, you learn how to:

- Set up an Azure Migrate project.
- Set up and register an Azure Migrate appliance.
- Start continuous discovery of on-premises VMs.
- Group discovered VMs, and assess the group.
- Review the assessment.

**NOTE**

Tutorials show you the simplest deployment path for a scenario so that you can quickly set up a proof-of-concept. Tutorials use default options where possible, and don't show all possible settings and paths. For detailed instructions, review the How-to articles.

If you don’t have an Azure subscription, create a free account before you begin.

**Prerequisites**

- Complete the first tutorial in this series. If you don't, the instructions in this tutorial won't work.
- Here's what you should have done in the first tutorial:
  - Prepare Azure to work with Azure Migrate.
  - Prepare Hyper-V hosts and VMs assessment.
  - Verify what you need in order to deploy the Azure Migrate appliance for Hyper-V assessment.

**Set up an Azure Migrate project**

1. In the Azure portal > All services, search for Azure Migrate.
2. In the search results, select Azure Migrate.
3. In Overview, under Discover, assess and migrate servers, click Assess and migrate servers.
4. In **Getting started**, click **Add tools**.

5. In the **Migrate project** tab, select your Azure subscription, and create a resource group if you don’t have one.

6. In **Project Details**, specify the project name, and the region in which you want to create the project. Review supported geographies for **public** and **government clouds**.
   - The project region is used only to store the metadata gathered from on-premises VMs.
   - You can select a different Azure target region when you migrate the VMs. All Azure regions are supported for migration target.

7. Click **Next**.

8. In **Select assessment tool**, select **Azure Migrate: Server Assessment** > **Next**.
9. In Select migration tool, select Skip adding a migration tool for now > Next.

10. In Review + add tools, review the settings, and click Add tools.

11. Wait a few minutes for the Azure Migrate project to deploy. You'll be taken to the project page. If you don't see the project, you can access it from Servers in the Azure Migrate dashboard.

Set up the Azure Migrate appliance

Azure Migrate:Server Assessment uses a lightweight Azure Migrate appliance. The appliance performs VM discovery and sends VM metadata and performance data to Azure Migrate. The appliance can be set up in a number of ways.

- Set up on a Hyper-V VM using a downloaded Hyper-V VHD. This is the method used in this tutorial.
- Set up on a Hyper-V VM or physical machine with a PowerShell installer script. This method should be used if you can't set up a VM using the VHD, or if you're in Azure Government.

After creating the appliance, you check that it can connect to Azure Migrate:Server Assessment, configure it for the first time, and register it with the Azure Migrate project.

Download the VHD

Download the zipped VHD template for the appliance.

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.
2. In Discover machines > Are your machines virtualized?, click Yes, with Hyper-V.
3. Click Download to download the VHD file.
Verify security

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.

2. Run the following PowerShell command to generate the hash for the ZIP file

   ```
   C:\>Get-FileHash -Path <file_location> -Algorithm [Hashing Algorithm]
   ```

   Example usage:

   ```
   C:\>Get-FileHash -Path ./AzureMigrateAppliance_v1.19.06.27.zip -Algorithm SHA256
   ```

3. For appliance version 2.19.07.30, the generated hash should match these settings.

<table>
<thead>
<tr>
<th>ALGORITHM</th>
<th>HASH VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD5</td>
<td>29a7531f32bc69f32d964fa5ae950bc</td>
</tr>
<tr>
<td>SHA256</td>
<td>37b3f27bc44f475872e355f04fcb8f38606c84534c117d160f92d12444569b31</td>
</tr>
</tbody>
</table>

Create the appliance VM

Import the downloaded file, and create the VM.

1. After downloading the zipped VHD file to the Hyper-V host on which the appliance VM will be placed, extract the zipped file.

   - In the extracted location, the file unzips into a folder called `AzureMigrateAppliance_VersionNumber`.
   - This folder contains a subfolder, also called `AzureMigrateAppliance_VersionNumber`.
   - This subfolder contains three further subfolders - Snapshots, Virtual Hard Disks, and Virtual Machines.

3. In the Import Virtual Machine Wizard > **Before you begin**, click **Next**.

4. In **Locate Folder**, select the **Virtual Machines** folder. Then click **Next**.

5. In **Select Virtual Machine**, click **Next**.

6. In **Choose Import Type**, click **Copy the virtual machine (create a new unique ID)**. Then click **Next**.

7. In **Choose Destination**, leave the default setting. Click **Next**.

8. In **Storage Folders**, leave the default setting. Click **Next**.

9. In **Choose Network**, specify the virtual switch that the VM will use. The switch needs internet connectivity to send data to Azure. **Learn** about creating a virtual switch.

10. In **Summary**, review the settings. Then click **Finish**.

11. In Hyper-V Manager > **Virtual Machines**, start the VM.

**Verify appliance access to Azure**

Make sure that the appliance VM can connect to Azure URLs for **public** and **government** clouds.

**Configure the appliance**

Set up the appliance for the first time.

**NOTE**

If you set up the appliance using a **PowerShell script** instead of the downloaded VHD, the first two steps in this procedure aren't relevant.

1. In Hyper-V Manager > **Virtual Machines**, right-click the VM > **Connect**.

2. Provide the language, time zone, and password for the appliance.

3. Open a browser on any machine that can connect to the VM, and open the URL of the appliance web app: **https://appliance name or IP address**: **44368**.

   Alternately, you can open the app from the appliance desktop by clicking the app shortcut.

4. In the web app > **Set up prerequisites**, do the following:
   - **License**: Accept the license terms, and read the third-party information.
   - **Connectivity**: The app checks that the VM has internet access. If the VM uses a proxy:
Register the appliance with Azure Migrate

1. Click **Log In**. If it doesn't appear, make sure you've disabled the pop-up blocker in the browser.
2. On the new tab, sign in using your Azure credentials.
   - Sign in with your username and password.
   - Sign-in with a PIN isn't supported.
3. After successfully signing in, go back to the web app.
4. Select the subscription in which the Azure Migrate project was created. Then select the project.
5. Specify a name for the appliance. The name should be alphanumeric with 14 characters or less.
6. Click **Register**.

Delegate credentials for SMB VHDs

If you're running VHDs on SMBs, you must enable delegation of credentials from the appliance to the Hyper-V hosts. This requires the following:

- You enable each host to act as a delegate for the appliance. If you followed the tutorials in order, you did this in the previous tutorial, when you prepared Hyper-V for assessment and migration. You should have either set up CredSSP for the hosts **manually**, or by **running a script** that does this.
- Enable CredSSP delegation so that the Azure Migrate appliance can act as the client, delegating credentials to a host.

Enable on the appliance as follows:

**Option 1**

On the appliance VM, run this command. HyperVHost1/HyperVHost2 are example host names.

```
Enable-WSManCredSSP -Role Client -DelegateComputer HyperVHost1.contoso.com HyperVHost2.contoso.com -Force
```

Example:

```
Enable-WSManCredSSP -Role Client -DelegateComputer HyperVHost1.contoso.com HyperVHost2.contoso.com -Force
```

**Option 2**

Alternatively, do this in the Local Group Policy Editor on the appliance:

1. In **Local Computer Policy > Computer Configuration**, click **Administrative Templates > System > Credentials Delegation**.
2. Double-click **Allow delegating fresh credentials**, and select **Enabled**.
3. In **Options**, click **Show**, and add each Hyper-V host you want to discover to the list, with `wsman/` as a prefix.
4. Then, in **Credentials Delegation**, double-click **Allow delegating fresh credentials with NTLM-only server authentication**. Again, add each Hyper-V host you want to discover to the list, with `wsman/` as a prefix.

Start continuous discovery

Connect from the appliance to Hyper-V hosts or clusters, and start VM discovery.
1. In User name and Password, specify the account credentials that the appliance will use to discover VMs. Specify a friendly name for the credentials, and click Save details.

2. Click Add host, and specify Hyper-V host/cluster details.

3. Click Validate. After validation, the number of VMs that can be discovered on each host/cluster is shown.

   - If validation fails for a host, review the error by hovering over the icon in the Status column. Fix issues, and validate again.
   - To remove hosts or clusters, select > Delete.
   - You can't remove a specific host from a cluster. You can only remove the entire cluster.
   - You can add a cluster, even if there are issues with specific hosts in the cluster.

4. After validation, click Save and start discovery to start the discovery process.

This starts discovery. It takes around 1.5 minutes per host for metadata of discovered servers to appear in the Azure portal.

Verify VMs in the portal

After discovery finishes, you can verify that the VMs appear in the portal.

1. Open the Azure Migrate dashboard.

2. In Azure Migrate - Servers > Azure Migrate: Server Assessment page, click the icon that displays the count for Discovered servers.

Set up an assessment

There are two types of assessments you can run using Azure Migrate Server Assessment.

<table>
<thead>
<tr>
<th>ASSESSMENT</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance-based</td>
<td>Assessments based on collected performance data</td>
<td>Recommended VM size: Based on CPU and memory utilization data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recommended disk type (standard or premium managed disk): Based on the IOPS and throughput of the on-premises disks.</td>
</tr>
<tr>
<td>As on-premises</td>
<td>Assessments based on on-premises sizing.</td>
<td>Recommended VM size: Based on the on-premises VM size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recommended disk type: Based on the storage type setting you select for the assessment</td>
</tr>
</tbody>
</table>

Run an assessment

Run an assessment as follows:

1. Review the best practices for creating assessments.

2. In Servers > Azure Migrate: Server Assessment, click Assess.
3. In **Assess Servers**, specify a name for the assessment.

4. Click **View all** to review the assessment properties.

5. In **Select or create a group**, select **Create New**, and specify a group name. A group gathers one or more VMs together for assessment.

6. In **Add machines to the group**, select VMs to add to the group.

7. Click **Create Assessment** to create the group, and run the assessment.
8. After the assessment is created, view it in Servers > Azure Migrate: Server Assessment.

9. Click Export assessment, to download it as an Excel file.

**Review an assessment**

An assessment describes:

- **Azure readiness**: Whether VMs are suitable for migration to Azure.
- **Monthly cost estimation**: The estimated monthly compute and storage costs for running the VMs in Azure.
- **Monthly storage cost estimation**: Estimated costs for disk storage after migration.

**View an assessment**

1. In Migration goals > Servers > Azure Migrate: Server Assessment, click Assessments.

2. In Assessments, click on an assessment to open it.
Review Azure readiness

1. In **Azure readiness**, verify whether VMs are ready for migration to Azure.

2. Review the VM status:
   - **Ready for Azure**: Azure Migrate recommends a VM size and cost estimates for VMs in the assessment.
   - **Ready with conditions**: Shows issues and suggested remediation.
   - **Not ready for Azure**: Shows issues and suggested remediation.
   - **Readiness unknown**: Used when Azure Migrate can't assess readiness, due to data availability issues.

3. Click on an **Azure readiness** status. You can view VM readiness details, and drill down to see VM details, including compute, storage, and network settings.

Review cost details

This view shows the estimated compute and storage cost of running VMs in Azure.

1. Review the monthly compute and storage costs. Costs are aggregated for all VMs in the assessed group.
   - Cost estimates are based on the size recommendations for a machine, and its disks and properties.
   - Estimated monthly costs for compute and storage are shown.
   - The cost estimation is for running the on-premises VMs as IaaS VMs. Azure Migrate Server Assessment doesn't consider PaaS or SaaS costs.

2. You can review monthly storage cost estimates. This view shows aggregated storage costs for the assessed group, split over different types of storage disks.

3. You can drill down to see details for specific VMs.

Review confidence rating

When you run performance-based assessments, a confidence rating is assigned to the assessment.

- A rating from 1-star (lowest) to 5-star (highest) is awarded.
- The confidence rating helps you estimate the reliability of the size recommendations provided by the assessment.
- The confidence rating is based on the availability of data points needed to compute the assessment.
Confidence ratings for an assessment are as follows.

<table>
<thead>
<tr>
<th>DATA POINT AVAILABILITY</th>
<th>CONFIDENCE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%-20%</td>
<td>1 Star</td>
</tr>
<tr>
<td>21%-40%</td>
<td>2 Star</td>
</tr>
<tr>
<td>41%-60%</td>
<td>3 Star</td>
</tr>
<tr>
<td>61%-80%</td>
<td>4 Star</td>
</tr>
<tr>
<td>81%-100%</td>
<td>5 Star</td>
</tr>
</tbody>
</table>

Learn more about best practices for confidence ratings.

**Next steps**

In this tutorial, you:

- Set up an Azure Migrate appliance
- Created and reviewed an assessment

Continue to the third tutorial in the series, to learn how to migrate Hyper-V VMs to Azure with Azure Migrate Server Migration.

*Migrate Hyper-V VMs*
This article shows you how to migrate on-premises Hyper-V VMs to Azure, using agentless migration with the Azure Migrate: Server Migration tool.

Azure Migrate provides a central hub to track discovery, assessment, and migration of your on-premises apps and workloads, and private/public cloud VMs, to Azure. The hub provides Azure Migrate tools for assessment and migration, as well as third-party independent software vendor (ISV) offerings.

This tutorial is the third in a series that demonstrates how to assess and migrate Hyper-V to Azure using Azure Migrate Server Assessment and Server Migration. In this tutorial, you learn how to:

- Prepare Azure and your on-premises Hyper-V environment
- Set up the source environment.
- Set up the target environment.
- Enable replication.
- Run a test migration to make sure everything’s working as expected.
- Run a full migration to Azure.

If you don't have an Azure subscription, create a free account before you begin.

**Prerequisites**

Before you begin this tutorial, you should:

1. Review the Hyper-V migration architecture.
2. Review Hyper-V host requirements, and the Azure URLs that the Hyper-V hosts need to access.
3. Review requirements for Hyper-V VMs that you want to migrate. Hyper-V VMs must conform with Azure VM requirements.
4. We recommend that you complete the previous tutorials in this series. The first tutorial shows you how to set up Azure and Hyper-V for migration. The second tutorial shows you how to assess Hyper-V VMs before migration, using Azure Migrate:Server Assessment.

**NOTE**

Although we recommend that you try out an assessment, you don't have to run an assessment before you migrate VMs. For migrating Hyper-V VMs, Azure Migrate:Server Migration runs software agents (Microsoft Azure Site Recovery provider and Microsoft Azure Recovery Service agent) on Hyper-V Hosts or cluster nodes, to orchestrate and replicate data to Azure Migrate. The Azure Migrate appliance isn't used for Hyper-V migration.

5. Make sure that your Azure account is assigned the Virtual Machine Contributor role, so that you have permissions to:
   - Create a VM in the selected resource group.
   - Create a VM in the selected virtual network.
   - Write to an Azure managed disk.
6. Set up an Azure network. When you migrate to Azure, the created Azure VMs are joined to an Azure network you specify when you set up migration.
Add the Azure Migrate:Server Migration tool

Add the Azure Migrate:Server Migration tool.

- If you followed the second tutorial to assess VMware VMs, you have already set up an Azure Migrate project, and can go ahead and add the tool now.
- If you didn’t follow the second tutorial, follow these instructions to set up an Azure Migrate project. You add the Azure Migrate:Server Migration tool when you create the project.

If you have a project set up, add the tool as follows:

1. In the Azure Migrate project, click Overview.
2. In Discover, assess, and migration servers, click Assess and migrate servers.
3. In Migration tools, select Click here to add a migration tool when you are ready to migrate.
4. In the tools list, select Azure Migrate: Server Migration > Add tool

Prepare Hyper-V hosts

1. In the Azure Migrate project > Servers, in Azure Migrate: Server Migration, click Discover.
2. In Discover machines > Are your machines virtualized?, select Yes, with Hyper-V.
3. In Target region, select the Azure region to which you want to migrate the machines.
4. Select Confirm that the target region for migration is region-name.
5. Click Create resources. This creates an Azure Site Recovery vault in the background.
resources were set up previously.

- You can’t change the target region for this project after clicking this button.
- All subsequent migrations are to this region.

6. In **Prepare Hyper-V host servers**, download the Hyper-V Replication provider, and the registration key file.

- The registration key is needed to register the Hyper-V host with Azure Migrate Server Migration.
- The key is valid for five days after you generate it.

![Discover machines](image)

7. Copy the provider setup file and registration key file to each Hyper-V host (or cluster node) running VMs you want to replicate.

8. Run the provider setup file on each host, as described in the next procedure.

9. After installing the provider on hosts, in **Discover machines**, click **Finalize registration**.

![Finalize registration](image)

It can take up to 15 minutes after finalizing registration until discovered VMs appear in Azure Migrate Server Migration. As VMs are discovered, the **Discovered servers** count rises.

![Migration tools](image)

**Replicate Hyper-V VMs**
With discovery completed, you can begin replication of Hyper-V VMs to Azure.

**NOTE**

You can replicate up to 10 machines together. If you need to replicate more, then replicate them simultaneously in batches of 10.

1. In the Azure Migrate project > Servers, Azure Migrate: Server Migration, click Replicate.

2. In Replicate, > Source settings > Are your machines virtualized?, select Yes, with Hyper-V. Then click Next: Virtual machines.

3. In Virtual machines, select the machines you want to replicate.

   - If you've run an assessment for the VMs, you can apply VM sizing and disk type (premium/standard) recommendations from the assessment results. To do this, in Import migration settings from an Azure Migrate assessment?, select the Yes option.

   - If you didn't run an assessment, or you don't want to use the assessment settings, select the No options.

   - If you selected to use the assessment, select the VM group, and assessment name.

4. In Virtual machines, search for VMs as needed, and check each VM you want to migrate. Then, click Next: Target settings.
5. **In Target settings**, select the target region to which you’ll migrate, the subscription, and the resource group in which the Azure VMs will reside after migration.

6. **In Replication Storage Account**, select the Azure Storage account in which replicated data will be stored in Azure.

7. **Virtual Network**, select the Azure VNet/subnet to which the Azure VMs will be joined after migration.

8. **In Azure Hybrid Benefit:**
   - Select **No** if you don’t want to apply Azure Hybrid Benefit. Then, click **Next**.
   - Select **Yes** if you have Windows Server machines that are covered with active Software Assurance or Windows Server subscriptions, and you want to apply the benefit to the machines you’re migrating. Then click **Next**.
9. In **Compute**, review the VM name, size, OS disk type, and availability set. VMs must conform with **Azure requirements**.

- **VM size**: If you’re using assessment recommendations, the VM size dropdown will contain the recommended size. Otherwise Azure Migrate picks a size based on the closest match in the Azure subscription. Alternatively, pick a manual size in **Azure VM size**.
- **OS disk**: Specify the OS (boot) disk for the VM. The OS disk is the disk that has the operating system bootloader and installer.
- **Availability set**: If the VM should be in an Azure availability set after migration, specify the set. The set must be in the target resource group you specify for the migration.

10. In **Disks**, specify whether the VM disks should be replicated to Azure, and select the disk type (standard SSD/HDD or premium-managed disks) in Azure. Then click **Next**.

- You can exclude disks from replication.
- If you exclude disks, won’t be present on the Azure VM after migration.
11. In **Review and start replication**, review the settings, and click **Replicate** to start the initial replication for the servers.

**NOTE**
You can update replication settings any time before replication starts, in **Manage > Replicating machines**. Settings can't be changed after replication starts.

### Provisioning for the first time

If this is the first VM you're replicating in the Azure Migrate project, Azure Migrate: Server Migration automatically provisions these resources in same resource group as the project.

- **Service bus**: Azure Migrate: Server Migration uses the Service Bus to send replication orchestration messages to the appliance.
- **Gateway storage account**: Azure Migrate: Server Migration uses the gateway storage account to store state information about the VMs being replicated.
- **Log storage account**: The Azure Migrate appliance uploads replication logs for VMs to a log storage account. Azure Migrate applies the replication information to the replica-managed disks.
- **Key vault**: The Azure Migrate appliance uses the key vault to manage connection strings for the service bus, and access keys for the storage accounts used in replication. You should have set up the permissions that the key vault needs to access the storage account when you prepared Azure for Hyper-V VM assessment and migration.

### Track and monitor

- When you click **Replicate** a Start Replication job begins.
- When the Start Replication job finishes successfully, the machines begin their initial replication to Azure.
- After initial replication finishes, delta replication begins. Incremental changes to on-premises disks are periodically replicated to Azure.

You can track job status in the portal notifications.

You can monitor replication status by clicking on **Replicating servers** in **Azure Migrate: Server Migration**.

<table>
<thead>
<tr>
<th>NAME</th>
<th>Disks to Replicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContosoVMWareMigration2</td>
<td>All selected</td>
</tr>
<tr>
<td></td>
<td>sscs010</td>
</tr>
<tr>
<td>ContosoCSR</td>
<td>All selected</td>
</tr>
<tr>
<td></td>
<td>sss100</td>
</tr>
<tr>
<td>Contoso-FrontTier3</td>
<td>All selected</td>
</tr>
<tr>
<td></td>
<td>sscs010</td>
</tr>
<tr>
<td>ContosoWeb1</td>
<td>All selected</td>
</tr>
<tr>
<td></td>
<td>sscs010</td>
</tr>
</tbody>
</table>
Run a test migration

When delta replication begins, you can run a test migration for the VMs, before running a full migration to Azure. We highly recommend that you do this at least once for each machine, before you migrate it.

- Running a test migration checks that migration will work as expected, without impacting the on-premises machines, which remain operational, and continue replicating.
- Test migration simulates the migration by creating an Azure VM using replicated data (usually migrating to a non-production Azure VNet in your Azure subscription).
- You can use the replicated test Azure VM to validate the migration, perform app testing, and address any issues before full migration.

Do a test migration as follows:

1. In Migration goals > Servers > Azure Migrate: Server Migration, click Test migrated servers.

2. Right-click the VM to test, and click Test migrate.
3. In **Test Migration**, select the Azure virtual network in which the Azure VM will be located after the migration. We recommend you use a non-production virtual network.

4. The **Test migration** job starts. Monitor the job in the portal notifications.

5. After the migration finishes, view the migrated Azure VM in **Virtual Machines** in the Azure portal. The machine name has a suffix -**Test**.

6. After the test is done, right-click the Azure VM in **Replicating machines**, and click **Clean up test migration**.

---

**Migrate VMs**

After you've verified that the test migration works as expected, you can migrate the on-premises machines.

1. In the Azure Migrate project > **Servers** > **Azure Migrate: Server Migration**, click **Replicating servers**.
2. In Replicating machines, right-click the VM > Migrate.

3. In Migrate > Shut down virtual machines and perform a planned migration with no data loss, select Yes > OK.

   - By default Azure Migrate shuts down the on-premises VM, and runs an on-demand replication to synchronize any VM changes that occurred since the last replication occurred. This ensures no data loss.
   - If you don’t want to shut down the VM, select No

4. A migration job starts for the VM. Track the job in Azure notifications.

5. After the job finishes, you can view and manage the VM from the Virtual Machines page.

Complete the migration

1. After the migration is done, right-click the VM > Stop migration. This does the following:
   - Stops replication for the on-premises machine.
   - Removes the machine from the Replicating servers count in Azure Migrate: Server Migration.
   - Cleans up replication state information for the VM.

2. Install the Azure VM Windows or Linux agent on the migrated machines.

3. Perform any post-migration app tweaks, such as updating database connection strings, and web server configurations.

4. Perform final application and migration acceptance testing on the migrated application now running in Azure.

5. Cut over traffic to the migrated Azure VM instance.

6. Remove the on-premises VMs from your local VM inventory.

7. Remove the on-premises VMs from local backups.

8. Update any internal documentation to show the new location and IP address of the Azure VMs.

Post-migration best practices

- For increased resilience:
  - Keep data secure by backing up Azure VMs using the Azure Backup service. Learn more.
  - Keep workloads running and continuously available by replicating Azure VMs to a secondary region.
Next steps

Investigate the cloud migration journey in the Azure Cloud Adoption Framework.

For increased security:
- Lock down and limit inbound traffic access with Azure Security Center - Just in time administration.
- Restrict network traffic to management endpoints with Network Security Groups.
- Deploy Azure Disk Encryption to help secure disks, and keep data safe from theft and unauthorized access.
- Read more about securing IaaS resources, and visit the Azure Security Center.

For monitoring and management:
- Consider deploying Azure Cost Management to monitor resource usage and spending.
This article describes how to prepare for assessment of on-premises physical servers with Azure Migrate. Azure Migrate provides a hub of tools that help you to discover, assess, and migrate apps, infrastructure, and workloads to Microsoft Azure. The hub includes Azure Migrate tools, and third-party independent software vendor (ISV) offerings.

This tutorial is the first in a series that shows you how to assess physical servers with Azure Migrate. In this tutorial, you learn how to:

- Prepare Azure. Set up permissions for your Azure account and resources to work with Azure Migrate.
- Prepare on-premises physical servers for server assessment.

NOTE
Tutorials show you the simplest deployment path for a scenario so that you can quickly set up a proof-of-concept. Tutorials use default options where possible, and don't show all possible settings and paths. For detailed instructions, review the How-tos for physical servers assessment.

If you don't have an Azure subscription, create a free account before you begin.

Prepare Azure for server assessment

Set up Azure to work with Azure Migrate.

<table>
<thead>
<tr>
<th>TASK</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an Azure Migrate project</td>
<td>Your Azure account needs Contributor or Owner permissions to create a project.</td>
</tr>
<tr>
<td>Register resource providers (assessment only)</td>
<td>Azure Migrate uses a lightweight Azure Migrate appliance to discover and assess machines with Azure Migrate:Server Assessment. During appliance registration, resource providers are registered with the subscription chosen in the appliance. Learn more. To register the resource providers, you need a Contributor or Owner role on the subscription.</td>
</tr>
<tr>
<td>Create Azure AD app (assessment only)</td>
<td>When registering the appliance, Azure Migrate creates an Azure Active Directory (Azure AD) app that's used for communication between the agents running on the appliance with their respective services running on Azure. Learn more. You need permissions to create Azure AD apps (available in the Application Developer) role.</td>
</tr>
</tbody>
</table>
Assign permissions to create project

Check you have permissions to create an Azure Migrate project.

1. In the Azure portal, open the subscription, and select Access control (IAM).
2. In Check access, find the relevant account, and click it to view permissions.
3. You should have Contributor or Owner permissions.
   - If you just created a free Azure account, you're the owner of your subscription.
   - If you're not the subscription owner, work with the owner to assign the role.

Assign permissions to register the appliance

You can assign permissions for Azure Migrate to create the Azure AD app during appliance registration, using one of the following methods:

- A tenant/global admin can grant permissions to users in the tenant, to create and register Azure AD apps.
- A tenant/global admin can assign the Application Developer role (that has the permissions) to the account.

NOTE

- The app does not have any other access permissions on the subscription other than those described above.
- You only need these permissions when you register a new appliance. You can remove the permissions after the appliance is set up.

Grant account permissions

The tenant/global admin can grant permissions as follows:

1. In Azure AD, the tenant/global admin should navigate to Azure Active Directory > Users > User Settings.
2. The admin should set App registrations to Yes.

![Azure AD User Settings](image)
**NOTE**
This is a default setting that isn't sensitive. Learn more.

**Assign Application Developer role**
The tenant/global admin can assign the Application Developer role to an account. Learn more.

**Prepare Azure for physical server migration**
Prepare Azure to migrate physical servers, using Server Migration.

<table>
<thead>
<tr>
<th>TASK</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an Azure Migrate project</td>
<td>Your Azure account needs Contributor or Owner permissions to create a project.</td>
</tr>
<tr>
<td>Verify permissions for your Azure account</td>
<td>Your Azure account needs permissions to create a VM, and write to an Azure managed disk.</td>
</tr>
<tr>
<td>Create an Azure network</td>
<td>Set up a network in Azure.</td>
</tr>
</tbody>
</table>

**Assign permissions to create project**
1. In the Azure portal, open the subscription, and select Access control (IAM).
2. In Check access, find the relevant account, and click it to view permissions.
3. You should have Contributor or Owner permissions.
   - If you just created a free Azure account, you're the owner of your subscription.
   - If you're not the subscription owner, work with the owner to assign the role.

**Assign Azure account permissions**
Assign the Virtual Machine Contributor role to the Azure account. This provides permissions to:

- Create a VM in the selected resource group.
- Create a VM in the selected virtual network.
- Write to an Azure managed disk.

**Create an Azure network**
Set up an Azure virtual network (VNet). When you replicate to Azure, Azure VMs are created and joined to the Azure VNet that you specify when you set up migration.

**Prepare for physical server assessment**
To prepare for physical server assessment, you need to verify the physical server settings and verify settings for appliance deployment:

**Verify physical server settings**
1. Verify physical server requirements for server assessment.
2. Make sure the required ports are open on physical servers.

**Verify appliance settings**
Before setting up the Azure Migrate appliance and beginning assessment in the next tutorial, prepare for appliance deployment:

1. Verify appliance requirements for physical servers.
2. Review the Azure URLs that the appliance needs to access in the public and government clouds.
3. Review that the appliance will collect during discovery and assessment.
4. Note port access requirements physical server assessment.

**Set up an account for physical server discovery**

Azure Migrate needs permissions to discover on-premises servers.

- **Windows**: Set up a local user account on all the Windows servers that you want to include in the discovery. The user account needs to be added to the following groups: - Remote Management Users - Performance Monitor Users - Performance Log users
- **Linux**: You need a root account on the Linux servers that you want to discover.

**Prepare for physical server migration**

Review the requirements for migration of physical servers.

```
NOTE
When migrating physical machines, Azure Migrate:Server Migration uses the same replication architecture as agent-based disaster recovery in the Azure Site Recovery service, and some components share the same code base. Some content might link to Site Recovery documentation.
```

- Review physical server requirements for migration.
- Azure Migrate:Server Migration uses a replication server for physical server migration:
  - Review the deployment requirements for the replication appliance, and the options for installing MySQL on the appliance.
  - Review the Azure URLs required for the replication appliance to access public and government clouds.
  - Review [port] (migrate-replication-appliance.md#port-access) access requirements for the replication appliance.

**Next steps**

In this tutorial, you:

- Set up Azure account permissions.
- Prepared physical servers for assessment.

Continue to the next tutorial to create an Azure Migrate project, and assess physical servers for migration to Azure

**Assess physical servers**
This article shows you how to assess on-premises physical servers, using the Azure Migrate:Server Assessment tool.

**Azure Migrate** provides a hub of tools that help you to discover, assess, and migrate apps, infrastructure, and workloads to Microsoft Azure. The hub includes Azure Migrate tools, and third-party independent software vendor (ISV) offerings.

This tutorial is the second in a series that demonstrates how to assess and migrate physical servers to Azure. In this tutorial, you learn how to:

- Set up an Azure Migrate project.
- Set up an Azure Migrate appliance that runs on-premises to assess physical servers.
- Start continuous discovery of on-premises physical servers. The appliance sends configuration and performance data for discovered servers to Azure.
- Group discovered servers, and assess the server group.
- Review the assessment.

**NOTE**

Tutorials show you the simplest deployment path for a scenario so that you can quickly set up a proof-of-concept. Tutorials use default options where possible, and don't show all possible settings and paths. For detailed instructions, review the How-to articles.

If you don’t have an Azure subscription, create a [free account](#) before you begin.

**Prerequisites**

- **Complete** the first tutorial in this series. If you don’t, the instructions in this tutorial won’t work.
- Here’s what you should have done in the first tutorial:
  - Set up Azure permissions for Azure Migrate.
  - Prepare physical servers for assessment. Appliance requirements should be verified. You should also have an account set up for physical server discovery. Required ports should be available, and you should be aware of the URLs needed for access to Azure.

**Set up an Azure Migrate project**

Set up a new Azure Migrate project as follows.

1. In the Azure portal > **All services**, search for Azure Migrate.
2. Under **Services**, select Azure Migrate.
3. In **Overview**, under **Discover, assess and migrate servers**, click **Assess and migrate servers**.
4. In **Getting started**, click **Add tools**.

5. In **Migrate project**, select your Azure subscription, and create a resource group if you don't have one.

6. In **Project Details**, specify the project name, and the geography in which you want to create the project.

   - The project geography is used only to store the metadata gathered from on-premises servers.
   - You can select any target region when you run a migration.

   **Add a tool**

<table>
<thead>
<tr>
<th>Migrate project</th>
<th>Select assessment tool</th>
<th>Select migration tool</th>
<th>Review + add tool(s)</th>
</tr>
</thead>
</table>

   A migrate project is used to store the discovery, assessment and migration metadata reported by your on-premises environment. Select a subscription and resource group in your preferred geography to create the migrate project.

   - Subscription
   - Resource group

   **PROJECT DETAILS**

   Specify the name of the migrate project and the preferred geography.

   - Migrate project
   - Region

   **(Asia Pacific) Southeast Asia**

7. Click **Next**.

8. In **Select assessment tool**, select **Azure Migrate: Server Assessment > Next**.
9. In Select migration tool, select Skip adding a migration tool for now > Next.

10. In Review + add tools, review the settings, and click Add tools.

11. Wait a few minutes for the Azure Migrate project to deploy. You’ll be taken to the project page. If you don’t see the project, you can access it from Servers in the Azure Migrate dashboard.

Set up the appliance

Azure Migrate: Server Assessment runs a lightweight appliance.

- This appliance performs physical server discovery and sends server metadata and performance data to Azure Migrate Server Assessment.

- To set up the appliance you:
  - Download a zipped file with Azure Migrate installer script from the Azure portal.
  - Extract the contents from the zipped file. Launch the PowerShell console with administrative privileges.
  - Execute the PowerShell script to launch the appliance web application.
  - Configure the appliance for the first time, and register it with the Azure Migrate project.

- You can set up multiple appliances for a single Azure Migrate project. Across all appliances, you can discover any number of physical servers. A maximum of 250 servers can be discovered per appliance.

Download the installer script

Download the zipped file for the appliance.

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.

2. In Discover machines > Are your machines virtualized?, click Not virtualized/Other.

3. Click Download to download the zipped file.
Verify security

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.

2. Run the following command to generate the hash for the zipped file:

   ```
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   ```

   **Example usage for public cloud:**
   ```
   C:\>CertUtil -HashFile C:\Users\administrator\Desktop\AzureMigrateInstaller.zip SHA256
   ```

   **Example usage for government cloud:**
   ```
   C:\>CertUtil -HashFile C:\Users\administrator\Desktop\AzureMigrateInstaller-Server-USGov.zip MD5
   ```

3. Verify hash values:

   - For the public cloud (for the latest appliance version):
     ```
     | ALGORITHM | HASH VALUE     |
     |-----------|---------------|
     | MD5       | 1e92ede3e87c03bd148e56a708cdd33f |
     | SHA256    | a3fa78edc8f8aff9ab5ae66be1b64e66de7b9f475b5642bee114b20bfdaac3c |
     ```

   - For Azure government (for the latest appliance version):
     ```
     | ALGORITHM | HASH VALUE     |
     |-----------|---------------|
     | MD5       | f81c1556c4a1409901caea948713913f |
     ```
Run the Azure Migrate installer script

The installer script does the following:

- Installs agents and a web application for physical server discovery and assessment.
- Install Windows roles, including Windows Activation Service, IIS, and PowerShell ISE.
- Download and installs an IIS rewritable module. Learn more.
- Updates a registry key (HKLM) with persistent setting details for Azure Migrate.
- Creates the following files under the path:
  - **Config Files**: %Programdata%\Microsoft Azure\Config
  - **Log Files**: %Programdata%\Microsoft Azure\Logs

Run the script as follows:

1. Extract the zipped file to a folder on the server that will host the appliance. Make sure you don’t run the script on a machine on an existing Azure Migrate appliance.
2. Launch PowerShell on the above server with administrative (elevated) privilege.
3. Change the PowerShell directory to the folder where the contents have been extracted from the downloaded zipped file.
4. Run the script named **AzureMigrateInstaller.ps1** by running the following command:
   
   For the public cloud:
   ```powershell
   PS C:\Users\administrator\Desktop\AzureMigrateInstaller> AzureMigrateInstaller.ps1
   ```
   
   For Azure Government:
   ```powershell
   PS C:\Users\Administrators\Desktop\AzureMigrateInstaller-Server-USGov>AzureMigrateInstaller.ps1
   ```

   The script will launch the appliance web application when it finishes successfully.

If you come across any issues, you can access the script logs at C:\ProgramData\Microsoft Azure\Logs\AzureMigrateScenarioInstaller_ Timestamp.log for troubleshooting.

Verify appliance access to Azure

Make sure that the appliance can connect to Azure URLs for public and government clouds.

Configure the appliance

Set up the appliance for the first time.

1. Open a browser on any machine that can connect to the appliance, and open the URL of the appliance web app: `https://appliance name or IP address: 44368`

   Alternately, you can open the app from the desktop by clicking the app shortcut.

2. In the web app > **Set up prerequisites**, do the following:
   
   - **License**: Accept the license terms, and read the third-party information.
   - **Connectivity**: The app checks that the server has internet access. If the server uses a proxy:
     - Click **Proxy settings**, and specify the proxy address and listening port, in the form http://ProxyIPAddress or http://ProxyFQDN.
     - Specify credentials if the proxy needs authentication.
     - Only HTTP proxy is supported.
   - **Time sync**: Time is verified. The time on the appliance should be in sync with internet time for server discovery to work properly.
   - **Install updates**: Azure Migrate Server Assessment checks that the appliance has the latest updates installed.
Register the appliance with Azure Migrate

1. Click Log In. If it doesn’t appear, make sure you’ve disabled the pop-up blocker in the browser.
2. On the new tab, sign in using your Azure credentials.
   - Sign in with your username and password.
   - Sign in with a PIN isn’t supported.
3. After successfully signing in, go back to the web app.
4. Select the subscription in which the Azure Migrate project was created. Then select the project.
5. Specify a name for the appliance. The name should be alphanumeric with 14 characters or less.
6. Click Register.

Start continuous discovery

Now, connect from the appliance to the physical servers to be discovered, and start the discovery.

1. Click Add Credentials to specify the account credentials that the appliance will use to discover servers.
2. Specify the Operating System, a friendly name for the credentials, and the username and password. Then click Add. You can add one set of credentials each for Windows and Linux servers.
3. Click Add server, and specify server details: FQDN/IP address and friendly name of credentials (one entry per row) to connect to the server.
4. Click Validate. After validation, the list of servers that can be discovered is shown.
   - If validation fails for a server, review the error by hovering over the icon in the Status column. Fix issues, and validate again.
   - To remove a server, select > Delete.
5. After validation, click Save and start discovery to start the discovery process.

This starts discovery. It takes around 1.5 minutes per server for metadata of discovered server to appear in the Azure portal.

Verify servers in the portal

After discovery, you can verify that the servers appear in the Azure portal.

1. Open the Azure Migrate dashboard.
2. In Azure Migrate - Servers > Azure Migrate: Server Assessment page, click the icon that displays the count for Discovered servers.

Set up an assessment

There are two types of assessments you can create using Azure Migrate: Server Assessment.

<table>
<thead>
<tr>
<th>ASSESSMENT</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance-based</td>
<td>Assessments based on collected performance data</td>
<td>Recommended VM size: Based on CPU and memory utilization data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recommended disk type (standard or premium managed disk): Based on the IOPS and throughput of the on-premises disks.</td>
</tr>
</tbody>
</table>
Run an assessment

Run an assessment as follows:

1. Review the best practices for creating assessments.

2. In the Servers tab, in Azure Migrate: Server Assessment tile, click Assess.

3. In Assess servers, specify a name for the assessment.

4. Click View all to review the assessment properties.
5. In **Select or create a group**, select **Create New**, and specify a group name. A group gathers one or more servers together for assessment.

6. In **Add machines to the group**, select servers to add to the group.

7. Click **Create Assessment** to create the group, and run the assessment.
8. After the assessment is created, view it in **Servers > Azure Migrate: Server Assessment > Assessments**.

9. Click **Export assessment**, to download it as an Excel file.

**Review an assessment**

An assessment describes:

- **Azure readiness**: Whether servers are suitable for migration to Azure.
- **Monthly cost estimation**: The estimated monthly compute and storage costs for running the servers in Azure.
- **Monthly storage cost estimation**: Estimated costs for disk storage after migration.

**View an assessment**

1. In **Migration goals > Servers**, click **Assessments** in **Azure Migrate: Server Assessment**.

2. In **Assessments**, click on an assessment to open it.
Review Azure readiness

1. In **Azure readiness**, verify whether the servers are ready for migration to Azure.

2. Review the status:
   - **Ready for Azure**: Azure Migrate recommends a VM size and cost estimates for VMs in the assessment.
   - **Ready with conditions**: Shows issues and suggested remediation.
   - **Not ready for Azure**: Shows issues and suggested remediation.
   - **Readiness unknown**: Used when Azure Migrate can’t assess readiness, due to data availability issues.

3. Click on an **Azure readiness** status. You can view server readiness details, and drill down to see server details, including compute, storage, and network settings.

Review cost details

This view shows the estimated compute and storage cost of running VMs in Azure.

1. Review the monthly compute and storage costs. Costs are aggregated for all servers in the assessed group.
   - Cost estimates are based on the size recommendations for a machine, and its disks and properties.
   - Estimated monthly costs for compute and storage are shown.
   - The cost estimation is for running the on-premises servers as IaaS VMs. Azure Migrate Server Assessment doesn’t consider PaaS or SaaS costs.

2. You can review monthly storage cost estimates. This view shows aggregated storage costs for the assessed group, split over different types of storage disks.

3. You can drill down to see details for specific servers.

Review confidence rating

When you run performance-based assessments, a confidence rating is assigned to the assessment.

- A rating from 1-star (lowest) to 5-star (highest) is awarded.
- The confidence rating helps you estimate the reliability of the size recommendations provided by the assessment.
- The confidence rating is based on the availability of data points needed to compute the assessment.
Confidence ratings for an assessment are as follows.

<table>
<thead>
<tr>
<th>DATA POINT AVAILABILITY</th>
<th>CONFIDENCE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%-20%</td>
<td>1 Star</td>
</tr>
<tr>
<td>21%-40%</td>
<td>2 Star</td>
</tr>
<tr>
<td>41%-60%</td>
<td>3 Star</td>
</tr>
<tr>
<td>61%-80%</td>
<td>4 Star</td>
</tr>
<tr>
<td>81%-100%</td>
<td>5 Star</td>
</tr>
</tbody>
</table>

Learn more about best practices for confidence ratings.

Next steps

In this tutorial, you:

- Set up an Azure Migrate appliance
- Created and reviewed an assessment

Continue to the third tutorial in the series, to learn how to migrate physical servers to Azure with Azure Migrate: Server Migration.

Migrate physical servers
This article shows you how to migrate machines as physical servers to Azure, using the Azure Migrate:Server Migration tool. Migrating machines by treating them as physical servers is useful in a number of scenarios:

- Migrate on-premises physical servers.
- Migrate VMs virtualized by platforms such as Xen, KVM.
- Migrate Hyper-V or VMware VMs, if for some reason you're unable to use the standard migration process for Hyper-V, or VMware migration.
- Migrate VMs running in private clouds.
- Migrate VMs running in public clouds such as Amazon Web Services (AWS) or Google Cloud Platform (GCP).

This tutorial is the third in a series that demonstrates how to assess and migrate physical servers to Azure. In this tutorial, you learn how to:

- Prepare to use Azure with Azure Migrate:Server Migration.
- Check requirements for machines you want to migrate, and prepare a machine for the Azure Migrate replication appliance that's used to discover and migrate machines to Azure.
- Add the Azure Migrate Server Migration tool in the Azure Migrate hub.
- Set up the replication appliance.
- Install the Mobility service on machines you want to migrate.
- Enable replication.
- Run a test migration to make sure everything's working as expected.
- Run a full migration to Azure.

**NOTE**

Tutorials show you the simplest deployment path for a scenario so that you can quickly set up a proof-of-concept. Tutorials use default options where possible, and don't show all possible settings and paths. For detailed instructions, review the How-tos for Azure Migrate.

If you don't have an Azure subscription, create a [free account] before you begin.

**Prerequisites**

Before you begin this tutorial, you should:

Review the migration architecture.

**Prepare Azure**

Prepare Azure for migration with Server Migration.

<table>
<thead>
<tr>
<th>TASK</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an Azure Migrate project</td>
<td>Your Azure account needs Contributor or Owner permissions to create a project.</td>
</tr>
</tbody>
</table>
**Verify permissions for your Azure account**

Your Azure account needs permissions to create a VM, and write to an Azure managed disk.

**Assign permissions to create project**

1. In the Azure portal, open the subscription, and select **Access control (IAM)**.
2. In **Check access**, find the relevant account, and click it to view permissions.
3. You should have **Contributor** or **Owner** permissions.
   - If you just created a free Azure account, you're the owner of your subscription.
   - If you're not the subscription owner, work with the owner to assign the role.

**Assign Azure account permissions**

Assign the Virtual Machine Contributor role to the Azure account. This provides permissions to:

- Create a VM in the selected resource group.
- Create a VM in the selected virtual network.
- Write to an Azure managed disk.

**Create an Azure network**

Set up an Azure virtual network (VNet). When you replicate to Azure, Azure VMs are created and joined to the Azure VNet that you specify when you set up migration.

**Prepare for migration**

To prepare for physical server migration, you need to verify the physical server settings, and prepare to deploy a replication appliance.

**Check machine requirements for migration**

Make sure machines comply with requirements for migration to Azure.

**NOTE**

When migrating physical machines, Azure Migrate:Server Migration uses the same replication architecture as agent-based disaster recovery in the Azure Site Recovery service, and some components share the same code base. Some content might link to Site Recovery documentation.

1. **Verify** physical server requirements.
2. **Verify** that on-premises machines that you replicate to Azure comply with **Azure VM requirements**.

**Prepare a machine for the replication appliance**

Azure Migrate:Server Migration uses a replication appliance to replicate machines to Azure. The replication appliance runs the following components.

- **Configuration server**: The configuration server coordinates communications between on-premises and Azure, and manages data replication.
- **Process server**: The process server acts as a replication gateway. It receives replication data; optimizes it with caching, compression, and encryption, and sends it to a cache storage account in Azure.

Prepare for appliance deployment as follows:

- You prepare a machine to host the replication appliance. **Review** the machine requirements. The appliance shouldn't be installed on a source machine that you want to replicate.
• The replication appliance uses MySQL. Review the options for installing MySQL on the appliance.
• Review the Azure URLs required for the replication appliance to access public and government clouds.
• Review [port] (migrate-replication-appliance.md#port-access) access requirements for the replication appliance.

Add the Server Migration tool

Set up an Azure Migrate project, and then add the Server Migration tool to it.

1. In the Azure portal > All services, search for Azure Migrate.
2. Under Services, select Azure Migrate.
3. In Overview, click Assess and migrate servers.
4. Under Discover, assess and migrate servers, click Assess and migrate servers.

5. In Discover, assess and migrate servers, click Add tools.
6. In Migrate project, select your Azure subscription, and create a resource group if you don’t have one.
7. In Project Details, specify the project name, and geography in which you want to create the project, and click Next. Review supported geographies for public and government clouds.

8. In Select assessment tool, select Skip adding an assessment tool for now > Next.
Set up the replication appliance

The first step of migration is to set up the replication appliance. To set up the appliance for physical server migration, you download the installer file for the appliance, and then run it on the machine you prepared. After installing the appliance, you register it with Azure Migrate Server Migration.

Download the replication appliance installer

1. In the Azure Migrate project > Servers, in Azure Migrate: Server Migration, click Discover.
2. In Discover machines > Are your machines virtualized?, click Not virtualized/Other.

3. In Target region, select the Azure region to which you want to migrate the machines.

4. Select Confirm that the target region for migration is region-name.

5. Click Create resources. This creates an Azure Site Recovery vault in the background.
   - If you’ve already set up migration with Azure Migrate Server Migration, the target option can’t be configured, since resources were set up previously.
   - You can’t change the target region for this project after clicking this button.
   - All subsequent migrations are to this region.

6. In Do you want to install a new replication appliance?, select Install a replication appliance.

7. In Download and install the replication appliance software, download the appliance installer, and the registration key. You need to the key in order to register the appliance. The key is valid for five days after it’s downloaded.

8. Copy the appliance setup file and key file to the Windows Server 2016 machine you created for the appliance.

9. Run the replication appliance setup file, as described in the next procedure. After installation completes, the Appliance configuration wizard will be launched automatically (You can also launch the wizard manually by using the cspsconfigtool shortcut that is created on the desktop of the appliance). Use the Manage Accounts tab of the wizard to add account details to use for push installation of the Mobility service. In this tutorial we’ll be manually installing the Mobility Service on machines to be replicated, so create a dummy account in this step and proceed.

10. After the appliance has restarted after setup, in Discover machines, select the new appliance in Select Configuration Server, and click Finalize registration. Finalize registration performs a couple of final tasks to prepare the replication appliance.
3. Finalize registration

Prepare for replication by finalizing registration for the replication appliance (Configuration Server). Select the replication appliance from the drop down to finalize registration for it.

* Select Configuration Server

WIN-DVHS6VQ7TRQ [✓] Registration finalized

It may take some time after finalizing registration until discovered machines appear in Azure Migrate Server Migration. As VMs are discovered, the Discovered servers count rises.

<table>
<thead>
<tr>
<th>Migration tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Azure Migrate: Server Migration</strong></td>
</tr>
<tr>
<td><img src="image" alt="Discover" /> <img src="image" alt="Replicate" /> <img src="image" alt="Migrate" /> <img src="image" alt="Overview" /></td>
</tr>
<tr>
<td>Discovered servers</td>
</tr>
</tbody>
</table>

Install the Mobility service

On machines you want to migrate, you need to install the Mobility service agent. The agent installers are available on the replication appliance. You find the right installer, and install the agent on each machine you want to migrate. Do this as follows:

1. Sign in to the replication appliance.
2. Navigate to %ProgramData%\ASR\home\svsystems\pushinstallsvc\repository.
3. Find the installer for the machine operating system and version. Review supported operating systems.
4. Copy the installer file to the machine you want to migrate.
5. Make sure that you have the passphrase that was generated when you deployed the appliance.
   - Store the file in a temporary text file on the machine.
   - You can obtain the passphrase on the replication appliance. From the command line, run `C:\ProgramData\ASR\home\svsystems\bin\genpassphrase.exe -v` to view the current passphrase.
   - Don’t regenerate the passphrase. This will break connectivity and you will have to reregister the replication appliance.

**Install on Windows**

1. Extract the contents of installer file to a local folder (for example C:\Temp) on the machine, as follows:

   ```
   ren Microsoft-ASR_UA*Windows*release.exe MobilityServiceInstaller.exe
   MobilityServiceInstaller.exe /q /x:C:\Temp\Extracted
   cd C:\Temp\Extracted
   ```

2. Run the Mobility Service Installer:

   ```
   UnifiedAgent.exe /Role "MS" /Silent
   ```

3. Register the agent with the replication appliance:
**Install on Linux**

1. Extract the contents of the installer tarball to a local folder (for example `/tmp/MobSvcInstaller`) on the machine, as follows:

   ```bash
   mkdir /tmp/MobSvcInstaller
   tar -C /tmp/MobSvcInstaller -xvf <Installer tarball>
   cd /tmp/MobSvcInstaller
   ```

2. Run the installer script:

   ```bash
   sudo ./install -r MS -q
   ```

3. Register the agent with the replication appliance:

   ```bash
   /usr/local/ASR/Vx/bin/UnifiedAgentConfigurator.sh -i <replication appliance IP address> -P <Passphrase File Path>
   ```

**Replicate machines**

Now, select machines for migration.

**NOTE**

You can replicate up to 10 machines together. If you need to replicate more, then replicate them simultaneously in batches of 10.

1. In the Azure Migrate project > **Servers, Azure Migrate: Server Migration**, click **Replicate**.
2. In **Replicate**, > **Source settings** > **Are your machines virtualized?**, select **Not virtualized/Other**.

3. In **On-premises appliance**, select the name of the Azure Migrate appliance that you set up.

4. In **Process Server**, select the name of the replication appliance.

5. In **Guest credentials**, you specify a dummy account that will be used for installing the Mobility service manually (push install is not supported in Physical). Then click **Next: Virtual machines**.
6. In **Virtual Machines**, in **Import migration settings from an assessment?**, leave the default setting **No, I'll specify the migration settings manually**.

7. Check each VM you want to migrate. Then click **Next: Target settings**.

8. In **Target settings**, select the subscription, and target region to which you'll migrate, and specify the resource group in which the Azure VMs will reside after migration.

9. In **Virtual Network**, select the Azure VNet/subnet to which the Azure VMs will be joined after migration.

10. In **Azure Hybrid Benefit**:
    - Select **No** if you don't want to apply Azure Hybrid Benefit. Then click **Next**.
    - Select **Yes** if you have Windows Server machines that are covered with active Software Assurance or
Windows Server subscriptions, and you want to apply the benefit to the machines you’re migrating. Then click **Next**.

11. In **Compute**, review the VM name, size, OS disk type, and availability set. VMs must conform with Azure requirements.

   - **VM size**: By default, Azure Migrate Server Migration picks a size based on the closest match in the Azure subscription. Alternatively, pick a manual size in Azure VM size.
   
   - **OS disk**: Specify the OS (boot) disk for the VM. The OS disk is the disk that has the operating system bootloader and installer.
   
   - **Availability set**: If the VM should be in an Azure availability set after migration, specify the set. The set must be in the target resource group you specify for the migration.

12. In **Disks**, specify whether the VM disks should be replicated to Azure, and select the disk type (standard SSD/HDD or premium managed disks) in Azure. Then click **Next**.

   - You can exclude disks from replication.
   
   - If you exclude disks, won’t be present on the Azure VM after migration.
13. In **Review and start replication**, review the settings, and click **Replicate** to start the initial replication for the servers.

**NOTE**

You can update replication settings any time before replication starts, **Manage > Replicating machines**. Settings can't be changed after replication starts.

**Track and monitor**

- When you click **Replicate** a Start Replication job begins.
- When the Start Replication job finishes successfully, the machines begin their initial replication to Azure.
- After initial replication finishes, delta replication begins. Incremental changes to on-premises disks are periodically replicated to the replica disks in Azure.

You can track job status in the portal notifications.

You can monitor replication status by clicking on **Replicating servers** in **Azure Migrate: Server Migration**.

**Run a test migration**
When delta replication begins, you can run a test migration for the VMs, before running a full migration to Azure. We highly recommend that you do this at least once for each machine, before you migrate it.

- Running a test migration checks that migration will work as expected, without impacting the on-premises machines, which remain operational, and continue replicating.
- Test migration simulates the migration by creating an Azure VM using replicated data (usually migrating to a non-production VNet in your Azure subscription).
- You can use the replicated test Azure VM to validate the migration, perform app testing, and address any issues before full migration.

Do a test migration as follows:

1. In **Migration goals > Servers > Azure Migrate: Server Migration**, click **Test migrated servers**.

   ![Migration tools](image)

   - In **Migration tools**.
   - **Azure Migrate: Server Migration**.
   - Click **Discover**, **Replicate**, **Migrate**, **Overview**.
   - **Discovered servers**: 442
   - **Replicating servers**: 6
   - **Test migrated servers**: 1
   - **Migrated servers**: 1
   - **Next step**: You can start migrating the replicating servers to Azure

2. Right-click the VM to test, and click **Test migrate**.

   ![Test migration](image)

   - **Dashboard > Azure Migrate > Servers > Azure Migrate: Server Migration**.
   - **Replicating machines**.
   - **NAME**: Contoso\WIN2016R2SP1
   - **STATUS**: Delta sync
   - **HEALTH**: Healthy
   - **MIGRATION PHASE**: Test migration pending
   - **LAST SYNC**: 2/17/2019, 12:00:00 AM

3. In **Test Migration**, select the Azure VNet in which the Azure VM will be located after the migration. We recommend you use a non-production VNet.

4. The **Test migration** job starts. Monitor the job in the portal notifications.

5. After the migration finishes, view the migrated Azure VM in **Virtual Machines** in the Azure portal. The machine name has a suffix -**Test**.
6. After the test is done, right-click the Azure VM in **Replicating machines**, and click **Clean up test migration**.

![Image](image.png)

**Migrate VMs**

After you've verified that the test migration works as expected, you can migrate the on-premises machines.

1. In the Azure Migrate project > **Servers** > **Azure Migrate: Server Migration**, click **Replicating servers**.

2. In **Replicating machines**, right-click the VM > **Migrate**.

3. In **Migrate** > **Shut down virtual machines and perform a planned migration with no data loss**, select **Yes > OK**.
   - If you don't want to shut down the VM, select **No**

   Note: For Physical Server Migration, the recommendation is to bring the application down as part of the migration window (don't let the applications accept any connections) and then initiate the migration (The server needs to be kept running, so remaining changes can be synchronized) before the migration is completed.

4. A migration job starts for the VM. Track the job in Azure notifications.
Complete the migration

1. After the migration is done, right-click the VM > Stop migration. This does the following:
   - Stops replication for the on-premises machine.
   - Removes the machine from the Replicating servers count in Azure Migrate: Server Migration.
   - Cleans up replication state information for the machine.
2. Install the Azure VM Windows or Linux agent on the migrated machines.
3. Perform any post-migration app tweaks, such as updating database connection strings, and web server configurations.
4. Perform final application and migration acceptance testing on the migrated application now running in Azure.
5. Cut over traffic to the migrated Azure VM instance.
6. Remove the on-premises VMs from your local VM inventory.
7. Remove the on-premises VMs from local backups.
8. Update any internal documentation to show the new location and IP address of the Azure VMs.

Post-migration best practices

- For increased resilience:
  - Keep data secure by backing up Azure VMs using the Azure Backup service. Learn more.
  - Keep workloads running and continuously available by replicating Azure VMs to a secondary region with Site Recovery. Learn more.
- For increased security:
  - Lock down and limit inbound traffic access with Azure Security Center - Just in time administration.
  - Restrict network traffic to management endpoints with Network Security Groups.
  - Deploy Azure Disk Encryption to help secure disks, and keep data safe from theft and unauthorized access.
  - Read more about securing IaaS resources, and visit the Azure Security Center.
- For monitoring and management:
  - Consider deploying Azure Cost Management to monitor resource usage and spending.

Next steps

Investigate the cloud migration journey in the Azure Cloud Adoption Framework.
This article explains how to assess on-premises servers with the Azure Migrate: Server Assessment tool, by importing server metadata in comma-separated values (CSV) format. This assessment method doesn’t require you to set up the Azure Migrate appliance to create an assessment. It’s useful if:

- You want to create a quick, initial assessment before you deploy the appliance.
- You can’t deploy the Azure Migrate appliance in your organization.
- You can’t share credentials that allow access to on-premises servers.
- Security constraints prevent you from gathering and sending data collected by the appliance to Azure. You can control the data you share in an imported file. Also, much of the data (for example, providing IP addresses) is optional.

**Before you start**

Be aware of these points:

- You can add up to a maximum of 20,000 servers in a single CSV file.
- You can add up to 20,000 servers in an Azure Migrate project by using CSV.
- You can upload server information to Server Assessment multiple times by using CSV.
- Gathering application information is useful in evaluating your on-premises environment for migration. However, Server Assessment doesn’t currently perform application-level assessment or take applications into account when creating an assessment.

In this tutorial, you learn how to:

- Set up an Azure Migrate project.
- Fill in a CSV file with server information.
- Import the file to add server information into Server Assessment.
- Create and review an assessment.

**NOTE**

Tutorials show you the simplest deployment path for a scenario, so that you can quickly set up a proof of concept. Tutorials use default options where possible, and don’t show all possible settings and paths. For detailed instructions, review the How-to guides.

If you don’t have an Azure subscription, create a free account before you begin.

**Set Azure permissions for Azure Migrate**

Your Azure account needs permissions to create an Azure Migrate project.

1. In the Azure portal, open the subscription, and select **Access control (IAM)**.
2. In **Check access**, find the relevant account, and then select it to view permissions.
3. Make sure you have **Contributor** or **Owner** permissions.
   - If you just created a free Azure account, you’re the owner of your subscription.
   - If you’re not the subscription owner, work with the owner to assign the role.
Set up an Azure Migrate project

To set up a new Azure Migrate project:

1. In the Azure portal, in All services, search for Azure Migrate.

2. Under Services, select Azure Migrate.

3. In Overview, under Discover, assess and migrate servers, select Assess and migrate servers.

4. In Getting started, select Add tool(s).

5. In Migrate project, select your Azure subscription, and create a resource group if you don’t have one.

6. In PROJECT DETAILS, specify the project name and the geography in which you want to create the project. For more information:
   - Review the supported geographies for public and government clouds.
   - You can select any target region when you run a migration.

7. Select Next.

8. In Select assessment tool, select Azure Migrate: Server Assessment > Next.
9. In **Select migration tool**, select **Skip adding a migration tool for now** > **Next**.

10. In **Review + add tools**, review the settings, and then select **Add tools**.

11. Wait a few minutes for the Azure Migrate project to deploy. You’ll then be taken to the project page. If you don’t see the project, you can access it from **Servers** in the Azure Migrate dashboard.

**Prepare the CSV**

Download the CSV template and add server information to it.

**Download the template**

1. In **Migration Goals > Servers > Azure Migrate: Server Assessment**, select **Discover**.

2. In **Discover machines**, select **Import using CSV**.

3. Select **Download** to download the CSV template. Alternatively, you can download it directly.
Add server information

Gather server data and add it to the CSV file.

- To gather data, you can export it from tools you use for on-premises server management, such as VMware vSphere or your configuration-management database (CMDB).
- To review sample data, download our example file.

The following table summarizes the file fields to fill in:

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>MANDATORY</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server name</td>
<td>Yes</td>
<td>We recommend specifying the fully qualified domain name (FQDN).</td>
</tr>
<tr>
<td>IP address</td>
<td>No</td>
<td>Server address.</td>
</tr>
<tr>
<td>Cores</td>
<td>Yes</td>
<td>Number of processor cores allocated to the server.</td>
</tr>
<tr>
<td>Memory</td>
<td>Yes</td>
<td>Total RAM, in MB, allocated to the server.</td>
</tr>
<tr>
<td>OS name</td>
<td>Yes</td>
<td>Server operating system. Operating system names that match or contain the names in this list are recognized by the assessment.</td>
</tr>
<tr>
<td>OS version</td>
<td>No</td>
<td>Server operating system version.</td>
</tr>
<tr>
<td>Number of disks</td>
<td>No</td>
<td>Not needed if individual disk details are provided.</td>
</tr>
<tr>
<td>FIELD NAME</td>
<td>MANDATORY</td>
<td>DETAILS</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disk 1 size</td>
<td>No</td>
<td>Maximum size of disk, in GB. You can add details for more disks by adding columns in the template. You can add up to eight disks.</td>
</tr>
<tr>
<td>Disk 1 read ops</td>
<td>No</td>
<td>Disk read operations per second.</td>
</tr>
<tr>
<td>Disk 1 write ops</td>
<td>No</td>
<td>Disk write operations per second.</td>
</tr>
<tr>
<td>Disk 1 read throughput</td>
<td>No</td>
<td>Data read from the disk per second, in MB per second.</td>
</tr>
<tr>
<td>Disk 1 write throughput</td>
<td>No</td>
<td>Data written to disk per second, in MB per second.</td>
</tr>
<tr>
<td>CPU utilization percentage</td>
<td>No</td>
<td>Percentage of CPU used.</td>
</tr>
<tr>
<td>Memory utilization percentage</td>
<td>No</td>
<td>Percentage of RAM used.</td>
</tr>
<tr>
<td>Total disks read ops</td>
<td>No</td>
<td>Disk-read operations per second.</td>
</tr>
<tr>
<td>Total disks write ops</td>
<td>No</td>
<td>Disk-write operations per second.</td>
</tr>
<tr>
<td>Total disks read throughput</td>
<td>No</td>
<td>Data read from the disk, in MB per second.</td>
</tr>
<tr>
<td>Total disks write throughput</td>
<td>No</td>
<td>Data written to disk, in MB per second.</td>
</tr>
<tr>
<td>Network In throughput</td>
<td>No</td>
<td>Data received by the server, in MB per second.</td>
</tr>
<tr>
<td>Network Out throughput</td>
<td>No</td>
<td>Data transmitted by the server, in MB per second.</td>
</tr>
<tr>
<td>Firmware type</td>
<td>No</td>
<td>Server firmware. Values can be &quot;BIOS&quot; or &quot;UEFI&quot;.</td>
</tr>
<tr>
<td>No</td>
<td></td>
<td>Server MAC address.</td>
</tr>
</tbody>
</table>

**Add operating systems**

Assessment recognizes specific operating system names. Any name you specify must exactly match one of the strings in the supported names list.

**Add multiple disks**

The template provides default fields for the first disk. You can add similar columns for up to eight disks.

For example, to specify all fields for a second disk, add these columns:

- Disk 2 size
- Disk 2 read ops
- Disk 2 write ops
- Disk 2 read throughput
Import the server information

After adding information to the CSV template, import the servers into Server Assessment.

1. In Azure Migrate, in Discover machines, go to the completed template.
2. Select Import.
3. The import status is shown.
   - If warnings appear in the status, you can either fix them or continue without addressing them.
   - To improve assessment accuracy, improve the server information as suggested in warnings.
   - To view and fix warnings, select Download warning details .CSV. This operation downloads the CSV with warnings included. Review the warnings and fix issues as needed.
   - If errors appear in the status so that the import status is Failed, you must fix those errors before you can continue with the import:
     a. Download the CSV, which now includes error details.
     b. Review and address the errors as necessary.
     c. Upload the modified file again.
4. When the import status is Completed, the server information has been imported.

Update server information

You can update the information for a server by importing the data for the server again with the same Server name. You can't modify the Server name field. Deleting servers is currently not supported.

Verify servers in the portal

To verify that the servers appear in the Azure portal after discovery:

1. Open the Azure Migrate dashboard.
2. On the Azure Migrate - Servers > Azure Migrate: Server Assessment page, select the icon that displays the count for Discovered servers.
3. Select the Import based tab.

Set up and run an assessment

You can create two types of assessments by using Server Assessment.

<table>
<thead>
<tr>
<th>ASSESSMENT TYPE</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance-based</td>
<td>Assessments based on performance-data values specified.</td>
<td>Recommended VM size: Based on CPU and memory usage data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recommended disk type (standard or premium managed disk): Based on the input/output per second (IOPS) and throughput of the on-premises disks.</td>
</tr>
</tbody>
</table>
As on-premises

Assessments based on on-premises sizing.

Recommended VM size: Based on the server size specified.

Recommended disk type: Based on the storage-type setting you select for the assessment.

To run an assessment:

1. Review the best practices for creating assessments.

2. In the Servers tab, in the Azure Migrate: Server Assessment tile, select Assess.

3. In Assess servers, specify a name for the assessment.

4. In Discovery source, select Machines added via import to Azure Migrate.

5. Select View all to review the assessment properties.
6. In **Select or create a group**, select **Create New**, and specify a group name. A group gathers one or more VMs together for assessment.

7. In **Add machines to the group**, select servers to add to the group.

8. Select **Create assessment** to create the group, and then run the assessment.
9. After the assessment is created, view it in **Servers > Azure Migrate: Server Assessment > Assessments**.

10. Select **Export assessment** to download it as a Microsoft Excel file.

### Review an assessment

An assessment describes:

- **Azure readiness**: Whether servers are suitable for migration to Azure.
- **Monthly cost estimation**: Estimated monthly compute and storage costs for running the servers in Azure.
- **Monthly storage cost estimation**: Estimated costs for disk storage after migration.

### View an assessment

1. In **Migration goals > Servers**, select **Assessments** in **Azure Migrate: Server Assessment**.

2. In **Assessments**, select an assessment to open it.
### Review Azure readiness

1. In **Azure readiness**, determine whether the servers are ready for migration to Azure.

2. Review the status:

   - **Ready for Azure**: Azure Migrate recommends a VM size and cost estimates for VMs in the assessment.
   - **Ready with conditions**: Shows problems and suggested remediation.
   - **Not ready for Azure**: Shows problems and suggested remediation.
   - **Readiness unknown**: Azure Migrate can’t assess readiness, due to data-availability issues.

3. Select an **Azure readiness** status. You can view server-readiness details and drill down to see server details, including compute, storage, and network settings.

### Review cost details

This view shows the estimated compute and storage cost of running VMs in Azure. You can:

- Review the monthly compute and storage costs. Costs are aggregated for all servers in the assessed group.
  - Cost estimates are based on the size recommendations for a machine, and its disks and properties.
  - Estimated monthly costs for compute and storage are shown.
  - The cost estimate is for running the on-premises servers as infrastructure-as-a-service (IaaS) VMs. Server Assessment doesn’t consider platform-as-a-service (PaaS) or software-as-a-service (SaaS) costs.
- Review monthly storage-cost estimates. This view shows aggregated storage costs for the assessed group, split among different types of storage disks.
- Drill down to see details for specific VMs.

### Supported operating system names

Operating system names provided in the CSV must match or contain the names in this list. This is necessary for the names specified to be recognized as valid by the assessment.

- Apple Mac OS X 10
- Asianux 3
Asianux 4
Asianux 5

CentOS
CentOS 4/5

CoreOS Linux

Debian GNU/Linux 4
Debian GNU/Linux 5
Debian GNU/Linux 6
Debian GNU/Linux 7
Debian GNU/Linux 8

FreeBSD

I - R

IBM OS/2

MS-DOS

Novell NetWare 5
Novell NetWare 6

Oracle Linux
Oracle Linux 4/5
Oracle Solaris 10
Oracle Solaris 11

Red Hat Enterprise Linux 2
Red Hat Enterprise Linux 3
Red Hat Enterprise Linux 4
Red Hat Enterprise Linux 5
Red Hat Enterprise Linux 6
Red Hat Enterprise Linux 7
Red Hat Fedora

S - T

SCO OpenServer 5
SCO OpenServer 6
SCO UnixWare 7

Serenity Systems eComStation 1
Serenity Systems eComStation 2

Sun Microsystems Solaris 8
Sun Microsystems Solaris 9

SUSE Linux Enterprise 10
SUSE Linux Enterprise 11
SUSE Linux Enterprise 12
SUSE Linux Enterprise 8/9
SUSE Linux Enterprise 11
SUSE openSUSE

U - Z
Next steps

In this tutorial, you:

- Imported servers into Azure Migrate: Server Assessment by using CSV.
- Created and reviewed an assessment.

Now, deploy an appliance for more accurate assessments, and gather servers together into groups for deeper assessment by using dependency analysis.
You can use the Azure Migrate service to assess and migrate machines to the Microsoft Azure cloud. This article summarizes general support settings and limitations for Azure Migrate scenarios and deployments.

Supported assessment/migration scenarios

The table summarizes supported discovery, assessment, and migration scenarios.

<table>
<thead>
<tr>
<th>DEPLOYMENT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>App-specific discovery</td>
<td>You can discover apps, roles, and features running on VMWare VMs. Currently this feature is limited to discovery only. Assessment is currently at the machine level. We don't yet offer app, role, or feature-specific assessment.</td>
</tr>
<tr>
<td>On-premises assessment</td>
<td>Assess on-premises workloads and data running on VMware VMs, Hyper-V VMs, and physical servers. Assess using Azure Migrate Server Assessment and Microsoft Data Migration Assistant (DMA), as well as other tools and ISV offerings.</td>
</tr>
<tr>
<td>On-premises migration to Azure</td>
<td>Migrate workloads and data running on physical servers, VMware VMs, Hyper-V VMs, physical servers, and cloud-based VMS to Azure. Migrate using Azure Migrate Server Assessment and Azure Database Migration Service (DMS), and well as other tools and ISV offerings.</td>
</tr>
</tbody>
</table>

NOTE
Currently, ISV tools can't send data to Azure Migrate in Azure Government. You can use integrated Microsoft tools, or use partner tools independently.

Supported tools

Specific tool support is summarized in the table.

<table>
<thead>
<tr>
<th>TOOL</th>
<th>ASSESS</th>
<th>MIGRATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Azure Migrate Server Assessment</td>
<td>Assess VMware VMs, Hyper-V VMs, and physical servers.</td>
<td>Not available (NA)</td>
</tr>
<tr>
<td>Azure Migrate Server Migration</td>
<td>NA</td>
<td>Migrate VMware VMs, Hyper-V VMs, and physical servers.</td>
</tr>
<tr>
<td>Carbonite</td>
<td>NA</td>
<td>Migrate VMware VMs, Hyper-V VMs, physical servers, public cloud workloads.</td>
</tr>
<tr>
<td>Cloudamize</td>
<td>Assess VMware VMs, Hyper-V VMs, physical servers, public cloud workloads.</td>
<td>NA</td>
</tr>
<tr>
<td>TOOL</td>
<td>ASSESS</td>
<td>MIGRATE</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Corent Technology</td>
<td>Assess and migrate VMware VMs, Hyper-V VMs, physical servers, public cloud workloads.</td>
<td>Migrate VMware VMs, Hyper-V VMs, physical servers, public cloud workloads.</td>
</tr>
<tr>
<td>Device 42</td>
<td>Assess VMware VMs, Hyper-V VMs, physical servers, public cloud workloads.</td>
<td>NA</td>
</tr>
<tr>
<td>DMA</td>
<td>Assess on-premises SQL Server databases.</td>
<td>NA</td>
</tr>
<tr>
<td>DMS</td>
<td>NA</td>
<td>Migrate SQL Server, Oracle, MySQL, PostgreSQL, MongoDB.</td>
</tr>
<tr>
<td>Lakeside</td>
<td>Assess virtual desktop infrastructure (VDI)</td>
<td>NA</td>
</tr>
<tr>
<td>Movere</td>
<td>Assess VMWare VMs, Hyper-V VMs, Xen VMs, physical machines, workstations (including VDI), public cloud workloads</td>
<td>NA</td>
</tr>
<tr>
<td>RackWare</td>
<td>NA</td>
<td>Migrate VMWare VMs, Hyper-V VMs, Xen VMs, KVM VMs, physical machines, public cloud workloads</td>
</tr>
<tr>
<td>Turbonomic</td>
<td>Assess VMware VMs, Hyper-V VMs, physical servers, public cloud workloads.</td>
<td>NA</td>
</tr>
<tr>
<td>UnifyCloud</td>
<td>Assess VMware VMs, Hyper-V VMs, physical servers, public cloud workloads, and SQL Server databases.</td>
<td>NA</td>
</tr>
<tr>
<td>Webapp Migration Assistant</td>
<td>Assess web apps</td>
<td>Migrate web apps.</td>
</tr>
</tbody>
</table>

**Azure Migrate projects**

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription</td>
<td>You can have multiple Azure Migrate projects in a subscription.</td>
</tr>
<tr>
<td>Azure permissions</td>
<td>You need Contributor or Owner permissions in the subscription to create an Azure Migrate project.</td>
</tr>
<tr>
<td>VMware VMs</td>
<td>Assess up to 35,000 VMware VMs in a single project.</td>
</tr>
<tr>
<td>Hyper-V VMs</td>
<td>Assess up to 35,000 Hyper-V VMs in a single project.</td>
</tr>
</tbody>
</table>

A project can include both VMware VMs and Hyper-V VMs, up to the assessment limits.

**Azure permissions**

For Azure Migrate to work with Azure you need these permissions before you start assessing and migrating machines.
<table>
<thead>
<tr>
<th>TASK</th>
<th>PERMISSIONS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an Azure Migrate project</td>
<td>Your Azure account needs permissions to create a project.</td>
<td>Set up for VMware, Hyper-V, or physical servers.</td>
</tr>
</tbody>
</table>
| Register the Azure Migrate appliance      | Azure Migrate uses a lightweight Azure Migrate appliance to assess machines with Azure Migrate Server Assessment, and to run agentless migration of VMware VMs with Azure Migrate Server Migration. This appliance discovers machines, and sends metadata and performance data to Azure Migrate.  
  During registration, register providers (Microsoft.OffAzure, Microsoft.Migrate, and Microsoft.KeyVault) are registered with the subscription chosen in the appliance, so that the subscription works with the resource provider. To register, you need Contributor or Owner access on the subscription.  
  **VMware** - During onboarding, Azure Migrate creates two Azure Active Directory (Azure AD) apps. The first app communicates between the appliance agents and the Azure Migrate service. The app doesn't have permissions to make Azure resource management calls or have RBAC access for resources. The second app accesses an Azure Key Vault created in the user subscription for agentless VMware migration only. In agentless migration, Azure Migrate creates a Key Vault to manage access keys to the replication storage account in your subscription. It has RBAC access on the Azure Key Vault (in the customer tenant) when discovery is initiated from the appliance.  
  **Hyper-V** - During onboarding, Azure Migrate creates one Azure AD app. The app communicates between the appliance agents and the Azure Migrate service. The app doesn't have permissions to make Azure resource management calls or have RBAC access for resources. | Set up for VMware, Hyper-V, or physical servers. |
| Create a key vault for VMware agentless migration | To migrate VMware VMs with agentless Azure Migrate Server Migration, Azure Migrate creates a Key Vault to manage access keys to the replication storage account in your subscription. To create the vault, you set permissions (Owner, or Contributor and User Access Administrator) on the resource group in which the Azure Migrate project resides.                                                                                       | Set up permissions.          |
Supported geographies (public cloud)

You can create an Azure Migrate project in a number of geographies in the public cloud. Although you can only create projects in these geographies, you can assess or migrate machines for other target locations. The project geography is only used to store the discovered metadata.

<table>
<thead>
<tr>
<th>GEOGRAPHY</th>
<th>METADATA STORAGE LOCATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asia Pacific</td>
<td>East Asia or Southeast Asia</td>
</tr>
<tr>
<td>Australia</td>
<td>Australia East or Australia Southeast</td>
</tr>
<tr>
<td>Brazil</td>
<td>Brazil South</td>
</tr>
<tr>
<td>Canada</td>
<td>Canada Central or Canada East</td>
</tr>
<tr>
<td>Europe</td>
<td>North Europe or West Europe</td>
</tr>
<tr>
<td>France</td>
<td>France Central</td>
</tr>
<tr>
<td>India</td>
<td>Central India or South India</td>
</tr>
<tr>
<td>Japan</td>
<td>Japan East or Japan West</td>
</tr>
<tr>
<td>Korea</td>
<td>Korea Central or Korea South</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>UK South or UK West</td>
</tr>
<tr>
<td>United States</td>
<td>Central US or West US 2</td>
</tr>
</tbody>
</table>

Supported geographies (Azure Government)

<table>
<thead>
<tr>
<th>TASK</th>
<th>GEOGRAPHY</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create project</td>
<td>United States</td>
<td>Metadata is stored in US Gov Arizona, US Gov Virginia</td>
</tr>
</tbody>
</table>

VMware assessment and migration

Review the Azure Migrate Server Assessment and Server Migration support matrix for VMware VMs.

Hyper-V assessment and migration

Review the Azure Migrate Server Assessment and Server Migration support matrix for Hyper-V VMs.
Azure Migrate versions

There are two versions of the Azure Migrate service:

- **Current version**: Using this version you can create new Azure Migrate projects, discover on-premises assesses, and orchestrate assessments and migrations. Learn more.
- **Previous version**: For customer using the previous version of Azure Migrate (only assessment of on-premises VMware VMs was supported), you should now use the current version. In the previous version, you can't create new Azure Migrate projects or perform new discoveries.

Next steps

- **Assess VMware VMs** for migration.
- **Assess Hyper-V VMs** for migration.
This article summarizes prerequisites and support requirements when you assess VMware VMs for migration to Azure, using the Azure Migrate:Server Assessment tool. If you want to migrate VMware VMs to Azure, review the migration support matrix.

To assess VMware VMs, you create an Azure Migrate project, and then add the Server Assessment tool to the project. After the tool is added, you deploy the Azure Migrate appliance. The appliance continuously discovers on-premises machines, and sends machine metadata and performance data to Azure. After discovery is complete, you gather discovered machines into groups, and run an assessment for a group.

### Limitations

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project limits</strong></td>
<td>You can create multiple projects in an Azure subscription.</td>
</tr>
<tr>
<td></td>
<td>You can discover and assess up to 35,000 VMware VMs in a single project. A project can also include physical servers, and Hyper-V VMs, up to the assessment limits for each.</td>
</tr>
<tr>
<td><strong>Discovery</strong></td>
<td>The Azure Migrate appliance can discover up to 10,000 VMware VMs on a vCenter Server.</td>
</tr>
<tr>
<td><strong>Assessment</strong></td>
<td>You can add up to 35,000 machines in a single group.</td>
</tr>
<tr>
<td></td>
<td>You can assess up to 35,000 VMs in a single assessment.</td>
</tr>
</tbody>
</table>

Learn more about assessments.

### Application discovery

In addition to discovering machines, Server Assessment can discover apps, role, and features running on machines. Discovering your app inventory allows you to identify and plan a migration path tailored for your on-premises workloads.

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supported machines</strong></td>
<td>App discovery is currently supported for VMware VMs only.</td>
</tr>
<tr>
<td><strong>Discovery</strong></td>
<td>App discovery is agentless. It uses machine guest credentials, and remotely accesses machines using WMI and SSH calls.</td>
</tr>
<tr>
<td><strong>VM support</strong></td>
<td>App-discovery is supported for all Windows and Linux versions.</td>
</tr>
<tr>
<td><strong>vCenter credentials</strong></td>
<td>App discovery needs a vCenter Server account with read-only access, and privileges enabled for Virtual Machines &gt; Guest Operations.</td>
</tr>
</tbody>
</table>
VM credentials

App discovery currently supports the use of one credential for all Windows servers, and one credential for all Linux servers.

You create a guest user account for Windows VMs, and a regular/normal user account (non-sudo access) for all Linux VMs.

VMware tools

VMware tools must be installed and running on VMs you want to discover.

The VMware tools version must be later than 10.2.0.

PowerShell

VMs must have PowerShell version 2.0 or later installed.

Port access

On ESXi hosts running VMs you want to discover, the Azure Migrate appliance must be able to connect to TCP port 443.

Limits

For app-discovery, you can discover up to 10000 VMs on each Azure Migrate appliance.

### VMware requirements

<table>
<thead>
<tr>
<th>VMware</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware VMs</td>
<td>Assessment is supported for all Windows and Linux operating systems.</td>
</tr>
<tr>
<td>vCenter Server</td>
<td>Machines you want to discovery and assess must be managed by vCenter Server version 5.5, 6.0, 6.5, or 6.7.</td>
</tr>
<tr>
<td>Permissions (assessment)</td>
<td>vCenter Server read-only account.</td>
</tr>
<tr>
<td>Permissions (app-discovery)</td>
<td>vCenter Server account with read-only access, and privileges enabled for Virtual machines &gt; Guest Operations.</td>
</tr>
<tr>
<td>Permissions (dependency visualization)</td>
<td>Center Server account with read-only access, and privileges enabled for Virtual machines &gt; Guest Operations.</td>
</tr>
</tbody>
</table>

### Azure Migrate appliance requirements

Azure Migrate uses the Azure Migrate appliance for discovery and assessment. You can deploy the appliance as a VMware VM using an OVA template, imported into vCenter Server, or using a PowerShell script.

- Learn about appliance requirements for VMware.
- Learn about URLs that the appliance needs to access in public and government clouds.
- In Azure Government, you must deploy the appliance using the script.

### Port access

<table>
<thead>
<tr>
<th>Device</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEVICE</td>
<td>CONNECTION</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
</tr>
</tbody>
</table>
| Appliance | Inbound connections on TCP port 3389 to allow remote desktop connections to the appliance.  
Inbound connections on port 44368 to remotely access the appliance management app using the URL: https://<appliance-ip-or-name>:44368  
Outbound connections on port 443 (HTTPS), to send discovery and performance metadata to Azure Migrate. |
| vCenter server | Inbound connections on TCP port 443 to allow the appliance to collect configuration and performance metadata for assessments.  
The appliance connects to vCenter on port 443 by default. If the vCenter server listens on a different port, you can modify the port when you set up discovery. |
| ESXi hosts (app discovery/agentless dependency analysis) | If you want to do app discovery or agentless dependency analysis, then the appliance connects to ESXi hosts on TCP port 443, to discover applications, to and run agentless dependency visualization on VMs. |

**Agentless dependency analysis requirements**

Dependency analysis helps you to identify dependencies between on-premises machines that you want to assess and migrate to Azure. The table summarizes the requirements for setting up agentless dependency analysis.

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
</table>
| Before deployment | You should have an Azure Migrate project in place, with the Server Assessment tool added to the project.  
You deploy dependency visualization after setting up an Azure Migrate appliance to discover your on-premises VMware machines.  
Learn how to create a project for the first time.  
Learn how to add an assessment tool to an existing project.  
Learn how to set up the Azure Migrate appliance for assessment of VMware VMs. |
| VM support | Currently supported for VMware VMs only. |
| Windows VMs | Windows Server 2016  
Windows Server 2012 R2  
Windows Server 2012  
Windows Server 2008 R2 (64-bit). |
<p>| Windows account | For dependency analysis, the Azure Migrate appliance needs a local or a domain Administrator account to access Windows VMs. |</p>
<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
</table>
| Linux VMs           | Red Hat Enterprise Linux 7, 6, 5  
                      | Ubuntu Linux 14.04, 16.04  
                      | Debian 7, 8  
                      | Oracle Linux 6, 7  
                      | CentOS 5, 6, 7     |
| Linux account       | For dependency analysis, on Linux machines the Azure Migrate appliance needs a user account with Root privilege.  
                      | Alternately, the user account needs these permissions on /bin/netstat and /bin/ls files: CAP_DAC_READ_SEARCH and CAP_SYS_PTRACE. |
| Required agents     | No agent required on machines you want to analyze.                                                                                       |
| VMware Tools        | VMware Tools (later than 10.2) must be installed and running on each VM you want to analyze.                                              |
| vCenter Server credentials | Dependency visualization needs a vCenter Server account with read-only access, and privileges enabled for Virtual Machines > Guest Operations. |
| PowerShell          | VMs must have PowerShell version 2.0 or above installed.                                                                                  |
| Port access         | On ESXi hosts running VMs you want to analyze, the Azure Migrate appliance must be able to connect to TCP port 443.                      |

**Agent-based dependency analysis requirements**

*Dependency analysis* helps you to identify dependencies between on-premises machines that you want to assess and migrate to Azure. The table summarizes the requirements for setting up agent-based dependency analysis.

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
</table>
| Before deployment   | You should have an Azure Migrate project in place, with the Azure Migrate: Server Assessment tool added to the project.  
                      | You deploy dependency visualization after setting up an Azure Migrate appliance to discover your on-premises machines  
                      | **Learn how** to create a project for the first time.  
                      | **Learn how** to add an assessment tool to an existing project.  
<pre><code>                  | Learn how to set up the Azure Migrate appliance for assessment of Hyper-V, VMware, or physical servers. |
</code></pre>
<p>| Azure Government    | Dependency visualization isn't available in Azure Government.                                                                                   |</p>
<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
</table>
You associate a new or existing Log Analytics workspace with an Azure Migrate project. The workspace for an Azure Migrate project can't be modified after it's added.  
The workspace must be in the same subscription as the Azure Migrate project.  
The workspace must reside in the East US, Southeast Asia, or West Europe regions. Workspaces in other regions can't be associated with a project.  
The workspace must be in a region in which [Service Map is supported](https://docs.microsoft.com/en-us/azure/migrate/service-map).  
In Log Analytics, the workspace associated with Azure Migrate is tagged with the Migration Project key, and the project name. |
| Required agents     | On each machine you want to analyze, install the following agents:  
The [Dependency agent](https://docs.microsoft.com/en-us/azure/monitoring-logs).  
If on-premises machines aren't connected to the internet, you need to download and install Log Analytics gateway on them.  
Learn more about installing the [Dependency agent](https://docs.microsoft.com/en-us/azure/monitoring-logs) and [MMA](https://docs.microsoft.com/en-us/azure/monitoring-logs). |
| Log Analytics workspace | The workspace must be in the same subscription as the Azure Migrate project.  
Azure Migrate supports workspaces residing in the East US, Southeast Asia, and West Europe regions.  
The workspace must be in a region in which [Service Map is supported](https://docs.microsoft.com/en-us/azure/migrate/service-map).  
The workspace for an Azure Migrate project can't be modified after it's added. |
<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Costs</td>
<td>The Service Map solution doesn't incur any charges for the first 180 days (from the day that you associate the Log Analytics workspace with the Azure Migrate project)/</td>
</tr>
<tr>
<td></td>
<td>After 180 days, standard Log Analytics charges will apply.</td>
</tr>
<tr>
<td></td>
<td>Using any solution other than Service Map in the associated Log Analytics workspace will incur standard charges for Log Analytics.</td>
</tr>
<tr>
<td></td>
<td>When the Azure Migrate project is deleted, the workspace is not deleted along with it. After deleting the project, Service Map usage isn't free, and each node will be charged as per the paid tier of Log Analytics workspace/</td>
</tr>
<tr>
<td></td>
<td>If you have projects that you created before Azure Migrate general availability (GA - 28 February 2018), you might have incurred additional Service Map charges. To ensure payment after 180 days only, we recommend that you create a new project, since existing workspaces before GA are still chargeable.</td>
</tr>
<tr>
<td>Management</td>
<td>When you register agents to the workspace, you use the ID and key provided by the Azure Migrate project.</td>
</tr>
<tr>
<td></td>
<td>You can use the Log Analytics workspace outside Azure Migrate.</td>
</tr>
<tr>
<td></td>
<td>If you delete the associated Azure Migrate project, the workspace isn't deleted automatically. Delete it manually.</td>
</tr>
<tr>
<td></td>
<td>Don't delete the workspace created by Azure Migrate, unless you delete the Azure Migrate project. If you do, the dependency visualization functionality will not work as expected.</td>
</tr>
<tr>
<td>Internet connectivity</td>
<td>If machines aren't connected to the internet, you need to install the Log Analytics gateway on them.</td>
</tr>
<tr>
<td>Azure Government</td>
<td>Agent-based dependency analysis isn't supported.</td>
</tr>
</tbody>
</table>

**Next steps**

- Review best practices for creating assessments.
- Prepare for VMware assessment.
This article summarizes support settings and limitations for migrating VMware VMs with Azure Migrate: Server Migration. If you're looking for information about assessing VMware VMs for migration to Azure, review the assessment support matrix.

**Migration options**

You can migrate VMware VMs in a couple of ways:

- With agentless migration: Migrate VMs without needing to install anything on them. You deploy the Azure Migrate appliance for agentless migration.
- With agent-based migration: Install an agent on the VM for replication. For agent-based migration, you need to deploy a replication appliance.

Review this article to figure out which method you want to use.

**Migration limitations**

- You can select up to 10 VMs at once for replication. If you want to migrate more machines, then replicate in groups of 10.
- For VMware agentless migration, you can run up to 100 replications simultaneously.

**Agentless-VMware servers**

<table>
<thead>
<tr>
<th>VMware</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware vCenter Server</td>
<td>Version 5.5, 6.0, 6.5, or 6.7.</td>
</tr>
<tr>
<td>VMware vSphere ESXI host</td>
<td>Version 5.5, 6.0, 6.5, or 6.7.</td>
</tr>
</tbody>
</table>
### vCenter Server permissions

Agentless migration uses the Migrate Appliance. The appliance needs these permissions:

- **Datastore.Browse**: Allow browsing of VM log files to troubleshoot snapshot creation and deletion.

- **Datastore.LowLevelFileOperations**: Allow read/write/delete/rename operations in the datastore browser, to troubleshoot snapshot creation and deletion.

- **VirtualMachine.Configuration.DiskChangeTracking**: Allow enable or disable change tracking of VM disks, to pull changed blocks of data between snapshots.

- **VirtualMachine.Configuration.DiskLease**: Allow disk lease operations for a VM, to read the disk using the VMware vSphere Virtual Disk Development Kit (VDDK).

- **VirtualMachine.Provisioning.AllowDiskAccess**: (specifically for vSphere 6.0 and above) Allow opening a disk on a VM for random read access on the disk using the VDDK.

- **VirtualMachine.Provisioning.AllowReadOnlyDiskAccess**: Allow opening a disk on a VM, to read the disk using the VDDK.

- **VirtualMachine.Provisioning.AllowDiskRandomAccess**: Allow opening a disk on a VM, to read the disk using the VDDK.

- **VirtualMachine.Provisioning.AllowVirtualMachineDownload**: Allows read operations on files associated with a VM, to download the logs and troubleshoot if failure occurs.

- **VirtualMachine.SnapshotManagement.**: Allow creation and management of VM snapshots for replication.

- **Virtual Machine.Interaction.Power Off**: Allow the VM to be powered off during migration to Azure.

### Agentless-VMware VMs

<table>
<thead>
<tr>
<th>Supported operating systems</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows and Linux</strong> operating systems that are supported by Azure can be migrated using agentless migration.</td>
<td></td>
</tr>
</tbody>
</table>
## Required changes for Azure

Some VMs might require changes so that they can run in Azure. Azure Migrate makes these changes automatically for the following operating systems:
- Red Hat Enterprise Linux 6.5+, 7.0+
- CentOS 6.5+, 7.0+
- SUSE Linux Enterprise Server 12 SP1+
- Ubuntu 14.04LTS, 16.04LTS, 18.04LTS
- Debian 7, 8

For other operating systems, you need to make adjustments manually before migration. The relevant articles contain instructions about how to do this.

### Linux boot

If `/boot` is on a dedicated partition, it should reside on the OS disk, and not be spread across multiple disks. If `/boot` is part of the root `/` partition, then the `/` partition should be on the OS disk, and not span other disks.

### UEFI boot

VMs with UEFI boot aren't supported for migration.

### Disk size

2 TB OS disk; 8 TB for data disks.

### Disk limits

Up to 60 disks per VM.

### Encrypted disks/volumes

VMs with encrypted disks/volumes aren't supported for migration.

### Shared disk cluster

Not supported.

### Independent disks

Not supported.

### RDM/passthrough disks

If VMs have RDM or passthrough disks, these disks won't be replicated to Azure.

### NFS

NFS volumes mounted as volumes on the VMs won't be replicated.

### iSCSI targets

VMs with iSCSI targets aren't supported for agentless migration.

### Multipath IO

Not supported.

### Storage vMotion

Not supported. Replication won't work if a VM uses storage vMotion.

### Teamed NICs

Not supported.

### IPv6

Not supported.

### Target disk

VMs can only be migrated to managed disks (standard HDD, premium SSD) in Azure.

### Simultaneous replication

100 VMs per vCenter Server. If you have more, migrate them in batches of 100.
Agentless-Azure Migrate appliance

Agentless migration uses the Azure Migrate appliance. You can deploy the appliance as a VMWare VM using an OVA template, imported into vCenter Server, or using a PowerShell script.

- Learn about appliance requirements for VMware.
- Learn about URLs that the appliance needs to access in public and government clouds.
- In Azure Government, you must deploy the appliance using the script.

Agentless-ports

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>CONNECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliance</td>
<td>Outbound connections on port 443 to upload replicated data to Azure, and to communicate with Azure Migrate services orchestrating replication and migration.</td>
</tr>
<tr>
<td>vCenter server</td>
<td>Inbound connections on port 443 to allow the appliance to orchestrate replication - create snapshots, copy data, release snapshots</td>
</tr>
<tr>
<td>vSphere/ESX Host</td>
<td>Inbound on TCP port 902 for the appliance to replicate data from snapshots.</td>
</tr>
</tbody>
</table>

Agent-based-VMware servers

This table summarizes assessment support and limitations for VMware virtualization servers.

<table>
<thead>
<tr>
<th>VMWARE REQUIREMENTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware vCenter Server</td>
<td>Version 5.5, 6.0, 6.5, or 6.7.</td>
</tr>
<tr>
<td>VMware vSphere ESX Host</td>
<td>Version 5.5, 6.0, 6.5, or 6.7.</td>
</tr>
<tr>
<td>vCenter Server permissions</td>
<td>A read-only account for vCenter Server.</td>
</tr>
</tbody>
</table>

Agent-based-VMware VMs

The table summarizes VMware VM support for VMware VMs you want to migrate using agent-based migration.

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine workload</td>
<td>Azure Migrate supports migration of any workload (say Active Directory, SQL server, etc.) running on a supported machine.</td>
</tr>
<tr>
<td>Operating systems</td>
<td>For the latest information, review the operating system support for Site Recovery. Azure Migrate provides identical VM operating system support.</td>
</tr>
<tr>
<td>Linux file system/guest storage</td>
<td>For the latest information, review the Linux file system support for Site Recovery. Azure Migrate has identical Linux file system support.</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>DETAILS</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Network/Storage</td>
<td>For the latest information, review the network and storage prerequisites for Site Recovery. Azure Migrate provides identical network/storage requirements.</td>
</tr>
<tr>
<td>Azure requirements</td>
<td>For the latest information, review the Azure network, storage, and compute requirements for Site Recovery. Azure Migrate has identical requirements for VMware migration.</td>
</tr>
<tr>
<td>Mobility service</td>
<td>The Mobility service agent must be installed on each VM you want to migrate.</td>
</tr>
<tr>
<td>UEFI boot</td>
<td>The migrated VM in Azure will be automatically converted to a BIOS boot VM. The OS disk should have up to four partitions, and volumes should be formatted with NTFS.</td>
</tr>
<tr>
<td>Target disk</td>
<td>VMs can only be migrated to managed disks (standard HDD, premium SSD) in Azure.</td>
</tr>
<tr>
<td>Disk size</td>
<td>2 TB OS disk; 8 TB for data disks.</td>
</tr>
<tr>
<td>Disk limits</td>
<td>Up to 63 disks per VM.</td>
</tr>
<tr>
<td>Encrypted disks/volumes</td>
<td>VMs with encrypted disks/volumes aren't supported for migration.</td>
</tr>
<tr>
<td>Shared disk cluster</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Independent disks</td>
<td>Supported.</td>
</tr>
<tr>
<td>Passthrough disks</td>
<td>Supported.</td>
</tr>
<tr>
<td>NFS</td>
<td>NFS volumes mounted as volumes on the VMs won't be replicated.</td>
</tr>
<tr>
<td>iSCSI targets</td>
<td>VMs with iSCSI targets aren't supported for agentless migration.</td>
</tr>
<tr>
<td>Multipath IO</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>Supported.</td>
</tr>
<tr>
<td>Teamed NICs</td>
<td>Not supported.</td>
</tr>
<tr>
<td>IPv6</td>
<td>Not supported.</td>
</tr>
</tbody>
</table>

**Agent-based-replication appliance**

When you set up the replication appliance using the OVA template provided in the Azure Migrate hub, the appliance runs Windows Server 2016 and complies with the support requirements. If you set up the replication appliance manually on a physical server, then make sure that it complies with the requirements.
Learn about replication appliance requirements for VMware.
MySQL must be installed on the appliance. Learn about installation options.
Learn about URLs that the replication appliance needs to access in public and government clouds.
Review the ports the replication appliance needs to access.

### Agent-based-ports

<table>
<thead>
<tr>
<th>Device</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMs</td>
<td>The Mobility service running on VMs communicates with the on-premises replication appliance (configuration server) on port HTTPS 443 inbound, for replication management. VMs send replication data to the process server (running on the configuration server machine) on port HTTPS 9443 inbound. This port can be modified.</td>
</tr>
<tr>
<td>Replication appliance</td>
<td>The replication appliance orchestrates replication with Azure over port HTTPS 443 outbound.</td>
</tr>
<tr>
<td>Process server</td>
<td>The process server receives replication data, optimizes, and encrypts it, and sends it to Azure storage over port 443 outbound. By default the process server runs on the replication appliance.</td>
</tr>
</tbody>
</table>

### Azure VM requirements

All on-premises VMs replicated to Azure must meet the Azure VM requirements summarized in this table. When Site Recovery runs a prerequisites check for replication, the check will fail if some of the requirements aren’t met.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest operating system</td>
<td>Verifies supported VMware VM operating systems for migration. You can migrate any workload running on a supported operating system.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Guest operating system architecture</td>
<td>64-bit.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Operating system disk size</td>
<td>Up to 2,048 GB.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Operating system disk count</td>
<td>1</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Data disk count</td>
<td>64 or less.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Data disk size</td>
<td>Up to 4,095 GB</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Network adapters</td>
<td>Multiple adapters are supported.</td>
<td></td>
</tr>
<tr>
<td>Shared VHD</td>
<td>Not supported.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>FC disk</td>
<td>Not supported.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>COMPONENT</td>
<td>REQUIREMENTS</td>
<td>DETAILS</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BitLocker</td>
<td>Not supported.</td>
<td>BitLocker must be disabled before you enable replication for a machine.</td>
</tr>
<tr>
<td>VM name</td>
<td>From 1 to 63 characters. Restricted to letters, numbers, and hyphens.</td>
<td>Update the value in the machine properties in Site Recovery.</td>
</tr>
<tr>
<td></td>
<td>The machine name must start and end with a letter or number.</td>
<td></td>
</tr>
<tr>
<td>Connect after migration-Windows</td>
<td>To connect to Azure VMs running Windows after migration:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Before migration enables RDP on the on-premises VM. Make sure that TCP,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and UDP rules are added for the Public profile, and that RDP is allowed in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Firewall &gt; Allowed Apps, for all profiles.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For site-to-site VPN access, enable RDP and allow RDP in Windows Firewall &gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Allowed apps and features for Domain and Private networks. In addition,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>check that the operating system's SAN policy is set to OnlineAll.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Learn more.</td>
<td></td>
</tr>
<tr>
<td>Connect after migration-Linux</td>
<td>To connect to Azure VMs after migration using SSH:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Before migration, on the on-premises machine, check that the Secure Shell</td>
<td></td>
</tr>
<tr>
<td></td>
<td>service is set to Start, and that firewall rules allow an SSH connection.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>After failover, on the Azure VM, allow incoming connections to the SSH port</td>
<td></td>
</tr>
<tr>
<td></td>
<td>for the network security group rules on the failed over VM, and for the Azure</td>
<td></td>
</tr>
<tr>
<td></td>
<td>subnet to which it’s connected. In addition, add a public IP address for the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VM.</td>
<td></td>
</tr>
</tbody>
</table>

**Next steps**

Select a VMware migration option.
This article summarizes prerequisites and support requirements when you assess Hyper-V VMs for migration to Azure, using the Azure Migrate:Server Assessment tool. If you want to migrate Hyper-V VMs to Azure, review the migration support matrix.

To set up Hyper-V VM assessment, you create an Azure Migrate project, and add the Server Assessment tool to the project. After the tool is added, you deploy the Azure Migrate appliance. The appliance continuously discovers on-premises machines, and sends machine metadata and performance data to Azure. After discovery is complete, you gather discovered machines into groups, and run an assessment for a group.

## Limitations

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assessment limits</strong></td>
<td>You can discover and assess up to 35,000 Hyper-V VMs in a single Azure Migrate project.</td>
</tr>
<tr>
<td><strong>Project limits</strong></td>
<td>You can create multiple projects in an Azure subscription. In addition to Hyper-V VMs, a project can include VMware VMs and physical servers, up to the assessment limits for each.</td>
</tr>
<tr>
<td><strong>Discovery</strong></td>
<td>The Azure Migrate appliance can discover up to 5000 Hyper-V VMs. The appliance can connect to up to 300 Hyper-V hosts.</td>
</tr>
<tr>
<td><strong>Assessment</strong></td>
<td>You can add up to 35,000 machines in a single group. You can assess up to 35,000 VMs in a single assessment for a group.</td>
</tr>
</tbody>
</table>

Learn more about assessments.

## Hyper-V host requirements

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hyper-V host</strong></td>
<td>The Hyper-V host can be standalone, or deployed in a cluster. The Hyper-V host can run Windows Server 2019, Windows Server 2016, or Windows Server 2012 R2. You can't assess VMs located on Hyper-V hosts running Windows Server 2012.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td>You need Administrator permissions on the Hyper-V host. If you don't want to assign Administrator permissions, create a local or domain user account, and add the user account to these groups- Remote Management Users, Hyper-V Administrators, and Performance Monitor Users.</td>
</tr>
</tbody>
</table>
PowerShell remoting must be enabled on each Hyper-V host.

If you use Hyper-V Replica (or you have multiple VMs with the same VM identifiers), and you discover both the original and replicated VMs using Azure Migrate, the assessment generated by Azure Migrate might not be accurate.

Hyper-V VM requirements

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>All Windows and Linux operating systems.</td>
</tr>
<tr>
<td>Integration Services</td>
<td>Hyper-V Integration Services must be running on VMs that you assess, in order to capture operating system information.</td>
</tr>
</tbody>
</table>

Azure Migrate appliance requirements

Azure Migrate uses the Azure Migrate appliance for discovery and assessment. You can deploy the appliance using a compressed Hyper-V VHD that you download from the portal, or using a PowerShell script.

- Learn about appliance requirements for Hyper-V.
- Learn about URLs that the appliance needs to access in public and government clouds.
- In Azure Government, you must deploy the appliance using the script.

Port access

The following table summarizes port requirements for assessment.

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>CONNECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliance</td>
<td>Inbound connections on TCP port 3389 to allow remote desktop connections to the appliance.</td>
</tr>
<tr>
<td></td>
<td>Inbound connections on port 44368 to remotely access the appliance management app using the URL: https://&lt;appliance-ip-or-name&gt;:44368</td>
</tr>
<tr>
<td></td>
<td>Outbound connections on ports 443 (HTTPS), to send discovery and performance metadata to Azure Migrate.</td>
</tr>
<tr>
<td>Hyper-V host/cluster</td>
<td>Inbound connections on WinRM ports 5985 (HTTP) and 5986 (HTTPS), to pull metadata and performance data for Hyper-V VMs using a Common Information Model (CIM) session.</td>
</tr>
</tbody>
</table>

Agent-based dependency analysis requirements

Dependency analysis helps you to identify dependencies between on-premises machines that you want to assess and migrate to Azure. The table summarizes the requirements for setting up agent-based dependency analysis. Hyper-V currently only supports agent-based dependency visualization.
<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before deployment</td>
<td>You should have an Azure Migrate project in place, with the Server Assessment tool added to the project.</td>
</tr>
<tr>
<td></td>
<td>You deploy dependency visualization after setting up an Azure Migrate appliance to discover your on-premises machines.</td>
</tr>
<tr>
<td></td>
<td>Learn how to create a project for the first time.</td>
</tr>
<tr>
<td></td>
<td>Learn how to add an assessment tool to an existing project.</td>
</tr>
<tr>
<td></td>
<td>Learn how to set up the Azure Migrate appliance for assessment of Hyper-V VMs.</td>
</tr>
<tr>
<td>Azure Government</td>
<td>Dependency visualization isn't available in Azure Government.</td>
</tr>
<tr>
<td>Log Analytics</td>
<td>Azure Migrate uses the Service Map solution in Azure Monitor logs for dependency visualization.</td>
</tr>
<tr>
<td></td>
<td>You associate a new or existing Log Analytics workspace with an Azure Migrate project. The workspace for an Azure Migrate project can't be modified after it's added.</td>
</tr>
<tr>
<td></td>
<td>The workspace must be in the same subscription as the Azure Migrate project.</td>
</tr>
<tr>
<td></td>
<td>The workspace must reside in the East US, Southeast Asia, or West Europe regions. Workspaces in other regions can't be associated with a project.</td>
</tr>
<tr>
<td></td>
<td>The workspace must be in a region in which Service Map is supported.</td>
</tr>
<tr>
<td></td>
<td>In Log Analytics, the workspace associated with Azure Migrate is tagged with the Migration Project key, and the project name.</td>
</tr>
<tr>
<td>Required agents</td>
<td>On each machine you want to analyze, install the following agents:</td>
</tr>
<tr>
<td></td>
<td>The Microsoft Monitoring agent (MMA).</td>
</tr>
<tr>
<td></td>
<td>The Dependency agent.</td>
</tr>
<tr>
<td></td>
<td>If on-premises machines aren't connected to the internet, you need to download and install Log Analytics gateway on them.</td>
</tr>
<tr>
<td></td>
<td>Learn more about installing the Dependency agent and MMA.</td>
</tr>
<tr>
<td>Log Analytics workspace</td>
<td>The workspace must be in the same subscription as the Azure Migrate project.</td>
</tr>
<tr>
<td></td>
<td>Azure Migrate supports workspaces residing in the East US, Southeast Asia, and West Europe regions.</td>
</tr>
<tr>
<td></td>
<td>The workspace must be in a region in which Service Map is supported.</td>
</tr>
<tr>
<td></td>
<td>The workspace for an Azure Migrate project can't be modified after it's added.</td>
</tr>
</tbody>
</table>
**Costs**

The Service Map solution doesn't incur any charges for the first 180 days (from the day that you associate the Log Analytics workspace with the Azure Migrate project).

After 180 days, standard Log Analytics charges will apply.

Using any solution other than Service Map in the associated Log Analytics workspace will incur standard charges for Log Analytics.

When the Azure Migrate project is deleted, the workspace is not deleted along with it. After deleting the project, Service Map usage isn't free, and each node will be charged as per the paid tier of Log Analytics workspace.

If you have projects that you created before Azure Migrate general availability (GA - 28 February 2018), you might have incurred additional Service Map charges. To ensure payment after 180 days only, we recommend that you create a new project, since existing workspaces before GA are still chargeable.

**Management**

When you register agents to the workspace, you use the ID and key provided by the Azure Migrate project.

You can use the Log Analytics workspace outside Azure Migrate.

If you delete the associated Azure Migrate project, the workspace isn't deleted automatically. **Delete it manually.**

Don't delete the workspace created by Azure Migrate, unless you delete the Azure Migrate project. If you do, the dependency visualization functionality will not work as expected.

**Internet connectivity**

If machines aren't connected to the internet, you need to install the Log Analytics gateway on them.

**Azure Government**

Agent-based dependency analysis isn't supported.

**Next steps**

Prepare for Hyper-V VM assessment
This article summarizes support settings and limitations for migrating Hyper-V VMs with Azure Migrate: Server Migration. If you’re looking for information about assessing Hyper-V VMs for migration to Azure, review the assessment support matrix.

Migration limitations

You can select up to 10 VMs at once for replication. If you want to migrate more machines, replicate in groups of 10.

Hyper-V hosts

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deployment</td>
<td>The Hyper-V host can be standalone or deployed in a cluster. Azure Migrate replication software (Hyper-V Replication provider) is installed on the Hyper-V hosts.</td>
</tr>
<tr>
<td>Permissions</td>
<td>You need administrator permissions on the Hyper-V host.</td>
</tr>
<tr>
<td>Port access</td>
<td>Outbound connections on HTTPS port 443 to send VM replication data.</td>
</tr>
</tbody>
</table>

URL access (public cloud)

The replication provider software on the Hyper-V hosts will need access to these URLs.

<table>
<thead>
<tr>
<th>URL</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>backup.windowsazure.com</td>
<td>Replication data transfer and coordination.</td>
</tr>
<tr>
<td>*.hypervrecoverymanager.windowsazure.com</td>
<td>Used for migration.ótclas</td>
</tr>
<tr>
<td>*.blob.core.windows.net</td>
<td>Upload data to storage accounts.</td>
</tr>
<tr>
<td>dc.services.visualstudio.com</td>
<td>Upload app logs used for internal monitoring.</td>
</tr>
<tr>
<td>time.windows.com</td>
<td>Verifies time synchronization between system and global time.</td>
</tr>
</tbody>
</table>

URL access (Azure Government)

The replication provider software on the Hyper-V hosts will need access to these URLs.
<table>
<thead>
<tr>
<th>URL</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>login.microsoftonline.us</td>
<td>Access control and identity management using Active Directory.</td>
</tr>
<tr>
<td>backup.windowsazure.us</td>
<td>Replication data transfer and coordination.</td>
</tr>
<tr>
<td>*.hypervrecoverymanager.windowsazure.us</td>
<td>Used for migration.</td>
</tr>
<tr>
<td>*.blob.core.usgovcloudapi.net</td>
<td>Upload data to storage accounts.</td>
</tr>
<tr>
<td>dc.services.visualstudio.com</td>
<td>Upload app logs used for internal monitoring.</td>
</tr>
<tr>
<td>time.nist.gov</td>
<td>Verifies time synchronization between system and global time.</td>
</tr>
</tbody>
</table>

**Hyper-V VMs**

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system</strong></td>
<td>All Windows and Linux operating systems that are supported by Azure.</td>
</tr>
<tr>
<td><strong>Required changes for Azure</strong></td>
<td>Some VMs might require changes so that they can run in Azure. Make adjustments manually before migration. The relevant articles contain instructions about how to do this.</td>
</tr>
<tr>
<td><strong>Linux boot</strong></td>
<td>If /boot is on a dedicated partition, it should reside on the OS disk, and not be spread across multiple disks. If /boot is part of the root (/) partition, then the '/' partition should be on the OS disk, and not span other disks.</td>
</tr>
<tr>
<td><strong>UEFI boot</strong></td>
<td>The migrated VM in Azure will be automatically converted to a BIOS boot VM. The VM should be running Windows Server 2012 and later only. The OS disk should have up to five partitions or fewer and the size of OS disk should be less than 300 GB.</td>
</tr>
<tr>
<td><strong>Disk size</strong></td>
<td>2 TB for the OS disk, 4 TB for data disks.</td>
</tr>
<tr>
<td><strong>Disk number</strong></td>
<td>A maximum of 16 disks per VM.</td>
</tr>
<tr>
<td><strong>Encrypted disks/volumes</strong></td>
<td>Not supported for migration.</td>
</tr>
<tr>
<td><strong>RDM/passthrough disks</strong></td>
<td>Not supported for migration.</td>
</tr>
<tr>
<td><strong>Shared disk</strong></td>
<td>VMs using shared disks aren't supported for migration.</td>
</tr>
<tr>
<td><strong>NFS</strong></td>
<td>NFS volumes mounted as volumes on the VMs won't be replicated.</td>
</tr>
<tr>
<td><strong>iSCSI</strong></td>
<td>VMs with iSCSI targets aren't supported for migration.</td>
</tr>
</tbody>
</table>
Target disk
You can migrate to Azure VMs with managed disks only.

IPv6
Not supported.

NIC teaming
Not supported.

Azure Site Recovery
You can't replicate using Azure Migrate Server Migration if the VM is enabled for replication with Azure Site Recovery.

Ports
Outbound connections on HTTPS port 443 to send VM replication data.

## Azure VM requirements

All on-premises VMs replicated to Azure must meet the Azure VM requirements summarized in this table.

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system disk size</td>
<td>Up to 2,048 GB.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Operating system disk count</td>
<td>1</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Data disk count</td>
<td>16 or less.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Data disk size</td>
<td>Up to 4,095 GB</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Network adapters</td>
<td>Multiple adapters are supported.</td>
<td></td>
</tr>
<tr>
<td>Shared VHD</td>
<td>Not supported.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>FC disk</td>
<td>Not supported.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>BitLocker</td>
<td>Not supported.</td>
<td>BitLocker must be disabled before you enable replication for a machine.</td>
</tr>
<tr>
<td>VM name</td>
<td>From 1 to 63 characters. Restricted to letters, numbers, and hyphens. The machine name must start and end with a letter or number</td>
<td>Update the value in the machine properties in Site Recovery.</td>
</tr>
</tbody>
</table>

All on-premises VMs replicated to Azure must meet the Azure VM requirements summarized in this table.
<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect after migration-Windows</td>
<td>To connect to Azure VMs running Windows after migration:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Before migration enables RDP on the on-premises VM. Make sure that TCP,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and UDP rules are added for the Public profile, and that RDP is allowed in</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Windows Firewall</strong> &gt; <strong>Allowed Apps</strong>, for all profiles.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For site-to-site VPN access, enable RDP and allow RDP in <strong>Windows Firewall</strong> &gt; <strong>Allowed apps and features</strong> for <strong>Domain and Private</strong> networks. In addition, check that the operating system's SAN policy is set to <strong>OnlineAll</strong>.</td>
<td>Learn more.</td>
</tr>
<tr>
<td>Connect after migration-Linux</td>
<td>To connect to Azure VMs after migration using SSH:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Before migration, on the on-premises machine, check that the Secure Shell</td>
<td></td>
</tr>
<tr>
<td></td>
<td>service is set to Start, and that firewall rules allow an SSH connection.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>After failover, on the Azure VM, allow incoming connections to the SSH port for the network security group rules on the failed over VM, and for the Azure subnet to which it's connected. In addition, add a public IP address for the VM.</td>
<td></td>
</tr>
</tbody>
</table>

**Next steps**

*Migration Hyper-V VMs* for migration.
This article summarizes prerequisites and support requirements when you assess physical servers for migration to Azure, using the Azure Migrate:Server Assessment tool. If you want to migrate physical servers to Azure, review the migration support matrix.

To assess physical servers, you create an Azure Migrate project, and add the Server Assessment tool to the project. After the tool is added, you deploy the Azure Migrate appliance. The appliance continuously discovers on-premises machines, and sends machine metadata and performance data to Azure. After discovery is complete, you gather discovered machines into groups, and run an assessment for a group.

### Limitations

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assessment limits</strong></td>
<td>You can discover and assess up to 35,000 physical servers in a single Azure Migrate project.</td>
</tr>
<tr>
<td><strong>Project limits</strong></td>
<td>You can create multiple projects in an Azure subscription. In addition to physical servers, a project can include VMware VMs and Hyper-V VMs, up to the assessment limits for each.</td>
</tr>
<tr>
<td><strong>Discovery</strong></td>
<td>The Azure Migrate appliance can discover up to 250 physical servers.</td>
</tr>
<tr>
<td><strong>Assessment</strong></td>
<td>You can add up to 35,000 machines in a single group.</td>
</tr>
<tr>
<td></td>
<td>You can assess up to 35,000 machines in a single assessment.</td>
</tr>
</tbody>
</table>

Learn more about assessments.

### Physical server requirements

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical server deployment</strong></td>
<td>The physical server can be standalone, or deployed in a cluster.</td>
</tr>
<tr>
<td><strong>Permissions</strong></td>
<td><strong>Windows</strong>: You need a local or domain user account on all the Windows servers you want to discover. The user account should be added to these groups: Remote Desktop Users, Performance Monitor Users, and Performance Log users.</td>
</tr>
<tr>
<td></td>
<td><strong>Linux</strong>: You need a root account on the Linux servers that you want to discover.</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
<td>All Windows and Linux operating systems that are supported by Azure, except for Windows Server 2003, and SUSE Linux.</td>
</tr>
</tbody>
</table>

### Azure Migrate appliance requirements
Azure Migrate uses the Azure Migrate appliance for discovery and assessment. The appliance for physical servers can run on a VM or a physical machine. You set the appliance up using a PowerShell script that you download from the Azure portal.

- Learn about appliance requirements for physical servers.
- Learn about URLs that the appliance needs to access in public and government clouds.

Port access

The following table summarizes port requirements for assessment.

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>CONNECTION</th>
</tr>
</thead>
</table>
| Appliance         | Inbound connections on TCP port 3389, to allow remote desktop connections to the appliance.  
                   | Inbound connections on port 44368, to remotely access the appliance management app using the URL: [https://<appliance-ip-or-name>:44368](https://<appliance-ip-or-name>:44368)  
                   | Outbound connections on ports 443 (HTTPS), to send discovery and performance metadata to Azure Migrate.  |
| Physical servers  | **Windows:** Inbound connections on WinRM ports 5985 (HTTP) and 5986 (HTTPS), to pull configuration and performance metadata from Windows servers.  
                   | **Linux:** Inbound connections on port 22 (UDP), to pull configuration and performance metadata from Linux servers.  |

Agent-based dependency analysis requirements

Dependency analysis helps you to identify dependencies between on-premises machines that you want to assess and migrate to Azure. The table summarizes the requirements for setting up agent-based dependency analysis. Currently only agent-based dependency analysis is supported for physical servers.

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
</table>
| **Before deployment** | You should have an Azure Migrate project in place, with the Server Assessment tool added to the project.  
                      | You deploy dependency visualization after setting up an Azure Migrate appliance to discover your on-premises machines  
                      | Learn how to create a project for the first time.  
                      | Learn how to add an assessment tool to an existing project.  
<pre><code>                  | Learn how to set up the Azure Migrate appliance for assessment of Hyper-V, VMware, or physical servers.  |
</code></pre>
<p>| <strong>Azure Government</strong> | Dependency visualization isn't available in Azure Government.            |</p>
<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Analytics</td>
<td>Azure Migrate uses the Service Map solution in Azure Monitor logs for dependency visualization.</td>
</tr>
<tr>
<td></td>
<td>You associate a new or existing Log Analytics workspace with an Azure Migrate project. The workspace for an Azure Migrate project can't be modified after it's added.</td>
</tr>
<tr>
<td></td>
<td>The workspace must be in the same subscription as the Azure Migrate project.</td>
</tr>
<tr>
<td></td>
<td>The workspace must reside in the East US, Southeast Asia, or West Europe regions. Workspaces in other regions can't be associated with a project.</td>
</tr>
<tr>
<td></td>
<td>The workspace must be in a region in which Service Map is supported.</td>
</tr>
<tr>
<td></td>
<td>In Log Analytics, the workspace associated with Azure Migrate is tagged with the Migration Project key, and the project name.</td>
</tr>
<tr>
<td>Required agents</td>
<td>On each machine you want to analyze, install the following agents:</td>
</tr>
<tr>
<td></td>
<td>The Microsoft Monitoring agent (MMA).</td>
</tr>
<tr>
<td></td>
<td>The Dependency agent.</td>
</tr>
<tr>
<td></td>
<td>If on-premises machines aren't connected to the internet, you need to download and install Log Analytics gateway on them.</td>
</tr>
<tr>
<td></td>
<td>Learn more about installing the Dependency agent and MMA.</td>
</tr>
<tr>
<td>Log Analytics workspace</td>
<td>The workspace must be in the same subscription as the Azure Migrate project.</td>
</tr>
<tr>
<td></td>
<td>Azure Migrate supports workspaces residing in the East US, Southeast Asia, and West Europe regions.</td>
</tr>
<tr>
<td></td>
<td>The workspace must be in a region in which Service Map is supported.</td>
</tr>
<tr>
<td></td>
<td>The workspace for an Azure Migrate project can't be modified after it's added.</td>
</tr>
<tr>
<td>REQUIREMENT</td>
<td>DETAILS</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Costs</td>
<td>The Service Map solution doesn't incur any charges for the first 180 days (from the day that you associate the Log Analytics workspace with the Azure Migrate project). After 180 days, standard Log Analytics charges will apply. Using any solution other than Service Map in the associated Log Analytics workspace will incur standard charges for Log Analytics. When the Azure Migrate project is deleted, the workspace is not deleted along with it. After deleting the project, Service Map usage isn't free, and each node will be charged as per the paid tier of Log Analytics workspace. If you have projects that you created before Azure Migrate general availability (GA - 28 February 2018), you might have incurred additional Service Map charges. To ensure payment after 180 days only, we recommend that you create a new project, since existing workspaces before GA are still chargeable.</td>
</tr>
<tr>
<td>Management</td>
<td>When you register agents to the workspace, you use the ID and key provided by the Azure Migrate project. You can use the Log Analytics workspace outside Azure Migrate. If you delete the associated Azure Migrate project, the workspace isn't deleted automatically. Delete it manually. Don't delete the workspace created by Azure Migrate, unless you delete the Azure Migrate project. If you do, the dependency visualization functionality will not work as expected.</td>
</tr>
<tr>
<td>Internet connectivity</td>
<td>If machines aren't connected to the internet, you need to install the Log Analytics gateway on them.</td>
</tr>
<tr>
<td>Azure Government</td>
<td>Agent-based dependency analysis isn't supported.</td>
</tr>
</tbody>
</table>

**Next steps**

*Prepare for physical server assessment.*
This article summarizes support settings and limitations for migrating physical servers with Azure Migrate: Server Migration. If you're looking for information about assessing physical servers for migration to Azure, review the assessment support matrix.

Overview

You can migrate on-premises machines as physical servers, using agent-based replication. Using this tool, you can migrate a wide range of machines to Azure:

- On-premises physical servers.
- VMs virtualized by platforms such as Xen, KVM.
- Hyper-V VMs or VMware VMs if for some reason you don’t want to use the standard Hyper-V or VMware flows.
- VMs running in private clouds.
- VMs running in public clouds such as Amazon Web Services (AWS) or Google Cloud Platform (GCP).

Migration limitations

You can select up to 10 machines at once for replication. If you want to migrate more machines, then replicate in groups of 10.

Physical server requirements

The table summarizes support for physical servers you want to migrate using agent-based migration.

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine workload</td>
<td>Azure Migrate supports migration of any workload (say Active Directory, SQL server, etc.) running on a supported machine.</td>
</tr>
<tr>
<td>Operating systems</td>
<td>For the latest information, review the operating system support for Site Recovery. Azure Migrate provides identical operating system support.</td>
</tr>
<tr>
<td>Linux file system/guest storage</td>
<td>For the latest information, review the Linux file system support for Site Recovery. Azure Migrate provides identical Linux file system support.</td>
</tr>
<tr>
<td>Network/Storage</td>
<td>For the latest information, review the network and storage prerequisites for Site Recovery. Azure Migrate provides identical network/storage requirements.</td>
</tr>
<tr>
<td>Azure requirements</td>
<td>For the latest information, review the Azure network, storage, and compute requirements for Site Recovery. Azure Migrate has identical requirements for physical server migration.</td>
</tr>
<tr>
<td>Mobility service</td>
<td>The Mobility service agent must be installed on each machine you want to migrate.</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>DETAILS</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UEFI boot</td>
<td>The migrated machine in Azure will be automatically converted to a BIOS boot Azure VM. Only server running Windows Server 2012 and later supported. The OS disk should have up to four partitions, and volumes should be formatted with NTFS.</td>
</tr>
<tr>
<td>Target disk</td>
<td>Machines can only be migrated to managed disks (standard HDD, premium SSD) in Azure.</td>
</tr>
<tr>
<td>Disk size</td>
<td>2 TB OS disk; 8 TB for data disks.</td>
</tr>
<tr>
<td>Disk limits</td>
<td>Up to 63 disks per machine.</td>
</tr>
<tr>
<td>Encrypted disks/volumes</td>
<td>Machines with encrypted disks/volumes aren't supported for migration.</td>
</tr>
<tr>
<td>Shared disk cluster</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Independent disks</td>
<td>Supported.</td>
</tr>
<tr>
<td>Passthrough disks</td>
<td>Supported.</td>
</tr>
<tr>
<td>NFS</td>
<td>NFS volumes mounted as volumes on the machines won't be replicated.</td>
</tr>
<tr>
<td>iSCSI targets</td>
<td>Machines with iSCSI targets aren't supported for agentless migration.</td>
</tr>
<tr>
<td>Multipath IO</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>Supported.</td>
</tr>
<tr>
<td>Teamed NICs</td>
<td>Not supported.</td>
</tr>
<tr>
<td>IPv6</td>
<td>Not supported.</td>
</tr>
</tbody>
</table>

**Replication appliance requirements**

If you set up the replication appliance manually on a physical server, then make sure that it complies with the requirements summarized in the table. When you set up the Azure Migrate replication appliance as an VMware VM using the OVA template provided in the Azure Migrate hub, the appliance is set up with Windows Server 2016, and complies with the support requirements.

- Learn about replication appliance requirements.
- MySQL must be installed on the appliance. Learn about installation options.
- Learn about URLs the replication appliance needs to access.

**Azure VM requirements**

All on-premises VMs replicated to Azure must meet the Azure VM requirements summarized in this table. When Site Recovery runs a prerequisites check for replication, the check will fail if some of the requirements aren't met.
<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest operating system</td>
<td>Verifies supported operating systems. You can migrate any workload running on a supported operating system.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Guest operating system architecture</td>
<td>64-bit.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Operating system disk size</td>
<td>Up to 2,048 GB.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Operating system disk count</td>
<td>1</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Data disk count</td>
<td>64 or less.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Data disk size</td>
<td>Up to 4,095 GB</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>Network adapters</td>
<td>Multiple adapters are supported.</td>
<td></td>
</tr>
<tr>
<td>Shared VHD</td>
<td>Not supported.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>FC disk</td>
<td>Not supported.</td>
<td>Check fails if unsupported.</td>
</tr>
<tr>
<td>BitLocker</td>
<td>Not supported.</td>
<td>BitLocker must be disabled before you enable replication for a machine.</td>
</tr>
<tr>
<td>VM name</td>
<td>From 1 to 63 characters. Restricted to letters, numbers, and hyphens.</td>
<td>Update the value in the machine properties in Site Recovery.</td>
</tr>
<tr>
<td></td>
<td>The machine name must start and end with a letter or number.</td>
<td></td>
</tr>
<tr>
<td>Connect after migration-Windows</td>
<td>To connect to Azure VMs running Windows after migration:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Before migration enables RDP on the on-premises VM. Make sure that TCP, and UDP rules are added for the <strong>Public</strong> profile, and that RDP is allowed in <strong>Windows Firewall &gt; Allowed Apps</strong>, for all profiles. For site-to-site VPN access, enable RDP and allow RDP in <strong>Windows Firewall &gt; Allowed apps and features for Domain and Private</strong> networks. In addition, check that the operating system's SAN policy is set to <strong>OnlineAll</strong>. Learn more.</td>
<td></td>
</tr>
</tbody>
</table>
### Connect after migration-Linux

To connect to Azure VMs after migration using SSH:
Before migration, on the on-premises machine, check that the Secure Shell service is set to Start, and that firewall rules allow an SSH connection. After failover, on the Azure VM, allow incoming connections to the SSH port for the network security group rules on the failed over VM, and for the Azure subnet to which it’s connected. In addition, add a public IP address for the VM.

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connect after migration-Linux</strong></td>
<td>To connect to Azure VMs after migration using SSH:</td>
<td><strong>Before migration, on the on-premises machine, check that the Secure Shell service is set to Start, and that firewall rules allow an SSH connection. After failover, on the Azure VM, allow incoming connections to the SSH port for the network security group rules on the failed over VM, and for the Azure subnet to which it’s connected. In addition, add a public IP address for the VM.</strong></td>
</tr>
</tbody>
</table>

### Next steps

Migrate physical servers.
This article summarizes the prerequisites and support requirements for the Azure Migrate appliance.

### Deployment scenarios

The Azure Migrate appliance is used in the following scenarios.

<table>
<thead>
<tr>
<th>SCENARIO</th>
<th>TOOL</th>
<th>USED FOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware VM assessment</td>
<td>Azure Migrate:Server Assessment</td>
<td>Discover VMware VMs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discover machine apps and dependencies</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Collect machine metadata and performance metadata for assessments.</td>
</tr>
<tr>
<td>VMware VM agentless migration</td>
<td>Azure Migrate:Server Migration</td>
<td>Discover VMware VMs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Replicate VMware VMs with agentless migration.</td>
</tr>
<tr>
<td>Hyper-V VM assessment</td>
<td>Azure Migrate:Server Assessment</td>
<td>Discover Hyper-V VMs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Collect machine metadata and performance metadata for assessments.</td>
</tr>
<tr>
<td>Physical machine assessment</td>
<td>Azure Migrate:Server Assessment</td>
<td>Discover physical servers (or VMs you treat as physical servers).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Collect machine metadata and performance metadata for assessments.</td>
</tr>
</tbody>
</table>

### Deployment methods

The appliance can be deployed using a couple of methods:

- The appliance can be deployed using a template for VMware VMs and Hyper-V VMs (OVA template for VMware or VHD for Hyper-V).
- If you don’t want to use a template, you can deploy the appliance for VMware or Hyper-V using a PowerShell script.
- In Azure Government, you should deploy the appliance using a script.
- For physical servers, you always deploy the appliance using a script.
- Download links are available in the tables below.

### Appliance - VMware

The following table summarizes the Azure Migrate appliance requirements for VMware.
## Appliance components

The appliance has the following components:

- **Management app**: This is a web app for user input during appliance deployment. Used when assessing machines for migration to Azure.
- **Discovery agent**: The agent gathers machine configuration data. Used when assessing machines for migration to Azure.
- **Assessment agent**: The agent collects performance data. Used when assessing machines for migration to Azure.
- **Auto update service**: Updates appliance components (runs every 24 hours).
- **DRA agent**: Orchestrates VM replication, and coordinates communication between replicated machines and Azure. Used only when replicating VMware VMs to Azure using agentless migration.
- **Gateway**: Sends replicated data to Azure. Used only when replicating VMware VMs to Azure using agentless migration.

## Supported deployment

Deploy as VMware VM using OVA template.

Deploy as a VMware VM or physical machine using PowerShell installation script.

## Project support

An appliance can be associated with a single project. Any number of appliances can be associated with a single project.

## Discovery limits

An appliance can discover up to 10,000 VMware VMs on a vCenter Server.

An appliance can connect to a single vCenter Server.

## OVA template

Download from portal or from https://aka.ms/migrate/appliance/vmware.

Download size is 11.2 GB.

The downloaded appliance template comes with a Windows Server 2016 evaluation license, which is valid for 180 days. If the evaluation period is close to expiry, we recommend that you download and deploy a new appliance, or that you activate the operating system license of the appliance VM.

## PowerShell script

Script download.
<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>VMWARE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software/hardware</td>
<td>The appliance should run on a machine with Windows Server 2016, 32-GB RAM, 8 vCPUs, around 80 GB of disk storage, and an external virtual switch. The appliance requires internet access, either directly or through a proxy. If you run the appliance on a VMware VM, you need enough resources on the vCenter Server to allocate a VM that meets the requirements. If you run the appliance on a physical machine, make sure that it’s running Windows Server 2016, and meets hardware requirements.</td>
</tr>
<tr>
<td>VMware requirements</td>
<td>If you deploy the appliance as a VMware VM, it must be deployed on an ESXi host running version 5.5 or later. vCenter Server running 5.5, 6.0, 6.5, or 6.7.</td>
</tr>
<tr>
<td>VDDK (agentless migration)</td>
<td>If you deploy the appliance as a VMware VM, and you’re running an agentless migration, the VMware vSphere VDDK must be installed on the appliance VM.</td>
</tr>
<tr>
<td>Hash value-OVA</td>
<td>Verify the OVA template hash values.</td>
</tr>
<tr>
<td>Hash value-PowerShell script</td>
<td>Verify the PowerShell script hash values.</td>
</tr>
</tbody>
</table>

### Appliance - Hyper-V

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>HYPER-V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appliance components</td>
<td>The appliance has the following components:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Management app</strong>: This is a web app for user input during appliance deployment. Used when assessing machines for migration to Azure.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Discovery agent</strong>: The agent gathers machine configuration data. Used when assessing machines for migration to Azure.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Assessment agent</strong>: The agent collects performance data. Used when assessing machines for migration to Azure.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Auto update service</strong>: Updates appliance components (runs every 24 hours).</td>
</tr>
<tr>
<td>Supported deployment</td>
<td>Deploy as Hyper-V VM using a VHD template.</td>
</tr>
<tr>
<td></td>
<td>Deploy as a Hyper-V VM or physical machine using a PowerShell installation script.</td>
</tr>
<tr>
<td>Project support</td>
<td>An appliance can be associated with a single project. Any number of appliances can be associated with a single project.</td>
</tr>
<tr>
<td>Discovery limits</td>
<td>An appliance can discover up to 5000 Hyper-V VMs. An appliance can connect to up to 300 Hyper-V hosts.</td>
</tr>
<tr>
<td>REQUIREMENT</td>
<td>HYPER-V</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>VHD template</strong></td>
<td>Zipped folder including VHD. Download from portal or from <a href="https://aka.ms/migrate/appliance/hyperv">https://aka.ms/migrate/appliance/hyperv</a>. Download size is 10 GB. The downloaded appliance template comes with a Windows Server 2016 evaluation license, which is valid for 180 days. If the evaluation period is close to expiry, we recommend that you download and deploy a new appliance, or that you activate the operating system license of the appliance VM.</td>
</tr>
<tr>
<td><strong>PowerShell script</strong></td>
<td>Script download.</td>
</tr>
<tr>
<td><strong>Software/hardware</strong></td>
<td>The appliance should run on machine with Windows Server 2016, 32-GB RAM, 8 vCPUs, around 80 GB of disk storage, and an external virtual switch. The appliance needs a static or dynamic IP address, and requires internet access, either directly or through a proxy. If you run the appliance as a Hyper-V VM, you need enough resources on the Hyper-V host to allocate 16-GB RAM, 8 vCPUs, around 80 GB of storage space, and an external switch for the appliance VM. If you run the appliance on a physical machine, make sure that it's running Windows Server 2016, and meets hardware requirements.</td>
</tr>
<tr>
<td><strong>Hyper-V requirements</strong></td>
<td>If you deploy the appliance with the VHD template, the appliance VM provided by Azure Migrate is Hyper-V VM version 5.0. The Hyper-V host must be running Windows Server 2012 R2 or later.</td>
</tr>
<tr>
<td><strong>Hash value-VHD</strong></td>
<td>Verify the VHD template hash values.</td>
</tr>
<tr>
<td><strong>Hash value-PowerShell script</strong></td>
<td>Verify the PowerShell script hash values.</td>
</tr>
</tbody>
</table>

**Appliance - Physical**
Appliance components

The appliance has the following components:

- **Management app**: This is a web app for user input during appliance deployment. Used when assessing machines for migration to Azure.
- **Discovery agent**: The agent gathers machine configuration data. Used when assessing machines for migration to Azure.
- **Assessment agent**: The agent collects performance data. Used when assessing machines for migration to Azure.
- **Auto update service**: Updates appliance components (runs every 24 hours).

Supported deployment

Deploy as a dedicated physical machine, or a VM, using a PowerShell installation script. The script is available for download from the portal.

Project support

An appliance can be associated with a single project. Any number of appliances can be associated with a single project.

Discovery limits

An appliance can discover up to 250 physical servers.

PowerShell script

Download the script (AzureMigrateInstaller.ps1) in a zipped folder from the portal. Learn more. Alternatively, download directly.

Download size is 59.7 MB.

Software/hardware

The appliance should run on machine with Windows Server 2016, 32-GB RAM, 8 vCPUs, around 80 GB of disk storage, and an external virtual switch.

The appliance needs a static or dynamic IP address, and requires internet access, either directly or through a proxy.

If you run the appliance on a physical machine, make sure that it's running Windows Server 2016, and meets hardware requirements.

Hash value

Verify the PowerShell script hash values.

URL access

The Azure Migrate appliance needs connectivity to the internet.

- When you deploy the appliance, Azure Migrate does a connectivity check to the required URLs.
- If you're using a URL-based proxy to connect to the internet, you need to allow access to these URLs, making sure that the proxy resolves any CNAME records received while looking up the URLs.

Public cloud URLs

<table>
<thead>
<tr>
<th>URL</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.portal.azure.com</td>
<td>Navigate to the Azure portal.</td>
</tr>
<tr>
<td>URL</td>
<td>DETAILS</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>*.windows.net</td>
<td>Sign in to your Azure subscription.</td>
</tr>
<tr>
<td>*.msftauth.net</td>
<td></td>
</tr>
<tr>
<td>*.msauth.net</td>
<td></td>
</tr>
<tr>
<td>*.microsoft.com</td>
<td></td>
</tr>
<tr>
<td>*.live.com</td>
<td></td>
</tr>
<tr>
<td>*.microsoftonline.com</td>
<td>Create Azure Active Directory (AD) apps for the appliance to communicate with Azure Migrate.</td>
</tr>
<tr>
<td>*.microsoftonline-p.com</td>
<td></td>
</tr>
<tr>
<td>management.azure.com</td>
<td>Create Azure AD apps for the appliance to communicate with the Azure Migrate service.</td>
</tr>
<tr>
<td>dc.services.visualstudio.com</td>
<td>Upload app logs used for internal monitoring.</td>
</tr>
<tr>
<td>*.vault.azure.net</td>
<td>Manage secrets in the Azure Key Vault.</td>
</tr>
<tr>
<td>aka.ms/*</td>
<td>Allow access to aka links. Used for Azure Migrate appliance updates.</td>
</tr>
<tr>
<td>download.microsoft.com/download</td>
<td>Allow downloads from Microsoft download.</td>
</tr>
<tr>
<td>*.servicebus.windows.net</td>
<td>Communication between the appliance and the Azure Migrate service.</td>
</tr>
<tr>
<td>*.discoverysrv.windowsazure.com</td>
<td>Connect to Azure Migrate service URLs.</td>
</tr>
<tr>
<td>*.migration.windowsazure.com</td>
<td></td>
</tr>
<tr>
<td>*.hypervrecoverymanager.windowsazure.com</td>
<td>Used for VMware agentless migration</td>
</tr>
<tr>
<td>*.blob.core.windows.net</td>
<td>Used for VMware agentless migration</td>
</tr>
<tr>
<td></td>
<td>Upload data to storage for migration.</td>
</tr>
</tbody>
</table>

**Government cloud URLs**

<table>
<thead>
<tr>
<th>URL</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.portal.azure.us</td>
<td>Navigate to the Azure portal.</td>
</tr>
<tr>
<td>graph.windows.net</td>
<td>Sign in to your Azure subscription.</td>
</tr>
<tr>
<td>login.microsoftonline.us</td>
<td>Create Azure Active Directory (AD) apps for the appliance to communicate with Azure Migrate.</td>
</tr>
<tr>
<td>management.usgovcloudapi.net</td>
<td>Create Azure AD apps for the appliance to communicate with the Azure Migrate service.</td>
</tr>
<tr>
<td>dc.services.visualstudio.com</td>
<td>Upload app logs used for internal monitoring.</td>
</tr>
<tr>
<td>*.vault.usgovcloudapi.net</td>
<td>Manage secrets in the Azure Key Vault.</td>
</tr>
</tbody>
</table>
Collected data - VMware

The appliance collects metadata, performance data, and dependency analysis data (if agentless dependency analysis is used).

**Metadata**

Metadata discovered by the Azure Migrate appliance helps you to figure out whether machines and apps are ready for migration to Azure, right-size machines and apps, plans costs, and analyze application dependencies. Microsoft doesn't use this data in any license compliance audit.

Here's the full list of VMware VM metadata that the appliance collects and sends to Azure.

<table>
<thead>
<tr>
<th>DATA</th>
<th>COUNTER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine details</td>
<td></td>
</tr>
<tr>
<td>VM ID</td>
<td>vm.Config.InstanceUuid</td>
</tr>
<tr>
<td>VM name</td>
<td>vm.Config.Name</td>
</tr>
<tr>
<td>vCenter Server ID</td>
<td>VMwareClient.Instance.Uuid</td>
</tr>
<tr>
<td>VM description</td>
<td>vm.Summary.Config.Annotation</td>
</tr>
<tr>
<td>License product name</td>
<td>vm.Client.ServiceContent.About.LicenseProductName</td>
</tr>
<tr>
<td>Operating system type</td>
<td>vm.SummaryConfig.GuestFullName</td>
</tr>
<tr>
<td>Boot type</td>
<td>vm.Config.Firmware</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td><strong>Counter</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Number of cores</td>
<td><code>vm.Config.Hardware.NumCPU</code></td>
</tr>
<tr>
<td>Memory (MB)</td>
<td><code>vm.Config.Hardware.MemoryMB</code></td>
</tr>
<tr>
<td>Number of disks</td>
<td><code>vm.Config.Hardware.Device.ToList().FindAll(x =&gt; is VirtualDisk).count</code></td>
</tr>
<tr>
<td>Disk size list</td>
<td><code>vm.Config.Hardware.Device.ToList().FindAll(x =&gt; is VirtualDisk)</code></td>
</tr>
<tr>
<td>Network adapters list</td>
<td><code>vm.Config.Hardware.Device.ToList().FindAll(x =&gt; is VirtualEthernet).count</code></td>
</tr>
<tr>
<td>CPU utilization</td>
<td><code>cpu.usage.average</code></td>
</tr>
<tr>
<td>Memory utilization</td>
<td><code>mem.usage.average</code></td>
</tr>
<tr>
<td><strong>Per disk details</strong></td>
<td></td>
</tr>
<tr>
<td>Disk key value</td>
<td><code>disk.Key</code></td>
</tr>
<tr>
<td>Diskunit number</td>
<td><code>disk.UnitNumber</code></td>
</tr>
<tr>
<td>Disk controller key value</td>
<td><code>disk.ControllerKey.Value</code></td>
</tr>
<tr>
<td>Gigabytes provisioned</td>
<td><code>virtualDisk.DeviceInfo.Summary</code></td>
</tr>
<tr>
<td>Disk name</td>
<td>Value generated using <code>disk.UnitNumber</code>, <code>disk.Key</code>, <code>disk.ControllerKey.Value</code></td>
</tr>
<tr>
<td>Read operations per second</td>
<td><code>virtualDisk.numberReadAveraged.average</code></td>
</tr>
<tr>
<td>Write operations per second</td>
<td><code>virtualDisk.numberWriteAveraged.average</code></td>
</tr>
<tr>
<td>Read throughput (MB per second)</td>
<td><code>virtualDisk.read.average</code></td>
</tr>
<tr>
<td>Write throughput (MB per second)</td>
<td><code>virtualDisk.write.average</code></td>
</tr>
<tr>
<td><strong>Per NIC details</strong></td>
<td></td>
</tr>
<tr>
<td>Network adapter name</td>
<td><code>nic.Key</code></td>
</tr>
<tr>
<td>MAC address</td>
<td><code>((VirtualEthernetCard)nic).MacAddress</code></td>
</tr>
<tr>
<td>IPv4 addresses</td>
<td><code>vm.Guest.Net</code></td>
</tr>
<tr>
<td>IPv6 addresses</td>
<td><code>vm.Guest.Net</code></td>
</tr>
<tr>
<td>Read throughput (MB per second)</td>
<td><code>net.received.average</code></td>
</tr>
<tr>
<td>Write throughput (MB per second)</td>
<td><code>net.transmitted.average</code></td>
</tr>
</tbody>
</table>
### Inventory path details

<table>
<thead>
<tr>
<th>Name</th>
<th>COUNTER</th>
<th>Type of child object</th>
<th>COUNTER</th>
<th>Reference details</th>
<th>COUNTER</th>
<th>Parent details</th>
<th>COUNTER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>container.GetType().Name</td>
<td>container.ChildType</td>
<td>container:MoRef</td>
<td>ContainerParent</td>
<td>ContainerParent</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Folder details per VM
- `((Folder)container).ChildEntity.Type`

### Datacenter details per VM
- `((Datacenter)container).VmFolder`

### Datacenter details per host folder
- `((Datacenter)container).HostFolder`

### Cluster details per host
- `((ClusterComputeResource)container).Host`

### Host details per VM
- `((HostSystem)container).VM`

### Performance data

Here's the VMware VM performance data that the appliance collects and sends to Azure.

<table>
<thead>
<tr>
<th>DATA</th>
<th>COUNTER</th>
<th>ASSESSMENT IMPACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU utilization</td>
<td>cpu.usage.average</td>
<td>Recommended VM size/cost</td>
</tr>
<tr>
<td>Memory utilization</td>
<td>mem.usage.average</td>
<td>Recommended VM size/cost</td>
</tr>
<tr>
<td>Disk read throughput (MB per second)</td>
<td>virtualDisk.read.average</td>
<td>Calculation for disk size, storage cost, VM size</td>
</tr>
<tr>
<td>Disk writes throughput (MB per second)</td>
<td>virtualDisk.write.average</td>
<td>Calculation for disk size, storage cost, VM size</td>
</tr>
<tr>
<td>Disk read operations per second</td>
<td>virtualDisk.numberReadAveraged.average</td>
<td>Calculation for disk size, storage cost, VM size</td>
</tr>
<tr>
<td>Disk writes operations per second</td>
<td>virtualDisk.numberWriteAveraged.average</td>
<td>Calculation for disk size, storage cost, VM size</td>
</tr>
<tr>
<td>NIC read throughput (MB per second)</td>
<td>net.received.average</td>
<td>Calculation for VM size</td>
</tr>
<tr>
<td>NIC writes throughput (MB per second)</td>
<td>net.transmitted.average</td>
<td>Calculation for VM size</td>
</tr>
</tbody>
</table>

### App dependencies metadata

Agentless dependency analysis collects connection and process data.

### Connection data

Here's the connection data that the appliance collects from each VM enabled for agentless dependency
analysis. This data is sent to Azure.

<table>
<thead>
<tr>
<th>DATA</th>
<th>COMMAND USED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local port</td>
<td>netstat</td>
</tr>
<tr>
<td>Local IP address</td>
<td>netstat</td>
</tr>
<tr>
<td>Remote port</td>
<td>netstat</td>
</tr>
<tr>
<td>Remote IP address</td>
<td>netstat</td>
</tr>
<tr>
<td>TCP connection state</td>
<td>netstat</td>
</tr>
<tr>
<td>Process ID</td>
<td>netstat</td>
</tr>
<tr>
<td>No. of active connections</td>
<td>netstat</td>
</tr>
</tbody>
</table>

**Process data**

Here's the process data that the appliance collects from each VM enabled for agentless dependency analysis. This data is sent to Azure.

<table>
<thead>
<tr>
<th>DATA</th>
<th>WMI CLASS</th>
<th>WMI CLASS PROPERTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process name</td>
<td>Win32_Process</td>
<td>ExecutablePath</td>
</tr>
<tr>
<td>Process arguments</td>
<td>Win32_Process</td>
<td>CommandLine</td>
</tr>
<tr>
<td>Application name</td>
<td>Win32_Process</td>
<td>VersionInfo.ProductName parameter of ExecutablePath property</td>
</tr>
</tbody>
</table>

**Linux VM data**

Here's the connection and process data that the appliance collects from each Linux VM enabled for agentless dependency analysis. This data is sent to Azure.

<table>
<thead>
<tr>
<th>DATA</th>
<th>COMMAND USED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local port</td>
<td>netstat</td>
</tr>
<tr>
<td>Local IP address</td>
<td>netstat</td>
</tr>
<tr>
<td>Remote port</td>
<td>netstat</td>
</tr>
<tr>
<td>Remote IP address</td>
<td>netstat</td>
</tr>
<tr>
<td>TCP connection state</td>
<td>netstat</td>
</tr>
<tr>
<td>No. of active connections</td>
<td>netstat</td>
</tr>
<tr>
<td>Process ID</td>
<td>netstat</td>
</tr>
<tr>
<td>Process name</td>
<td>ps</td>
</tr>
</tbody>
</table>
Collected data - Hyper-V

The appliance collects metadata, performance data, and dependency analysis data (if agentless dependency analysis is used).

**Metadata**

Metadata discovered by the Azure Migrate appliance helps you to figure out whether machines and apps are ready for migration to Azure, right-size machines and apps, plans costs, and analyze application dependencies. Microsoft doesn't use this data in any license compliance audit.

Here’s the full list of Hyper-V VM metadata that the appliance collects and sends to Azure.

<table>
<thead>
<tr>
<th>DATA</th>
<th>WMI CLASS</th>
<th>WMI CLASS PROPERTY</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Machine details</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial number of BIOS</td>
<td>Msvm_BIOSElement</td>
<td>BIOSSerialNumber</td>
</tr>
<tr>
<td>VM type (Gen 1 or 2)</td>
<td>Msvm_VirtualSystemSettingData</td>
<td>VirtualSystemSubType</td>
</tr>
<tr>
<td>VM display name</td>
<td>Msvm_VirtualSystemSettingData</td>
<td>ElementName</td>
</tr>
<tr>
<td>VM version</td>
<td>Msvm_ProcessorSettingData</td>
<td>VirtualQuantity</td>
</tr>
<tr>
<td>Memory (bytes)</td>
<td>Msvm_MemorySettingData</td>
<td>VirtualQuantity</td>
</tr>
<tr>
<td>Maximum memory that can be consumed by VM</td>
<td>Msvm_MemorySettingData</td>
<td>Limit</td>
</tr>
<tr>
<td>Dynamic memory enabled</td>
<td>Msvm_MemorySettingData</td>
<td>DynamicMemoryEnabled</td>
</tr>
<tr>
<td>Operating system name/version/FQDN</td>
<td>Msvm_KvpExchangeComponent</td>
<td>GuestIntrinsicExchangeItems Name Data</td>
</tr>
<tr>
<td>VM power status</td>
<td>Msvm_ComputerSystem</td>
<td>EnabledState</td>
</tr>
<tr>
<td><strong>Per disk details</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk identifier</td>
<td>Msvm_VirtualHardDiskSettingData</td>
<td>VirtualDiskId</td>
</tr>
<tr>
<td>Virtual hard disk type</td>
<td>Msvm_VirtualHardDiskSettingData</td>
<td>Type</td>
</tr>
<tr>
<td>Virtual hard disk size</td>
<td>Msvm_VirtualHardDiskSettingData</td>
<td>MaxInternalSize</td>
</tr>
<tr>
<td>Virtual hard disk parent</td>
<td>Msvm_VirtualHardDiskSettingData</td>
<td>ParentPath</td>
</tr>
</tbody>
</table>
**Data** | **WMI Class** | **WMI Class Property**
---|---|---
Per NIC details | | |
IP addresses (synthetic NICs) | Msvm_GuestNetworkAdapterConfiguration | IPAddresses
DHCP enabled (synthetic NICs) | Msvm_GuestNetworkAdapterConfiguration | DHCPEnabled
NIC ID (synthetic NICs) | Msvm_SyntheticEthernetPortSettingData | InstanceID
NIC MAC address (synthetic NICs) | Msvm_SyntheticEthernetPortSettingData | Address
NIC ID (legacy NICs) | MsvmEmulatedEthernetPortSettingData | InstanceID
NIC MAC ID (legacy NICs) | MsvmEmulatedEthernetPortSettingData | Address

**Performance data**
Here's the Hyper VM performance data that the appliance collects and sends to Azure.

<table>
<thead>
<tr>
<th>Performance Counter Class</th>
<th>Counter</th>
<th>Assessment Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hyper-V Hypervisor Virtual Processor</td>
<td>% Guest Run Time</td>
<td>Recommended VM size/cost</td>
</tr>
<tr>
<td>Hyper-V Dynamic Memory VM</td>
<td>Current Pressure (%) Guest Visible Physical Memory (MB)</td>
<td>Recommended VM size/cost</td>
</tr>
<tr>
<td>Hyper-V Virtual Storage Device</td>
<td>Read Bytes/Second</td>
<td>Calculation for disk size, storage cost, VM size</td>
</tr>
<tr>
<td>Hyper-V Virtual Storage Device</td>
<td>Write Bytes/Second</td>
<td>Calculation for disk size, storage cost, VM size</td>
</tr>
<tr>
<td>Hyper-V Virtual Network Adapter</td>
<td>Bytes Received/Second</td>
<td>Calculation for VM size</td>
</tr>
<tr>
<td>Hyper-V Virtual Network Adapter</td>
<td>Bytes Sent/Second</td>
<td>Calculation for VM size</td>
</tr>
</tbody>
</table>

- CPU utilization is the sum of all usage, for all virtual processors attached to a VM.
- Memory utilization is (Current Pressure * Guest Visible Physical Memory) / 100.
- Disk and network utilization values are collected from the listed Hyper-V performance counters.

**Appliance upgrades**
The appliance is upgraded as the Azure Migrate agents running on the appliance are updated. This happens automatically, because auto-update is enabled on the appliance by default. You can change this default setting, to update the appliance services manually.

**Turn off auto-update**
1. On the machine running the appliance, open the Registry Editor.
2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\AzureAppliance.

3. To turn off auto-update, create a registry key **AutoUpdate** key with DWORD value of 0.

   ![Registry Editor screenshot](image)

   **Turn on auto-update**

   You can turn on auto-update using either of these methods:
   
   - By deleting the AutoUpdate registry key from HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\AzureAppliance.
   - After discovery is complete, in the Appliance Configuration Manager.

   To delete the registry key:
   
   1. On the machine running the appliance, open the Registry Editor.
   2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\AzureAppliance.
   3. Delete the registry key **AutoUpdate**, that was previously created to turn off auto-update.

   To turn on from Appliance Configuration Manager, after discovery is complete:
   
   1. On the appliance machine, open the Appliance Configuration Manager.
   2. In Appliance services \> Automatic update of Azure Migrate components is turned off, click to turn on auto-update.

   ![Appliance services screenshot](image)

   **Check the appliance services version**
You can check the appliance services version using either of these methods:

- In Appliance Configuration Manager, after discovery is complete.
- On the appliance machine, in the Control Panel > Programs and Features.

To check in the Appliance Configuration Manager:

1. After discovery is complete, open Appliance Configuration Manager (in the appliance web app).
2. In Appliance services, verify the appliance services versions.

![Appliance services](image)

To check in the Control Panel:

1. On the appliance, click Start > Control Panel > Programs and Features
2. Check the appliance services versions in the list.

![Programs and Features](image)

Manually update an older version

If you are running an older version for any of the components, you must uninstall the service, and manually update to the latest version.

1. To check for the latest appliance service versions, download the LatestComponents.json file.
2. After downloading, open the LatestComponents.json file in Notepad.
3. Find the latest service version in the file, and the download link for it. For example:

   "Name": "ASRMigrationWebApp", "DownloadLink":
   "https://download.microsoft.com/download/f/3/4/f34b2eb9-cc8d-4978-9ffbf-17321ad9b7ed/MicrosoftAzureApplianceConfigurationManager.msi", "Version": "6.0.211.2",
4. Download the latest version of an outdated service, using the download link in the file.

5. After downloading, run the following command in an administrator command window, to verify the integrity of the downloaded MSI.

   ```
   C:\>Get-FileHash -Path <file_location> -Algorithm [Hashing Algorithm] For example: C:>CertUtil -HashFile C:\Users\public\downloads\MicrosoftAzureApplianceConfigurationManager.MSI MD5
   ```

6. Check that the command output matches the hash value entry for the service in the file (for example, the MD5 hash value above).

7. Now, run the MSI to install the service. It’s a silent install, and the installation window closes after it’s done.

8. After installation is complete, check the version of the service in **Control panel > Programs and Features**. The service version should now be upgraded to the latest shown in the json file.

**Next steps**

- [Learn how](#) to set up the appliance for VMware.
- [Learn how](#) to set up the appliance for Hyper-V.
- [Learn how](#) to set up the appliance for physical servers.
This article describes the replication appliance used by Azure Migrate: Server Migration tool when migrating VMware VMs, physical machines, and private/public cloud VMs to Azure, using agent-based migration.

Overview

The replication appliance is deployed when you set up agent-based migration of VMware VMs or physical servers. It's deployed as a single on-premises machine, either as a VMware VM or a physical server. It runs:

- **Replication appliance**: The replication appliance coordinates communications, and manages data replication, for on-premises VMware VMs and physical servers replicating to Azure.
- **Process server**: The process server, which is installed by default on the replication appliance, and does the following:
  - **Replication gateway**: It acts as a replication gateway. It receives replication data from machines enabled for replication. It optimizes replication data with caching, compression, and encryption, and sends it to Azure.
  - **Agent installer**: Performs a push installation of the Mobility Service. This service must be installed and running on each on-premises machine that you want to replicate for migration.

Appliance deployment

<table>
<thead>
<tr>
<th>USED FOR</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware VM agent-based migration</td>
<td>You download OVA template from the Azure Migrate hub, and import to vCenter Server to create the appliance VM.</td>
</tr>
<tr>
<td>Physical machine agent-based migration</td>
<td>If you don't have a VMware infrastructure, or if you can't create a VMware VM using an OVA template, you download a software installer from the Azure Migrate hub, and run it to set up the appliance machine.</td>
</tr>
</tbody>
</table>

**NOTE**

If you're deploying in Azure Government, use the installation file to deploy the replication appliance.

Appliance requirements

When you set up the replication appliance using the OVA template provided in the Azure Migrate hub, the appliance runs Windows Server 2016 and complies with the support requirements. If you set up the replication appliance manually on a physical server, then make sure that it complies with the requirements.

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware VM appliance</td>
<td></td>
</tr>
<tr>
<td>PowerCLI</td>
<td>PowerCLI version 6.0 should be installed if the replication appliance is running on a VMware VM.</td>
</tr>
</tbody>
</table>
## Hardware settings

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>NIC type</td>
<td>VMXNET3 (if the appliance is a VMware VM)</td>
</tr>
<tr>
<td>CPU cores</td>
<td>8</td>
</tr>
<tr>
<td>RAM</td>
<td>16 GB</td>
</tr>
<tr>
<td>Number of disks</td>
<td>Three: The OS disk, process server cache disk, and retention drive.</td>
</tr>
<tr>
<td>Free disk space (cache)</td>
<td>600 GB</td>
</tr>
<tr>
<td>Free disk space (retention disk)</td>
<td>600 GB</td>
</tr>
</tbody>
</table>

## Software settings

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows Server 2016 or Windows Server 2012 R2</td>
</tr>
</tbody>
</table>
| License             | The appliance comes with a Windows Server 2016 evaluation license, which is valid for 180 days.  
|                     | If the evaluation period is close to expiry, we recommend that you download and deploy a new appliance, or that you activate the operating system license of the appliance VM. |
| Operating system locale | English (en-us)                                      |
| TLS                 | TLS 1.2 should be enabled.                                                 |
| .NET Framework      | .NET Framework 4.6 or later should be installed on the machine (with strong cryptography enabled). |
| MySQL               | MySQL should be installed on the appliance. MySQL should be installed. You can install manually, or Site Recovery can install it during appliance deployment. |
| Other apps          | Don't run other apps on the replication appliance.                        |
| Windows Server roles| Don't enable these roles:  
|                     | - Active Directory Domain Services  
|                     | - Internet Information Services  
|                     | - Hyper-V |
| Group policies      | Don't enable these group policies:  
|                     | - Prevent access to the command prompt.  
|                     | - Prevent access to registry editing tools.  
|                     | - Trust logic for file attachments.  
|                     | - Turn on Script Execution.  
|                     | Learn more |
MySQL installation

MySQL must be installed on the replication appliance machine. It can be installed using one of these methods.

<table>
<thead>
<tr>
<th>METHOD</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download and install manually</td>
<td>Download MySQL application &amp; place it in the folder C:\Temp\ASRSSetup, then install manually. When you set up the appliance MySQL will show as already installed.</td>
</tr>
<tr>
<td>Without online download</td>
<td>Place the MySQL installer application in the folder C:\Temp\ASRSSetup. When you install the appliance and click to download and install MySQL, setup will use the installer you added.</td>
</tr>
<tr>
<td>Download and install in Azure Migrate</td>
<td>When you install the appliance and are prompted for MySQL, select Download and install.</td>
</tr>
</tbody>
</table>

URL access

The replication appliance needs access to these URLs in the Azure public cloud.

<table>
<thead>
<tr>
<th>URL</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.backup.windowsazure.com</td>
<td>Used for replicated data transfer and coordination</td>
</tr>
<tr>
<td>*.store.core.windows.net</td>
<td>Used for replicated data transfer and coordination</td>
</tr>
<tr>
<td>*.blob.core.windows.net</td>
<td>Used to access storage account that stores replicated data</td>
</tr>
<tr>
<td>*.hypervrecoverymanager.windowsazure.com</td>
<td>Used for replication management operations and coordination</td>
</tr>
<tr>
<td><a href="https://management.azure.com">https://management.azure.com</a></td>
<td>Used for replication management operations and coordination</td>
</tr>
<tr>
<td>*.services.visualstudio.com</td>
<td>Used for telemetry purposes (It is optional)</td>
</tr>
<tr>
<td>URL</td>
<td>DETAILS</td>
</tr>
<tr>
<td>-------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>time.windows.com</td>
<td>Used to check time synchronization between system and global time.</td>
</tr>
<tr>
<td><a href="https://login.microsoftonline.com">https://login.microsoftonline.com</a></td>
<td>Appliance setup needs access to these URLs. They are used for access control and identity management by Azure Active Directory</td>
</tr>
<tr>
<td><a href="https://secure.aadcdn.microsoftonline-p.com">https://secure.aadcdn.microsoftonline-p.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://login.live.com">https://login.live.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://graph.windows.net">https://graph.windows.net</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://login.windows.net">https://login.windows.net</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://www.live.com">https://www.live.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://www.microsoft.com">https://www.microsoft.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://dev.mysql.com/get/Downloads/MySQLInstaller/mysql-">https://dev.mysql.com/get/Downloads/MySQLInstaller/mysql-</a></td>
<td>To complete MySQL download. In a few regions, the download might be redirected to the CDN URL. Ensure that the CDN URL is also allowed if needed.</td>
</tr>
<tr>
<td>installer-community-5.7.20.0.msi</td>
<td></td>
</tr>
</tbody>
</table>

**Azure Government URL access**

The replication appliance needs access to these URLs in Azure Government.

<table>
<thead>
<tr>
<th>URL</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.backup.windowsazure.us</td>
<td>Used for replicated data transfer and coordination</td>
</tr>
<tr>
<td>*.store.core.windows.net</td>
<td>Used for replicated data transfer and coordination</td>
</tr>
<tr>
<td>*.blob.core.windows.net</td>
<td>Used to access storage account that stores replicated data</td>
</tr>
<tr>
<td>*.hypervrecoverymanager.windowsazure.us</td>
<td>Used for replication management operations and coordination</td>
</tr>
<tr>
<td><a href="https://management.usgovcloudapi.net">https://management.usgovcloudapi.net</a></td>
<td>Used for replication management operations and coordination</td>
</tr>
<tr>
<td>*.services.visualstudio.com</td>
<td>Used for telemetry purposes (It is optional)</td>
</tr>
<tr>
<td>time.nist.gov</td>
<td>Used to check time synchronization between system and global time.</td>
</tr>
<tr>
<td><a href="https://login.microsoftonline.com">https://login.microsoftonline.com</a></td>
<td>Appliance setup with OVA needs access to these URLs. They are used for access control and identity management by Azure Active Directory.</td>
</tr>
<tr>
<td><a href="https://secure.aadcdn.microsoftonline-p.com">https://secure.aadcdn.microsoftonline-p.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://login.live.com">https://login.live.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://graph.windows.net">https://graph.windows.net</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://login.windows.net">https://login.windows.net</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://www.live.com">https://www.live.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://www.microsoft.com">https://www.microsoft.com</a></td>
<td></td>
</tr>
<tr>
<td><a href="https://dev.mysql.com/get/Downloads/MySQLInstaller/mysql-">https://dev.mysql.com/get/Downloads/MySQLInstaller/mysql-</a></td>
<td>To complete MySQL download. In a few regions, the download might be redirected to the CDN URL. Ensure that the CDN URL is also allowed if needed.</td>
</tr>
<tr>
<td>installer-community-5.7.20.0.msi</td>
<td></td>
</tr>
</tbody>
</table>

**Port access**

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>CONNECTION</th>
</tr>
</thead>
</table>
**Replication process**

1. When you enable replication for a VM, initial replication to Azure storage begins, using the specified replication policy.
2. Traffic replicates to Azure storage public endpoints over the internet. Replicating traffic over a site-to-site virtual private network (VPN) from an on-premises site to Azure isn't supported.
3. After initial replication finishes, delta replication begins. Tracked changes for a machine are logged.
4. Communication happens as follows:
   - VMs communicate with the replication appliance on port HTTPS 443 inbound, for replication management.
   - The replication appliance orchestrates replication with Azure over port HTTPS 443 outbound.
   - VMs send replication data to the process server (running on the replication appliance) on port HTTPS 9443 inbound. This port can be modified.
   - The process server receives replication data, optimizes, and encrypts it, and sends it to Azure storage over port 443 outbound.
5. The replication data logs first land in a cache storage account in Azure. These logs are processed and the data is stored in an Azure managed disk.
Appliance upgrades

The appliance is upgraded manually from the Azure Migrate hub. We recommend that you always run the latest version.

1. In Azure Migrate > Servers > Azure Migrate: Server Assessment, Infrastructure servers, click **Configuration servers**.
2. In **Configuration servers**, a link appears in **Agent Version** when a new version of the replication appliance is available.
3. Download the installer to the replication appliance machine, and install the upgrade. The installer detects the version current running on the appliance.

Next steps

- **Learn how** to set up the replication appliance for agent-based VMware VM migration.
- **Learn how** to set up the replication appliance for physical servers.
This article describes the Azure Migrate appliance architecture and processes. The Azure Migrate appliance is a lightweight appliance that's deployed on premises, to discover VMs and physical servers for migration to Azure.

Deployment scenarios

The Azure Migrate appliance is used in the following scenarios.

<table>
<thead>
<tr>
<th>SCENARIO</th>
<th>TOOL</th>
<th>USED FOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware VM migration (agentless)</td>
<td>Azure Migrate:Server Migration</td>
<td>Discover VMware VMs. Replicate VMware VMs with agentless migration.</td>
</tr>
<tr>
<td>Hyper-V VM assessment</td>
<td>Azure Migrate:Server Assessment</td>
<td>Discover Hyper-V VMs. Collect machine metadata and performance metadata and send to Azure.</td>
</tr>
</tbody>
</table>

Appliance components

The appliance has a number of components.

- **Management app**: This is a web app for user input during appliance deployment. Used when assessing machines for migration to Azure.
- **Discovery agent**: The agent gathers machine configuration data. Used when assessing machines for migration to Azure.
- **Assessment agent**: The agent collects performance data. Used when assessing machines for migration to Azure.
- **DRA agent**: Orchestrates VM replication, and coordinates communication between replicated machines and Azure. Used only when replicating VMware VMs to Azure using agentless migration.
- **Gateway**: Sends replicated data to Azure. Used only when replicating VMware VMs to Azure using agentless migration.
Appliance deployment

- The Azure Migrate appliance can be set up using a template for Hyper-V or VMware or using a PowerShell script installer for VMware/Hyper-V, and for physical servers.
- Appliance support requirements and deployment prerequisites are summarized in the appliance support matrix.

Appliance registration

During appliance setup, you register the appliance with Azure Migrate, and the actions summarized in the table occur.

<table>
<thead>
<tr>
<th>ACTION</th>
<th>DETAILS</th>
<th>PERMISSIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register source providers</td>
<td>These resources providers are registered in the subscription you choose during appliance setup: Microsoft.OfAz, Microsoft.Migrate and Microsoft.KeyVault.</td>
<td>To register the resource providers, you need a Contributor or Owner role on the subscription.</td>
</tr>
<tr>
<td></td>
<td>Registering a resource provider configures your subscription to work with the resource provider.</td>
<td></td>
</tr>
<tr>
<td>Create Azure AD app-communication</td>
<td>Azure Migrate creates an Azure Active Directory (Azure AD) app for communication (authentication and authorization) between the agents running on the appliance, and their respective services running on Azure.</td>
<td>You need these permissions for Azure Migrate to create the app.</td>
</tr>
<tr>
<td></td>
<td>This app does not have privileges to make Azure Resource Manager calls, or RBAC access on any resource.</td>
<td></td>
</tr>
<tr>
<td>Create Azure AD apps-Key vault</td>
<td>This app is created only for agentless migration of VMware VMs to Azure.</td>
<td>You need these permissions for Azure Migrate to create the app.</td>
</tr>
<tr>
<td></td>
<td>It's used exclusively to access the key vault created in the user's subscription for agentless migration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>It has RBAC access on the Azure key vault (created in customer's tenant), when discovery is initiated from the appliance.</td>
<td></td>
</tr>
</tbody>
</table>

Collected data

Data collected by the client for all deployment scenarios is summarized in the appliance support matrix.

Discovery and collection process
The appliance communicates with vCenter Servers and Hyper-V hosts/cluster using the following process.

1. **Start discovery:**
   - When you start the discovery on the Hyper-V appliance, it communicates with the Hyper-V hosts on WinRM ports 5985 (HTTP) and 5986 (HTTPS).
   - When you start discovery on the VMware appliance, it communicates with the vCenter server on TCP port 443 by default. If the vCenter server listens on a different port, you can configure it in the appliance web app.

2. **Gather metadata and performance data:**
   - The appliance uses a Common Information Model (CIM) session to gather Hyper-V VM data from the Hyper-V host on ports 5985 and 5986.
   - The appliance communicates with port 443 by default, to gather VMware VM data from the vCenter Server.

3. **Send data:** The appliance sends the collected data to Azure Migrate Server Assessment and Azure Migrate Server Migration over SSL port 443. The appliance can connect to Azure over the internet, or you can use ExpressRoute with public/Microsoft peering.
   - For performance data, the appliance collects real-time utilization data.
     - Performance data is collected every 20 seconds for VMware, and every 30 seconds for Hyper-V, for each performance metric.
     - The collected data is rolled up to create a single data point for 10 minutes.
     - The peak utilization value is selected from all of the 20/30-second data points, and sent to Azure for assessment calculation.
     - Based on the percentile value specified in the assessment properties (50th/90th/95th/99th), the ten-minute points are sorted in ascending order, and the appropriate percentile value is used to compute the assessment.
   - For Server Migration, the appliance starts collecting VM data, and replicates it to Azure.

4. **Assess and migrate:** You can now create assessments from the metadata collected by the appliance using Azure Migrate Server Assessment. In addition, you can also start migrating VMware VMs using Azure Migrate Server Migration to orchestrate agentless VM replication.
The appliance is upgraded as the Azure Migrate agents running on the appliance are updated. This happens automatically because auto-update is enabled on the appliance by default. You can change this default setting to update the agents manually.

You turn off auto-update in the registry by setting the
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\AzureAppliance "AutoUpdate" key to 0 (DWORD).

Next steps

Review the appliance support matrix.
This article provides an overview of the architecture and processes used when you migrate Hyper-V VMs with the Azure Migrate Server Migration tool.

**Azure Migrate** provides a central hub to track discovery, assessment, and migration of your on-premises apps and workloads, and private/public cloud VMs, to Azure. The hub provides Azure Migrate tools for assessment and migration, as well as third-party independent software vendor (ISV) offerings.

### Agentless migration

The Azure Migrate Server Migration tool provides agentless replication for on-premises Hyper-V VMs, using a migration workflow that's optimized for Hyper-V. You install a software agent only on Hyper-V hosts or cluster nodes. Nothing needs to be installed on Hyper-V VMs.

### Server Migration and Azure Site Recovery

Azure Migrate Server Migration is a tool for migrating on-premises workloads, and cloud-based VMs, to Azure. Site Recovery is a disaster recovery tool. The tools share some common technology components used for data replication, but serve different purposes.

### Architectural components

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>DEPLOYMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication provider</td>
<td>The Microsoft Azure Site Recovery provider is installed on Hyper-V hosts, and registered with Azure Migration Server Migration.</td>
</tr>
<tr>
<td></td>
<td>The provider orchestrates replication for Hyper-V VMs.</td>
</tr>
</tbody>
</table>
Recovery Services agent

The Microsoft Azure Recovery Service agent handles data replication. It works with the provider to replicate data from Hyper-V VMs to Azure. The replicated data is uploaded to a storage account in your Azure subscription. The Server Migration tool processes the replicated data, and applies it to replica disks in the subscription. The replica disks are used to create the Azure VMs when you migrate.

- Components are installed by a single setup file, downloaded from Azure Migrate Server Migration in the portal.
- The provider and appliance use outbound HTTPS port 443 connections to communicate with Azure Migrate Server Migration.
- Communications from the provider and agent are secure and encrypted.

Replication process

1. When you enable replication for a Hyper-V VM, initial replication begins.
2. A Hyper-V VM snapshot is taken.
3. VHDS on the VM are replicated one-by-one, until they’re all copied to Azure. Initial replication time depends on the VM size, and network bandwidth.
4. Disk changes that occur during initial replication are tracked using Hyper-V Replica, and stored in log files (hrl files).
   - Log files are in the same folder as the disks.
   - Each disk has an associated hrl file that’s sent to secondary storage.
   - The snapshot and log files consume disk resources while initial replication is in progress.
5. After initial replication finishes, the VM snapshot is deleted, and delta replication begins.
6. Incremental disk changes are tracked in hrl files. Replication logs are periodically uploaded to an Azure storage account by the Recovery Services agent.

Performance and scaling

Replication performance for Hyper-V is influenced by factors that include VM size, the data change rate (churn) of the VMs, available space on the Hyper-V host for log file storage, upload bandwidth for replication data, and target storage in Azure.

- If you’re replicating multiple machines at the same time, use the Azure Site Recovery Deployment Planner for Hyper-V, to help optimize replication.
- Plan your Hyper-V replication, and distribute replication over Azure storage accounts, in accordance with capacity.

Control upload throughput

You can limit the amount of bandwidth used to upload data to Azure on each Hyper-V host. Be careful. If you set the values too low it will adversely impact replication, and delay migration.

1. Sign in to the Hyper-V host or cluster node.
2. Run `C:\Program Files\Microsoft Azure Recovery Services Agent\bin\wabadmin.msc`, to open the Windows Azure Backup MMC snap-in.
3. In the snap-in, select Change Properties.
4. In Throttling, select Enable internet bandwidth usage throttling for backup operations. Set the limits for work and non-work hours. Valid ranges are from 512 Kbps to 1,023 Mbps.
**Influence upload efficiency**

If you have spare bandwidth for replication, and want to increase uploads, you can increase the number of threads allocated for the upload task, as follows:

1. Open the registry with Regedit.
2. Navigate to key `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows Azure Backup\Replication\UploadThreadsPerVM`
3. Increase the value for the number of threads used for data upload for each replicating VM. The default value is 4 and the max value is 32.

**Next steps**

Try out [Hyper-V migration](https://example.com) using Azure Migrate Server Migration.
This article provides an overview of the architecture and processes used for agent-based replication of VMware VMs with the Azure Migrate: Server Migration tool.

Using Azure Migrate: Server Migration, you can replicate VMware VMs with a couple of options:

- Migrate VMs using agent-based replication, as described in this article.
- Migrate VMware VMs using agentless replication. This migrates VMs without needing to install anything on them.

Learn more about selecting and comparing migration methods for VMware VMs.

**Agent-based migration**

Agent-based migration is used to migrate on-premises VMware VMs and physical servers to Azure. It can also be used to migrate other on-premises virtualized servers, as well as private and public cloud VMs, including AWS instances, and GCP VMs. Agent-based migration in Azure Migrate uses some backend functionality from the Azure Site Recovery service.

**Architectural components**

The diagram illustrates the components involved in agent-based migration.

The table summarizes the components used for agent-based migration.

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>DETAILS</th>
<th>INSTALLATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication appliance</td>
<td>Used for centralized management</td>
<td></td>
</tr>
<tr>
<td>Source: VMware VMs / non-virtualized machines</td>
<td>Public Internet or ExpressRoute with Microsoft Peering</td>
<td></td>
</tr>
<tr>
<td>Replication appliance - configuration server</td>
<td>Used for caching, compression, and encryption</td>
<td></td>
</tr>
<tr>
<td>Replication appliance - process server</td>
<td>Mobility Service captures all data writes from memory</td>
<td></td>
</tr>
<tr>
<td>COMPONENT</td>
<td>DETAILS</td>
<td>INSTALLATION</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Replication appliance</td>
<td>The replication appliance (configuration server/process server) is an on-premises machine that acts as a bridge between the on-premises environment, and Server Migration. The appliance discovers the on-premises machine inventory, so that Server Migration can orchestrate replication and migration. The appliance has two components: <strong>Configuration server</strong>: Connects to Server Migration and coordinates replication. <strong>Process server</strong>: Handles data replication. The process server receives machine data, compresses and encrypts it, and sends to Azure. In Azure, Server Migration writes the data to managed disks.</td>
<td>By default the process server is installed together with the configuration server on the replication appliance.</td>
</tr>
<tr>
<td>Mobility service</td>
<td>The Mobility service is an agent installed on each machine you want to replicate and migrate. It sends replication data from the machine to the process server.</td>
<td>Installation files for different versions of the Mobility service are located on the replication appliance. You download and install the agent you need, in accordance with the operating system and version of the machine you want to replicate.</td>
</tr>
</tbody>
</table>

**Mobility service installation**

You can deploy the Mobility Service using the following methods:

- **Push installation**: The Mobility service is installed by the process server when you enable protection for a machine.
- **Install manually**: You can install the Mobility service manually on each machine through UI or command prompt.

The Mobility service communicates with the replication appliance and replicated machines. If you have antivirus software running on the replication appliance, process servers, or machines being replicated, the following folders should be excluded from scanning:

- `C:\Program Files\Microsoft Azure Recovery Services Agent`
- `C:\ProgramData\ASR`
- `C:\ProgramData\ASRLogs`
- `C:\ProgramData\ASRSetupLogs`
- `C:\ProgramData\LogUploadServiceLogs`
- `C:\ProgramData\Microsoft Azure Site Recovery`
- `C:\Program Files (x86)\Microsoft Azure Site Recovery`
- `C:\ProgramData\ASR\agent` (on Windows machines with the Mobility service installed)

**Replication process**

1. When you enable replication for a machine, initial replication to Azure begins.
2. During initial replication, the Mobility service reads data from the machine disks, and sends it to the process server.
3. This data is used to seed a copy of the disk in your Azure subscription.

4. After initial replication finishes, replication of delta changes to Azure begins. Replication is block-level, and near-continuous.

5. The Mobility service intercepts writes to disk memory, by integrating with the storage subsystem of the operating system. This method avoids disk I/O operations on the replicating machine, for incremental replication.

6. Tracked changes for a machine are sent to the process server on inbound port HTTPS 9443. This port can be modified. The process server compresses and encrypts it, and sends it to Azure.

### Ports

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>CONNECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replicating machines</td>
<td>The Mobility service running on VMs communicates with the on-premises replication appliance on port HTTPS 443 inbound, for replication management. Machines send replication data to the process server on port HTTPS 9443 inbound. This port can be modified.</td>
</tr>
<tr>
<td>Replication appliance</td>
<td>The replication appliance orchestrates replication with Azure over port HTTPS 443 outbound.</td>
</tr>
<tr>
<td>Process server</td>
<td>The process server receives replication data, optimizes and encrypts it, and sends it to Azure storage over port 443 outbound.</td>
</tr>
</tbody>
</table>

### Performance and scaling

By default, you deploy a single replication appliance that runs both the configuration server and the process server. If you're only replicating a few machines, this deployment is sufficient. However, if you're replicating and migrating hundreds of machines, a single process server might not be able to handle all the replication traffic. In this case, you can deploy additional, scale-out process servers.

**Plan VMware deployment**

If you're replicating VMware VMs, you can use the [Site Recovery Deployment Planner for VMware](#), to help determine performance requirements, including the daily data change rate, and the process servers you need.

**Replication appliance capacity**

Use the values in this table to figure out whether you need an additional process server in your deployment.

- If your daily change rate (churn rate) is over 2 TB, deploy an additional process server.
- If you're replicating more than 200 machines, deploy an additional replication appliance.

<table>
<thead>
<tr>
<th>CPU</th>
<th>MEMORY</th>
<th>FREE SPACE-DATA CACHING</th>
<th>CHURN RATE</th>
<th>REPLICATION LIMITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 vCPUs (2 sockets * 4 cores @ 2.5 GHz)</td>
<td>16 GB</td>
<td>300 GB</td>
<td>500 GB or less</td>
<td>&lt; 100 machines</td>
</tr>
<tr>
<td>12 vCPUs (2 sockets * 6 cores @ 2.5 GHz)</td>
<td>18 GB</td>
<td>600 GB</td>
<td>501 GB to 1 TB</td>
<td>100-150 machines.</td>
</tr>
</tbody>
</table>
Sizing scale-out process servers

If you need to deploy a scale-out process server, use this table to figure out server sizing.

<table>
<thead>
<tr>
<th>PROCESS SERVER</th>
<th>FREE SPACE FOR DATA CACHING</th>
<th>CHURN RATE</th>
<th>REPLICATION LIMITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 vCPUs (2 sockets * 2 cores @ 2.5 GHz), 8-GB memory</td>
<td>300 GB</td>
<td>250 GB or less</td>
<td>Up to 85 machines</td>
</tr>
<tr>
<td>8 vCPUs (2 sockets * 4 cores @ 2.5 GHz), 12-GB memory</td>
<td>600 GB</td>
<td>251 GB to 1 TB</td>
<td>86-150 machines</td>
</tr>
<tr>
<td>12 vCPUs (2 sockets * 6 cores @ 2.5 GHz), 24-GB memory</td>
<td>1 TB</td>
<td>1-2 TB</td>
<td>151-225 machines</td>
</tr>
</tbody>
</table>

Throttle upload bandwidth.

VMware traffic that replicates to Azure goes through a specific process server. You can limit upload throughput by throttling bandwidth on the machines that are running as process servers. You can influence bandwidth using this registry key:

- The HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows Azure Backup\Replication\UploadThreadsPerVM registry value specifies the number of threads that are used for data transfer (initial or delta replication) of a disk. A higher value increases the network bandwidth that’s used for replication. The default value is four. The maximum value is 32. Monitor traffic to optimize the value.

- In addition, you can throttle bandwidth on the process server machine as follows:
  1. On the process server machine, open the Azure Backup MMC snap-in. There’s a shortcut on the desktop or in the folder C:\Program Files\Microsoft Azure Recovery Services Agent\bin.
  2. In the snap-in, select Change Properties.
  3. In Throttling, select Enable internet bandwidth usage throttling for backup operations. Set the limits for work and non-work hours. Valid ranges are from 512 Kbps to 1,023 Mbps.

Next steps

Try out agent-based migration for VMware or physical servers.
This article provides an overview of assessments in the Azure Migrate: Server Assessment tool. The tool can assess on-premises VMware virtual machines, Hyper-V VMs, and physical servers for migration to Azure.

What's an assessment?

An assessment with the Server Assessment tool measures the readiness and estimates the effect of migrating on-premises servers to Azure.

### Types of assessments

Assessments you create with Server Assessment are a point-in-time snapshot of data. Server Assessment provides two types of assessments.

<table>
<thead>
<tr>
<th>ASSESSMENT TYPE</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance-based</td>
<td>Assessments that make recommendations based on collected performance data</td>
<td>The VM size recommendation is based on CPU and RAM-utilization data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The disk-type recommendation is based on the input/output operations per second (IOPS) and throughput of the on-premises disks. Disk types are Azure Standard HDD, Azure Standard SSD, and Azure Premium disks.</td>
</tr>
<tr>
<td>As-is on-premises</td>
<td>Assessments that don't use performance data to make recommendations</td>
<td>The VM size recommendation is based on the on-premises VM size.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The recommended disk type is based on the selected storage type for the assessment.</td>
</tr>
</tbody>
</table>

How do I run an assessment?

There are a couple of ways to run an assessment.

- Assess machines by using server metadata collected by a lightweight Azure Migrate appliance. The appliance discovers on-premises machines. It then sends machine metadata and performance data to Azure Migrate.
- Assess machines by using server metadata that's imported in a comma-separated values (CSV) format.

How do I assess with the appliance?

If you're deploying an Azure Migrate appliance to discover on-premises servers, do the following steps:
1. Set up Azure and your on-premises environment to work with Server Assessment.
2. For your first assessment, create an Azure project and add the Server Assessment tool to it.
3. Deploy a lightweight Azure Migrate appliance. The appliance continuously discovers on-premises machines and sends machine metadata and performance data to Azure Migrate. Deploy the appliance as a VM or a physical machine. You don't need to install anything on machines that you want to assess.

After the appliance begins machine discovery, you can gather machines you want to assess into a group and run an assessment for the group.

Follow our tutorials for **VMware**, **Hyper-V**, or **physical servers** to try out these steps.

### How do I assess with imported data?

If you're assessing servers by using a CSV file, you don't need an appliance. Instead, do the following steps:

1. Set up Azure to work with Server Assessment.
2. For your first assessment, create an Azure project and add the Server Assessment tool to it.
3. Download a CSV template and add server data to it.
4. Import the template into Server Assessment.
5. Discover servers added with the import, gather them into a group, and run an assessment for the group.

### What data does the appliance collect?

If you're using the Azure Migrate appliance for assessment, learn about the metadata and performance data that's collected for **VMware** and **Hyper-V**.

### How does the appliance calculate performance data?

If you use the appliance for discovery, it collects performance data for compute settings with these steps:

1. The appliance collects a real-time sample point.
   - **VMware VMs**: A sample point is collected every 20 seconds.
   - **Hyper-V VMs**: A sample point is collected every 30 seconds.
   - **Physical servers**: A sample point is collected every five minutes.
2. The appliance combines the sample points to create a single data point every 10 minutes. To create the data point, the appliance selects the peak values from all samples. It then sends the data point to Azure.
3. Server Assessment stores all the 10-minute data points for the last month.
4. When you create an assessment, Server Assessment identifies the appropriate data point to use for rightsizing. Identification is based on the percentile values for **performance history** and **percentile utilization**.
   - For example, if the performance history is one week and the percentile utilization is the 95th percentile, Server Assessment sorts the 10-minute sample points for the last week. It sorts them in ascending order and picks the 95th percentile value for rightsizing.
   - The 95th percentile value makes sure you ignore any outliers, which might be included if you picked the 99th percentile.
   - If you want to pick the peak usage for the period and don't want to miss any outliers, select the 99th percentile for percentile utilization.
5. This value is multiplied by the comfort factor to get the effective performance utilization data for these metrics that the appliance collects:
   - CPU utilization
How are assessments calculated?

Server Assessment uses the on-premises machines’ metadata and performance data to calculate assessments. If you deploy the Azure Migrate appliance, assessment uses the data the appliance collects. But if you run an assessment imported using a CSV file, you provide the metadata for the calculation.

Calculations occur in these three stages:

1. **Calculate Azure readiness**: Assess whether machines are suitable for migration to Azure.
2. **Calculate sizing recommendations**: Estimate compute, storage, and network sizing.
3. **Calculate monthly costs**: Calculate the estimated monthly compute and storage costs for running the machines in Azure after migration.

Calculations are in the preceding order. A machine server moves to a later stage only if it passes the previous one. For example, if a server fails the Azure readiness stage, it’s marked as unsuitable for Azure. Sizing and cost calculations aren’t done for that server.

What’s in an assessment?

Here’s what’s included in an assessment in Server Assessment:

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target location</td>
<td>The location to which you want to migrate. Server Assessment currently supports these target Azure regions: Australia East, Australia Southeast, Brazil South, Canada Central, Canada East, Central India, Central US, China East, China North, East Asia, East US, East US 2, Germany Central, Germany Northeast, Japan East, Japan West, Korea Central, Korea South, North Central US, North Europe, South Central US, Southeast Asia, South India, UK South, UK West, US Gov Arizona, US Gov Texas, US Gov Virginia, West Central US, West Europe, West India, West US, and West US 2.</td>
</tr>
<tr>
<td>Target storage disk (as-is sizing)</td>
<td>The type of disk to use for storage in Azure. Specify the target storage disk as Premium-managed, Standard SSD-managed, or Standard HDD-managed.</td>
</tr>
<tr>
<td>PROPERTY</td>
<td>DETAILS</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Target storage disk (performance-based sizing)</td>
<td>Specifies the type of target storage disk as automatic, Premium-managed, Standard HDD-managed, or Standard SSD-managed.</td>
</tr>
<tr>
<td></td>
<td><strong>Automatic</strong>: The disk recommendation is based on the performance data of the disks, meaning the IOPS and throughput.</td>
</tr>
<tr>
<td></td>
<td><strong>Premium or Standard</strong>: The assessment recommends a disk SKU within the storage type selected.</td>
</tr>
<tr>
<td></td>
<td>If you want a single-instance VM service-level agreement (SLA) of 99.9%, consider using Premium-managed disks. This use ensures that all disks in the assessment are recommended as Premium-managed disks.</td>
</tr>
<tr>
<td></td>
<td>Azure Migrate supports only managed disks for migration assessment.</td>
</tr>
<tr>
<td>Azure Reserved Virtual Machine Instances</td>
<td>Specifies reserved instances so that cost estimations in the assessment take them into account.</td>
</tr>
<tr>
<td></td>
<td>Azure Migrate currently supports Azure Reserved VM Instances only for pay-as-you-go offers.</td>
</tr>
<tr>
<td>Sizing criteria</td>
<td>Used to rightszie the Azure VM.</td>
</tr>
<tr>
<td></td>
<td>Use as-is sizing or performance-based sizing.</td>
</tr>
<tr>
<td>Performance history</td>
<td>Used with performance-based sizing. Performance history specifies the duration used when performance data is evaluated.</td>
</tr>
<tr>
<td>Percentile utilization</td>
<td>Used with performance-based sizing. Percentile utilization specifies the percentile value of the performance sample used for rightsizing.</td>
</tr>
<tr>
<td>VM series</td>
<td>The Azure VM series that you want to consider for rightsizing. For example, if you don't have a production environment that needs A-series VMs in Azure, you can exclude A-series from the list of series.</td>
</tr>
<tr>
<td>Comfort factor</td>
<td>The buffer used during assessment. It's applied to the CPU, RAM, disk, and network utilization data for VMs. It accounts for issues like seasonal usage, short performance history, and likely increases in future usage.</td>
</tr>
<tr>
<td></td>
<td>For example, a 10-core VM with 20% utilization normally results in a two-core VM. With a comfort factor of 2.0, the result is a four-core VM instead.</td>
</tr>
<tr>
<td>Offer</td>
<td>The Azure offer in which you're enrolled. Server Assessment estimates the cost for that offer.</td>
</tr>
<tr>
<td>Currency</td>
<td>The billing currency for your account.</td>
</tr>
</tbody>
</table>
Discount (%)  
Any subscription-specific discounts you receive on top of the Azure offer. The default setting is 0%.

VM uptime  
The duration in days per month and hours per day for Azure VMs that won't run continuously. Cost estimates are based on that duration. 
The default values are 31 days per month and 24 hours per day.

Azure Hybrid Benefit  
Specifies whether you have software assurance and are eligible for Azure Hybrid Benefit. If the setting has the default value “Yes,” Azure prices for operating systems other than Windows are considered for Windows VMs.

Review the best practices for creating an assessment with Server Assessment.

Calculate readiness

Not all machines are suitable to run in Azure. Server Assessment assesses all on-premises machines and assigns them a readiness category.

- **Ready for Azure**: The machine can be migrated as-is to Azure without any changes. It will start in Azure with full Azure support.
- **Conditionally ready for Azure**: The machine might start in Azure but might not have full Azure support. For example, Azure doesn't support a machine that's running an old version of Windows Server. You must be careful before you migrate these machines to Azure. To fix any readiness problems, follow the remediation guidance the assessment suggests.
- **Not ready for Azure**: The machine won't start in Azure. For example, if an on-premises machine's disk stores more than 64 TB, Azure can't host the machine. Follow the remediation guidance to fix the problem before migration.
- **Readiness unknown**: Azure Migrate can't determine the readiness of the machine because of insufficient metadata.

To calculate readiness, Server Assessment reviews the machine properties and operating system settings summarized in the following tables.

**Machine properties**

Server Assessment reviews the following properties of an on-premises VM to determine whether it can run on Azure.

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>DETAILS</th>
<th>AZURE READINESS STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot type</td>
<td>Azure supports VMs with a boot type of BIOS, not UEFI.</td>
<td>Conditionally ready if the boot type is UEFI</td>
</tr>
<tr>
<td>PROPERTY</td>
<td>DETAILS</td>
<td>AZURE READINESS STATUS</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Cores</td>
<td>Each machine must have no more than 128 cores, which is the maximum number an Azure VM supports. If performance history is available, Azure Migrate considers the utilized cores for comparison. If the assessment settings specify a comfort factor, the number of utilized cores is multiplied by the comfort factor. If there's no performance history, Azure Migrate uses the allocated cores without applying the comfort factor.</td>
<td>Ready if the number of cores is within the limit</td>
</tr>
<tr>
<td>RAM</td>
<td>Each machine must have no more than 3,892 GB of RAM, which is the maximum size an Azure M-series Standard M128m2 VM supports. Learn more. If performance history is available, Azure Migrate considers the utilized RAM for comparison. If a comfort factor is specified, the utilized RAM is multiplied by the comfort factor. If there's no history, the allocated RAM is used without application of a comfort factor.</td>
<td>Ready if the amount of RAM is within the limit</td>
</tr>
<tr>
<td>Storage disk</td>
<td>The allocated size of a disk must be no more than 32 TB. Although Azure supports 64-TB disks with Azure Ultra SSD disks, Azure Migrate: Server Assessment currently checks for 32 TB as the disk-size limit because it doesn't support Ultra SSD yet. The number of disks attached to the machine, including the OS disk, must be 65 or fewer.</td>
<td>Ready if the disk size and number are within the limits</td>
</tr>
<tr>
<td>Networking</td>
<td>A machine must have no more than 32 network interfaces (NICs) attached to it.</td>
<td>Ready if the number of NICs is within the limit</td>
</tr>
</tbody>
</table>

**Guest operating system**

Along with reviewing VM properties, Server Assessment looks at the guest operating system of a machine to determine whether it can run on Azure.

**NOTE**

To handle guest analysis for VMware VMs, Server Assessment uses the operating system specified for the VM in vCenter Server. For Linux VMs running on VMware, Server Assessment currently doesn't identify the kernel version of the guest OS.

Server Assessment uses the following logic to identify Azure readiness based on the operating system:
<table>
<thead>
<tr>
<th>OPERATING SYSTEM</th>
<th>DETAILS</th>
<th>AZURE READINESS STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2016 and all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure.</td>
</tr>
<tr>
<td>Windows Server 2012 R2 and all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure.</td>
</tr>
<tr>
<td>Windows Server 2012 and all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure.</td>
</tr>
<tr>
<td>Windows Server 2008 R2 with all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure.</td>
</tr>
<tr>
<td>Windows Server 2003 and Windows Server 2003 R2</td>
<td>These operating systems have passed their end-of-support dates and need a Custom Support Agreement (CSA) for support in Azure.</td>
<td>Conditionally ready for Azure. Consider upgrading the OS before migrating to Azure.</td>
</tr>
<tr>
<td>Windows 2000, Windows 98, Windows 95, Windows NT, Windows 3.1, and MS-DOS</td>
<td>These operating systems have passed their end-of-support dates. The machine might start in Azure, but Azure provides no OS support.</td>
<td>Conditionally ready for Azure. We recommend that you upgrade the OS before migrating to Azure.</td>
</tr>
<tr>
<td>Windows Vista and Windows XP Professional</td>
<td>These operating systems have passed their end-of-support dates. The machine might start in Azure, but Azure provides no OS support.</td>
<td>Conditionally ready for Azure. We recommend that you upgrade the OS before migrating to Azure.</td>
</tr>
<tr>
<td>Linux</td>
<td>See the Linux operating systems that Azure endorses. Other Linux operating systems might start in Azure. But we recommend that you upgrade the OS to an endorsed version before you migrate to Azure.</td>
<td>Ready for Azure if the version is endorsed. Conditionally ready if the version isn't endorsed.</td>
</tr>
<tr>
<td>Other operating systems like Oracle Solaris, Apple macOS, and FreeBSD</td>
<td>Azure doesn't endorse these operating systems. The machine might start in Azure, but Azure provides no OS support.</td>
<td>Conditionally ready for Azure. We recommend that you install a supported OS before migrating to Azure.</td>
</tr>
<tr>
<td>OS specified as Other in vCenter Server</td>
<td>Azure Migrate can't identify the OS in this case.</td>
<td>Unknown readiness. Ensure that Azure supports the OS running inside the VM.</td>
</tr>
<tr>
<td>32-bit operating systems</td>
<td>The machine might start in Azure, but Azure might not provide full support.</td>
<td>Conditionally ready for Azure. Consider upgrading to a 64-bit OS before migrating to Azure.</td>
</tr>
</tbody>
</table>

**Calculating sizing**

After the machine is marked as ready for Azure, Server Assessment makes sizing recommendations. These
recommendations identify the Azure VM and disk SKU. Sizing calculations depend on whether you're using as-is on-premises sizing or performance-based sizing.

**Calculate sizing (as-is on-premises)**

If you use as-is on-premises sizing, Server Assessment doesn't consider the performance history of the VMs and disks.

- **Compute sizing:** Server Assessment allocates an Azure VM SKU based on the size allocated on-premises.
- **Storage and disk sizing:** Server Assessment looks at the storage type specified in assessment properties and recommends the appropriate disk type. Possible storage types are Standard HDD, Standard SSD, and Premium. The default storage type is Premium.
- **Network sizing:** Server Assessment considers the network adapter on the on-premises machine.

**Calculate sizing (performance-based)**

If you use performance-based sizing, Server Assessment makes sizing recommendations as follows:

- Server Assessment considers the performance history of the machine to identify the VM size and disk type in Azure.
- If you import servers by using a CSV file, the values you specify are used. This method is especially helpful if you've overallocated the on-premises machine, utilization is low, and you want to rightszie the Azure VM to save costs.
- If you don't want to use the performance data, reset the sizing criteria to as-is on-premises, as described in the previous section.

**Calculate storage sizing**

For storage sizing, Azure Migrate tries to map each disk that is attached to the machine to an Azure disk. Sizing works as follows:

1. Server Assessment adds the read and write IOPS of a disk to get the total IOPS required. Similarly, it adds the read and write throughput values to get the total throughput of each disk.
2. If you've specified the storage type as automatic, the selected type is based on the effective IOPS and throughput values. Server Assessment determines whether to map the disk to a Standard HDD, Standard SSD, or Premium disk in Azure. If the storage type is set to one of those disk types, Server Assessment tries to find a disk SKU within the storage type selected.
3. Disks are selected as follows:
   - If Server Assessment can't find a disk with the required IOPS and throughput, it marks the machine as unsuitable for Azure.
   - If Server Assessment finds a set of suitable disks, it selects the disks that support the location specified in the assessment settings.
   - If there are multiple eligible disks, Server Assessment selects the disk with the lowest cost.
   - If performance data for any disk is unavailable, the configuration disk size is used to find a Standard SSD disk in Azure.

**Calculate network sizing**

Server Assessment tries to find an Azure VM that supports the number and required performance of network adapters attached to the on-premises machine.

- To get the effective network performance of the on-premises VM, Server Assessment aggregates the data transmission rate out of the machine (network out) across all network adapters. It then applies the comfort factor. It uses the resulting value to find an Azure VM that can support the required network performance.
- Along with network performance, Server Assessment also considers whether the Azure VM can support the required number of network adapters.
- If network performance data is unavailable, Server Assessment considers only the network adapter count for VM sizing.
Calculate compute sizing

After it calculates storage and network requirements, Server Assessment considers CPU and RAM requirements to find a suitable VM size in Azure.

- Azure Migrate looks at the effective utilized cores and RAM to find a suitable Azure VM size.
- If no suitable size is found, the machine is marked as unsuitable for Azure.
- If a suitable size is found, Azure Migrate applies the storage and networking calculations. It then applies location and pricing-tier settings for the final VM size recommendation.
- If there are multiple eligible Azure VM sizes, the one with the lowest cost is recommended.

Confidence ratings (performance-based)

Each performance-based assessment in Azure Migrate is associated with a confidence rating. The rating ranges from one (lowest) to five (highest) stars. The confidence rating helps you estimate the reliability of the size recommendations Azure Migrate provides.

- The confidence rating is assigned to an assessment. The rating is based on the availability of data points that are needed to compute the assessment.
- For performance-based sizing, Server Assessment needs:
  - The utilization data for CPU and VM RAM.
  - The disk IOPS and throughput data for every disk attached to the VM.
  - The network I/O to handle performance-based sizing for each network adapter attached to a VM.

If any of these utilization numbers isn't available, the size recommendations might be unreliable.

**NOTE**

Confidence ratings aren't assigned for servers assessed using an imported CSV file. Ratings also aren't applicable for as-is on-premises assessment.

### Ratings

This table shows the assessment confidence ratings, which depend on the percentage of available data points:

<table>
<thead>
<tr>
<th>AVAILABILITY OF DATA POINTS</th>
<th>CONFIDENCE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-20%</td>
<td>1 star</td>
</tr>
<tr>
<td>21-40%</td>
<td>2 stars</td>
</tr>
<tr>
<td>41-60%</td>
<td>3 stars</td>
</tr>
<tr>
<td>61-80%</td>
<td>4 stars</td>
</tr>
<tr>
<td>81-100%</td>
<td>5 stars</td>
</tr>
</tbody>
</table>

**Low confidence ratings**

Here are a few reasons why an assessment could get a low confidence rating:

- You didn't profile your environment for the duration for which you're creating the assessment. For example, if you create the assessment with performance duration set to one day, you must wait at least a day after you start discovery for all the data points to get collected.
- Some VMs were shut down during the time for which the assessment was calculated. If any VMs are turned off for some duration, Server Assessment can't collect the performance data for that period.
• Some VMs were created during the time for which the assessment was calculated. For example, assume you created an assessment for the performance history of the last month, but some VMs were created only a week ago. The performance history of the new VMs won’t exist for the complete duration.

**NOTE**
If the confidence rating of any assessment is less than five stars, we recommend that you wait at least a day for the appliance to profile the environment and then recalculate the assessment. Otherwise, performance-based sizing might be unreliable. In that case, we recommend that you switch the assessment to on-premises sizing.

**Calculate monthly costs**

After sizing recommendations are complete, Azure Migrate calculates compute and storage costs for after migration.

• **Compute cost**: Azure Migrate uses the recommended Azure VM size and the Azure Billing API to calculate the monthly cost for the VM.

  The calculation takes into account the:
  - Operating system
  - Software assurance
  - Reserved instances
  - VM uptime
  - Location
  - Currency settings

  Server Assessment aggregates the cost across all machines to calculate the total monthly compute cost.

• **Storage cost**: The monthly storage cost for a machine is calculated by aggregating the monthly cost of all disks that are attached to the machine.

  Server Assessment calculates the total monthly storage costs by aggregating the storage costs of all machines. Currently, the calculation doesn’t consider offers specified in the assessment settings.

Costs are displayed in the currency specified in the assessment settings.

**Next steps**

Review best practices for creating assessments.

• Learn about running assessments for **VMware VMs**, **Hyper-V VMs**, and **physical servers**.
• Learn about assessing servers **imported with a CSV file**.
• Learn about setting up **dependency visualization**.
Best practices for creating assessments

11/19/2019 • 4 minutes to read • Edit Online

Azure Migrate provides a hub of tools that help you to discover, assess, and migrate apps, infrastructure, and workloads to Microsoft Azure. The hub includes Azure Migrate tools, and third-party independent software vendor (ISV) offerings.

This article summarizes best practices when creating assessments using the Azure Migrate Server Assessment tool.

About assessments

Assessments you create with Azure Migrate Server Assessment are a point-in-time snapshot of data. There are two types of assessments in Azure Migrate.

<table>
<thead>
<tr>
<th>ASSESSMENT TYPE</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance-based</td>
<td>Assessments that make recommendations based on collected performance data</td>
<td>VM size recommendation is based on CPU and memory utilization data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disk type recommendation (standard HDD/SSD or premium-managed disks) is based on the IOPS and throughput of the on-premises disks.</td>
</tr>
<tr>
<td>As-is on-premises</td>
<td>Assessments that don't use performance data to make recommendations.</td>
<td>VM size recommendation is based on the on-premises VM size.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The recommended disk type is based on what you select in the storage type setting for the assessment.</td>
</tr>
</tbody>
</table>

Example

As an example, if you have an on-premises VM with four cores at 20% utilization, and memory of 8 GB with 10% utilization, the assessments will be as follows:

- **Performance-based assessment:**
  - Identifies effective cores and memory based on core (4 x 0.20 = 0.8), and memory (8 GB x 0.10 = 0.8) utilization.
  - Applies the comfort factor specified in assessment properties (let's say 1.3x) to get the values to be used for sizing.
  - Recommends the nearest VM size in Azure that can support ~1.04 cores (0.8 x 1.3) and ~1.04 GB (0.8 x 1.3) memory.

- **As-is (as on-premises) assessment:**
  - Recommends a VM with four cores; 8 GB of memory.

Best practices for creating assessments

The Azure Migrate appliance continuously profiles your on-premises environment, and sends metadata and performance data to Azure. Follow these best practices for assessments of servers discovered using an appliance:
• **Create as-is assessments**: You can create as-is assessments immediately once your machines show up in the Azure Migrate portal.

• **Create performance-based assessment**: After setting up discovery, we recommend that you wait at least a day before running a performance-based assessment:
  - Collecting performance data takes time. Waiting at least a day ensures that there are enough performance data points before you run the assessment.
  - When you're running performance-based assessments, make sure you profile your environment for the assessment duration. For example, if you create an assessment with a performance duration set to one week, you need to wait for at least a week after you start discovery, for all the data points to be collected. If you don't, the assessment won't get a five-star rating.

• **Recalculate assessments**: Since assessments are point-in-time snapshots, they aren't automatically updated with the latest data. To update an assessment with the latest data, you need to recalculate it.

Follow these best practices for assessments of servers imported into Azure Migrate via .CSV file:

• **Create as-is assessments**: You can create as-is assessments immediately once your machines show up in the Azure Migrate portal.

• **Create performance-based assessment**: This helps to get a better cost estimate, especially if you have overprovisioned server capacity on-premises. However, the accuracy of the performance-based assessment depends on the performance data specified by you for the servers.

• **Recalculate assessments**: Since assessments are point-in-time snapshots, they aren't automatically updated with the latest data. To update an assessment with the latest data, you need to recalculate it.

**Best practices for confidence ratings**

When you run performance-based assessments, a confidence rating from 1-star (lowest) to 5-star (highest) is awarded to the assessment. To use confidence ratings effectively:

• Azure Migrate Server Assessment needs the utilization data for VM CPU/Memory.
• For each disk attached to the on-premises VM, it needs the read/write IOPS/throughput data.
• For each network adapter attached to the VM, it needs the network in/out data.

Depending on the percentage of data points available for the selected duration, the confidence rating for an assessment is provided as summarized in the following table.

<table>
<thead>
<tr>
<th>DATA POINT AVAILABILITY</th>
<th>CONFIDENCE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%-20%</td>
<td>1 Star</td>
</tr>
<tr>
<td>21%-40%</td>
<td>2 Star</td>
</tr>
<tr>
<td>41%-60%</td>
<td>3 Star</td>
</tr>
<tr>
<td>61%-80%</td>
<td>4 Star</td>
</tr>
<tr>
<td>81%-100%</td>
<td>5 Star</td>
</tr>
</tbody>
</table>

**Common assessment issues**

Here's how to address some common environment issues that affect assessments.

**Out-of-sync assessments**

If you add or remove machines from a group after you create an assessment, the assessment you created will be
Outdated assessments

If there are on-premises changes to VMs that are in a group that’s been assessed, the assessment is marked **outdated**. To reflect the changes, run the assessment again.

Low confidence rating

An assessment might not have all the data points for a number of reasons:

- You did not profile your environment for the duration for which you are creating the assessment. For example, if you are creating a **performance-based assessment** with performance duration set to one week, you need to wait for at least a week after you start the discovery for all the data points to get collected. You can always click on **Recalculate** to see the latest applicable confidence rating. Confidence rating is applicable only when you create a **performance-based** assessment.

- Few VMs were shut down during the period for which the assessment is calculated. If some VMs were powered off for some duration, Server Assessment will not be able to collect the performance data for that period.

- Few VMs were created after discovery in Server Assessment had started. For example, if you are creating an assessment for the performance history of last one month, but few VMs were created in the environment only a week ago. In this case, the performance data for the new VMs will not be available for the entire duration and the confidence rating would be low.

Next steps

- Learn how assessments are calculated.
- Learn how to customize an assessment.
This article describes dependency analysis in Azure Migrate: Server Assessment.

Overview

Dependency analysis helps you to identify dependencies between on-premises machines that you want to assess and migrate to Azure.

- In Azure Migrate: Server Assessment, you gather machines into a group, and then assess the group. Dependency analysis helps you to group machines more accurately, with high confidence for assessment.
- Dependency analysis enables you to identify machines that must be migrated together. You can identify whether machines are in use, or if they can be decommissioned instead of migrated.
- Analyzing dependencies helps ensure that nothing is left behind, and avoid surprise outages during migration.
- Analysis is especially useful if you're not sure whether machines are part of an app deployment that you want to migrate to Azure.
- Review common questions about dependency analysis.

There are two options for deploying dependency analysis

- **Agent-based**: Agent-based dependency analysis requires agents to be installed on each on-premises machine that you want to analyze.
- **Agentless**: With agentless analysis, you don’t need to install agents on machines you want to cross-check. This option is currently in preview, and is only available for VMware VMs.

Agent-based dependency analysis isn’t available in Azure Government. You can use agentless dependency analysis.

Agentless analysis

Agentless dependency analysis works by capturing TCP connection data from machines for which it’s enabled. No agents are installed on machines you want to analyze.

**Collected data**

After dependency discovery starts, the appliance polls data from machines every five minutes to gather data. This data is collected from guest VMs via vCenter Server, using vSphere APIs. The gathered data is processed on the Azure Migrate appliance, to deduce identity information, and is sent to Azure Migrate every six hours.

Polling gathers this data from machines:

- Name of processes that have active connections.
- Name of application that run processes that have active connections.
- Destination port on the active connections.

Agent-based analysis

For agent-based analysis, Server Assessment uses the Service Map solution in Azure Monitor to enable
dependency visualization and analysis. The Microsoft Monitoring Agent/Log Analytics agent and the Dependency agent, must be installed on each machine you want to analyze.

**Collected data**

For agent-based analysis, the following data is collected:

- Source machine server name, process, application name.
- Destination machine server name, process, application name, and port.
- Number of connections, latency, and data transfer information are gathered and available for Log Analytics queries.

**Compare agentless and agent-based**

The differences between agentless visualization and agent-based visualization are summarized in the table.

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>AGENTLESS</th>
<th>AGENT-BASED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support</td>
<td>This option is currently in preview, and is only available for VMware VMs. Review supported operating systems.</td>
<td>In general availability (GA).</td>
</tr>
<tr>
<td>Agent</td>
<td>No need to install agents on machines you want to cross-check.</td>
<td>Agents to be installed on each on-premises machine that you want to analyze: The Microsoft Monitoring agent (MMA), and the Dependency agent.</td>
</tr>
<tr>
<td>Log Analytics</td>
<td>Not required.</td>
<td>Azure Migrate uses the Service Map solution in Azure Monitor logs for dependency analysis.</td>
</tr>
<tr>
<td>How it works</td>
<td>Captures TCP connection data on machines enabled for dependency visualization. After discovery, it gathers data at intervals of five minutes.</td>
<td>Service Map agents installed on a machine gather data about TCP processes and inbound/outbound connections for each process.</td>
</tr>
<tr>
<td>Data</td>
<td>Source machine server name, process, application name.</td>
<td>Source machine server name, process, application name.</td>
</tr>
<tr>
<td></td>
<td>Destination machine server name, process, application name, and port.</td>
<td>Destination machine server name, process, application name, and port.</td>
</tr>
<tr>
<td></td>
<td>Number of connections, latency, and data transfer information are gathered and available for Log Analytics queries.</td>
<td></td>
</tr>
<tr>
<td>Visualization</td>
<td>Dependency map of single server can be viewed over a duration of one hour to 30 days.</td>
<td>Dependency map of a single server. Map can be viewed over an hour only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dependency map of a group of servers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Add and remove servers in a group from the map view.</td>
</tr>
<tr>
<td>Data export</td>
<td>Can't currently be downloaded in tabular format.</td>
<td>Data can be queried with Log Analytics.</td>
</tr>
</tbody>
</table>
Next steps

- Review the requirements for setting up agent-based analysis for VMware VMs, physical servers, and Hyper-V VMs.
- Review the requirements for agentless analysis of VMware VMs.
- Set up agent-based dependency visualization
- Try out agentless dependency visualization for VMware VMs.
- Review common questions about dependency visualization.
This article describes how to create, manage, and delete Azure Migrate projects.

Create a project for the first time

The first time you set up Azure Migrate, you create a project and add an assessment or migration tool. Follow these instructions to set up for the first time.

Create additional projects

If you already have an Azure Migrate project and you want to create an additional project, do the following:

1. In the Azure public portal or Azure Government, search for Azure Migrate.

2. On the Azure Migrate dashboard > Servers, select change in the upper-right corner.

3. To create a new project, select click here.

Find a project
Find a project as follows:

1. In the Azure portal, search for Azure Migrate.

2. In the Azure Migrate dashboard > Servers, select change in the upper-right corner.

3. Select the appropriate subscription and Azure Migrate project.

If you created the project in the previous version of Azure Migrate, find it as follows:

1. In the Azure portal, search for Azure Migrate.

2. In the Azure Migrate dashboard, if you’ve created a project in the previous version, a banner referencing older projects appears. Select the banner.

3. Review the list of old projects.

Delete a project

Delete as follows:

1. Open the Azure resource group in which the project was created.

2. In the resource group page, select Show hidden types.

3. Select the migrate project you want to delete, and its associated resources.
   - The resource type is Microsoft.Migrate/migrateprojects.
   - If the resource group is exclusively used by the Azure Migrate project, you can delete the entire resource group.

Note that:

- When you delete, both the project and the metadata about discovered machines are deleted.
- If you’re using the older version of Azure Migrate, open the Azure resource group in which the project was created. Select the migrate project you want to delete (the resource type is Migration project).
If you're using dependency analysis with an Azure Log Analytics workspace:

- If you've attached a Log Analytics workspace to the Server Assessment tool, the workspace isn't automatically deleted. The same Log Analytics workspace can be used for multiple scenarios.
- If you want to delete the Log Analytics workspace, do that manually.

**Delete a workspace manually**

1. Browse to the Log Analytics workspace attached to the project.

   - If you haven't deleted the Azure Migrate project, you can find the link to the workspace in **Essentials > Server Assessment**.

2. Follow the instructions to delete the workspace.

**Next steps**

Add assessment or migration tools to Azure Migrate projects.
This article describes how to add an assessment or migration tool to an Azure Migrate project for the first time. Azure Migrate provides a central hub to track discovery, assessment and migration of your on-premises apps and workloads, and private/public cloud VMs, to Azure. The hub provides Azure Migrate tools for assessment and migration, as well as other tools and independent software vendor (ISV) offerings.

Create a project and add a tool

Set up a new Azure Migrate project in an Azure subscription, and add a tool.

- An Azure Migrate project is used to store discovery, assessment, and migration metadata collected from the environment you’re assessing or migrating.
- In a project you can track discovered assets, and orchestrate assessment, and migration.

1. In the Azure portal > All services, search for Azure Migrate.
2. Under Services, select Azure Migrate.

3. In Overview, click Assess and migrate servers.
4. Under Discover, assess and migrate servers, click Assess and migrate servers.
5. In Discover, assess and migrate servers, click Add tools.

6. In Migrate project, select your Azure subscription, and create a resource group if you don’t have one.

7. In Project Details, specify the project name, and geography in which you want to create the project. Review supported geographies for public and government clouds.

<table>
<thead>
<tr>
<th>Add a tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migrate project Select assessment tool Select migration tool Review + add tool(s)</td>
</tr>
<tr>
<td>A migrate project is used to store the discovery, assessment and migration metadata reported by your on-premises environment. Select a subscription and resource group in your preferred geography to create the migrate project.</td>
</tr>
<tr>
<td>Subscription</td>
</tr>
<tr>
<td>Resource group</td>
</tr>
<tr>
<td>ContosoCorporation</td>
</tr>
<tr>
<td>Create new</td>
</tr>
</tbody>
</table>

**PROJECT DETAILS**
Specify the name of the migrate project and the preferred geography.

- Migrate project
  - Contoso-project
- Region
  - (Asia Pacific) Southeast Asia

- The geography specified for the project is only used to store the metadata gathered from on-premises VMs. You can select any target region for the actual migration.

- If you need to deploy a project within a specific region in a geography, use the following API to create a project. Specify the subscription ID, resource group name, and project name, along with the location. Review the geographies/regions for public and government clouds.

  ```
  PUT /subscriptions/<subid>/resourceGroups/<rg>/providers/Microsoft.Migrate/MigrateProjects/<mymigrateprojectname>?
  api-version=2018-09-01-preview "{location: 'centralus', properties: {}}"
  ```

8. Click Next, and add an assessment or migration tool.

**NOTE**
When you create a project you need to add at least one assessment or migration tool.

9. In Select assessment tool, add an assessment tool. If you don’t need an assessment tool, select Skip adding an assessment tool for now > Next.
10. In **Select migration tool**, add a migration tool as required. If you don’t need a migration tool right now, select **Skip adding a migration tool for now > Next**.

11. In **Review + add tools**, review the settings, and click **Add tools**.

After creating the project, you can select additional tools for assessment and migration of servers and workloads, databases, and web apps.

**Create additional projects**

In some circumstances, you might need to create additional Azure Migrate projects. For example if you have datacenters in different geographies, or you need to store metadata in a different geography. Create an additional project as follows:

1. In the current Azure Migrate project, click **Servers** or **Databases**.
2. In the top right-hand corner, click **Change** next to the current project name.
3. In **Settings**, select **Click here to create a new project**.
4. Create a new project and add a new tool as described in the previous procedure.

**Next steps**

Learn how to add additional **assessment** and **migration** tools.
This article describes how to add assessment tools in Azure Migrate.

Azure Migrate provides a hub of tools for assessment and migration to Azure. It includes Azure Migrate tools, as well as other tools and independent software vendor (ISV) offerings.

If you want to add an assessment tool and you don’t yet have an Azure Migrate project, follow this article.

**Select a tool**

If you choose a non-Azure Migrate tool for assessment, start by obtaining a license, or signing up for a free trial, in accordance with the tool policy. Tools have an option to connect to Azure Migrate. Follow the instructions and documentation, to connect the tool to Azure Migrate. Learn more about tools.

**Select an assessment scenario**

1. In the Azure Migrate project, click **Overview**.

2. Select the assessment scenario you want to use:
   - To discover and assess machines and workloads for migration to Azure, select **Assess and migrate servers**.
   - To assess on-premises SQL machines, select **Assess and migrate databases**.
   - To assess on-premises web apps, select **Assess and migrate web apps**.

   ![Assessment Options](image)

3. In **Azure Migrate**, select the assessment tool you want to use.

   **NOTE**
   If you need to navigate to a different project, in **Azure Migrate - Servers**, next to **See details for a different migrate project**, click Click here.
Select a database assessment tool
1. Click Assess and migrate databases
2. In Databases, click Add tools.
3. In Add a tool > Select assessment tool, select the tool you want to use to assess your database.

Select a web app assessment tool
1. Click Assess and migrate web apps.
2. Follow the link to the Migration tool for the Azure App Service. Use the migration tool to:
   - **Assess apps online**: You can assess apps with a public URL online, using the Azure App Service Migration Assistant.
   - **.NET/PHP**: For internal .NET and PHP apps, you can download and run the Migration Assistant.

Next steps
Try out an assess using Azure Migrate Server Assessment for VMware VMs, Hyper-V, or physical servers
Follow this article to set up the Azure Migrate appliance for assessment with the Azure Migrate:Server Assessment tool, and for agentless migration using the Azure Migrate:Server Migration tool.

The Azure Migrate appliance is a lightweight appliance used by Azure Migrate:Server Assessment and Server Migration to discover on-premises VMware VMs, send VM metadata/performance data to Azure, and for replication of VMware VMs during agentless migration.

You can deploy the appliance using a couple of methods:

- Set up on a VMware VM using a downloaded OVA template. This is the method described in this article.
- Set up on a VMware VM or physical machine with a PowerShell installer script. This method should be used if you can't set up a VM using an OVA template, or if you're in Azure government.

After creating the appliance, you check that it can connect to Azure Migrate:Server Assessment, configure it for the first time, and register it with the Azure Migrate project.

**Appliance deployment (OVA)**

To set up the appliance using an OVA template you:

- Download an OVA template file, and import it to vCenter Server.
- Create the appliance, and check that it can connect to Azure Migrate Server Assessment.
- Configure the appliance for the first time, and register it with the Azure Migrate project.

**Download the OVA template**

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.
2. In Discover machines > Are your machines virtualized?, click Yes, with VMware vSphere hypervisor.
3. Click Download to download the .OVA template file.

**Verify security**
Check that the OVA file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.
2. Run the following command, to generate the hash for the OVA:
   ```
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   ```
   Example usage: `C:\>CertUtil -HashFile C:\AzureMigrate\AzureMigrate.ova SHA256`
3. For the latest appliance version, the generated hash should match these settings.

Create the appliance VM

Import the downloaded file, and create a VM.

1. In the vSphere Client console, click File > Deploy OVF Template.

![Image of vSphere Client with Deploy OVF Template highlighted.

2. In the Deploy OVF Template Wizard > Source, specify the location of the OVA file.
3. In Name and Location, specify a friendly name for the VM. Select the inventory object in which the VM will be hosted.
4. In Host/Cluster, specify the host or cluster on which the VM will run.
5. In Storage, specify the storage destination for the VM.
6. In Disk Format, specify the disk type and size.
7. In Network Mapping, specify the network to which the VM will connect. The network needs internet connectivity, to send metadata to Azure Migrate Server Assessment.
8. Review and confirm the settings, then click Finish.

Verify appliance access to Azure

Make sure that the appliance VM can connect to Azure URLs for public and government clouds.

Configure the appliance

Set up the appliance for the first time. If you deploy the appliance using a script instead of an OVA template, the first two steps in the procedure aren't applicable.

1. In the vSphere Client console, right-click the VM > Open Console.
2. Provide the language, time zone, and password for the appliance.
3. Open a browser on any machine that can connect to the VM, and open the URL of the appliance web app: `https://appliance name or IP address: 44368`.
   Alternately, you can open the app from the appliance desktop by clicking the app shortcut.
4. In the web app > Set up prerequisites, do the following:
   - License: Accept the license terms, and read the third-party information.
   - Connectivity: The app checks that the VM has internet access. If the VM uses a proxy:
     - Click Proxy settings, and specify the proxy address and listening port, in the form
http://ProxyIPAddress or http://ProxyFQDN.
- Specify credentials if the proxy needs authentication.
- Only HTTP proxy is supported.
- **Time sync**: Time is verified. The time on the appliance should be in sync with internet time for discovery to work properly.
- **Install updates**: Azure Migrate checks that the latest appliance updates are installed.
- **Install VDDK**: Azure Migrate checks that the VMWare vSphere Virtual Disk Development Kit (VDDK) is installed.
  - Azure Migrate uses the VDDK to replicate machines during migration to Azure.
  - Download VDDK 6.7 from VMware, and extract the downloaded zip contents to the specified location on the appliance.

Register the appliance with Azure Migrate

1. Click Log In. If it doesn’t appear, make sure you’ve disabled the pop-up blocker in the browser.
2. On the new tab, sign in using your Azure credentials.
   - Sign in with your username and password.
   - Sign in with a PIN isn’t supported.
3. After successfully signing in, go back to the web app.
4. Select the subscription in which the Azure Migrate project was created. Then select the project.
5. Specify a name for the appliance. The name should be alphanumeric with 14 characters or less.
6. Click Register.

Start continuous discovery by providing vCenter Server and VM credential

The appliance needs to connect to vCenter Server to discover the configuration and performance data of the VMs.

**Specify vCenter Server details**

1. In **Specify vCenter Server details**, specify the name (FQDN) or IP address of the vCenter Server. You can leave the default port, or specify a custom port on which your vCenter Server listens.
2. In **User name** and **Password**, specify the read-only account credentials that the appliance will use to discover VMs on the vCenter server. You can scope the discovery by limiting access to the vCenter account.
   - [Learn more]
3. Click **Validate connection** to make sure that the appliance can connect to vCenter Server.

**Specify VM credentials**

For discovery of applications, roles and features and visualizing dependencies of the VMs, you can provide a VM credential that has access to the VMware VMs. You can add one credential for Windows VMs and one credential for Linux VMs. [Learn more] about the access privileges needed.

   ```markdown
   #NOTE
   This input is optional and is needed to enable application discovery and agentless dependency visualization.
   ```

1. In **Discover applications and dependencies on VMs**, click **Add credentials**.
2. Select the **Operating System**.
3. Provide a friendly name for the credential.
4. In **Username** and **Password**, specify an account that has at least guest access on the VMs.
5. Click **Add**.

Once you have specified the vCenter Server and VM credentials (optional), click **Save and start discovery** to start discovery of the on-premises environment.

It takes around 15 minutes for metadata of discovered VMs to appear in the portal. Discovery of installed applications, roles, and features takes some time, the duration depends on the number of VMs being discovered. For 500 VMs, it takes approximately 1 hour for the application inventory to appear in the Azure Migrate portal.

**Next steps**

Review the tutorials for **VMware assessment** and **agentless migration**.
Follow this article to set up the Azure Migrate appliance for assessment of Hyper-V VMs with the Azure Migrate:Server Assessment tool.

The Azure Migrate appliance is a lightweight appliance used by Azure Migrate:Server Assessment/Migration to discover on-premises Hyper-V VMs, and send VM metadata/performance data to Azure.

You can deploy the appliance using a couple of methods:

- Set up on a Hyper-V VM using a downloaded VHD. This is the method described in this article.
- Set up on a Hyper-V VM or physical machine with a PowerShell installer script. This method should be used if you can't set up a VM using a VHD, or if you're in Azure Government.

After creating the appliance, you check that it can connect to Azure Migrate:Server Assessment, configure it for the first time, and register it with the Azure Migrate project.

**Appliance deployment (VHD)**

To set up the appliance using a VHD template:

- Download a compressed Hyper-V VHD from the Azure portal.
- Create the appliance, and check that it can connect to Azure Migrate Server Assessment.
- Configure the appliance for the first time, and register it with the Azure Migrate project.

**Download the VHD**

Download the zipped VHD template for the appliance.

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.
2. In Discover machines > Are your machines virtualized?, click Yes, with Hyper-V.
3. Click Download to download the VHD file.

**Verify security**

Check that the zipped file is secure, before you deploy it.
1. On the machine to which you downloaded the file, open an administrator command window.

2. Run the following command to generate the hash for the VHD

   - `C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   - Example usage: `C:\>CertUtil -HashFile C:\AzureMigrate\AzureMigrate.vhd SHA256`

3. For appliance version 2.19.11.12, the generated hash should match these settings.

Create the appliance VM

Import the downloaded file, and create the VM.

1. Extract the zipped VHD file to a folder on the Hyper-V host that will host the appliance VM. Three folders are extracted.


![Import Virtual Machine](image)

3. In the Import Virtual Machine Wizard > Before you begin, click Next.

4. In Locate Folder, specify the folder containing the extracted VHD. Then click Next.

5. In Select Virtual Machine, click Next.

6. In Choose Import Type, click Copy the virtual machine (create a new unique ID). Then click Next.

7. In Choose Destination, leave the default setting. Click Next.

8. In Storage Folders, leave the default setting. Click Next.

9. In Choose Network, specify the virtual switch that the VM will use. The switch needs internet connectivity to send data to Azure.

10. In Summary, review the settings. Then click Finish.

11. In Hyper-V Manager > Virtual Machines, start the VM.

   **Verify appliance access to Azure**

   Make sure that the appliance VM can connect to Azure URLs for public and government clouds.

Configure the appliance

Set up the appliance for the first time. If you deploy the appliance using a script instead of a VHD, the first two steps in the procedure aren't applicable.

1. In Hyper-V Manager > Virtual Machines, right-click the VM > Connect.
2. Provide the language, time zone, and password for the appliance.

3. Open a browser on any machine that can connect to the VM, and open the URL of the appliance web app:  
   https://appliance name or IP address: 44368.

   Alternately, you can open the app from the appliance desktop by clicking the app shortcut.

4. In the web app > Set up prerequisites, do the following:
   
   - **License:** Accept the license terms, and read the third-party information.
   - **Connectivity:** The app checks that the VM has internet access. If the VM uses a proxy:
     - Click **Proxy settings**, and specify the proxy address and listening port, in the form http://ProxyIPAddress or http://ProxyFQDN.
     - Specify credentials if the proxy needs authentication.
     - Only HTTP proxy is supported.
   - **Time sync:** Time is verified. The time on the appliance should be in sync with internet time for VM discovery to work properly.
   - **Install updates:** Azure Migrate Server Assessment checks that the appliance has the latest updates installed.

**Register the appliance with Azure Migrate**

1. Click **Log In**. If it doesn't appear, make sure you've disabled the pop-up blocker in the browser.
2. On the new tab, sign in using your Azure credentials.
   - Sign in with your username and password.
   - Sign-in with a PIN isn't supported.
3. After successfully signing in, go back to the web app.
4. Select the subscription in which the Azure Migrate project was created. Then select the project.
5. Specify a name for the appliance. The name should be alphanumeric with 14 characters or less.
6. Click **Register**.

**Delegate credentials for SMB VHDs**

If you're running VHDs on SMBs, you must enable delegation of credentials from the appliance to the Hyper-V hosts. To do this from the appliance:

1. On the appliance VM, run this command. HyperVHost1/HyperVHost2 are example host names.

   ```
   Enable-WSManCredSSP -Role Client -DelegateComputer HyperVHost1.contoso.com HyperVHost2.contoso.com -Force
   ```

2. Alternatively, do this in the Local Group Policy Editor on the appliance:

   - In **Local Computer Policy > Computer Configuration**, click **Administrative Templates > System > Credentials Delegation**.
   - Double-click **Allow delegating fresh credentials**, and select **Enabled**.
   - In **Options**, click **Show**, and add each Hyper-V host you want to discover to the list, with **wsman/** as a prefix.
   - In **Credentials Delegation**, double-click **Allow delegating fresh credentials with NTLM-only server authentication**. Again, add each Hyper-V host you want to discover to the list, with **wsman/** as a prefix.

**Start continuous discovery**

Connect from the appliance to Hyper-V hosts or clusters, and start VM discovery.
1. In **User name** and **Password**, specify the account credentials that the appliance will use to discover VMs. Specify a friendly name for the credentials, and click **Save details**.
2. Click **Add host**, and specify Hyper-V host/cluster details.
3. Click **Validate**. After validation, the number of VMs that can be discovered on each host/cluster is shown.
   - If validation fails for a host, review the error by hovering over the icon in the **Status** column. Fix issues, and validate again.
   - To remove hosts or clusters, select > **Delete**.
   - You can't remove a specific host from a cluster. You can only remove the entire cluster.
   - You can add a cluster, even if there are issues with specific hosts in the cluster.
4. After validation, click **Save and start discovery** to start the discovery process.

This starts discovery. It takes around 15 minutes for metadata of discovered VMs to appear in the Azure portal.

### Verify VMs in the portal

After discovery finishes, you can verify that the VMs appear in the portal.

1. Open the Azure Migrate dashboard.
2. In **Azure Migrate - Servers** > **Azure Migrate: Server Assessment** page, click the icon that displays the count for **Discovered servers**.

### Next steps

Try out **Hyper-V assessment** with Azure Migrate Server Assessment.
Follow this article to create an Azure Migrate appliance for the assessment/migration of VMware VMs, and Hyper-V VMs. You run a script to create an appliance, and verify that it can connect to Azure.

You can deploy the appliance for VMware and Hyper-V VMs using a script, or using a template that you download from the Azure portal. Using a script is useful if you’re unable to create a VM using the downloaded template.

- To use a template, follow the tutorials for VMware or Hyper-V.
- To set up an appliance for physical servers, you can only use a script. Follow this article.
- To set up an appliance in an Azure Government cloud, follow this article.

**Prerequisites**

The script sets up the Azure Migrate appliance on an existing physical machine or VM.

- The machine that will act as the appliance must be running Windows Server 2016, with 32 GB of memory, eight vCPUs, around 80 GB of disk storage, and an external virtual switch. It requires a static or dynamic IP address, and access to the internet.
- Before you deploy the appliance, review detailed appliance requirements for VMware VMs, Hyper-V VMs, and physical servers.
- Don’t run the script on an existing Azure Migrate appliance.

**Set up the appliance for VMware**

To set up the appliance for VMware you download a zipped file from the Azure portal, and extract the contents. You run the PowerShell script to launch the appliance web app. You set up the appliance and configure it for the first time. Then, you register the appliance with the Azure Migrate project.

**Download the script**

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.
2. In Discover machines > Are your machines virtualized?, select Yes, with VMWare vSphere hypervisor.
3. Click Download, to download the zipped file.

**Verify file security**

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.
2. Run the following command to generate the hash for the zipped file

   ```
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   Example: C:\>CertUtil -HashFile C:\Users\administrator\Desktop\AzureMigrateInstaller.zip SHA256
   ```
3. Verify the generated hash value. For the latest appliance version:

<table>
<thead>
<tr>
<th>ALGORITHM</th>
<th>HASH VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHA256</td>
<td>0b2c4f...</td>
</tr>
</tbody>
</table>

   - Don’t run the script on an existing Azure Migrate appliance.
Run the script

Here's what the script does:

- Installs agents and a web application.
- Installs Windows roles, including Windows Activation Service, IIS, and PowerShell ISE.
- Downloads and installs an IIS rewritable module. Learn more.
- Updates a registry key (HKLM), with persistent settings for Azure Migrate.
- Creates log and configuration files as follows:
  - **Config Files**: %ProgramData%\Microsoft Azure\Config
  - **Log Files**: %ProgramData%\Microsoft Azure\Logs

To run the script:

1. Extract the zipped file to a folder on the machine that will host the appliance. Make sure you don’t run the script on a machine on an existing Azure Migrate appliance.

2. Launch PowerShell on the machine, with administrator (elevated) privileges.

3. Change the PowerShell directory to the folder containing the contents extracted from the downloaded zipped file.

4. Run the script `AzureMigrateInstaller.ps1`, as follows:

   ```powershell
   PS C:\Users\administrator\Desktop\AzureMigrateInstaller> AzureMigrateInstaller.ps1 -scenario VMware
   ``-

5. After the script runs successfully, it launches the appliance web application so that you can set up the appliance. If you encounter any issues, review the script logs at C:\ProgramData\Microsoft Azure\Logs\AzureMigrateScenarioInstaller_Timestamp.log.

Verify access

Make sure that the appliance can connect to Azure URLs for the public cloud.

Set up the appliance for Hyper-V

To set up the appliance for Hyper-V you download a zipped file from the Azure portal, and extract the contents. You run the PowerShell script to launch the appliance web app. You set up the appliance and configure it for the first time. Then, you register the appliance with the Azure Migrate project.

Download the script

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.

2. In Discover machines > Are your machines virtualized?, select Yes, with Hyper-V.

3. Click Download, to download the zipped file.

Verify file security

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.

2. Run the following command to generate the hash for the zipped file:
**Run the script**

Here’s what the script does:

- Installs agents and a web application.
- Installs Windows roles, including Windows Activation Service, IIS, and PowerShell ISE.
- Downloads and installs an IIS rewritable module. [Learn more.](#)
- Updates a registry key (HKLM), with persistent settings for Azure Migrate.
- Creates log and configuration files as follows:
  - **Config Files**: `%ProgramData%\Microsoft Azure\Config`
  - **Log Files**: `%ProgramData%\Microsoft Azure\Logs`

To run the script:

1. Extract the zipped file to a folder on the machine that will host the appliance. Make sure you don’t run the script on a machine on an existing Azure Migrate appliance.
2. Launch PowerShell on the machine, with administrator (elevated) privileges.
3. Change the PowerShell directory to the folder containing the contents extracted from the downloaded zipped file.
4. Run the script `AzureMigrateInstaller.ps1`, as follows:
   ```powershell
   PS C:\Users\administrator\Desktop>AzureMigrateInstaller> AzureMigrateInstaller.ps1 -scenario Hyperv
   ```
5. After the script runs successfully, it launches the appliance web application so that you can set up the appliance. If you encounter any issues, review the script logs at `C:\ProgramData\Microsoft Azure\Logs\AzureMigrateScenarioInstaller_Timestamp.log`.

**Verify access**

Make sure that the appliance can connect to Azure URLs for the public cloud.

**Next steps**

After deploying the appliance, you need to configure it for the first time, and register it with the Azure Migrate project.

- Set up the appliance for [VMware](#).
- Set up the appliance for [Hyper-V](#).

---

**Verify access**

Make sure that the appliance can connect to Azure URLs for the public cloud.

**Next steps**

After deploying the appliance, you need to configure it for the first time, and register it with the Azure Migrate project.

- Set up the appliance for [VMware](#).
- Set up the appliance for [Hyper-V](#).
This article describes how to set up the Azure Migrate appliance if you're assessing physical servers with the Azure Migrate: Server Assessment tool.

The Azure Migrate appliance is a lightweight appliance, used by Azure Migrate Server Assessment to do the following:

- Discover on-premises servers.
- Send metadata and performance data for discovered servers to Azure Migrate Server Assessment.

Learn more about the Azure Migrate appliance.

Appliance deployment steps

To set up the appliance you:

- Download a zipped file with Azure Migrate installer script from the Azure portal.
- Extract the contents from the zipped file. Launch the PowerShell console with administrative privileges.
- Execute the PowerShell script to launch the appliance web application.
- Configure the appliance for the first time, and register it with the Azure Migrate project.

Download the installer script

Download the zipped file for the appliance.

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.
2. In Discover machines > Are your machines virtualized?, click Not virtualized/Other.
3. Click Download to download the zipped file.
Verify security

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.

2. Run the following command to generate the hash for the zipped file:

   - Download Azure Migrate appliance
     The Azure Migrate appliance enables you to discover your on-premises machines. Use this PowerShell script to set up the appliance. Download the zipped folder to proceed.
     
     Download zip file, 50MB

   - Run the script to set up the appliance
     Before you start, ensure these prerequisites are met. Run the script to deploy the appliance configuration manager either on a virtual machine or a physical server.

   - Configure the appliance and start discovery from web browser
     Access the appliance configuration UI from your browser by going to the IP address of the machine (in your network). Complete the process to initiate the discovery.

3. Verify hash values:

   - For the public cloud (for the latest appliance version):

     | ALGORITHM | HASH VALUE |
     |-----------|------------|
     | MD5       | e92ede387c03bd148e56a708cdd33f |
     | SHA256    | a3fa78edc88aff9ab56e6be1b64e66de7b9f475b6542beef114b20b7f235c |

   - For Azure government (for the latest appliance version):

     | ALGORITHM | HASH VALUE |
     |-----------|------------|
     | MD5       | f81c155fca109901c5a948713913f |
Run the Azure Migrate installer script

The installer script does the following:

- Installs agents and a web application for physical server discovery and assessment.
- Install Windows roles, including Windows Activation Service, IIS, and PowerShell ISE.
- Download and installs an IIS rewritable module. Learn more.
- Updates a registry key (HKLM) with persistent setting details for Azure Migrate.
- Creates the following files under the path:
  - **Config Files**: %Programdata%\Microsoft Azure\Config
  - **Log Files**: %Programdata%\Microsoft Azure\Logs

Run the script as follows:

1. Extract the zipped file to a folder on the server that will host the appliance. Make sure you don’t run the script on a machine on an existing Azure Migrate appliance.
2. Launch PowerShell on the above server with administrative (elevated) privilege.
3. Change the PowerShell directory to the folder where the contents have been extracted from the downloaded zipped file.
4. Run the script named **AzureMigrateInstaller.ps1** by running the following command:
   - For the public cloud:
     ```powershell
     PS C:\Users\administrator\Desktop\AzureMigrateInstaller> AzureMigrateInstaller.ps1
     ```
   - For Azure Government:
     ```powershell
     PS C:\Users\Administrators\Desktop\AzureMigrateInstaller-Server-USGov>AzureMigrateInstaller.ps1
     ```
     The script will launch the appliance web application when it finishes successfully.

If you come across any issues, you can access the script logs at C:\ProgramData\Microsoft Azure\Logs\AzureMigrateScenarioInstaller_Timestamp.log for troubleshooting.

**Verify appliance access to Azure**

Make sure that the appliance VM can connect to Azure URLs for **public** and **government** clouds.

**Configure the appliance**

Set up the appliance for the first time.

1. Open a browser on any machine that can connect to the VM, and open the URL of the appliance web app:
   - **https://appliance name or IP address: 44368**.
   Alternately, you can open the app from the desktop by clicking the app shortcut.
2. In the web app > **Set up prerequisites**, do the following:
   - **License**: Accept the license terms, and read the third-party information.
   - **Connectivity**: The app checks that the VM has internet access. If the VM uses a proxy:
     - Click **Proxy settings**, and specify the proxy address and listening port, in the form http://ProxyIPAddress or http://ProxyFQDN.
     - Specify credentials if the proxy needs authentication.
     - Only HTTP proxy is supported.
   - **Time sync**: Time is verified. The time on the appliance should be in sync with internet time for VM discovery to work properly.
   - **Install updates**: Azure Migrate Server Assessment checks that the appliance has the latest updates
Register the appliance with Azure Migrate

1. Click Log In. If it doesn't appear, make sure you've disabled the pop-up blocker in the browser.
2. On the new tab, sign in using your Azure credentials.
   - Sign in with your username and password.
   - Sign-in with a PIN isn't supported.
3. After successfully signing in, go back to the web app.
4. Select the subscription in which the Azure Migrate project was created. Then select the project.
5. Specify a name for the appliance. The name should be alphanumeric with 14 characters or less.
6. Click Register.

Start continuous discovery

Connect from the appliance to physical servers, and start the discovery.

1. Click Add Credentials to specify the account credentials that the appliance will use to discover servers.
2. Specify the Operating System, a friendly name for the credentials, and the username and password. Then click Add. You can add one set of credentials each for Windows and Linux servers.
3. Click Add server, and specify server details- FQDN/IP address and friendly name of credentials (one entry per row) to connect to the server.
4. Click Validate. After validation, the list of servers that can be discovered is shown.
   - If validation fails for a server, review the error by hovering over the icon in the Status column. Fix issues, and validate again.
   - To remove a server, select > Delete.
5. After validation, click Save and start discovery to start the discovery process.

This starts discovery. It takes around 15 minutes for metadata of discovered VMs to appear in the Azure portal.

Verify discovery in the portal

After discovery finishes, you can verify that the servers appear in the portal.

1. Open the Azure Migrate dashboard.
2. In Azure Migrate - Servers > Azure Migrate: Server Assessment page, click the icon that displays the count for Discovered servers.

Next steps

Try out assessment of physical servers with Azure Migrate Server Assessment.
Follow this article to deploy an Azure Migrate appliance for VMware VMs, Hyper-V VMs, and physical servers, in an Azure Government cloud. You run a script to create the appliance, and verify that it can connect to Azure. If you want to set up an appliance in the public cloud, follow this article.

**Prerequisites**

The script sets up the Azure Migrate appliance on an existing physical machine or VM.

- The machine that will act as the appliance must be running Windows Server 2016, with 32 GB of memory, eight vCPUs, around 80 GB of disk storage, and an external virtual switch. It requires a static or dynamic IP address, and access to the internet.
- Before you deploy the appliance, review detailed appliance requirements for VMware VMs, Hyper-V VMs, and physical servers.
- Don’t run the script on an existing Azure Migrate appliance.

**Set up the appliance for VMware**

To set up the appliance for VMware you download a zipped file from the Azure portal, and extract the contents. You run the PowerShell script to launch the appliance web app. You set up the appliance and configure it for the first time. Then, you register the appliance with the Azure Migrate project.

**Download the script**

1. In Migration Goals > Servers > Azure Migrate: Server Assessment, click Discover.
2. In Discover machines > Are your machines virtualized?, select Yes, with VMWare vSphere hypervisor.
3. Click Download, to download the zipped file.

**Verify file security**

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.
2. Run the following command to generate the hash for the zipped file

   ```
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   
   Example:
   C:\>CertUtil -HashFile C:\Users\administrator\Desktop\AzureMigrateInstaller-VMWare-USGov.zip MD5
   ```

3. Verify the generated hash values. For the latest appliance version:
Run the script

Here’s what the script does:

- Installs agents and a web application.
- Installs Windows roles, including Windows Activation Service, IIS, and PowerShell ISE.
- Downloads and installs an IIS rewritable module. Learn more.
- Updates a registry key (HKLM), with persistent settings for Azure Migrate.
- Creates log and configuration files as follows:
  - **Config Files**: %ProgramData%\Microsoft Azure\Config
  - **Log Files**: %ProgramData%\Microsoft Azure\Logs

To run the script:

1. Extract the zipped file to a folder on the machine that will host the appliance. Make sure you don’t run the script on a machine on an existing Azure Migrate appliance.
2. Launch PowerShell on the machine, with administrator (elevated) privileges.
3. Change the PowerShell directory to the folder containing the contents extracted from the downloaded zipped file.
4. Run the script **AzureMigrateInstaller.ps1**, as follows:
   ```powershell
   PS C:\Users\Administrators\Desktop\AzureMigrateInstaller-VMware-USGov>AzureMigrateInstaller.ps1
   ```
5. After the script runs successfully, it launches the appliance web application so that you can set up the appliance. If you encounter any issues, review the script logs at C:\ProgramData\Microsoft Azure\Logs\AzureMigrateScenarioInstaller_{Timestamp}.log.

Verify access

Make sure that the appliance can connect to Azure URLs for **government clouds**.

Set up the appliance for Hyper-V

To set up the appliance for Hyper-V you download a zipped file from the Azure portal, and extract the contents. You run the PowerShell script to launch the appliance web app. You set up the appliance and configure it for the first time. Then, you register the appliance with the Azure Migrate project.

Download the script

1. In **Migration Goals > Servers > Azure Migrate: Server Assessment**, click **Discover**.
2. In **Discover machines > Are your machines virtualized?**, select **Yes, with Hyper-V**.
3. Click **Download**, to download the zipped file.

Verify file security

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.
2. Run the following command to generate the hash for the zipped file
   ```cmd
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   ```
   
   **Example:**
   ```cmd
   C:\>CertUtil -HashFile C:\Users\administrator\Desktop\AzureMigrateInstaller-HyperV-USGov.zip MD5
   ```
3. Verify the generated hash values. For the latest appliance version:
Run the script

Here’s what the script does:

- Installs agents and a web application.
- Installs Windows roles, including Windows Activation Service, IIS, and PowerShell ISE.
- Downloads and installs an IIS rewritable module. Learn more.
- Updates a registry key (HKLM), with persistent settings for Azure Migrate.
- Creates log and configuration files as follows:
  - **Config Files**: `%ProgramData%\Microsoft Azure\Config`
  - **Log Files**: `%ProgramData%\Microsoft Azure\Logs`

To run the script:

1. Extract the zipped file to a folder on the machine that will host the appliance. Make sure you don’t run the script on a machine on an existing Azure Migrate appliance.
2. Launch PowerShell on the machine, with administrator (elevated) privileges.
3. Change the PowerShell directory to the folder containing the contents extracted from the downloaded zipped file.
4. Run the script `AzureMigrateInstaller.ps1`, as follows:
   
   ```
   PS C:\Users\Administrators\Desktop\AzureMigrateInstaller-HyperV-USGov>AzureMigrateInstaller.ps1
   ```

5. After the script runs successfully, it launches the appliance web application so that you can set up the appliance. If you encounter any issues, review the script logs at `C:\ProgramData\Microsoft Azure\Logs\AzureMigrateScenarioInstaller_timestamp.log`.

Verify access

Make sure that the appliance can connect to Azure URLs for government clouds.

Set up the appliance for physical servers

To set up the appliance for VMware you download a zipped file from the Azure portal, and extract the contents. You run the PowerShell script to launch the appliance web app. You set up the appliance and configure it for the first time. Then, you register the appliance with the Azure Migrate project.

Download the script

1. In **Migration Goals > Servers > Azure Migrate: Server Assessment**, click Discover.
2. In **Discover machines > Are your machines virtualized?**, select `Not virtualized/Other`.
3. Click **Download**, to download the zipped file.

Verify file security

Check that the zipped file is secure, before you deploy it.

1. On the machine to which you downloaded the file, open an administrator command window.
2. Run the following command to generate the hash for the zipped file
   
   ```
   C:\>CertUtil -HashFile <file_location> [Hashing Algorithm]
   ```

   **Example:**
   
   ```
   C:\>CertUtil -HashFile C:\Users\Administrator\Desktop\AzureMigrateInstaller-Server-USGov.zip MD5
   ```

3. Verify the generated hash values. For the latest appliance version:
Run the script

Here’s what the script does:

- Installs agents and a web application.
- Installs Windows roles, including Windows Activation Service, IIS, and PowerShell ISE.
- Downloads and installs an IIS rewritable module. Learn more.
- Updates a registry key (HKLM), with persistent settings for Azure Migrate.
- Creates log and configuration files as follows:
  - **Config Files**: `%ProgramData%\Microsoft Azure\Config`
  - **Log Files**: `%ProgramData%\Microsoft Azure\Logs`

To run the script:

1. Extract the zipped file to a folder on the machine that will host the appliance. Make sure you don’t run the script on a machine on an existing Azure Migrate appliance.
2. Launch PowerShell on the machine, with administrator (elevated) privileges.
3. Change the PowerShell directory to the folder containing the contents extracted from the downloaded zipped file.
4. Run the script `AzureMigrateInstaller.ps1`, as follows:

```
PS C:\Users\Administrators\Desktop\AzureMigrateInstaller-Server-USGov> AzureMigrateInstaller.ps1
```

5. After the script runs successfully, it launches the appliance web application so that you can set up the appliance. If you encounter any issues, review the script logs at `C:\ProgramData\Microsoft Azure\Logs\AzureMigrateScenarioInstaller_Timestamp.log`.

Verify access

Make sure that the appliance can connect to Azure URLs for government clouds.

Next steps

After deploying the appliance, you need to configure it for the first time, and register it with the Azure Migrate project.

- Set up the appliance for VMware.
- Set up the appliance for Hyper-V.
- Set up the appliance for physical servers.
This article describes how to limit the scope of discovery for VMware VMs that are discovered by the Azure Migrate appliance.

The Azure Migrate appliance discovers on-premises VMware VMs when you:

- Use the Azure Migrate:Server Assessment tool to assess VMware VMs for migration to Azure.
- Use the Azure Migrate:Server Migration tool for agentless migration of VMware VMs to Azure.

**Set discovery scope**

After you set up the Azure Migrate appliance for VMware VMs assessment or migration, the appliance starts discovering VMs, and sending VM metadata to Azure. Before you connect the appliance to vCenter Server for discovery, you can set the discovery scope to limit discovery to vCenter Server datacenters, clusters, a folder of clusters, hosts, a folder of hosts, or individual VMs.

To set the scope, you assign permissions on the account that Azure Migrate is using to access the vCenter Server.

**Create a vCenter user account**

If you haven’t already set up a vCenter user account that the Azure Migrate appliance uses to discover, assess, and migrate VMware VMs, do that first.

1. Log in to vSphere Web Client as the vCenter Server administrator.
2. Select Administration > SSO users and Groups, and click the Users tab.
3. Select the New User icon.
4. Fill in the new user information > OK.

The account permissions depend on what you’re deploying.

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>ACCOUNT PERMISSIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assess</td>
<td>The account needs read-only access.</td>
</tr>
<tr>
<td>Discover apps/roles/features</td>
<td>The account needs read-only access, with privileges enabled for Virtual machines &gt; Guest Operations.</td>
</tr>
<tr>
<td>Analyze dependencies (agentless)</td>
<td>The account needs read-only access, with privileges enabled for Virtual machines &gt; Guest Operations.</td>
</tr>
<tr>
<td>Migrate (agentless)</td>
<td>You need a role that’s assigned the right permissions.</td>
</tr>
<tr>
<td></td>
<td>To create a role, log in to vSphere Web Client as the vCenter Server administrator.</td>
</tr>
<tr>
<td></td>
<td>Select the vCenter Server instance &gt; <strong>Create role</strong>. Specify a role name, for example Azure_Migrate, and assign the <strong>required permissions</strong> to the role.</td>
</tr>
</tbody>
</table>

**Assign permissions on vCenter objects**

You can assign permissions on inventory objects using one of two methods:
- Assign a role with the required permissions, to the account you're using, for all parent objects that host VMs you want to discover/migrate.
- Alternatively, you can assign the role and user account at the datacenter level, and propagate them to the child objects. Then give the account a No access role, for every object that you don’t want to discover/migrate. We don’t recommend this approach since it’s cumbersome, and might expose access controls, because every new child object is automatically granted access inherited from the parent.

To assign a role to the account you're using for all relevant objects, do the following:

- **For assessment**: For VM assessment, apply the **Read-only** role to the vCenter user account for all parent objects hosting VMs you want to discover. Parent objects included: host, folder of hosts, cluster, and folder of clusters in the hierarchy, up to the datacenter. Propagate these permissions to child objects in the hierarchy.

- **For agentless migration**: For agentless migration, apply a user-defined role with **required permissions** to the user account, for all parent objects hosting VMs you want to discover. You can name the role *Azure_Migrate*.

**Scope support**

Currently, the Server Assessment tool can’t discover VMs if the vCenter account has access granted at the vCenter VM folder level. Folders of hosts and clusters are supported.

If you want to scope your discovery by VM folders, complete the next procedure to ensure that the vCenter account has read-only access assigned at a VM level.

1. Assign read-only permissions on all VMs in the VM folders you want to scope for discovery.
2. Grant read-only access to all the parent objects that host VMs.
   - All parent objects (host, folder of hosts, cluster, folder of clusters) in the hierarchy up to the datacenter are included.
   - You don’t need to propagate the permissions to all child objects.
3. Use the credentials for discovery by selecting the datacenter as **Collection Scope**. The role-based access control setup ensures that the corresponding vCenter user account has access to only tenant-specific VMs.
Next steps

Set up the appliance and start continuous discovery.
This article describes how to discover applications, roles, and features on on-premises servers, using Azure Migrate: Server Assessment.

Discovering the inventory of apps, and roles/features running on your on-premises machines helps you to identify and plan a migration path to Azure that’s tailored for your workloads.

**NOTE**

App discovery is currently in preview for VMware VMs only, and is limited to discovery only. We don't yet offer app-based assessment. Machine-based assessment for on-premises VMware VMs, Hyper-V VMs, and physical servers.

App discovery using Azure Migrate: Server Assessment is agentless. Nothing is installed on machines and VMs. Server Assessment uses the Azure Migrate appliance to perform discovery along with machine guest credentials. The appliance remotely accesses the VMware machines using VMware APIs.

### Before you start

1. Make sure you've created an Azure Migrate project.
2. Make sure you've added the Azure Migrate: Server Assessment tool to a project.
3. Check the [VMware requirements](#) for discovering and assessing VMware VMs with the Azure Migrate appliance.
4. Check the requirements for deploying the Azure Migrate appliance.
5. Verify support and requirements for application discovery.

### Prepare for app discovery

1. **Prepare for appliance deployment**. Preparation includes verifying appliance settings, and setting up an account that the appliance will use to access vCenter Server.
2. Make sure you have a user account (one each for Windows and Linux servers) with administrator permissions for machines on which you want to discover apps, roles, and features.
3. **Deploy the Azure Migrate appliance** to start discovery. To deploy the appliance, you download and import an OVA template into VMware to create the appliance as a VMware VM. You configure the appliance and then register it with Azure Migrate.
4. As you deploy the appliance, to start continuous discovery you specify the following:
   - The name of the vCenter Server to which you want to connect.
   - Credentials that you created for the appliance to connect to vCenter Server.
   - The account credentials you created for the appliance to connect to Windows/Linux VMs.

After the appliance is deployed and you've provided credentials, the appliance starts continuous discovery of VM metadata and performance data, along with and discovery of apps, features, and roles. The duration of app discovery depends on how many VMs you have. It typically takes an hour for app-discovery of 500 VMs.

### Review and export the inventory

After discovery ends, if you provided credentials for app discovery, you can review and export the app inventory in the Azure portal.
1. In Azure Migrate - Servers > Azure Migrate: Server Assessment, click the displayed count to open the Discovered servers page.

   **NOTE**
   At this stage you can also optionally set up dependency mapping for discovered machines, so that you can visualize dependencies across machines you want to assess. Learn more.

2. In Applications discovered, click the displayed count.

3. In Application inventory, you can review the discovered apps, roles, and features.

4. To export the inventory, in Discovered Servers, click Export app inventory.

   The app inventory is exported and downloaded in Excel format. The Application Inventory sheet displays all the apps discovered across all the machines.

**Next steps**

- Create an assessment for lift and shift migration of the discovered servers.
- Assess a SQL Server databases using Azure Migrate: Database Assessment.
This article describes how to create groups of machines for assessment with Azure Migrate: Server Assessment.

Azure Migrate helps you to migrate to Azure. Azure Migrate provides a centralized hub to track discovery, assessment, and migration of on-premises infrastructure, applications, and data to Azure. The hub provides Azure tools for assessment and migration, as well as third-party independent software vendor (ISV) offerings.

Grouping machines

You gather machines into groups to assess whether they're suitable for migration to Azure, and to get Azure sizing and cost estimations for them. There are a couple of ways to create groups:

- If you know the machines that need be migrated together, you can manually create the group in Azure Migrate.
- If you are not sure about the machines that need to be grouped together, you can use the dependency visualization functionality in Azure Migrate to create groups.

**NOTE**
The dependency visualization functionality is not available in Azure Government.

Create a group manually

You can create a group at the same time that you create an assessment.

If you want to create a group manually outside of creating an assessment, do the following:

1. In the Azure Migrate project > Overview, click Assess and migrate servers. In Azure Migrate: Server Assessment, click Groups

   - If you haven't yet added the Azure Migrate: Server Assessment tool, click to add it. Learn more.
   - If you haven't yet created an Azure Migrate project, learn more.
2. Click the Group icon.

3. In **Create group**, specify a group name, and in **Appliance name**, select the Azure Migrate appliance you’re using for machine discovery.

4. From the machine list, select the machines you want to add to the group > **Create**.

You can now use this group when you **create an assessment**.

**Refine a group with dependency mapping**

Dependency mapping helps you to visualize dependencies across machines. You typically use dependency mapping when you want to assess machine groups with higher levels of confidence.
It helps you to cross-check machine dependencies, before you run an assessment.

It also helps to effectively plan your migration to Azure, by ensuring that nothing is left behind, and thus avoiding surprise outages during migration.

You can discover interdependent systems that need to migrate together, and identify whether a running system is still serving users, or is a candidate for decommissioning instead of migration.

If you’ve already set up dependency mapping, and want to refine an existing group, do the following:

1. In the **Servers** tab, in **Azure Migrate: Server Assessment** tile, click **Groups**.

2. Click the group you want to refine.

   - If you haven’t yet set up dependency mapping, the **Dependencies** column will show a Requires installation status. For each VM for which you want to visualize dependencies, click Requires installation. Install a couple of agents on each VM, before you can map the machine dependencies. Learn more.

3. After clicking **View dependencies**, the group dependency map shows the following:
   - Inbound (clients) and outbound (servers) TCP connections to and from all machines in the group that have the dependency agents installed.
   - Dependent machines that don’t have the dependency agents installed are grouped by port numbers.
   - Dependent machines with dependency agents installed are shown as separate boxes.
   - Processes running inside the machine. Expand each machine box to view the processes.
   - Machine properties (including FQDN, operating system, MAC address). Click on each machine box to view the details.

4. To view dependencies in a time interval of your choice, modify the time range (an hour by default) by specifying start and end dates, or the duration.
5. After you've identified the dependencies you would like to add to or remove from the group, you can modify the group. Use Ctrl+Click to add or remove machines from the group.

- You can only add machines that have been discovered.
- Adding and removing machines invalidates past assessments for a group.
- You can optionally create a new assessment when you modify the group.

Next steps

Learn how to set up and use dependency mapping to create high confidence groups.
This article describes how to set up agent-based dependency analysis in Azure Migrate:Server Assessment. Dependency analysis helps you to identify and understand dependencies across machines you want to assess and migrate to Azure.

Before you start

- Learn about agent-based dependency analysis.
- Review the prerequisites and support requirements for setting up agent-based dependency visualization for VMware VMs, physical servers, and Hyper-V VMs.
- Make sure you've created an Azure Migrate project.
- If you've already created a project, make sure you've added the Azure Migrate:Server Assessment tool.
- Make sure you've set up an Azure Migrate appliance to discover your on-premises machines. Learn how to set up an appliance for VMware, Hyper-V, or physical servers. The appliance discovers on-premises machines, and sends metadata, performance data to Azure Migrate:Server Assessment.
- To use dependency visualization, you associate a Log Analytics workspace with an Azure Migrate project:
  - You can attach a workspace only after setting up the Azure Migrate appliance, and discovering machines in the Azure Migrate project.
  - Make sure you have a workspace in the subscription that contains the Azure Migrate project.
  - The workspace must reside in the East US, Southeast Asia, or West Europe regions. Workspaces in other regions can't be associated with a project.
  - The workspace must be in a region in which Service Map is supported.
  - You can associate a new or existing Log Analytics workspace with an Azure Migrate project.
  - You attach the workspace the first time that you set up dependency visualization for a machine. The workspace for an Azure Migrate project can't be modified after it's added.
  - In Log Analytics, the workspace associated with Azure Migrate is tagged with the Migration Project key, and the project name.

Associate a workspace

1. After you've discovered machines for assessment, in Servers > Azure Migrate: Server Assessment, click Overview.
3. In OMS Workspace, click Requires configuration.

4. In Configure OMS workspace, specify whether you want to create a new workspace, or use an existing one.
   - You can select an existing workspace from all the workspaces in the migrate project subscription.
   - You need Reader access to the workspace to associate it.
5. If you create a new workspace, select a location for it.

### Download and install the VM agents

On each machine you want to analyze, install the agents.

**NOTE**

For machines monitored by System Center Operations Manager 2012 R2 or later, you don't need to install the MMA agent. Service Map integrates with Operations Manager. Follow integration guidance.

1. In **Azure Migrate: Server Assessment**, click **Discovered servers**.

2. For each machine you want to analyze with dependency visualization, in the **Dependencies** column, click **Requires agent installation**.

3. In the **Dependencies** page, download the MMA and Dependency agent for Windows or Linux.

4. Under **Configure MMA agent**, copy the workspace ID and key. You need these when you install the MMA agent.

Once the installation of the agents is done, it may take up to 15 minutes to reflect in the Azure Migrate portal.
Install the MMA

Install the MMA on each Windows or Linux machine you want to analyze.

**Install MMA on a Windows machine**

To install the agent on a Windows machine:

1. Double-click the downloaded agent.
2. On the Welcome page, click Next. On the License Terms page, click I Agree to accept the license.
3. In Destination Folder, keep or modify the default installation folder > Next.
4. In Agent Setup Options, select Azure Log Analytics > Next.
5. Click Add to add a new Log Analytics workspace. Paste in the workspace ID and key that you copied from the portal. Click Next.

You can install the agent from the command line or using an automated method such as Configuration Manager or Intigua.

- Learn more about using these methods to install the MMA agent.
- The MMA agent can also be installed using this script.
- Learn more about the Windows operating systems supported by MMA.

**Install MMA on a Linux machine**

To install the MMA on a Linux machine:

1. Transfer the appropriate bundle (x86 or x64) to your Linux computer using scp/sftp.
2. Install the bundle by using the --install argument.

```
sudo sh ./omsagent-<version>.universal.x64.sh --install -w <workspace id> -s <workspace key>
```

Learn more about the list of Linux operating systems support by MMA.

**Install the Dependency agent**

1. To install the Dependency agent on a Windows machine, double-click the setup file and follow the wizard.
2. To install the Dependency agent on a Linux machine, install as root using the following command:

```
sh InstallDependencyAgent-Linux64.bin
```

- Learn more about how you can use scripts to install the Dependency agent.
- Learn more about the operating systems supported by the Dependency agent.

**Create a group using dependency visualization**

Now create a group for assessment.

**NOTE**

Groups for which you want to visualize dependencies shouldn't contain more than 10 machines. If you have more than 10 machines, split them into smaller groups.

1. In Azure Migrate: Server Assessment, click Discovered servers.
2. In the Dependencies column, click View dependencies for each machine you want to review.
3. On the dependency map, you can see the following:
- Inbound (clients) and outbound (servers) TCP connections, to and from the machine.
- Dependent machines that don't have the dependency agents installed are grouped by port numbers.
- Dependent machines with dependency agents installed are shown as separate boxes.
- Processes running inside the machine. Expand each machine box to view the processes.
- Machine properties (including FQDN, operating system, MAC address). Click on each machine box to view the details.

4. You can look at dependencies for different time durations by clicking on the time duration in the time range label.
   - By default the range is an hour.
   - You can modify the time range, or specify start and end dates, and duration.
   - Time range can be up to an hour. If you need a longer range, use Azure Monitor to query dependent data for a longer period.

5. After you've identified the dependent machines that you want to group together, use Ctrl+Click to select multiple machines on the map, and click Group machines.

6. Specify a group name.

7. Verify that the dependent machines are discovered by Azure Migrate.
   - If a dependent machine isn't discovered by Azure Migrate: Server Assessment, you can't add it to the group.
   - To add a machine, run discovery again, and verify that the machine is discovered.

8. If you want to create an assessment for this group, select the checkbox to create a new assessment for the group.

9. Click OK to save the group.

After creating the group, we recommend that you install agents on all the machines in the group, and then visualize dependencies for the entire group.

**Query dependency data in Azure Monitor**

You can query dependency data captured by Service Map in the Log Analytics workspace associated with the Azure Migrate project. Log Analytics is used to write and run Azure Monitor log queries.

- **Learn how to** search for Service Map data in Log Analytics.
- **Get an overview** of writing log queries in Log Analytics.

Run a query for dependency data as follows:

1. After you install the agents, go to the portal and click Overview.
2. In Azure Migrate: Server Assessment, click Overview. Click the down arrow to expand Essentials.
3. In OMS Workspace, click the workspace name.
4. On the Log Analytics workspace page > General, click Logs.
5. Write your query, and click Run.

**Sample queries**

Here are a few sample queries that you can use to extract dependency data.

- You can modify the queries to extract your preferred data points.
- Review a complete list of dependency data records.
- Review additional sample queries.

**Sample: Review inbound connections**
Review inbound connections for a set of VMs.

- The records in the table for connection metrics (VMConnection) don't represent individual physical network connections.
- Multiple physical network connections are grouped into a logical connection.
- Learn more about how physical network connection data is aggregated in VMConnection.

Sample: Summarize sent and received data
This sample summarizes the volume of data sent and received on inbound connections between a set of machines.

Next steps
Create an assessment for a group.
This article describes how to set up agentless dependency analysis in Azure Migrate:Server Assessment. **Dependency analysis** helps you to identify and understand dependencies across machines you want to assess and migrate to Azure.

### IMPORTANT
Agentless dependency visualization is currently in preview for VMware VMs only, discovered with the Azure Migrate:Server Assessment tool. Features might be limited or incomplete. This preview is covered by customer support and can be used for production workloads. For more information, see [Supplemental Terms of Use for Microsoft Azure Previews](#).

### Before you start
- Learn about agentless dependency analysis.
- Review the prerequisites and support requirements for setting up agentless dependency visualization for VMware VMs
- Make sure you've created an Azure Migrate project.
- If you've already created a project, make sure you've added the Azure Migrate:Server Assessment tool.
- Make sure you've set up an Azure Migrate appliance to discover your on-premises machines. Learn how to set up an appliance for VMware VMs. The appliance discovers on-premises machines, and sends metadata and performance data to Azure Migrate:Server Assessment.

### Current limitations
- Right now you can't add or remove a server from a group, in the dependency analysis view.
- A dependency map for a group of servers isn't currently not available.
- Currently, the dependency data can't be downloaded in tabular format.

### Create a user account for discovery
Set up a user account so that Server Assessment can access the VM for discovery. Learn about account requirements.

### Add the user account to the appliance
Add the user account to the appliance.

1. Open the appliance management app.
2. Navigate to the **Provide vCenter details** panel.
3. In **Discover application and dependencies on VMs**, click **Add credentials**
4. Choose the **Operating system**, provide a friendly name for the account, and the **User name/Password**
5. Click **Save**.
6. Click **Save and start discovery**.
Start dependency discovery
Choose the machines on which you want to enable dependency discovery.

1. In Azure Migrate: Server Assessment, click Discovered servers.
2. Click the Dependency analysis icon.
3. Click Add servers.
4. In the Add servers page, choose the appliance that’s discovering the relevant machines.
5. From the machine list, select the machines.
6. Click Add servers.
You can visualize dependencies around six hours after starting dependency discovery.

**Visualize dependencies**

1. In Azure Migrate: Server Assessment, click **Discovered servers**.
2. Search for the machine you want to view.
3. In the Dependencies column, click **View dependencies**
4. Change the time period for which you want to view the map using the **Time duration** dropdown.
5. Expand the Client group to list the machines with a dependency on the selected machine.
6. Expand the Port group to list the machines that have a dependency from the selected machine.
7. To navigate to the map view of any of the dependent machines, click on the machine name > Load server map
8. Expand the selected machine to view process-level details for each dependency.
Stop dependency discovery

Choose the machines on which you want to stop dependency discovery.

1. In Azure Migrate: Server Assessment, click Discovered servers.
2. Click the Dependency analysis icon.
3. Click Remove servers.
4. In the Remove servers page, choose the appliance that is discovering the VMs on which you look to stop dependency discovery.
5. From the machine list, select the machines.
6. Click Remove servers.

Next steps

Group the machines for assessment.
This article describes how to create an assessment for on-premises VMware VMs or Hyper-V VMs with Azure Migrate: Server Assessment.

**Azure Migrate** helps you to migrate to Azure. Azure Migrate provides a centralized hub to track discovery, assessment, and migration of on-premises infrastructure, applications, and data to Azure. The hub provides Azure tools for assessment and migration, as well as third-party independent software vendor (ISV) offerings.

**Before you start**

- Make sure you've created an Azure Migrate project.
- If you've already created a project, make sure you've added the Azure Migrate: Server Assessment tool.
- To create an assessment, you need to set up an Azure Migrate appliance for VMware or Hyper-V. The appliance discovers on-premises machines, and sends metadata and performance data to Azure Migrate: Server Assessment. Learn more.

**Assessment overview**

There are two types of assessments you can create using Azure Migrate: Server Assessment.

<table>
<thead>
<tr>
<th>ASSESSMENT</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance-based</td>
<td>Assessments based on collected performance data</td>
<td><strong>Recommended VM size</strong>: Based on CPU and memory utilization data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Recommended disk type (standard or premium managed disk)</strong>: Based on the IOPS and throughput of the on-premises disks.</td>
</tr>
<tr>
<td>As on-premises</td>
<td>Assessments based on on-premises sizing.</td>
<td><strong>Recommended VM size</strong>: Based on the on-premises VM size</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Recommended disk type</strong>: Based on the storage type setting you select for the assessment.</td>
</tr>
</tbody>
</table>

Learn more about assessments.

**Run an assessment**

Run an assessment as follows:

1. Review the best practices for creating assessments.
2. In the **Servers** tab, in **Azure Migrate: Server Assessment** tile, click **Assess**.
3. In **Assess servers**, specify a name for the assessment.

4. Click **View all** to review the assessment properties.
5. In Select or create a group, select Create New, and specify a group name. A group gathers one or more VMs together for assessment.

6. In Add machines to the group, select VMs to add to the group.

7. Click Create Assessment to create the group, and run the assessment.
8. After the assessment is created, view it in Servers > Azure Migrate: Server Assessment > Assessments.

9. Click Export assessment, to download it as an Excel file.

**Review an assessment**

An assessment describes:

- **Azure readiness**: Whether VMs are suitable for migration to Azure.
- **Monthly cost estimation**: The estimated monthly compute and storage costs for running the VMs in Azure.
- **Monthly storage cost estimation**: Estimated costs for disk storage after migration.

**View an assessment**

1. In Migration goals > Servers, click Assessments in Azure Migrate: Server Assessment.

2. In Assessments, click on an assessment to open it.
Review Azure readiness

1. In Azure readiness, verify whether VMs are ready for migration to Azure.

2. Review the VM status:
   - Ready for Azure: Azure Migrate recommends a VM size and cost estimates for VMs in the assessment.
   - Ready with conditions: Shows issues and suggested remediation.
   - Not ready for Azure: Shows issues and suggested remediation.
   - Readiness unknown: Used when Azure Migrate can't assess readiness, due to data availability issues.

3. Click on an Azure readiness status. You can view VM readiness details, and drill down to see VM details, including compute, storage, and network settings.

Review cost details

This view shows the estimated compute and storage cost of running VMs in Azure.

1. Review the monthly compute and storage costs. Costs are aggregated for all VMs in the assessed group.
   - Cost estimates are based on the size recommendations for a machine, and its disks and properties.
   - Estimated monthly costs for compute and storage are shown.
   - The cost estimation is for running the on-premises VMs as IaaS VMs. Azure Migrate Server Assessment doesn't consider PaaS or SaaS costs.

2. You can review monthly storage cost estimates. This view shows aggregated storage costs for the assessed group, split over different types of storage disks.

3. You can drill down to see details for specific VMs.

Review confidence rating

When you run performance-based assessments, a confidence rating is assigned to the assessment.

A rating from 1-star (lowest) to 5-star (highest) is awarded.
- The confidence rating helps you estimate the reliability of the size recommendations provided by the assessment.
- The confidence rating is based on the availability of data points needed to compute the assessment.
Confidence ratings for an assessment are as follows.

<table>
<thead>
<tr>
<th>DATA POINT AVAILABILITY</th>
<th>CONFIDENCE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%-20%</td>
<td>1 Star</td>
</tr>
<tr>
<td>21%-40%</td>
<td>2 Star</td>
</tr>
<tr>
<td>41%-60%</td>
<td>3 Star</td>
</tr>
<tr>
<td>61%-80%</td>
<td>4 Star</td>
</tr>
<tr>
<td>81%-100%</td>
<td>5 Star</td>
</tr>
</tbody>
</table>

Next steps

- Learn how to use dependency mapping to create high confidence groups.
- Learn more about how assessments are calculated.
This article describes how to customize assessments created by Azure Migrate Server Assessment.

**Azure Migrate** provides a central hub to track discovery, assessment, and migration of your on-premises apps and workloads, and private/public cloud VMs, to Azure. The hub provides Azure Migrate tools for assessment and migration, as well as third-party independent software vendor (ISV) offerings.

You can use the Azure Migrate Server Assessment tool to create assessments for on-premises VMware VMs and Hyper-V VMs, in preparation for migration to Azure.

### About assessments

There are two types of assessments you can run using Azure Migrate Server Assessment.

<table>
<thead>
<tr>
<th>ASSESSMENT</th>
<th>DETAILS</th>
<th>DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance-based</strong></td>
<td>Assessments based on collected performance data</td>
<td><strong>Recommended VM size</strong>: Based on CPU and memory utilization data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Recommended disk type (standard or premium managed disk)</strong>: Based on the IOPS and throughput of the on-premises disks.</td>
</tr>
<tr>
<td><strong>As on-premises</strong></td>
<td>Assessments based on on-premises sizing.</td>
<td><strong>Recommended VM size</strong>: Based on the on-premises VM size</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Recommended disk type</strong>: Based on the storage type setting you select for the assessment.</td>
</tr>
</tbody>
</table>

### How is an assessment done?

An assessment done in Azure Migrate Server Assessment has three stages. Assessment starts with a suitability analysis, followed by sizing, and lastly, a monthly cost estimation. A machine only moves along to a later stage if it passes the previous one. For example, if a machine fails the Azure suitability check, it’s marked as unsuitable for Azure, and sizing and costing won’t be done. [Learn more.](#)

### What's in an assessment?

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>PROPERTY</td>
<td>DETAILS</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Target location</td>
<td>The Azure location to which you want to migrate. Server Assessment currently supports these target regions: Australia East, Australia Southeast, Brazil South, Canada Central, Canada East, Central India, Central US, China East, China North, East Asia, East US, East US2, Germany Central, Germany Northeast, Japan East, Japan West, Korea Central, Korea South, North Central US, North Europe, South Central US, Southeast Asia, South India, UK South, UK West, US Gov Arizona, US Gov Texas, US Gov Virginia, West Central US, West Europe, West India, West US, and West US2.</td>
</tr>
<tr>
<td>Storage type</td>
<td>You can use this property to specify the type of disks you want to move to, in Azure. For as-on premises sizing, you can specify the target storage type either as Premium-managed disks, Standard SSD-managed disks or Standard HDD-managed disks. For performance-based sizing, you can specify the target disk type either as Automatic, Premium-managed disks, Standard HDD-managed disks, or Standard SSD-managed disks. When you specify the storage type as automatic, the disk recommendation is done based on the performance data of the disks (IOPS and throughput). If you specify the storage type as premium/standard, the assessment will recommend a disk SKU within the storage type selected. If you want to achieve a single instance VM SLA of 99.9%, you may want to specify the storage type as Premium-managed disks. This ensures that all disks in the assessment are recommended as Premium-managed disks. Azure.</td>
</tr>
<tr>
<td>Reserved Instances (RI)</td>
<td>This property helps you specify if you have Reserved Instances in Azure, cost estimations in the assessment are then done taking into RI discounts. Reserved instances are currently only supported for Pay-As-You-Go offer in Azure Migrate.</td>
</tr>
<tr>
<td>Sizing criterion</td>
<td>The criterion to be used to right-size VMs for Azure. You can either do performance-based sizing or size the VMs as on-premises, without considering the performance history.</td>
</tr>
<tr>
<td>Performance history</td>
<td>The duration to consider for evaluating the performance data of machines. This property is only applicable when sizing criterion is performance-based.</td>
</tr>
<tr>
<td>Percentile utilization</td>
<td>The percentile value of the performance sample set to be considered for right-sizing. This property is only applicable when sizing is performance-based.</td>
</tr>
<tr>
<td>VM series</td>
<td>You can specify the VM series that you would like to consider for right-sizing. For example, if you have a production environment that you do not plan to migrate to A-series VMs in Azure, you can exclude A-series from the list or series and the right-sizing is done only in the selected series.</td>
</tr>
<tr>
<td>PROPERTY</td>
<td>DETAILS</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comfort factor</td>
<td>Azure Migrate Server Assessment considers a buffer (comfort factor) during assessment. This buffer is applied on top of machine utilization data for VMs (CPU, memory, disk, and network). The comfort factor accounts for issues such as seasonal usage, short performance history, and likely increases in future usage. For example, a 10-core VM with 20% utilization normally results in a 2-core VM. However, with a comfort factor of 2.0x, the result is a 4-core VM instead.</td>
</tr>
<tr>
<td>Offer</td>
<td>The Azure offer you're enrolled to. Azure Migrate estimates the cost accordingly.</td>
</tr>
<tr>
<td>Currency</td>
<td>Billing currency.</td>
</tr>
<tr>
<td>Discount (%)</td>
<td>Any subscription-specific discount you receive on top of the Azure offer. The default setting is 0%.</td>
</tr>
<tr>
<td>VM uptime</td>
<td>If your VMs are not going to be running 24x7 in Azure, you can specify the duration (number of days per month and number of hours per day) for which they would be running and the cost estimations would be done accordingly. The default value is 31 days per month and 24 hours per day.</td>
</tr>
<tr>
<td>Azure Hybrid Benefit</td>
<td>Specify whether you have software assurance and are eligible for Azure Hybrid Benefit. If set to Yes, non-Windows Azure prices are considered for Windows VMs. Default is Yes.</td>
</tr>
</tbody>
</table>

**Edit assessment properties**

To edit assessment properties after creating an assessment, do the following:

1. In the Azure Migrate project, click **Servers**.
2. In **Azure Migrate: Server Assessment**, click the assessments count.
3. In **Assessment**, click the relevant assessment > **Edit properties**.
4. Customize the assessment properties in accordance with the table above.
5. Click **Save** to update the assessment.

You can also edit assessment properties when you're creating an assessment.

**Next steps**

Learn more about how assessments are calculated.
This article describes how to add migration tools in Azure Migrate.

Azure Migrate provides a hub of tools for assessment and migration to Azure. It includes native tools, tools provided by other Azure services, and third-party independent software vendor (ISV) offerings.

If you want to add a migration tool and haven’t yet set up an Azure Migrate project, follow this article.

Selecting an ISV tool

If you choose an ISV tool for migration, you can start by obtaining a license, or signing up for a free trial, in accordance with the ISV policy. In each tool, there’s an option to connect to Azure Migrate. Deploy the tool, and follow the tool instructions and documentation to connect the tool workspace with Azure Migrate.

Select a migration scenario

1. In the Azure Migrate project, click Overview.

2. Select the migration scenario you want to use:
   - To migrate machines and workloads to Azure, select Assess and migrate servers.
   - To migrate on-premises SQL machines, select Assess and migrate databases.
   - To migrate on-premises web apps, select Assess and migrate web apps.
   - To migrate large amounts of on-premises data to Azure in offline mode, select Order a Data Box.

Select a server migration tool

1. Click Assess and Migrate Servers.

2. In Azure Migrate - Servers, if you haven’t added migration tools yet, under Migration tools, select Click here to add a migration tool. If you’ve already added migration tools, in Add more migration tools, select Change.

   NOTE
   
   If you need to navigate to a different project, in Azure Migrate - Servers, next to See details for a different migrate project, click Click here.

3. In Azure Migrate, select the migration tool you want to use.
- If you use Azure Migrate Server Migration, you can set up and run migrations directly in the Azure Migrate project.
- If you use a third-party assessment tool, navigate to the link provided for the ISV, and run the migration in accordance with the instructions they provide.

Select a database migration tool

1. Click **Assess and migrate databases**
2. In **Databases**, click **Add tools**.
3. In Add a tool > **Select migration tool**, select the tool you want to use to migrate your database.

Select a web app migration tool

1. Click **Assess and migrate web apps**.
2. Follow the link to the Migration tool for the Azure App Service. Use the migration tool to:
   - **Assess apps online**: You can assess and migrate apps with a public URL online, using the Azure App Service Migration Assistant.
   - **.NET/PHP**: For internal .NET and PHP apps, you can download and run the Migration Assistant.

Order an Azure Data Box

To migrate large amounts of data to Azure, you can order an Azure Data Box for offline data transfer.

1. Click **Order a Data Box**.
2. In **Select your Azure Data Box**, specify your subscription.
3. The transfer will be an import to Azure. Specify the data source, and the Azure region destination for the data.

Next steps

Try out a migration using Azure Migrate Server Migration for **Hyper-V** or **VMware** VMs.
This article describes how to migrate VMware VMs to Azure virtual machines with disks encrypted using server-side encryption (SSE) with customer-managed keys (CMK), using Azure Migrate Server Migration (agentless replication).

The Azure Migrate Server Migration portal experience lets you migrate VMware VMs to Azure with agentless replication. The portal experience currently doesn't offer the ability to turn on SSE with CMK for your replicated disks in Azure. The ability to turn on SSE with CMK for the replicated disks is currently available only through REST API. In this article, you'll see how to create and deploy an Azure Resource Manager template to replicate a VMware VM and configure the replicated disks in Azure to use SSE with CMK.

The examples in this article use Azure PowerShell to perform the tasks needed to create and deploy the Resource Manager template.

Learn more about server-side encryption (SSE) with customer managed keys (CMK) for managed disks.

Prerequisites

- Review the tutorial on migration of VMware VMs to Azure with agentless replication to understand tool requirements.
- Follow these instructions to create an Azure Migrate project and add the Azure Migrate: Server Migration tool to the project.
- Follow these instructions to set up the Azure Migrate appliance for VMware in your on-premises environment and complete discovery.

Prepare for replication

Once VM discovery is complete, the Discovered Servers line on the Server Migration tile will show a count of VMware VMs discovered by the appliance.

Before you can start replicating VMs, the replication infrastructure needs to be prepared.

1. Create a Service Bus instance in the target region. The Service Bus is used by the on-premises Azure Migrate appliance to communicate with the Server Migration service to coordinate replication and migration.
2. Create a storage account for transfer of operation logs from replication.
3. Create a storage account that the Azure Migrate appliance uploads replication data to.
4. Create a Key Vault and configure the Key Vault to manage shared access signature tokens for blob access on the storage accounts created in step 3 and 4.
5. Generate a shared access signature token for the service bus created in step 1 and create a secret for the token in the Key Vault created in the previous step.
6. Create a Key Vault access policy to give the on-premises Azure Migrate appliance (using the appliance AAD app) and the Server Migration Service access to the Key Vault.
7. Create a replication policy and configure the Server Migration service with details of the replication infrastructure created in the previous step.

The replication infrastructure must be created in the target Azure region for the migration and in the target Azure subscription that the VMs are being migrated to.
The Server Migration portal experience simplifies preparation of the replication infrastructure by automatically doing this for you when you replicate a VM for the first time in a project. In this article, we'll assume that you've already replicated one or more VMs using the portal experience and that the replication infrastructure is already created. We'll look at how to discover details of the existing replication infrastructure and how to use these details as inputs to the Resource Manager template that will be used to set up replication with CMK.

Identifying replication infrastructure components

1. On the Azure portal, go to the resource groups page and select the resource group in which the Azure Migrate project was created.

2. Select Deployments from the left menu and search for a deployment name beginning with the string "Microsoft.MigrateV2.VMwareV2EnableMigrate". You'll see a list of Resource Manager templates created by the portal experience to set up replication for VMs in this project. We'll download one such template and use that as the base to prepare the template for replication with CMK.

3. To download the template, select any deployment matching the string pattern in the previous step > select Template from the left menu > Click Download from the top menu. Save the template.json file locally. You'll edit this template file in the last step.

Create a Disk Encryption Set

A disk encryption set object maps Managed Disks to a Key Vault that contains the CMK to use for SSE. To replicate VMs with CMK, you'll create a disk encryption set and pass it as an input to the replication operation.

Follow the example here to create a disk encryption set using Azure PowerShell. Ensure that the disk encryption set is created in the target subscription that VMs are being migrated to, and in the target Azure region for the migration.

```powershell
$Location = "southcentralus"                       #Target Azure region for migration
$TargetResourceGroupName = "ContosoMigrationTarget"
$KeyVaultName = "ContosoCMKVault"                  
$KeyName = "ContosoCMKKey"                         
$KeyDestination = "Software"                       
$DiskEncryptionSetName = "ContosoCMKDES"           
$KeyVault = New-AzKeyVault -Name $KeyVaultName -ResourceGroupName $TargetResourceGroupName -Location $Location -EnableSoftDelete -EnablePurgeProtection
$Key = Add-AzKeyVaultKey -VaultName $KeyVaultName -Name $KeyName -Destination $KeyDestination
$desConfig = New-AzDiskEncryptionSetConfig -Location $Location -SourceVaultId $KeyVault.ResourceId -KeyUrl $Key.Key.Kid -IdentityType SystemAssigned
$des = New-AzDiskEncryptionSet -Name $DiskEncryptionSetName -ResourceGroupName $TargetResourceGroupName -InputObject $desConfig
Set-AzKeyVaultAccessPolicy -VaultName $KeyVaultName -ObjectId $des.Identity.PrincipalId -PermissionsToKeys wrapkey,unwrapkey,get
New-AzRoleAssignment -ResourceName $KeyVaultName -ResourceGroupName $TargetResourceGroupName -ResourceType "Microsoft.KeyVault/vaults" -ObjectId $des.Identity.PrincipalId -RoleDefinitionName "Reader"
```

Get details of the VMware VM to migrate

In this step, you'll use Azure PowerShell to get the details of the VM that needs to be migrated. These details will be used to construct the Resource Manager template for replication. Specifically, the two properties of interest are:

- The machine Resource ID for the discovered VMs.
- The list of disks for the VM and their disk identifiers.
$ProjectResourceGroup = "ContosoVMwareCMK"  #Resource group that the Azure Migrate Project is created in
$ProjectName = "ContosoVMwareCMK"            #Name of the Azure Migrate Project


# Displays one entry for each appliance in the project mapping the appliance to the VMware sites discovered through the appliance.
$solution Properties.details.extendedDetails.applianceNameToSiteIDMapV2 | ConvertFrom-Json | select ApplianceName, SiteId

ApplianceName      SiteId
------------------  ------
VMwareAppliance    /subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.OffAzure/VMwareSites/VMwareAppliance8basite

Copy the value of the SiteId string corresponding to the Azure Migrate appliance that the VM is discovered through. In the example shown above, the SiteId is "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.OffAzure/VMwareSites/VMwareAppliance8basite"

#Replace value with SiteId from the previous step
$SiteId = "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.OffAzure/VMwareSites/VMwareAppliance8basite"
$SiteName = Get-AzResource -ResourceId $SiteId -ExpandProperties | Select-Object -ExpandProperty Name

#Get machine details
PS /home/bharathram> $MachineName = "FPL-W19-09"     #Replace string with VMware VM name of the machine to migrate
PS /home/bharathram> $machine = $Discoveredmachines | where {$_-Properties.displayName -eq $MachineName}
PS /home/bharathram> $machine.count   #Validate that only 1 VM was found matching this name.

Copy the ResourceId, name and disk uuid values for the machine to be migrated.

PS > $machine.Name
10-150-8-52-b090bef3-b733-5e34-bc8f-eb6f2701432a_50098f99-f949-22ca-642b-724ec6595210
PS > $machine.ResourceId
/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.OffAzure/VMwareSites/VMwareAppliance8basite/machines/10-150-8-52-b090bef3-b733-5e34-bc8f-eb6f2701432a_50098f99-f949-22ca-642b-724ec6595210

PS > $machine.Properties.disks | select uuid, label, name, maxSizeInBytes

\--- \--- \--- \---
6000C291-5106-2aac-7a74-4f33c3db78c Hard disk 1 scsi0:0    42949672960
6000C293-39a1-bd70-7b24-735f0ebeb79c4 Hard disk 2 scsi0:1    53687091200
6000C29e-cbee-4d79-39c7-d0dd0208aa9 Hard disk 3 scsi0:2    53687091200

Create Resource Manager template for replication

- Open the Resource Manager template file that you downloaded in the Identifying replication infrastructure
components step in an editor of your choice.

- Remove all resource definitions from the template except for resources that are of type "Microsoft.RecoveryServices/vaults/replicationFabrics/replicationProtectionContainers/replicationMigrationItems"
- If there are multiple resource definitions of the above type, remove all but one. Remove any dependsOn property definitions from the resource definition.
- At the end of this step, you should have a file that looks like the example below and has the same set of properties.

```json
{
  "contentVersion": "1.0.0.0",
  "resources": [
    {
      "type": "Microsoft.RecoveryServices/vaults/replicationFabrics/replicationProtectionContainers/replicationMigrationItems",
      "apiVersion": "2018-01-10",
      "name": "ContosoMigration7371rsvault/VMware104e4replicationFabric/VMware104e4replicationcontainer/10-150-8-52-b090bef3-b733-5e34-bc8f-eb6f2701432a_500937f3-805e-9414-11b1-f22923456e08",
      "properties": {
        "policyId": "/Subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/ContosoMigration/providers/Microsoft.RecoveryServices/vaults/ContosoMigration7371rsvault/replicationPolicies/migrateVMware104e4sitepolicy",
        "providerSpecificDetails": {
          "instanceType": "VMwareCbt",
          "vmwareMachineId": "/subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/ContosoMigration/providers/Microsoft.OffAzure/VMwareSites/VMware104e4site/machines/10-150-8-52-b090bef3-b733-5e34-bc8f-eb6f2701432a_500937f3-805e-9414-11b1-f22923456e08",
          "targetResourceGroupId": "/subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/PayrollRG",
          "targetNetworkId": "/subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/PayrollRG/providers/Microsoft.Network/virtualNetworks/PayrollNW",
          "targetSubnetName": "PayrollSubnet",
          "licenseType": "NoLicenseType",
          "disksToInclude": [
            {
              "diskId": "6000C295-dafe-a0eb-906e-d47cb5b05a1d",
              "isOSDisk": "true",
              "logStorageAccountId": "/subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/ContosoMigration/providers/Microsoft.Storage/storageAccounts/migratelsa1432469187",
              "logStorageAccountSasSecretName": "migratelsa1432469187-cacheSas",
              "diskType": "Standard_LRS"
            }
          ],
          "dataMoverRunAsAccountId": "/subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/ContosoMigration/providers/Microsoft.OffAzure/VMwareSites/VMware104e4site/runasaccounts/b090bef3-b733-5e34-bc8f-eb6f2701432a",
          "snapshotRunAsAccountId": "/subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/ContosoMigration/providers/Microsoft.OffAzure/VMwareSites/VMware104e4site/runasaccounts/b090bef3-b733-5e34-bc8f-eb6f2701432a",
          "targetBootDiagnosticsStorageAccountId": "/subscriptions/6785ea1f-ac40-4244-a9ce-94b12fd832ca/resourceGroups/ContosoMigration/providers/Microsoft.Storage/storageAccounts/migratelsa1432469187",
          "targetVmName": "PayrollWeb04"
        }
      }
    }
  ]
}
```

- Edit the name property in the resource definition. Replace the string that follows the last "/" in the name property with the value of $machine.Name (from the previous step).
- Change the value of the properties.providerSpecificDetails.vmwareMachineId property with value of
Set the values for targetResourceGroup, targetNetworkId, targetSubnetName to the target resource group ID, target virtual network resource ID, and target subnet name respectively.

Set the value of licenseType to "WindowsServer" to apply Azure Hybrid Benefit for this VM. If this VM is not eligible for Azure Hybrid Benefit, set the value of licenseType to NoLicenseType.

Change the value of the targetVmName property to the desired Azure virtual machine name for the migrated VM.

Optionally add a property named targetVmSize below the targetVmName property. Set the value of the targetVmSize property to the desired Azure virtual machine size for the migrated VM.

The disksToInclude property is a list of disk inputs for replication with each list item representing one on-premises disk. Create as many list items as the number of disks on the on-premises VM. Replace the diskId property in the list item to the uuid of the disks identified in the previous step. Set the isOSDisk value to "true" for the OS disk of the VM and "false" for all other disks. Leave the logStorageAccountId and the logStorageAccountSasSecretName properties unchanged. Set the diskType value to the Azure Managed Disk type (Standard_LRS, Premium_LRS, StandardSSD_LRS) to use for the disk. For the disks that need to be encrypted with CMK, add a property named diskEncryptionSetId and set the value to the resource ID of the disk encryption set created($des.Id) in the Create a Disk Encryption Set step.

Save the edited template file. For the example above, the edited template file looks as follows:

```json
{
  "contentVersion": "1.0.0.0",
  "resources": [
    {
      "type": "Microsoft.RecoveryServices/vaults/replicationFabrics/replicationProtectionContainers/replicationMigrationItems",
      "apiVersion": "2018-01-10",
      "name": "ContosoVMwareCMK00ddrsvault/VMwareApplianca8bareplicationfabric/VMwareApplianca8bareplicationcontainer/10-150-8-52-b090bef3-b733-5e34-bc8f-ebe6f2701432a_50098f99-f949-22ca-642b-724ec6595210",
      "properties": {
        "policyId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.RecoveryServices/vaults/ContosoVMwareCMK00ddrsvault/replicationPolicies/migrateVMwareApplianca8basitepolicy",
        "providerSpecificDetails": {
          "instanceType": "VMwareCbt",
          "vmwareMachineId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.OffAzure/VmwareSites/VMwareApplianca8basite/machines/10-150-8-52-b090bef3-b733-5e34-bc8f-ebe6f2701432a_50098f99-f949-22ca-642b-724ec6595210",
          "targetResourceGroupId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoMigrationTarget",
          "targetNetworkId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/cmkRTest/providers/Microsoft.Network/virtualNetworks/cmkvm1_vnet",
          "targetSubnetName": "cmkvm1_subnet",
          "licenseType": "NoLicenseType",
          "diskType": "Standard_LRS"
        },
        "disksToInclude": [
          {
            "diskId": "6000C291-5106-2aac-7a74-4f33c3dcb78c",
            "isOSDisk": "true",
            "logStorageAccountId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.Storage/storageAccounts/migratelsa1671875959",
            "logStorageAccountSasSecretName": "migratelsa1671875959-cachesas",
            "diskEncryptionSetId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/CONTOSOMIGRATIONTARGET/providers/Microsoft.Compute/diskEncryptionSets/ContosoCMKDES",
            "diskType": "Standard_LRS"
          },
          {
            "diskId": "6000C293-39a1-bd70-7b24-735f0eeb79c4",
            "isOSDisk": "false",
            "logStorageAccountId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/ContosoVMwareCMK/providers/Microsoft.Storage/storageAccounts/migratelsa1671875959",
            "logStorageAccountSasSecretName": "migratelsa1671875959-cachesas",
            "diskEncryptionSetId": "/subscriptions/509099b2-9d2c-4636-b43e-bd5cafb6be69/resourceGroups/CONTOSOMIGRATIONTARGET/providers/Microsoft.Compute/diskEncryptionSets/ContosoCMKDES",
            "diskType": "Standard_LRS"
          }
        ]
      }
    }
  ]
}
```
Set up replication

You can now deploy the edited Resource Manager template to the project resource group to set up replication for the VM. Learn how to deploy resource with Azure Resource Manager templates and Azure PowerShell

```
New-AzResourceGroupDeployment -ResourceGroupName $ProjectResourceGroup -TemplateFile "C:\Users\Administrator\Downloads\template.json"
```

Next steps

Monitor replication status through the portal experience and perform Test migrations and migration.
This article describes how to prepare on-premises machines before you start migrating them to Azure by using Azure Migrate: Server Migration.

In this article, you:

- Verify migration limitations.
- Check operating system requirements and support limitations.
- Review URL and port access for machines you want to migrate.
- Review changes you might need to make before you begin migration.
- Configure settings so drive letters are preserved after migration.
- Prepare machines so you can connect to the Azure VMs after migration.

### Verify migration limitations

- You can assess up to 35,000 VMware VMs/Hyper-V VMs in a single Azure Migrate project by using Azure Migrate Server Migration. A project can combine VMware VMs and Hyper-V VMs, up to the limits for each.
- You can select up to 10 VMs at a time for migration. If you need to replicate more, replicate in groups of 10.
- For VMware agentless migration, you can run up to 100 replications simultaneously.

### Verify operating system requirements

- Verify that your Windows operating systems are supported in Azure.
- Verify that your Linux distributions are supported in Azure.

### See what's supported

For VMware VMs, Server Migration supports agentless or agent-based migration.

- **VMware VMs**: Verify migration requirements and support for VMware VMs.
- **Hyper-V VMs**: Verify migration requirements and support for Hyper-V VMs.
- **Physical machines**: Verify migration requirements and support for on-premises physical machines and other virtualized servers.

### Review URL and port access

Machines might need internet access during migration.

- **Azure Migrate appliance**: Review URLs and ports the Azure Migrate appliance needs to access during agentless migration.
- **VMware VM agent-based migration**: Review URLs and ports the replication appliance uses during VMware VM agent-based migration.
- **Hyper-V hosts**: Review URLs and ports the Hyper-V hosts need to access during migration.
- **Physical servers**: Review URLs and ports the replication appliance uses during physical server migration.
Verify required changes before migrating

Some VMs might require changes so they can run in Azure. Azure Migrate makes these changes automatically for VMs that are running these operating systems:

- Red Hat Enterprise Linux 7.0+, 6.5+
- CentOS 7.0+, 6.5+
- SUSE Linux Enterprise Server 12 SP1+
- Ubuntu 18.04LTS, 16.04LTS, 14.04LTS
- Debian 8, 7

For other operating systems, you must manually prepare machines before migration.

Prepare Windows machines

If you're migrating a Windows machine, make the following changes before migration. If you migrate the VM before you make the changes, the VM might not boot up in Azure.

1. Enable Azure Serial Console for the Azure VM. Enabling the console helps you troubleshoot. You don’t need to reboot the VM. The Azure VM will boot by using the disk image. The disk image boot is equivalent to a reboot for the new VM.
2. If you're migrating machines that are running Windows Server 2003, install Hyper-V Guest Integration Services on the VM operating system. Learn more.

Prepare Linux machines

1. Install Hyper-V Linux Integration Services. Most new versions of Linux distributions include Hyper-V Linux Integration Services by default.
2. Rebuild the Linux init image so it contains the necessary Hyper-V drivers. Rebuilding the init image ensures that the VM will boot in Azure (required only on some distributions).
3. Enable Azure Serial Console logging. Enabling console logging helps you troubleshoot. You don’t need to reboot the VM. The Azure VM will boot by using the disk image. The disk image boot is equivalent to a reboot for the new VM.
4. Update the device map file with the device name-to-volume associations, so you use persistent device identifiers.
5. Update entries in the fstab file to use persistent volume identifiers.
6. Remove any udev rules that reserve interface names based on MAC address, and so on.
7. Update network interfaces to receive an IP address from DHCP.

Learn more about the steps to run a Linux VM on Azure, and get instructions for some of the popular Linux distributions.

Preserve drive letters after migration

When you migrate an on-premises machine to Microsoft Azure, the drive letters of additional data disks might change from their original values.

By default, Azure VMs are assigned drive D to use as temporary storage. This drive assignment causes all other attached storage drive assignments to increment by one letter. For example, if your on-premises installation uses a data disk that is assigned to drive D for application installations, the assignment for this drive increments to drive E after you migrate the VM to Azure. To prevent this automatic assignment, and to ensure that Azure assigns the next free drive letter to its temporary volume, set the storage area network (SAN) policy to OnlineAll:

1. On the on-premises machine (not the host server), open an elevated command prompt.
2. Enter `diskpart`.
3. Enter `SAN`. If the drive letter of the guest operating system isn't maintained, `Offline All` or `Offline Shared` is
Check Azure VM requirements

On-premises machines that you replicate to Azure must comply with Azure VM requirements for the operating system and architecture, the disks, network settings, and VM naming. Verify the requirements for VMware VMs and physical servers, and Hyper-V VMs before migrating.

Prepare to connect after migration

Azure VMs are created during migration to Azure. After migration, you must be able to connect to the new Azure VMs. Multiple steps are required to connect successfully.

Prepare to connect with Linux Azure VMs

On on-premises Linux machines:

1. Check that the Secure Shell service is set to start automatically on system boot.
2. Check that firewall rules allow an SSH connection.

Configure Azure VMs after migration

After migration, complete these steps on the Azure VMs that are created:

1. To connect to the VM over the internet, assign a public IP address to the VM. You must use a different public IP address for the Azure VM than you used for your on-premises machine. Learn more.
2. Check that network security group (NSG) rules on the VM allow incoming connections to the RDP or SSH port.
3. Check boot diagnostics to view the VM.

NOTE

The Azure Bastion service offers private RDP and SSH access to Azure VMs. Learn more about this service.

Next steps

Decide which method you want to use to migrate VMware VMs to Azure, or begin migrating Hyper-V VMs or physical servers or virtualized or cloud VMs.
This article describes how to delete an Azure Migrate project.

Before you start

Before you delete a project:

- When you delete a project, the project, and discovered machine metadata are deleted.
- If you've attached a Log Analytics workspace to the Server Assessment tool for dependency analysis, decide whether you want to delete the workspace.
  - The workspace isn't automatically deleted. Delete it manually.
  - Verify what a workspace is used for before you delete it. The same Log Analytics workspace can be used for multiple scenarios.
  - Before you delete the project, you can find a link to the workspace in Azure Migrate - Servers > Azure Migrate - Server Assessment, under OMS Workspace.
  - To delete a workspace after deleting a project, find the workspace in the relevant resource group, and follow these instructions.

Delete a project

1. In the Azure portal, open the resource group in which the project was created.
2. In the resource group page, select Show hidden types.
3. Select the project and the associated resources that you want to delete.
   - The resource type for Azure Migrate projects is Microsoft.Migrate/migrateprojects.
   - In the next section, review the resources created for discovery, assessment, and migration in an Azure Migrate project.
   - If the resource group only contains the Azure Migrate project, you can delete the entire resource group.
   - If you want to delete a project from the previous version of Azure Migrate, the steps are the same. The resource type for these projects is Migration project.

Created resources

These tables summarize the resources created for discovery, assessment, and migration in an Azure Migrate project.

<table>
<thead>
<tr>
<th>RESOURCE</th>
<th>TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Appliancename&quot;kv</td>
<td>Key vault</td>
</tr>
<tr>
<td>&quot;Appliancename&quot;site</td>
<td>Microsoft.OffAzure/VMwareSites</td>
</tr>
<tr>
<td>RESOURCE</td>
<td>TYPE</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>&quot;ProjectName&quot;</td>
<td>Microsoft.Migrate/migrateprojects</td>
</tr>
<tr>
<td>&quot;ProjectName&quot;.project</td>
<td>Microsoft.Migrate/assessmentProjects</td>
</tr>
<tr>
<td>&quot;ProjectName&quot;.rsvault</td>
<td>Recovery Services vault</td>
</tr>
<tr>
<td>&quot;ProjectName&quot;-MigrateVault-*</td>
<td>Recovery Services vault</td>
</tr>
<tr>
<td>migrateappligwsa*</td>
<td>Storage account</td>
</tr>
<tr>
<td>migrateapplilsa*</td>
<td>Storage account</td>
</tr>
<tr>
<td>migrateapplicsa*</td>
<td>Storage account</td>
</tr>
<tr>
<td>migrateapplikv*</td>
<td>Key vault</td>
</tr>
<tr>
<td>migrateapplisbns16041</td>
<td>Service Bus Namespace</td>
</tr>
</tbody>
</table>

Hyper-V VM

<table>
<thead>
<tr>
<th>RESOURCE</th>
<th>TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ProjectName&quot;</td>
<td>Microsoft.Migrate/migrateprojects</td>
</tr>
<tr>
<td>&quot;ProjectName&quot;.project</td>
<td>Microsoft.Migrate/assessmentProjects</td>
</tr>
<tr>
<td>HyperV*kv</td>
<td>Key vault</td>
</tr>
<tr>
<td>HyperV*Site</td>
<td>Microsoft.OffAzure/HyperVSites</td>
</tr>
<tr>
<td>&quot;ProjectName&quot;-MigrateVault-*</td>
<td>Recovery Services vault</td>
</tr>
</tbody>
</table>

Next steps

Learn how to add additional assessment and migration tools.
This article provides information about working with the previous version of Azure Migrate.

There are two versions of the Azure Migrate service:

- **Current version**: Use this version to create Azure Migrate projects, discover on-premises machines, and orchestrate assessments and migrations. [Learn more](#) about what's new in this version.
- **Previous version**: If you're using the previous version of Azure Migrate (only assessment of on-premises VMware VMs was supported), you should now use the current version. If you still need to use Azure Migrate projects created in the previous version, this is what you can and can't do:
  - You can no longer create migration projects.
  - We recommend that you don't perform new discoveries.
  - You can still access existing projects.
  - You can still run assessments.

### Upgrade between versions

You can't upgrade projects or components in the previous version to the new version. You need to [create a new Azure Migrate project](#), and add assessment and migration tools to it.

### Find projects from previous version

Find projects from the previous version as follows:

1. In the Azure portal > **All services**, search for and select **Azure Migrate**.
2. On the Azure Migrate dashboard, there's a notification and a link to access old Azure Migrate projects.
3. Click the link to open v1 projects.

### Create an assessment

After VMs are discovered in the portal, you group them and create assessments.

- You can immediately create as on-premises assessments immediately after VMs are discovered in the portal.
- For performance-based assessments, we recommend you wait at least a day before creating a performance-based assessment, to get reliable size recommendations.

Create an assessment as follows:

1. In the project **Overview** page, click **+Create assessment**.
2. Click **View all** to review the assessment properties.
3. Create the group, and specify a group name.
4. Select the machines that you want to add to the group.
5. Click **Create Assessment**, to create the group and the assessment.
6. After the assessment is created, view it in **Overview** > **Dashboard**.
7. Click **Export assessment**, to download it as an Excel file.

If you would like to update an existing assessment with the latest performance data, you can use the **Recalculate** command on the assessment to update it.
Review an assessment

An assessment has three stages:

- An assessment starts with a suitability analysis to figure out whether machines are compatible in Azure.
- Sizing estimations.
- Monthly cost estimation.

A machine only moves along to a later stage if it passes the previous one. For example, if a machine fails the suitability check, it's marked as unsuitable for Azure, and sizing and costing isn't done.

**Review Azure readiness**

The Azure readiness view in the assessment shows the readiness status of each VM.

<table>
<thead>
<tr>
<th>READINESS</th>
<th>STATE</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready for Azure</td>
<td>No compatibility issues. The machine can be migrated as-is to Azure, and it will boot in Azure with full Azure support.</td>
<td>For VMs that are ready, Azure Migrate recommends a VM size in Azure.</td>
</tr>
<tr>
<td>Conditionally ready for Azure</td>
<td>The machine might boot in Azure, but might not have full Azure support. For example, a machine with an older version of Windows Server that isn't supported in Azure.</td>
<td>Azure Migrate explains the readiness issues, and provides remediation steps.</td>
</tr>
<tr>
<td>Not ready for Azure</td>
<td>The VM won't boot in Azure. For example, if a VM has a disk that's more than 4 TB, it can't be hosted on Azure.</td>
<td>Azure Migrate explains the readiness issues, and provides remediation steps.</td>
</tr>
<tr>
<td>Readiness unknown</td>
<td>Azure Migrate can't identify Azure readiness, usually because data isn't available.</td>
<td></td>
</tr>
</tbody>
</table>

**Azure VM properties**

Readiness takes into account a number of VM properties, to identify whether the VM can run in Azure.

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>DETAILS</th>
<th>READINESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot type</td>
<td>BIOS supported. UEFI not supported.</td>
<td>Conditionally ready if boot type is UEFI.</td>
</tr>
<tr>
<td>Cores</td>
<td>Machines cores ≤ the maximum number of cores (128) supported for an Azure VM. If performance history is available, Azure Migrate considers the utilized cores. If a comfort factor is specified in the assessment settings, the number of utilized cores is multiplied by the comfort factor. If there's no performance history, Azure Migrate uses the allocated cores, without applying the comfort factor.</td>
<td>Ready if less than or equal to limits.</td>
</tr>
</tbody>
</table>
### Memory

<table>
<thead>
<tr>
<th>DETAILS</th>
<th>READINESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>The machine memory size &lt;= the maximum memory (3892 GB on Azure M series Standard_M128m^2) for an Azure VM. Learn more. &lt;br&gt; If performance history is available, Azure Migrate considers the utilized memory. &lt;br&gt; If a comfort factor is specified, the utilized memory is multiplied by the comfort factor. &lt;br&gt; If there’s no history the allocated memory is used, without applying the comfort factor.</td>
<td>Ready if within limits.</td>
</tr>
</tbody>
</table>

### Storage disk

<table>
<thead>
<tr>
<th>DETAILS</th>
<th>READINESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated size of a disk must be 4 TB (4096 GB) or less. &lt;br&gt; The number of disks attached to the machine must be 65 or less, including the OS disk.</td>
<td>Ready if within limits.</td>
</tr>
</tbody>
</table>

### Networking

<table>
<thead>
<tr>
<th>DETAILS</th>
<th>READINESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>A machine must have 32 or less NICs attached to it.</td>
<td>Ready if within limits.</td>
</tr>
</tbody>
</table>

### Guest operating system

Along with VM properties, Azure Migrate also looks at the guest OS of the on-premises VM to identify if the VM can run in Azure.

- Azure Migrate considers the OS specified in vCenter Server.
- Since the discovery done by Azure Migrate is appliance-based, it does not have a way to verify if the OS running inside the VM is same as the one specified in vCenter Server.

The following logic is used.

<table>
<thead>
<tr>
<th>OPERATING SYSTEM</th>
<th>DETAILS</th>
<th>READINESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2016 and all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure</td>
</tr>
<tr>
<td>Windows Server 2012 R2 and all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure</td>
</tr>
<tr>
<td>Windows Server 2012 and all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure</td>
</tr>
<tr>
<td>Windows Server 2008 R2 and all SPs</td>
<td>Azure provides full support.</td>
<td>Ready for Azure</td>
</tr>
<tr>
<td>Windows Server 2008 (32-bit and 64-bit)</td>
<td>Azure provides full support.</td>
<td>Ready for Azure</td>
</tr>
<tr>
<td>OPERATING SYSTEM</td>
<td>DETAILS</td>
<td>READINESS</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>Windows 2000, 98, 95, NT, 3.1, MS-DOS</td>
<td>Out-of-support. The machine might boot in Azure, but no OS support is provided by Azure.</td>
<td>Conditionally ready for Azure, it is recommended to upgrade the OS before migrating to Azure.</td>
</tr>
<tr>
<td>Windows Client 7, 8 and 10</td>
<td>Azure provides support with Visual Studio subscription only.</td>
<td>Conditionally ready for Azure</td>
</tr>
<tr>
<td>Windows 10 Pro Desktop</td>
<td>Azure provides support with Multitenant Hosting Rights.</td>
<td>Conditionally ready for Azure</td>
</tr>
<tr>
<td>Windows Vista, XP Professional</td>
<td>Out-of-support. The machine might boot in Azure, but no OS support is provided by Azure.</td>
<td>Conditionally ready for Azure, it is recommended to upgrade the OS before migrating to Azure.</td>
</tr>
<tr>
<td>Linux</td>
<td>Azure endorses these Linux operating systems. Other Linux operating systems might boot in Azure, but we recommend upgrading the OS to an endorsed version, before migrating to Azure.</td>
<td>Ready for Azure if the version is endorsed. Conditionally ready if the version is not endorsed.</td>
</tr>
<tr>
<td>Other operating systems</td>
<td>Azure doesn't endorse these operating systems. The machine may boot in Azure, but no OS support is provided by Azure.</td>
<td>Conditionally ready for Azure, it is recommended to install a supported OS before migrating to Azure.</td>
</tr>
<tr>
<td>OS specified as Other in vCenter Server</td>
<td>Azure Migrate cannot identify the OS in this case.</td>
<td>Unknown readiness. Ensure that the OS running inside the VM is supported in Azure.</td>
</tr>
<tr>
<td>32-bit operating systems</td>
<td>The machine may boot in Azure, but Azure may not provide full support.</td>
<td>Conditionally ready for Azure, consider upgrading the OS of the machine from 32-bit OS to 64-bit OS before migrating to Azure.</td>
</tr>
</tbody>
</table>

**Review sizing**

The Azure Migrate size recommendation depends on the sizing criterion specified in the assessment properties.

- If sizing is performance-based, the size recommendation considers the performance history of the VMs (CPU and memory) and disks (IOPS and throughput).
- If the sizing criterion is ‘as on-premises’, the size recommendation in Azure is based on the size of the VM on-premises. Disk sizing is based on the Storage type specified in the assessment properties (default is premium disks). Azure Migrate doesn’t consider the performance data for the VM and disks.

**Review cost estimates**

Cost estimates show the total compute and storage cost of running the VMs in Azure, along with the details for each machine.

- Cost estimates are calculated using the size recommendation for a VM machine, and its disks, and the assessment properties.
- Estimated monthly costs for compute and storage are aggregated for all VMs in the group.
- The cost estimation is for running the on-premises VM as Azure Infrastructure as a service (IaaS) VMs. Azure Migrate doesn’t consider Platform as a service (PaaS), or Software as a service (SaaS) costs.

**Review confidence rating (performance-based assessment)**
Each performance-based assessment is associated with a confidence rating.

- A confidence rating ranges from one-star to five-star (one-star being the lowest and five-star the highest).
- The confidence rating is assigned to an assessment, based on the availability of data points needed to compute the assessment.
- The confidence rating of an assessment helps you estimate the reliability of the size recommendations provided by Azure Migrate.
- Confidence rating isn't available for "as-is" on-premises assessments.

For performance-based sizing, Azure Migrate needs the following:

- Utilization data for CPU.
- VM memory data.
- For every disk attached to the VM, it needs the disk IOPS and throughput data.
- For each network adapter attached to a VM, Azure Migrate needs the network input/output.
- If any of the above aren't available, size recommendations (and thus confidence ratings) might not be reliable.

Depending on the percentage of data points available, the possible confidence ratings are summarized in the table.

<table>
<thead>
<tr>
<th>AVAILABILITY OF DATA POINTS</th>
<th>CONFIDENCE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%-20%</td>
<td>1 Star</td>
</tr>
<tr>
<td>21%-40%</td>
<td>2 Star</td>
</tr>
<tr>
<td>41%-60%</td>
<td>3 Star</td>
</tr>
<tr>
<td>61%-80%</td>
<td>4 Star</td>
</tr>
<tr>
<td>81%-100%</td>
<td>5 Star</td>
</tr>
</tbody>
</table>

Assessment issues affecting confidence ratings

An assessment might not have all the data points available due to a number of reasons:

- You didn't profile your environment for the duration of the assessment. For example, if you create the assessment with performance duration set to one day, you must wait for at least a day after you start the discovery, or all the data points to be collected.
- Some VMs were shut down during the period for which the assessment was calculated. If any VMs were powered off for part of the duration, Azure Migrate can't collect performance data for that period.
- Some VMs were created in between during the assessment calculation period. For example, if you create an assessment using the last month's performance history, but create a number of VMs in the environment a week ago, the performance history of the new VMs won't be for the entire duration.

**NOTE**

If the confidence rating of any assessment is below five-stars, wait for at least a day for the appliance to profile the environment, and then recalculate the assessment. If you don't performance-based sizing might not be reliable. If you don't want to recalculate, we recommended switching to as on-premises sizing, by changing the assessment properties.

Create groups using dependency visualization

In addition to creating groups manually, you can create groups using dependency visualization.

- You typically use this method when you want to assess groups with higher levels of confidence by cross-
checking machine dependencies, before you run an assessment.

- Dependency visualization can help you effectively plan your migration to Azure. It helps you ensure that nothing is left behind, and that surprise outages do not occur when you are migrating to Azure.
- You can discover all interdependent systems that need to migrate together and identify whether a running system is still serving users or is a candidate for decommissioning instead of migration.
- Azure Migrate uses the Service Map solution in Azure Monitor to enable dependency visualization.

NOTE
Dependency visualization is not available in Azure Government.

To set up dependency visualization, you associate a Log Analytics workspace with an Azure Migrate project, install agents on machines for which you want to visualize dependencies, and then create groups using dependency information.

**Associate a Log Analytics workspace**

To use dependency visualization, you associate a Log Analytics workspace with a migration project. You can only create or attach a workspace in the same subscription where the migration project is created.

1. To attach a Log Analytics workspace to a project, in Overview, > Essentials, click Requires configuration.
2. You can create a new workspace, or attach an existing one:
   - To create a new workspace, specify a name. The workspace is created in a region in the same Azure geography as the migration project.
   - When you attach an existing workspace, you can pick from all the available workspaces in the same subscription as the migration project. Only those workspaces are listed which were created in a supported Service Map region. To attach a workspace, ensure that you have ‘Reader’ access to the workspace.

NOTE
You can’t change the workspace associated with a migration project.

**Download and install VM agents**

After you configure a workspace, you download and install agents on each on-premises machine that you want to evaluate. In addition, if you have machines with no internet connectivity, you need to download and install Log Analytics gateway on them.

1. In Overview, click Manage > Machines, and select the required machine.
2. In the Dependencies column, click Install agents.
3. On the Dependencies page, download and install the Microsoft Monitoring Agent (MMA), and the Dependency agent on each VM you want to assess.
4. Copy the workspace ID and key. You need these when you install the MMA on the on-premises machine.

NOTE
To automate the installation of agents you can use a deployment tool such as Configuration Manager or a partner tool such as, Intigua, that provides an agent deployment solution for Azure Migrate.

**Install the MMA agent on a Windows machine**

To install the agent on a Windows machine:

1. Double-click the downloaded agent.
2. On the **Welcome** page, click **Next**. On the **License Terms** page, click **I Agree** to accept the license.
3. In **Destination Folder**, keep or modify the default installation folder > **Next**.
4. In **Agent Setup Options**, select **Azure Log Analytics** > **Next**.
5. Click **Add** to add a new Log Analytics workspace. Paste in the workspace ID and key that you copied from the portal. Click **Next**.

You can install the agent from the command line or using an automated method such as Configuration Manager. [Learn more](#) about using these methods to install the MMA agent.

**Install the MMA agent on a Linux machine**

To install the agent on a Linux machine:

1. Transfer the appropriate bundle (x86 or x64) to your Linux computer using `scp/sftp`.
2. Install the bundle by using the --install argument.

```bash
sudo sh ./omsagent-<version>.universal.x64.sh --install -w <workspace id> -s <workspace key>
```

[Learn more](#) about the list of Linux operating systems support by MMA.

**Install the MMA agent on a machine monitored by Operations Manager**

For machines monitored by System Center Operations Manager 2012 R2 or later, there is no need to install the MMA agent. Service Map integrates with the Operations Manager MMA to gather the necessary dependency data. [Learn more](#). The Dependency agent does need to be installed.

**Install the Dependency agent**

1. To install the Dependency agent on a Windows machine, double-click the setup file and follow the wizard.
2. To install the Dependency agent on a Linux machine, install as root using the following command:

```bash
sh InstallDependencyAgent-Linux64.bin
```

- [Learn more](#) about the **Dependency agent support** for the Windows and Linux operating systems.
- [Learn more](#) about how you can use scripts to install the Dependency agent.

**NOTE**

The Azure Monitor for VMs article referenced to provide an overview of the system prerequisites and methods to deploy the Dependency agent are also applicable to the Service Map solution.

**Create a group with dependency mapping**

1. After you install the agents, go to the portal and click **Manage** > **Machines**.
2. Search for the machine where you installed the agents.
3. The **Dependencies** column for the machine should now show as **View Dependencies**. Click the column to view the dependencies of the machine.
4. The dependency map for the machine shows the following details:

   - Inbound (Clients) and outbound (Servers) TCP connections to/from the machine
     - The dependent machines that do not have the MMA and dependency agent installed are grouped by port numbers.
     - The dependent machines that have the MMA and the dependency agent installed are shown as separate boxes.
   - Processes running inside the machine, you can expand each machine box to view the processes
   - Machine properties, including the FQDN, operating System, MAC address are shown. You can click on
5. You can view dependencies for different time durations by clicking on the time duration in the time range label. By default the range is an hour. You can modify the time range, or specify start and end dates, and duration.

**NOTE**
A time range of up to an hour is supported. Use Azure Monitor logs to query dependency data over a longer duration.

6. After you’ve identified dependent machines that you want to group together, use Ctrl+Click to select multiple machines on the map, and click **Group machines**.

7. Specify a group name. Verify that the dependent machines are discovered by Azure Migrate.

**NOTE**
If a dependent machine is not discovered by Azure Migrate, you can't add it to the group. To add such machines to the group, you need to run the discovery process again with the right scope in vCenter Server and ensure that the machine is discovered by Azure Migrate.

8. If you want to create an assessment for this group, select the checkbox to create a new assessment for the group.

9. Click **OK** to save the group.

Once the group is created, it is recommended to install agents on all the machines of the group and refine the group by visualizing the dependency of the entire group.

**Query dependency data from Azure Monitor logs**

Dependency data captured by Service Map is available for querying in the Log Analytics workspace associated with your Azure Migrate project. Learn more about the Service Map data tables to query in Azure Monitor logs.

To run the Kusto queries:

1. After you install the agents, go to the portal and click **Overview**.
2. In **Overview**, go to **Essentials** section of the project and click on workspace name provided next to **OMS Workspace**.
3. On the Log Analytics workspace page, click **General > Logs**.
4. Write your query to gather dependency data using Azure Monitor logs. Find sample queries in the next section.
5. Run your query by clicking on Run.

Learn more about how to write Kusto queries.

**Sample Azure Monitor logs queries**

Following are sample queries you can use to extract dependency data. You can modify the queries to extract your preferred data points. An exhaustive list of the fields in dependency data records is available here. Find more sample queries here.

**Summarize inbound connections on a set of machines**

The records in the table for connection metrics, VMConnection, do not represent individual physical network connections. Multiple physical network connections are grouped into a logical connection. Learn more about how physical network connection data is aggregated into a single logical record in VMConnection.
// the machines of interest
let ips=materialize(ServiceMapComputer_CL
  | summarize ips=makeset(todynamic(Ipv4Addresses_s)) by MonitoredMachine=ResourceName_s
  | mexpand ips to typeof(string));
let StartDateTime = datetime(2019-03-25T00:00:00Z);
let EndDateTime = datetime(2019-03-30T01:00:00Z);
VMConnection
  | where Direction == 'inbound'
  | where TimeGenerated > StartDateTime and TimeGenerated < EndDateTime
  | join kind=inner (ips) on $left.DestinationIp == $right.ips
  | summarize sum(LinksEstablished) by Computer, Direction, SourceIp, DestinationIp, DestinationPort

Summarize volume of data sent and received on inbound connections between a set of machines

// the machines of interest
let ips=materialize(ServiceMapComputer_CL
  | summarize ips=makeset(todynamic(Ipv4Addresses_s)) by MonitoredMachine=ResourceName_s
  | mexpand ips to typeof(string));
let StartDateTime = datetime(2019-03-25T00:00:00Z);
let EndDateTime = datetime(2019-03-30T01:00:00Z);
VMConnection
  | where Direction == 'inbound'
  | where TimeGenerated > StartDateTime and TimeGenerated < EndDateTime
  | join kind=inner (ips) on $left.DestinationIp == $right.ips
  | summarize sum(BytesSent), sum(BytesReceived) by Computer, Direction, SourceIp, DestinationIp, DestinationPort

Next steps
Learn about the latest version of Azure Migrate.
This article describes how to assess large numbers (1000-35,000) of on-premises VMware VMs for migration to Azure, using the Azure Migrate Server Assessment tool.

**Azure Migrate** provides a hub of tools that help you to discover, assess, and migrate apps, infrastructure, and workloads to Microsoft Azure. The hub includes Azure Migrate tools, and third-party independent software vendor (ISV) offerings.

In this article, you learn how to:

- Plan for assessment at scale.
- Configure Azure permissions, and prepare VMware for assessment.
- Create an Azure Migrate project, and create an assessment.
- Review the assessment as you plan for migration.

**NOTE**

If you want to try out a proof-of-concept to assess a couple of VMs before assessing at scale, follow our tutorial series.

**Plan for assessment**

When planning for assessment of large number of VMware VMs, there are a couple of things to think about:

- **Plan Azure Migrate projects**: Figure out how to deploy Azure Migrate projects. For example, if your data centers are in different geographies, or you need to store discovery, assessment or migration-related metadata in a different geography, you might need multiple projects.

- **Plan appliances**: Azure Migrate uses an on-premises Azure Migrate appliance, deployed as a VMware VM, to continually discover VMs. The appliance monitors environment changes such as adding VMs, disks, or network adapters. It also sends metadata and performance data about them to Azure. You need to figure out how many appliances you need to deploy.

- **Plan accounts for discovery**: The Azure Migrate appliance uses an account with access to vCenter Server in order to discover VMs for assessment and migration. If you’re discovering more than 10,000 VMs, set up multiple accounts.

**Planning limits**

Use the limits summarized in this table for planning.

<table>
<thead>
<tr>
<th>PLANNING</th>
<th>LIMITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Azure Migrate projects</td>
<td>Assess up to 35,000 VMs in a project.</td>
</tr>
</tbody>
</table>
### Azure Migrate appliance

An appliance can discover up to 10,000 VMs on a vCenter Server. An appliance can only connect to a single vCenter Server. An appliance can only be associated with a single Azure Migrate project. Any number of appliances can be associated with a single Azure Migrate project.

### Group

You can add up to 35,000 VMs in a single group.

### Azure Migrate assessment

You can assess up to 35,000 VMs in a single assessment.

With these limits in mind, here are some example deployments:

<table>
<thead>
<tr>
<th>VCENTER SERVER</th>
<th>VMS ON SERVER</th>
<th>RECOMMENDATION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>&lt; 10,000</td>
<td>One Azure Migrate project. One appliance. One vCenter account for discovery.</td>
<td>Set up appliance, connect to vCenter Server with an account.</td>
</tr>
<tr>
<td>One</td>
<td>&gt; 10,000</td>
<td>One Azure Migrate project. Multiple appliances. Multiple vCenter accounts.</td>
<td>Set up appliance for every 10,000 VMs. Set up vCenter accounts, and divide inventory to limit access for an account to less than 10,000 VMs. Connect each appliance to vCenter server with an account. You can analyze dependencies across machines that are discovered with different appliances.</td>
</tr>
<tr>
<td>Multiple</td>
<td>&lt; 10,000</td>
<td>One Azure Migrate project. Multiple appliances. One vCenter account for discovery.</td>
<td>Set up appliances, connect to vCenter Server with an account. You can analyze dependencies across machines that are discovered with different appliances.</td>
</tr>
</tbody>
</table>
Plan discovery in a multi-tenant environment

If you’re planning for a multi-tenant environment, you can scope the discovery on the vCenter Server.

- You can set the appliance discovery scope to a vCenter Server datacenters, clusters or folder of clusters, hosts or folder of hosts, or individual VMs.
- If your environment is shared across tenants and you want to discover each tenant separately, you can scope access to the vCenter account that the appliance uses for discovery.
  - You may want to scope by VM folders if the tenants share hosts. Azure Migrate can’t discover VMs if the vCenter account has access granted at the vCenter VM folder level. If you are looking to scope your discovery by VM folders, you can do so by ensuring the vCenter account has read-only access assigned at a VM level. Learn more.

Prepare for assessment

Prepare Azure and VMware for server assessment.

1. Verify VMware support requirements and limitations.
2. Set up permissions for your Azure account to interact with Azure Migrate.

Follow the instructions in this tutorial to configure these settings.

Create a project

In accordance with your planning requirements, do the following:

1. Create an Azure Migrate projects.
2. Add the Azure Migrate Server Assessment tool to the projects.

Learn more

Create and review an assessment
1. Create assessments for VMware VMs.
2. Review the assessments in preparation for migration planning.

Follow the instructions in this tutorial to configure these settings.

Next steps

In this article, you:

- Planned to scale Azure Migrate assessments for VMware VMs
- Prepared Azure and VMware for assessment
- Created an Azure Migrate project and ran assessments
- Reviewed assessments in preparation for migration.

Now, learn how assessments are calculated, and how to modify assessments.
Assess large numbers of Hyper-V VMs for migration to Azure

This article describes how to assess large numbers of on-premises Hyper-V VMs for migration to Azure, using the Azure Migrate Server Assessment tool.

Azure Migrate provides a hub of tools that help you to discover, assess, and migrate apps, infrastructure, and workloads to Microsoft Azure. The hub includes Azure Migrate tools, and third-party independent software vendor (ISV) offerings.

In this article, you learn how to:

- Plan for assessment at scale.
- Configure Azure permissions, and prepare Hyper-V for assessment.
- Create an Azure Migrate project, and create an assessment.
- Review the assessment as you plan for migration.

NOTE
If you want to try out a proof-of-concept to assess a couple of VMs before assessing at scale, follow our tutorial series

Plan for assessment

When planning for assessment of large number of Hyper-V VMs, there are a couple of things to think about:

- **Plan Azure Migrate projects**: Figure out how to deploy Azure Migrate projects. For example, if your data centers are in different geographies, or you need to store discovery, assessment or migration-related metadata in a different geography, you might need multiple projects.

- **Plan appliances**: Azure Migrate uses an on-premises Azure Migrate appliance, deployed as a Hyper-V VM, to continually discover VMs for assessment and migration. The appliance monitors environment changes such as adding VMs, disks, or network adapters. It also sends metadata and performance data about them to Azure. You need to figure out how many appliances to deploy.

Planning limits

Use the limits summarized in this table for planning.

<table>
<thead>
<tr>
<th>Planning</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Azure Migrate projects</td>
<td>Assess up to 35,000 VMs in a project.</td>
</tr>
<tr>
<td>Azure Migrate appliance</td>
<td>An appliance can discover up to 5000 VMs. An appliance can connect to up to 300 Hyper-V hosts. An appliance can only be associated with a single Azure Migrate project. Any number of appliances can be associated with a single Azure Migrate project.</td>
</tr>
</tbody>
</table>
Other planning considerations

- To start discovery from the appliance, you have to select each Hyper-V host.
- If you’re running a multi-tenant environment, you can’t currently discover only VMs that belong to a specific tenant.

Prepare for assessment

Prepare Azure and Hyper-V for server assessment.

1. Verify Hyper-V support requirements and limitations.
2. Set up permissions for your Azure account to interact with Azure Migrate
3. Prepare Hyper-V hosts and VMs

Follow the instructions in this tutorial to configure these settings.

Create a project

In accordance with your planning requirements, do the following:

1. Create an Azure Migrate project.
2. Add the Azure Migrate Server Assessment tool to the projects.

Learn more

Create and review an assessment

1. Create assessments for Hyper-V VMs.
2. Review the assessments in preparation for migration planning.

Learn more about creating and reviewing assessments.

Next steps

In this article, you:

- Planned to scale Azure Migrate assessments for Hyper-V VMs
- Prepared Azure and Hyper-V for assessment
- Created an Azure Migrate project and ran assessments
- Reviewed assessments in preparation for migration.

Now, learn how assessments are calculated, and how to modify assessments
Assess large numbers of physical servers for migration to Azure

This article describes how to assess large numbers of on-premises physical servers for migration to Azure, using the Azure Migrate Server Assessment tool.

Azure Migrate provides a hub of tools that help you to discover, assess, and migrate apps, infrastructure, and workloads to Microsoft Azure. The hub includes Azure Migrate tools, and third-party independent software vendor (ISV) offerings.

In this article, you learn how to:

- Plan for assessment at scale.
- Configure Azure permissions, and prepare physical servers for assessment.
- Create an Azure Migrate project, and create an assessment.
- Review the assessment as you plan for migration.

**NOTE**
If you want to try out a proof-of-concept to assess a couple of servers before assessing at scale, follow our tutorial series.

Plan for assessment

When planning for assessment of large number of physical servers, there are a couple of things to think about:

- **Plan Azure Migrate projects**: Figure out how to deploy Azure Migrate projects. For example, if your data centers are in different geographies, or you need to store discovery, assessment or migration-related metadata in a different geography, you might need multiple projects.

- **Plan appliances**: Azure Migrate uses an on-premises Azure Migrate appliance, deployed on a Windows machine, to continually discover servers for assessment and migration. The appliance monitors environment changes such as adding VMs, disks, or network adapters. It also sends metadata and performance data about them to Azure. You need to figure out how many appliances to deploy.

Planning limits

Use the limits summarized in this table for planning.

<table>
<thead>
<tr>
<th>PLANNING</th>
<th>LIMITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Azure Migrate projects</td>
<td>Assess up to 35,000 servers in a project.</td>
</tr>
<tr>
<td>Azure Migrate appliance</td>
<td>An appliance can discover up to 250 servers. An appliance can only be associated with a single Azure Migrate project. Any number of appliances can be associated with a single Azure Migrate project.</td>
</tr>
</tbody>
</table>
#### Other planning considerations

- To start discovery from the appliance, you have to select each physical server.

#### Prepare for assessment

Prepare Azure and physical servers for server assessment.

1. Verify physical server support requirements and limitations.
2. Set up permissions for your Azure account to interact with Azure Migrate.
3. Prepare the physical servers.

Follow the instructions in [this tutorial](#) to configure these settings.

#### Create a project

In accordance with your planning requirements, do the following:

1. Create an Azure Migrate project.
2. Add the Azure Migrate Server Assessment tool to the projects.

[Learn more](#)

#### Create and review an assessment

1. Create assessments for physical servers.
2. Review the assessments in preparation for migration planning.

[Learn more](#) about creating and reviewing assessments.

#### Next steps

In this article, you:

- Planned to scale Azure Migrate assessments for physical servers.
- Prepared Azure and physical servers for assessment.
- Created an Azure Migrate project and ran assessments.
- Reviewed assessments in preparation for migration.

Now, learn how assessments are calculated, and how to [modify assessments](#).
This article helps you understand how to use scripts to migrate large number of virtual machines (VMs). To scale migration, you use Azure Site Recovery.

Site Recovery scripts are available for your download at Azure PowerShell Samples repo on GitHub. The scripts can be used to migrate VMware, AWS, GCP VMs, and physical servers to managed disks in Azure. You can also use these scripts to migrate Hyper-V VMs if you migrate the VMs as physical servers. The scripts that leverage Azure Site Recovery PowerShell are documented here.

Current limitations

- Support specifying the static IP address only for the primary NIC of the target VM
- The scripts do not take Azure Hybrid Benefit related inputs, you need to manually update the properties of the replicated VM in the portal

How does it work?

**Prerequisites**

Before you get started, you need to do the following steps:

- Ensure that the Site Recovery vault is created in your Azure subscription
- Ensure that the Configuration Server and Process Server are installed in the source environment and the vault is able to discover the environment
- Ensure that a Replication Policy is created and associated with the Configuration Server
- Ensure that you have added the VM admin account to the config server (that will be used to replicate the on-premises VMs)
- Ensure that the target artifacts in Azure are created
  - Target Resource Group
  - Target Storage Account (and its Resource Group) - Create a premium storage account if you plan to migrate to premium-managed disks
  - Cache Storage Account (and its Resource Group) - Create a standard storage account in the same region as the vault
  - Target Virtual Network for failover (and its Resource Group)
  - Target Subnet
  - Target Virtual Network for Test failover (and its Resource Group)
  - Availability Set (if needed)
  - Target Network Security Group and its Resource Group
- Ensure that you have decided on the properties of the target VM
  - Target VM name
  - Target VM size in Azure (can be decided using Azure Migrate assessment)
  - Private IP Address of the primary NIC in the VM
- Download the scripts from Azure PowerShell Samples repo on GitHub

**CSV Input file**

Once you have all the pre-requisites completed, you need to create a CSV file, which has data for each source
machine that you want to migrate. The input CSV must have a header line with the input details and a row with details for each machine that needs to be migrated. All the scripts are designed to work on the same CSV file. A sample CSV template is available in the scripts folder for your reference.

**Script execution**

Once the CSV is ready, you can execute the following steps to perform migration of the on-premises VMs:

<table>
<thead>
<tr>
<th>STEP #</th>
<th>SCRIPT NAME</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>asr_startmigration.ps1</td>
<td>Enable replication for all the VMs listed in the csv, the script creates a CSV output with the job details for each VM</td>
</tr>
<tr>
<td>2</td>
<td>asr_replicationstatus.ps1</td>
<td>Check the status of replication, the script creates a csv with the status for each VM</td>
</tr>
<tr>
<td>3</td>
<td>asr_updateproperties.ps1</td>
<td>Once the VMs are replicated/protected, use this script to update the target properties of the VM (Compute and Network properties)</td>
</tr>
<tr>
<td>4</td>
<td>asr_propertiescheck.ps1</td>
<td>Verify if the properties are appropriately updated</td>
</tr>
<tr>
<td>5</td>
<td>asr_testmigration.ps1</td>
<td>Start the test failover of the VMs listed in the csv, the script creates a CSV output with the job details for each VM</td>
</tr>
<tr>
<td>6</td>
<td>asr_cleanuptestmigration.ps1</td>
<td>Once you manually validate the VMs that were test failed-over, you can use this script to clean up the test failover VMs</td>
</tr>
<tr>
<td>7</td>
<td>asr_migration.ps1</td>
<td>Perform an unplanned failover for the VMs listed in the csv, the script creates a CSV output with the job details for each VM. The script does not shut down the on-premises VMs before triggering the failover, for application consistency, it is recommended that you manually shut down the VMs before executing the script.</td>
</tr>
<tr>
<td>8</td>
<td>asr_completemigration.ps1</td>
<td>Perform the commit operation on the VMs and delete the Azure Site Recovery entities</td>
</tr>
<tr>
<td>9</td>
<td>asr_postmigration.ps1</td>
<td>If you plan to assign network security groups to the NICs post-failover, you can use this script to do that. It assigns an NSG to any one NIC in the target VM.</td>
</tr>
</tbody>
</table>

**How to migrate to managed disks?**

The script, by default, migrates the VMs to managed disks in Azure. If the target storage account provided is a premium storage account, premium-managed disks are created post migration. The cache storage account can still
be a standard account. If the target storage account is a standard storage account, standard disks are created post migration.

**Next steps**

[Learn more about migrating servers to Azure using Azure Site Recovery](#)
We have a series of articles that demonstrate how the fictitious organization Contoso migrates its on-premises infrastructure to the Microsoft Azure cloud.

The series includes scenarios that illustrate how to set up an infrastructure migration, and how to run different types of migrations. Scenarios grow in complexity as they progress. The articles show how the Contoso company handles migration, but general instructions and pointers are provided throughout.

**Migration articles**

The articles in the series are summarized in the table below.

- Each migration scenario is driven by slightly different business requirements, that determine the migration strategy.
- For each deployment scenario, we provide information about business drivers and goals, a proposed architecture, steps to perform the migration, and recommendations for cleanup and next steps after migration is complete.

<table>
<thead>
<tr>
<th>Article</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article 1: Overview</td>
<td>Overview of the article series, Contoso's migration strategy, and the sample apps that are used in the series.</td>
</tr>
<tr>
<td>Article 2: Deploy Azure infrastructure</td>
<td>Contoso prepares its on-premises infrastructure, and Azure infrastructure for migration. The same infrastructure is used for all articles in the series.</td>
</tr>
<tr>
<td>Article 3: Assess on-premises resources for migration to Azure</td>
<td>Contoso runs an assessment of its on-premises SmartHotel360 app running on VMware. Contoso assesses app VMs using the Azure Migrate service, and the app SQL Server database using Data Migration Assistant.</td>
</tr>
<tr>
<td>Article 4: Rehost an app on an Azure VM and SQL Database Managed Instance</td>
<td>Contoso runs a lift-and-shift migration to Azure for its on-premises SmartHotel360 app. Contoso migrates the app front-end VM using Azure Migrate. Contoso migrates the app database to an Azure SQL Database Managed Instance, using the Azure Database Migration Service.</td>
</tr>
<tr>
<td>Article 5: Rehost an app on Azure VMs</td>
<td>Contoso migrates its SmartHotel360 app VMs to Azure VMs using the Azure Migrate service.</td>
</tr>
<tr>
<td>Article 6: Rehost an app on Azure VMs and in a SQL Server AlwaysOn availability group</td>
<td>Contoso migrates the SmartHotel360 app. Contoso uses Azure Migrate to migrate the app VMs. It uses the Database Migration Service to migrate the app database to a SQL Server cluster that's protected by an AlwaysOn availability group.</td>
</tr>
<tr>
<td>Article 7: Rehost a Linux app on Azure VMs</td>
<td>Contoso completes a lift-and-shift migration of its Linux osTicket app to Azure VMs, using Azure Migrate.</td>
</tr>
<tr>
<td>ARTICLE</td>
<td>DETAILS</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Article 8: Rehost a Linux app on Azure VMs and Azure Database for MySQL</td>
<td>Contoso migrates its Linux osTicket app to Azure VMs using Azure Migrate. It migrates the app database to Azure Database for MySQL using Azure Database Migration Service (includes an alternative option using MySQL Workbench).</td>
</tr>
<tr>
<td>Article 9: Refactor an app in an Azure web app and Azure SQL Database</td>
<td>Contoso migrates its SmartHotel360 app to an Azure web app, and migrates the app database to an Azure SQL Server instance, using the Azure Database Migration Service.</td>
</tr>
<tr>
<td>Article 10: Refactor a Windows app using Azure App Services and SQL Managed Instance</td>
<td>Contoso migrates an on-premises Windows-based app to an Azure web app, and migrates the app database to an Azure SQL Managed Instance, using the Azure Database Migration Service.</td>
</tr>
<tr>
<td>Article 11: Refactor a Linux app in an Azure web app and Azure Database for MySQL</td>
<td>Contoso migrates its Linux osTicket app to an Azure web app in multiple Azure regions, using Azure Traffic Manager, integrated with GitHub for continuous delivery. Contoso migrates the app database to an Azure Database for MySQL instance.</td>
</tr>
<tr>
<td>Article 12: Refactor Team Foundation Server on Azure DevOps Services</td>
<td>Contoso migrates its on-premises Team Foundation Server deployment to Azure DevOps Services in Azure.</td>
</tr>
<tr>
<td>Article 13: Rebuild an app in Azure</td>
<td>Contoso rebuilds its SmartHotel app using a range of Azure capabilities and services, including Azure App Service, Azure Kubernetes Service (AKS), Azure Functions, Azure Cognitive Services, and Azure Cosmos DB.</td>
</tr>
<tr>
<td>Article 14: Scale a migration to Azure</td>
<td>After trying out migration combinations, Contoso prepares to scale to a full migration to Azure.</td>
</tr>
</tbody>
</table>

Next steps

- Learn about cloud migration.
- Learn about migration strategies for other scenarios (source/target pairs) in the Database Migration Guide.
Azure Migrate provides a hub of tools for assessment and migration, as well as third-party independent software vendor (ISV) offerings. This article helps you troubleshoot issues with Azure Migrate, Azure Migrate Server Assessment, and Azure Migrate Server Migration.

How do I create or find a project?
Review the Azure Migrate project troubleshooting guide.

I can't get the appliance working
Review answers to common issues with appliance deployment.

Machines aren't discovered
Review common discovery issues.

App-discovery isn't working
Discovery of apps, roles, and features running on on-premises machines is currently only supported for VMware VMs. Review common errors for app-discovery.

Assessment isn't working
Review common assessment issues and errors.
This article helps you troubleshoot issues when creating and managing Azure Migrate projects.

How to add new project?
You can have multiple Azure Migrate projects in a subscription. Learn how to create a project for the first time, or add additional projects.

What Azure permissions are needed?
You need Contributor or Owner permissions in the subscription to create an Azure Migrate project.

Can't find a project
Finding an existing Azure Migrate project depends upon whether you're using the current or old version of Azure Migrate. Follow.

Can't find a geography
You can create an Azure Migrate project in supported geographies for public and government clouds.

What are VM limits?
You can assess up to 35,000 VMware VMs or up to 35,000 Hyper-V VMs in a single project. A project can include both VMware VMs and Hyper-V VMs, up to the assessment limits.

Can I upgrade old project?
Projects from the previous version of Azure Migrate can't be updated. You need to create a new project, and add tools to it.

Can't create a project
If you try to create a project and encounter a deployment error:

- Try to create the project again in case it's a transient error. In Deployments, click on Re-deploy to try again.
- Check you have Contributor or Owner permissions in the subscription.
- If you're deploying in a newly added geography, wait a short time and try again.
- If you receive the error, "Requests must contain user identity headers", this might indicate that you don't have access to the Azure Active Directory (Azure AD) tenant of the organization. In this case:
  - When you're added to an Azure AD tenant for the first time, you receive an email invitation to join the tenant.
  - Accept the invitation to be added to the tenant.
  - If you can't see the email, contact a user with access to the tenant, and ask them to resend the invitation to you.
  - After receiving the invitation email, open it and select the link to accept the invitation. Then, sign out of the Azure portal and sign in again. (refreshing the browser won't work.) You can then start creating the
How do I delete a project

Follow these instructions to delete a project. Note that when you delete a project, both the project and the metadata about discovered machines in the project are deleted.

Added tools don't show

Make sure you have the right project selected. In the Azure Migrate hub > Servers or in Databases, click on Change next to Migrate project (Change) in the top-right corner of the screen. Choose the correct subscription and project name > OK. The page should refresh with the added tools of the selected project.

Next steps

Add assessment or migration tools to Azure Migrate projects.
This article helps you troubleshoot issues when deploying the Azure Migrate appliance, and using the appliance to discover on-premises machines.

What's supported?
Review the appliance support requirements.

"Invalid OVF manifest entry"
If you receive the error “The provided manifest file is invalid: Invalid OVF manifest entry”, do the following:

1. Verify that the Azure Migrate appliance OVA file is downloaded correctly by checking its hash value. Learn more. If the hash value doesn’t match, download the OVA file again and retry the deployment.
2. If deployment still fails, and you're using the VMware vSphere client to deploy the OVF file, try deploying it through the vSphere web client. If deployment still fails, try using a different web browser.
3. If you're using the vSphere web client and trying to deploy it on vCenter Server 6.5 or 6.7, try to deploy the OVA directly on the ESXi host:
   - Connect to the ESXi host directly (instead of vCenter Server) with the web client (https://<host IP Address>/ui).
   - In Home > Inventory, select File > Deploy OVF template. Browse to the OVA and complete the deployment.
4. If the deployment still fails, contact Azure Migrate support.

Can't connect to the internet
This can happen if the appliance machine is behind a proxy.
- Make sure you provide the authorization credentials if the proxy needs them.
- If you're using a URL-based firewall proxy to control outbound connectivity, add these URLs to an allow list.
- If you're using an intercepting proxy to connect to the internet, import the proxy certificate onto the appliance VM using these steps.

Can't sign into Azure from the appliance web app
The error “Sorry, but we're having trouble signing you in” appears if you're using the incorrect Azure account to sign into Azure. This error occurs for a couple of reasons:

- If you sign into the appliance web application for the public cloud, using user account credentials for the Government cloud portal.
- If you sign into the appliance web application for the government cloud using user account credentials for the private cloud portal.

Ensure you're using the correct credentials.

Date/time synchronization error
An error about date and time synchronization (802) indicates that the server clock might be out of synchronization with the current time by more than five minutes. Change the clock time on the collector VM to match the current time:

1. Open an admin command prompt on the VM.
2. To check the time zone, run `w32tm /tz`.
3. To synchronize the time, run `w32tm /resync`.

"UnableToConnectToServer"

If you get this connection error, you might be unable to connect to vCenter Server `servername.com:9443`. The error details indicate that there's no endpoint listening at `https://\*servername*.com:9443/sdk` that can accept the message.

- Check whether you're running the latest version of the appliance. If you're not, upgrade the appliance to the latest version.
- If the issue still occurs in the latest version, the appliance might be unable to resolve the specified vCenter Server name, or the specified port might be wrong. By default, if the port is not specified, the collector will try to connect to port number 443.
  1. Ping `servername.com` from the appliance.
  2. If step 1 fails, try to connect to the vCenter server using the IP address.
  3. Identify the correct port number to connect to vCenter Server.
  4. Verify that vCenter Server is up and running.

Error 60052/60039: Appliance might not be registered

- Error 60052, "The appliance might not be registered successfully to the Azure Migrate project" occurs if the Azure account used to register the appliance has insufficient permissions.
  - Make sure that the Azure user account used to register the appliance has at least Contributor permissions on the subscription.
  - Learn more about required Azure roles and permissions.
- Error 60039, "The appliance might not be registered successfully to the Azure Migrate project" can occur if registration fails because the Azure Migrate project used to the register the appliance can't be found.
  - In the Azure portal and check whether the project exists in the resource group.
  - If the project doesn't exist, create a new Azure Migrate project in your resource group and register the appliance again. Learn how to create a new project.

Error 60030/60031: Key Vault management operation failed

If you receive the error 60030 or 60031, "An Azure Key Vault management operation failed", do the following:

- Make sure the Azure user account used to register the appliance has at least Contributor permissions on the subscription.
- Make sure the account has access to the key vault specified in the error message, and then retry the operation.
- If the issue persists, contact Microsoft support.
- Learn more about the required Azure roles and permissions.

Error 60028: Discovery couldn't be initiated

Error 60028: "Discovery couldn't be initiated because of an error. The operation failed for the specified list of hosts or clusters" indicates that discovery couldn't be started on the hosts listed in the error because of a problem in
accessing or retrieving VM information. The rest of the hosts were successfully added.

- Add the hosts listed in the error again, using the **Add host** option.
- If there's a validation error, review the remediation guidance to fix the errors, and then try the **Save and start discovery** option again.

## Error 60025: Azure AD operation failed

Error 60025: “An Azure AD operation failed. The error occurred while creating or updating the Azure AD application” occurs when the Azure user account used to initiate the discovery is different from the account used to register the appliance. Do one of the following:

- Ensure that the user account initiating the discovery is same as the one used to register the appliance.
- Provide Azure Active Directory application access permissions to the user account for which the discovery operation is failing.
- Delete the resource group previously created for the Azure Migrate project. Create another resource group to start again.
- Learn more about Azure Active Directory application permissions.

## Error 50004: Can't connect to host or cluster

Error 50004: “Can't connect to a host or cluster because the server name can't be resolved. WinRM error code: 0x803381B9” might occur if the Azure DNS service for the appliance can't resolve the cluster or host name you provided.

- If you see this error on the cluster, cluster FQDN.
- You might also see this error for hosts in a cluster. This indicates that the appliance can connect to the cluster, but the cluster returns host names that aren't FQDNs. To resolve this error, update the hosts file on the appliance by adding a mapping of the IP address and host names:
  1. Open Notepad as an admin.
  2. Open the C:\Windows\System32\Drivers\etc\hosts file.
  3. Add the IP address and host name in a row. Repeat for each host or cluster where you see this error.
  4. Save and close the hosts file.
  5. Check whether the appliance can connect to the hosts, using the appliance management app. After 30 minutes, you should see the latest information for these hosts in the Azure portal.

## Discovered VMs not in portal

If discovery state is "Discovery in progress", but don't yet see the VMs in the portal, wait a few minutes:

- It takes around 15 minutes for a VMware VM.
- It takes around two minutes for each added host for Hyper-V VM discovery.

If you wait and the state doesn't change, select **Refresh** on the **Servers** tab. This should show the count of the discovered servers in Azure Migrate: Server Assessment and Azure Migrate: Server Migration.

If this doesn't work and you're discovering VMware servers:

- Verify that the vCenter account you specified has permissions set correctly, with access to at least one VM.
- Azure Migrate can't discovered VMware VMs if the vCenter account has access granted at vCenter VM folder level. Learn more about scoping discovery.

## VM data not in portal

...
If discovered VMs don’t appear in the portal or if the VM data is outdated, wait a few minutes. It takes up to 30 minutes for changes in discovered VM configuration data to appear in the portal. It may take a few hours for changes in application data to appear. If there’s no data after this time, try refreshing, as follows:

1. In Servers > Azure Migrate Server Assessment, select Overview.
2. Under Manage, select Agent Health.
3. Select Refresh agent.
4. Wait for the refresh operation to complete. You should now see up-to-date information.

### Deleted VMs appear in portal

If you delete VMs and they still appear in the portal, wait 30 minutes. If they still appear, refresh as described above.

### Common app discovery errors

Azure Migrate supports discovery of applications, roles, and features, using Azure Migrate: Server Assessment. App discovery is currently supported for VMware only. Learn more about the requirements and steps for setting up app discovery.

Typical app discovery errors are summarized in the table.

<table>
<thead>
<tr>
<th>ERROR</th>
<th>CAUSE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>10000: “Unable to discover the applications installed on the server”.</td>
<td>This might occur if the machine operating system isn’t Windows or Linux.</td>
<td>Only use app discovery for Windows/Linux.</td>
</tr>
<tr>
<td>10001: “Unable to retrieve the applications installed the server”.</td>
<td>Internal error - some missing files in appliance.</td>
<td>Contact Microsoft Support.</td>
</tr>
<tr>
<td>10002: “Unable to retrieve the applications installed the server”.</td>
<td>The discovery agent on the appliance might not be working properly.</td>
<td>If the issue doesn’t resolve itself within 24 hours, contact support.</td>
</tr>
<tr>
<td>10003 “Unable to retrieve the applications installed the server”.</td>
<td>The discovery agent on the appliance might not be working properly.</td>
<td>If the issue doesn’t resolve itself within 24 hours, contact support.</td>
</tr>
<tr>
<td>10004: “Unable to discover installed applications for &lt;Windows/Linux&gt; machines.”</td>
<td>Credentials to access &lt;Windows/Linux&gt; machines weren’t provided in the appliance.</td>
<td>Add a credential to the appliance that has access to the &lt;Windows/Linux&gt; machines.</td>
</tr>
<tr>
<td>10005: “Unable to access the on-premises server”.</td>
<td>The access credentials might be wrong.</td>
<td>Update the appliance credentials make sure you can access the relevant machine with them.</td>
</tr>
<tr>
<td>10006: “Unable to access the on-premises server”.</td>
<td>This might occur if the machine operating system isn’t Windows or Linux.</td>
<td>Only use app discovery for Windows/Linux.</td>
</tr>
<tr>
<td>10007: “Unable to process the metadata retrieved”</td>
<td>This internal error occurred while trying to deserialize JSON</td>
<td>Contact Microsoft Support for a resolution</td>
</tr>
<tr>
<td>9000/9001/9002: “Unable to discover the applications installed on the server”.</td>
<td>VMware tools might not be installed or is corrupted.</td>
<td>Install/reinstall VMware tools on the relevant machine, and check it’s running.</td>
</tr>
<tr>
<td>ERROR</td>
<td>CAUSE</td>
<td>ACTION</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>9003: Unable to discover</td>
<td>This might occur if the machine operating system isn't Windows or</td>
<td>Only use app discovery for Windows/Linux.</td>
</tr>
<tr>
<td>the applications installed</td>
<td>Linux.</td>
<td></td>
</tr>
<tr>
<td>on the server&quot;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9004: &quot;Unable to discover</td>
<td>This might happen if the VM is powered off.</td>
<td>For discovery, make sure the VM is on.</td>
</tr>
<tr>
<td>the applications installed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>on the server&quot;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9005: &quot;Unable to discover</td>
<td>This might occur if the machine operating system isn't Windows or</td>
<td>Only use app discovery for Windows/Linux.</td>
</tr>
<tr>
<td>the applications installed</td>
<td>Linux.</td>
<td></td>
</tr>
<tr>
<td>on the VM.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9006/9007: &quot;Unable to</td>
<td>The discovery agent on the appliance might not be working properly.</td>
<td>If the issue doesn't resolve itself within</td>
</tr>
<tr>
<td>retrieve the applications</td>
<td></td>
<td>24 hours, contact support.</td>
</tr>
<tr>
<td>installed the server&quot;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9008: &quot;Unable to retrieve</td>
<td>Might be an internal error</td>
<td>If the issue doesn't resolve itself within</td>
</tr>
<tr>
<td>the applications installed</td>
<td></td>
<td>24 hours, contact support.</td>
</tr>
<tr>
<td>the server&quot;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9009: &quot;Unable to retrieve</td>
<td>Can occur if the Windows User Account Control (UAC) settings on the</td>
<td>Search for 'User Account Control' settings</td>
</tr>
<tr>
<td>the applications installed</td>
<td>server are restrictive, and prevent discovery of installed</td>
<td>on the server, and configure the UAC</td>
</tr>
<tr>
<td>the server&quot;.</td>
<td>applications.</td>
<td>setting on the server to one of the lower</td>
</tr>
<tr>
<td>9010: &quot;Unable to retrieve</td>
<td>Might be an internal error</td>
<td>two levels.</td>
</tr>
<tr>
<td>the applications installed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>the server&quot;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9011: &quot;File to download</td>
<td>The issue can occur due to an internal error.</td>
<td>The issue should automatically get resolved</td>
</tr>
<tr>
<td>from guest is not found on</td>
<td></td>
<td>in 24 hours. If the issue still persists,</td>
</tr>
<tr>
<td>the guest VM&quot;</td>
<td></td>
<td>please contact Microsoft Support.</td>
</tr>
<tr>
<td>9012: &quot;Result file contents</td>
<td>The issue can occur due to an internal error.</td>
<td>The issue should automatically get resolved</td>
</tr>
<tr>
<td>are empty.&quot;</td>
<td></td>
<td>in 24 hours. If the issue still persists,</td>
</tr>
<tr>
<td>9013: &quot;A new temporary</td>
<td>A new temporary profile is created for every login into the VM</td>
<td>Ensure the user name provided in the guest</td>
</tr>
<tr>
<td>profile is created for</td>
<td></td>
<td>VM credentials is in UPN format.</td>
</tr>
<tr>
<td>every login to the VMware</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VM&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9015: &quot;Unable to connect</td>
<td>Guest Operations role is not enabled on the vCenter user account</td>
<td>Ensure Guest Operations role is enabled on</td>
</tr>
<tr>
<td>to VMware VMs due to</td>
<td></td>
<td>the vCenter user account.</td>
</tr>
<tr>
<td>insufficient privileges on</td>
<td></td>
<td></td>
</tr>
<tr>
<td>vCenter&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9016: &quot;Unable to connect</td>
<td>VMware tools is not properly installed or is not up to date.</td>
<td>Ensure the VMware tools is properly</td>
</tr>
<tr>
<td>to VMware VMs as the</td>
<td></td>
<td>installed and up to date.</td>
</tr>
<tr>
<td>guest operations agent is</td>
<td></td>
<td></td>
</tr>
<tr>
<td>out of data&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9017: &quot;File with discovered</td>
<td>The issue can occur due to an internal error.</td>
<td>Contact Microsoft Support for a</td>
</tr>
<tr>
<td>metadata is not found on</td>
<td></td>
<td>resolution.</td>
</tr>
<tr>
<td>the VM.&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9018: &quot;PowerShell is not</td>
<td>PowerShell is not available in the guest VM.</td>
<td>Install PowerShell in the guest VM.</td>
</tr>
<tr>
<td>installed in the Guest</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMs.&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ERROR</th>
<th>CAUSE</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>9019: “Unable to discover due to guest VM operation failures”</td>
<td>VMware guest operation failed on the VM.</td>
<td>Ensure that the VM credentials are valid and user name provided in the guest VM credentials is in UPN format.</td>
</tr>
<tr>
<td>9020: “File creation permission is denied.”</td>
<td>The role associated to the user or the group policy is restricting the user to create the file in the folder</td>
<td>Check if the guest user provided has create permission for the file in the folder. See Notifications in Server Assessment for the name of the folder.</td>
</tr>
<tr>
<td>9021: “File create permission is denied in folder System Temp Path.”</td>
<td>VMware tool version on the VM is unsupported</td>
<td>Upgrade your VMware tool version above 10.2.0.</td>
</tr>
<tr>
<td>9022: “Get WMI object access is denied.”</td>
<td>The role associated to the user or the group policy is restricting the user to access WMI object.</td>
<td>Please contact Microsoft Support.</td>
</tr>
<tr>
<td>9023: “SystemRoot environment variable value is empty.”</td>
<td>Not known</td>
<td>Please contact Microsoft Support.</td>
</tr>
<tr>
<td>9024: “TEMP environment variable value is empty.”</td>
<td>Not known</td>
<td>Please contact Microsoft Support.</td>
</tr>
<tr>
<td>9025: “PowerShell is corrupt in the Guest VMs.”</td>
<td>Not known</td>
<td>Reinstall PowerShell in the guest VM and check if PowerShell can be run on the guest VM.</td>
</tr>
<tr>
<td>8084: “Unable to discover applications due to VMware error.”</td>
<td>The Azure Migrate appliance uses VMware APIs to discover applications. This issue can happen if an exception is thrown by vCenter Server while trying to discover applications. The fault message from VMware is displayed in the error message shown in portal.</td>
<td>Search for the message in the VMware documentation, and follow the steps to fix. If you can't fix, contact Microsoft support.</td>
</tr>
</tbody>
</table>

**Next steps**

Set up an appliance for VMware, Hyper-V, or physical servers.
This article helps you troubleshoot issues with assessment and dependency visualization with Azure Migrate: Server Assessment.

Assessment readiness issues

Fix assessment readiness issues as follows:

<table>
<thead>
<tr>
<th>ISSUE</th>
<th>FIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsupported boot type</td>
<td>Azure doesn't support VMs with an EFI boot type. We recommend that you convert the boot type to BIOS before you run a migration.</td>
</tr>
<tr>
<td></td>
<td>You can use Azure Migrate Server Migration to handle the migration of such VMs. It will convert the boot type of the VM to BIOS during the migration.</td>
</tr>
<tr>
<td>Conditionally supported Windows operating system</td>
<td>The operating system has passed its end-of-support date, and needs a Custom Support Agreement (CSA) for support in Azure. Consider upgrading before you migrate to Azure.</td>
</tr>
<tr>
<td>Unsupported Windows operating system</td>
<td>Azure supports only selected Windows OS versions. Consider upgrading the machine before you migrate to Azure.</td>
</tr>
<tr>
<td>Conditionally endorsed Linux OS</td>
<td>Azure endorses only selected Linux OS versions. Consider upgrading the machine before you migrate to Azure.</td>
</tr>
<tr>
<td>Unendorsed Linux OS</td>
<td>The machine might start in Azure, but Azure provides no operating system support. Consider upgrading to an endorsed Linux version before you migrate to Azure.</td>
</tr>
<tr>
<td>Unknown operating system</td>
<td>The operating system of the VM was specified as &quot;Other&quot; in vCenter Server. This behavior blocks Azure Migrate from verifying the Azure readiness of the VM. Make sure that the operating system is supported by Azure before you migrate the machine.</td>
</tr>
<tr>
<td>Unsupported bit version</td>
<td>VMs with a 32-bit operating systems might boot in Azure, but we recommended that you upgrade to 64-bit before you migrate to Azure.</td>
</tr>
<tr>
<td>Requires a Microsoft Visual Studio subscription</td>
<td>The machine is running a Windows client operating system, which is supported only through a Visual Studio subscription.</td>
</tr>
<tr>
<td>VM not found for the required storage performance</td>
<td>The storage performance (input/output operations per second [IOPS] and throughput) required for the machine exceeds Azure VM support. Reduce storage requirements for the machine before migration.</td>
</tr>
<tr>
<td>ISSUE</td>
<td>FIX</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>VM not found for the required network performance</td>
<td>The network performance (in/out) required for the machine exceeds Azure VM support. Reduce the networking requirements for the machine.</td>
</tr>
<tr>
<td>VM not found in the specified location</td>
<td>Use a different target location before migration.</td>
</tr>
<tr>
<td>One or more unsuitable disks</td>
<td>One or more disks attached to the VM don't meet Azure requirements.</td>
</tr>
<tr>
<td></td>
<td>Azure Migrate: Server Assessment currently doesn't support Ultra SSD disks, and assesses the disks based on the disk limits for premium managed disks (32 TB).</td>
</tr>
<tr>
<td></td>
<td>For each disk attached to the VM, make sure that the size of the disk is $&lt; 64$ TB (supported by Ultra SSD disks).</td>
</tr>
<tr>
<td></td>
<td>If it isn't, reduce the disk size before you migrate to Azure, or use multiple disks in Azure and stripe them together to get higher storage limits. Make sure that the performance (IOPS and throughput) needed by each disk is supported by Azure managed virtual machine disks.</td>
</tr>
<tr>
<td>One or more unsuitable network adapters.</td>
<td>Remove unused network adapters from the machine before migration.</td>
</tr>
<tr>
<td>Disk count exceeds limit</td>
<td>Remove unused disks from the machine before migration.</td>
</tr>
<tr>
<td>Disk size exceeds limit</td>
<td>Azure Migrate: Server Assessment currently doesn't support Ultra SSD disks, and assesses the disks based on premium disk limits (32 TB).</td>
</tr>
<tr>
<td></td>
<td>However, Azure supports disks with up to 64-TB size (supported by Ultra SSD disks). Shrink disks to less than 64 TB before migration, or use multiple disks in Azure and stripe them together to get higher storage limits.</td>
</tr>
<tr>
<td>Disk unavailable in the specified location</td>
<td>Make sure the disk is in your target location before you migrate.</td>
</tr>
<tr>
<td>Disk unavailable for the specified redundancy</td>
<td>The disk should use the redundancy storage type defined in the assessment settings (LRS by default).</td>
</tr>
<tr>
<td>Could not determine disk suitability because of an internal error</td>
<td>Try creating a new assessment for the group.</td>
</tr>
<tr>
<td>VM with required cores and memory not found</td>
<td>Azure couldn't find a suitable VM type. Reduce the memory and number of cores of the on-premises machine before you migrate.</td>
</tr>
<tr>
<td>Could not determine VM suitability because of an internal error</td>
<td>Try creating a new assessment for the group.</td>
</tr>
<tr>
<td>Could not determine suitability for one or more disks because of an internal error</td>
<td>Try creating a new assessment for the group.</td>
</tr>
</tbody>
</table>
Linux VMs are "conditionally ready"

Server Assessment marks Linux VMs as "Conditionally ready" due to a known gap in Server Assessment.

- The gap prevents it from detecting the minor version of the Linux OS installed on the on-premises VMs.
- For example, for RHEL 6.10, currently Server Assessment detects only RHEL 6 as the OS version.
- Because Azure endorses only specific versions of Linux, the Linux VMs are currently marked as conditionally ready in Server Assessment.
- You can determine whether the Linux OS running on the on-premises VM is endorsed in Azure by reviewing Azure Linux support.
- After you've verified the endorsed distribution, you can ignore this warning.

Azure SKUs bigger than on-premises

Azure Migrate Server Assessment might recommend Azure VM SKUs with more cores and memory than current on-premises allocation based on the type of assessment:

- The VM SKU recommendation depends on the assessment properties.
- This is affected by the type of assessment you perform in Server Assessment: Performance-based, or As on-premises.
- For performance-based assessments, Server Assessment considers the utilization data of the on-premises VMs (CPU, memory, disk, and network utilization) to determine the right target VM SKU for your on-premises VMs. It also adds a comfort factor when determining effective utilization.
- For on-premises sizing, performance data is not considered, and the target SKU is recommended based on-premises allocation.

To show how this can affect recommendations, let's take an example:

We have an on-premises VM with four cores and eight GB of memory, with 50% CPU utilization and 50% memory utilization, and a specified comfort factor of 1.3.

- If the assessment is As on-premises, an Azure VM SKU with four cores and 8 GB of memory is recommended.
- If the assessment is performance-based, based on effective CPU and memory utilization (50% of 4 cores * 1.3 = 2.6 cores and 50% of 8-GB memory * 1.3 = 5.3-GB memory), the cheapest VM SKU of four cores (nearest supported core count) and eight GB of memory (nearest supported memory size) is recommended.
- Learn more about assessment sizing.

Azure disk SKUs bigger than on-premises

Azure Migrate Server Assessment might recommend a bigger disk based on the type of assessment.

- Disk sizing in Server Assessment depends on two assessment properties: sizing criteria and storage type.
- If the sizing criteria is Performance-based, and the storage type is set to Automatic, the IOPS, and throughput values of the disk are considered when identifying the target disk type (Standard HDD, Standard SSD, or Premium). A disk SKU from the disk type is then recommended, and the recommendation considers the size requirements of the on-premises disk.
- If the sizing criteria is Performance-based, and the storage type is Premium, a premium disk SKU in Azure is recommended based on the IOPS, throughput, and size requirements of the on-premises disk. The same logic is
used to perform disk sizing when the sizing criteria is **As on-premises** and the storage type is **Standard HDD**, **Standard SSD**, or **Premium**.

As an example, if you have an on-premises disk with 32 GB of memory, but the aggregated read and write IOPS for the disk is 800 IOPS, Server Assessment recommends a premium disk (because of the higher IOPS requirements), and then recommends a disk SKU that can support the required IOPS and size. The nearest match in this example would be P15 (256 GB, 1100 IOPS). Even though the size required by the on-premises disk was 32 GB, Server Assessment recommends a larger disk because of the high IOPS requirement of the on-premises disk.

**Utilized core/memory percentage missing**

Server Assessment reports “PercentageOfCoresUtilizedMissing” or “PercentageOfMemoryUtilizedMissing” when the Azure Migrate appliance can’t collect performance data for the relevant on-premises VMs.

- This can occur if the VMs are turned off during the assessment duration. The appliance can’t collect performance data for a VM when it’s turned off.
- If only the memory counters are missing and you’re trying to assess Hyper-V VMs, check whether you have dynamic memory enabled on these VMs. There’s a known issue for Hyper-V VMs only, in which an Azure Migrate appliance can’t collect memory utilization data for VMs that don’t have dynamic memory enabled.
- If any of the performance counters are missing, Azure Migrate Server Assessment falls back to the allocated cores and memory, and it recommends a corresponding VM size.
- If all of the performance counters are missing, ensure the port access requirements for assessment are met.
  Learn more about the port access requirements for **VMware**, **Hyper-V** and **physical** server assessment.

**Is the operating system license included?**

Azure Migrate Server Assessment currently considers the operating system license cost only for Windows machines. License costs for Linux machines aren’t currently considered.

**How does performance-based sizing work?**

Server Assessment continuously collects performance data of on-premises machines and uses it to recommend the VM SKU and disk SKU in Azure. Learn how performance-based data is collected.

**Dependency visualization in Azure Government**

Azure Migrate depends on Service Map for the dependency visualization functionality. Because Service Map is currently unavailable in Azure Government, this functionality is not available in Azure Government.

**Dependencies don't show after agent install**

After you’ve installed the dependency visualization agents on on-premises VMs, Azure Migrate typically takes 15-30 minutes to display the dependencies in the portal. If you’ve waited for more than 30 minutes, make sure that the Microsoft Monitoring Agent (MMA) can connect to the Log Analytics workspace.

For Windows VMs:

1. In the Control Panel, start MMA.
2. In the **Microsoft Monitoring Agent properties** > **Azure Log Analytics (OMS)**, make sure that the **Status** for the workspace is green.
3. If the status isn’t green, try removing the workspace and adding it again to MMA.
For Linux VMs, make sure that the installation commands for MMA and the dependency agent succeeded.

**Supported operating systems**

- **MMS agent**: Review the supported Windows, and Linux operating systems.
- **Dependency agent**: the supported Windows and Linux operating systems.

**Visualize dependencies for > hour**

Although Azure Migrate allows you to go back to a particular date in the last month, the maximum duration for which you can visualize the dependencies is one hour.

For example, you can use the time duration functionality in the dependency map to view dependencies for yesterday, but you can view them for a one-hour period only.

However, you can use Azure Monitor logs to query the dependency data over a longer duration.

**Visualized dependencies for > 10 machines**

In Azure Migrate Server Assessment, you can visualize dependencies for groups with up to 10 VMs. For larger groups, we recommend that you split the VMs into smaller groups to visualize dependencies.

**Machines show "Install agent"**

After migrating machines with dependency visualization enabled to Azure, machines might show "Install agent" action instead of "View dependencies" due to the following behavior:

- After migration to Azure, on-premises machines are turned off and equivalent VMs are spun up in Azure. These
machines acquire a different MAC address.

- Machines might also have a different IP address, based on whether you’ve retained the on-premises IP address or not.
- If both MAC and IP addresses are different from on-premises, Azure Migrate doesn't associate the on-premises machines with any Service Map dependency data. In this case, it will show the option to install the agent rather than to view dependencies.
- After a test migration to Azure, on-premises machines remain turned on as expected. Equivalent machines spun up in Azure acquire different MAC address and might acquire different IP addresses. Unless you block outgoing Azure Monitor log traffic from these machines, Azure Migrate won’t associate the on-premises machines with any Service Map dependency data, and thus will show the option to install agents, rather than to view dependencies.

**Capture network traffic**

Collect network traffic logs as follows:

1. Sign in to the Azure portal.
2. Press F12 to start Developer Tools. If needed, clear the **Clear entries on navigation** setting.
3. Select the **Network** tab, and start capturing network traffic:
   - In Chrome, select **Preserve log**. The recording should start automatically. A red circle indicates that traffic is being captured. If the red circle doesn't appear, select the black circle to start.
   - In Microsoft Edge and Internet Explorer, recording should start automatically. If it doesn't, select the green play button.
4. Try to reproduce the error.
5. After you've encountered the error while recording, stop recording, and save a copy of the recorded activity:
   - In Chrome, right-click and select **Save as HAR with content**. This action compresses and exports the logs as a .har file.
   - In Microsoft Edge or Internet Explorer, select the **Export captured traffic** option. This action compresses and exports the log.
6. Select the **Console** tab to check for any warnings or errors. To save the console log:
   - In Chrome, right-click anywhere in the console log. Select **Save as**, to export, and zip the log.
   - In Microsoft Edge or Internet Explorer, right-click the errors and select **Copy all**.

**Next steps**

Create or customize an assessment.